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1 Engineers Handbooks

The Engineer's Handbooks provide wider guidance on specific areas of the
program, for example, the workflows necessary to achieve specific design
objectives.

We recommend you familiarize yourself with the Engineer's Handbook topics
from the list below that are relevant to the types of structure you work with:

• Wind modeling handbook (page 11)

• Stability and imperfections handbook (page 111)

• Static analysis and design handbook (page 130)

• Seismic analysis and design handbook (page 156)

• Steel design handbook (page 172)

• Concrete member design handbook (page 247)

• Precast member design handbook (page 502)

• Timber member design handbook (page 539)

• Foundation design handbook (page 555)

• Sustainability and Tekla Structural Designer (page 618)

• Analysis verification examples (page 628)

1.1 Wind modeling handbook
Wind loads can be applied to Tekla Structural Designer models in a variety of
ways. The most appropriate method to use will generally depend on the type
and complexity of the structure.

• The wind model method (page 12) is suitable for regular closed structures
that can be readily clothed in wall panels and roof panels.

• The open structure wind method (page 89) is suitable for open industrial
structures that cannot be clothed in wall panels and roof panels.
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• The simple wind method (page 97) provides a quick means to apply wind
loads to a closed structure without having to create a wind model.

• For tall buildings you may require the assistance of wind specialists to
perform wind tunnel testing (page 108). The information they supply can
then be imported to Tekla Structural Designer model in the form of
diaphragm loads.

NOTE The Wind Model method is not currently available for the AS:1170.2
wind code variant.

Click the links below to find out more:

• Use of a wind model to create wind loads (page 12)

• The open structure wind method (page 89)

• Manually applied wind loads and simple wind loads (page 97)

• Wind tunnel testing and diaphragm loads (page 108)

Use of a wind model to create wind loads
This method is typically used for enclosed structures and requires at least one
wall panel, or roof panel to exist before it becomes available.

In this method, you 'clothe' the structure in wind and roof panels, and then
create a wind model by running the Wind Wizard.

The wizard creates wind zone loads that are subsequently decomposed to the
structure during analysis.

Wind loadcases are then created for the required directions.

• Overview of the wind model method (page 12)

• ASCE 7 Wind wizard (page 15)

• EC1991 1-4 Wind wizard (page 30)

• BS6399-2 Wind wizard (page 54)

• IS 875 (Part 3) Wind Wizard (page 71)

• Wind model loadcases (page 75)

• Wind model load decomposition (page 80)

NOTE The Wind Model method is not currently available for the AS:1170.2 wind
code variant.
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Overview of the wind model method
This guide provides an outline of the basic steps required to use the wind
model method.

The basic steps required to undertake the wind model method are as follows:

Clothe the structure in wind wall and roof panels

The Wind Model calculations depend on the geometry and inter-connectivity
of the wall panels and roof panels that envelope the building. You must
therefore define the model together with its wall and roof panels before you
run the Wind Wizard....

NOTE You can, should you wish, use Tekla Structural Designer purely for wind
assessment - by setting up a model consisting only of wall panels and roof
panels (no members). Tekla Structural Designercan then determine the wind
loading on the building envelope.

In order to get the best results you should ensure that you define the largest
possible sizes for the wind wall and roof panels. You may compromise the
results if you define many small panels rather than one large one. (The
calculation of the reference height in particular can be unconservative.)

Applying Wall Panels

A single wall panel is determined to be a single planar surface. The outward
face is vitally important for determining the wind direction relative to the wall,
that is windward or leeward.

It is recommended that you check the outward faces are as you intend by
ensuring they are all shaded in the same color (the one assigned to 'Wind Wall
- Front' in Settings > Scene). The inward faces will all be shaded in a different
color. To correct any mistakes, choose the Edit --> Reverse command and
then click once on a wall panel to switch its direction. Note that connected wall
panels are checked to ensure that the normal directions are consistent
whenever automatic zoning is carried out, for example at the end of the Wind
Wizard.... If there is a problem it is indicated on the Project Workspace -->
Wind tab, with affected panels being marked.

Once a wall panel has been placed the following additional panel properties
can be specified:

• Rotation angle - defines the span direction, 0° is horizontal and 90° is
vertical.

• Is a parapet wall - you can indicate whether the wall panel is a parapet or
not.

NOTE If a building face comprises a parapet above a wall, you should not
attempt to model this as a single wall panel. It should be input as
an upper and lower panel, with the upper panel being set as a
parapet.
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• Gap - (Head Codes: EC and BS only) where the gap to the adjacent building
is not consistent due to the shapes of the buildings it is up to you to decide
whether to specify the average or worst-case gap. The default gap is 1000
m which effectively give no funnelling. A zero gap value explicitly means
ignore funnelling, for example where this building and the adjacent one are
sheltered by upwind buildings

• Solidity - (Head Codes: EC and BS only) If you set the wall panel as a
parapet, then you also need to indicate the Solidity of the parapet. (Wall
panels that are not parapets automatically adopt a solidarity of 1.0).

• Decompose to - for wall panels that are not parapets, you can indicate
how the wall load is decomposed on to supporting members. See Wind
model load decomposition (page 80)

To set this information as you require, select the wall panels and then use the
Properties Window to make changes.

Applying Roof Panels

A single roof panel is determined to be a single planar surface. The orientation
of a roof panel is automatically determined when placed based upon the slope
vector - the line of maximum roof slope.

Initially the roof type is set to 'Default'. This is interpreted as Flat if the roof
slope < 5 degrees, otherwise it is interpreted as Monopitch. You should select
the roof panel and then use the Properties Window to adjust the roof type as
necessary for all other situations (i.e. For Duopitch, Hip Main, Hip Gable or
Mansard).

The span direction is also set in the Properties Window, this is defined as an
angle, where 0° is parallel to the X axis and 90° is parallel to the Y axis.

Perform the gravity design

We recommend that you perform an analysis and design at this stage for the
gravity loading only, but this is not essential.

Run the wind wizard

Once the model has been 'clothed' in wall panels and roof panels, the Wind
Wizard (located on the Load toolbar) guides you through the process of
intelligently 'applying' wind to the resulting building envelope.

The wizard uses databases where appropriate (depending on the wind code)
to determine the appropriate wind details for your structure location.

Having defined the wind directions in which you are interested, on completion
of the wizard the appropriate wind zones on the roofs and walls of your
structure are automatically calculated.

Related topics

EC1991 1-4 Wind wizard (page 30)

ASCE 7 Wind wizard (page 15)
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BS6399-2 Wind wizard (page 54)

IS 875 (Part 3) Wind Wizard (page 71)

Review the wind zones

The resulting wind model is accessed from the Project Workspace Wind tab.
Wind Views can also be opened as required for each wind direction.

From here, you can set the type of each roof to achieve the correct zoning, and
can then tailor the zoning to account for particular features in more detail, if
you so require.

Define the wind loadcases

The Wind Loadcases dialog (located on the Load toolbar) can then be used to
automatically define standard wind loadcases for you based on the usual
internal pressure coefficients, or you can define the loadcase information
yourself. In both cases the appropriate wind pressures are calculated on each
zone.

NOTE It is assumed that the wind loads are developed to assess the overall stability
of the structure and for member design. The wind loads have not been
specifically developed for the design of cladding and fixings.

Related topics

Wind model loadcases (page 75)

Review wind zone loads

Wind zones can be graphically displayed for each wind direction from the
appropriate Wind View. Once the wind loadcases have been created you can
also display the wind pressures and zone loads for each loadcase.

Combine the wind loadcases into design combinations

Combine the wind loadcases into design combinations in the usual way.

Perform the static design

Run a static design from the Design toolbar.

ASCE 7 Wind wizard
This topic will discuss in detail the Wind wizard when using ASCE7

To access this configuration of the Wind Wizard the Wind Loading Code has to
be set to ASCE7.

Once the wall and roof panels are in place, you use the Wind Wizard on the
Load toolbar to define sufficient site information to calculate the velocity
pressures for the required wind directions and heights around the building.
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NOTE Unless explicitly noted otherwise, all clauses, figures and tables referred to in
the topics in this section are from ASCE 7-10. References (page 89) 1.

Topics in this section

Scope (ASCE7 Wind Wizard) (page 16)

Limitations (ASCE7 Wind Wizard) (page 16)

Choice of Method (ASCE7 Wind Wizard) (page 18)

Low Rise Buildings - Geometry (ASCE7 Wind Wizard) (page 20)

Rigid Buildings of All Heights - Geometry (ASCE7 Wind Wizard) (page 22)

Basic Wind Data (ASCE7 Wind Wizard) (page 25)

Results (ASCE7 Wind Wizard) (page 26)

Wind Zones - ASCE7 Low Rise Building Method (page 27)

Wind Zones - ASCE7 All Heights Method (page 28)

Scope (ASCE7 Wind Wizard)

The scope of ASCE7-10 Wind Wizard encompasses:

• Choice of method:

• ASCE/SEI 7-10 - Directional Procedure Part 1 - Rigid Buildings of All
Heights

• ASCE/SEI 7-10 - Envelope Procedure Part 1 - Low-Rise Buildings

• The input of appropriate basic wind data is your responsibility.

• Having defined wall panels and roof panels (defaults are standard wall, flat
or pitched roof depending on the slope), you are able to specify the type in
more detail e.g. monoslope / mansard etc.

• Wherever possible the wind parameters are determined for you but
conservatively, you are able to override the values should you wish to.

• Given the above, zoning is semi-automatic, with full graphical feedback.

• Load decomposition is fully automatic where valid, (wall panels and roof
panels need to be fully supported in the direction of span).

• There may be situations when you perceive a need to manually define
loads that cannot be determined automatically. You can do this by defining
additional wind loadcases to contain these loads and then include these
with the relevant system generated loads in design combinations in the
normal way.

Limitations (ASCE7 Wind Wizard)
This page discusses the limitations to the wind wizard.
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Throughout the development of the Wind Wizard extensive reference has
been made to the References (page 89) and we consider it advisable that you
are fully familiar with these before using the software.

In addition, because wind loading is complex and its application to general
structures even more so, it is essential that you read and fully appreciate the
following limitations in the software:

Geometry

The shape of the building must lie within the shapes that are valid according to
ASCE7-10 Clauses 27.1.2 and 28.1.2:

• It should be a regular shaped building or structure

• It should not have response characteristics making it subject to across-
wind loading, vortex shedding, instability due to galloping or flutter; or
have a site location for which channelling effects or buffeting in the wake of
upwind obstructions warrant special consideration.

Although the software will generate wind loads for many situations - it is up to
you to accept that the loads generated are suitable according to ASCE7-10.

Other documented limitations include:

• Buildings must be enclosed or partially enclosed.

• Open sided buildings are not considered.

• Only rigid buildings are considered, not flexible buildings.

• Zones and loadcases are not generated for components and cladding.

• You will need to establish and enter the wind data yourself.

• Roof types must be set manually.

• Barrel-vault and domed roofs are not considered.

• Parapets and free-standing canopies are not considered.

• Roof Overhangs are not explicitly handled.

• There is no special handling for Multi-Bay roofs as they are not covered
explicitly in ASCE 7-10.

• There is no special handling for troughed roofs as they are not covered
explicitly in ASCE 7-10.

Loaded area

The difference between the loaded area of wall panels and roof panels defined
at the centre-line rather than the sheeting dimension is ignored.
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Wind direction

• All outward faces within 60 degs of being perpendicular to wind direction -
loads applied as windward normal to face. All inside faces within 60 degs to
wind direction - loads applied as leeward normal to face. All other faces
considered as side.

• Orthogonal wind directions at the definition of the user.

Design wind load

The design wind load is not explicitly checked to ensure it is greater than the
minimum of 16 psf - (as per Clause 27.4.7 for the Directional method, or 28.4.4
for the Envelope procedure.)

However, the average wind pressure for each of Windward, Leeward and Side
directions is provided for you to manually check this is satisfied.

Additional wind loads

There may be situations when you perceive a need to manually define loads
that cannot be determined automatically. You can do this by defining
additional wind loadcases to contain these loads and then include these with
the relevant system generated loads in design combinations in the normal
way.

Choice of Method (ASCE7 Wind Wizard)

Property Description
Rigid
Buildings of
All Heights:
Directional
Procedure
Part 1

Choose either the All Heights method, or the Low-Rise Buildings
method as required.

Low-Rise
Buildings
(<=60ft or
18m):
Envelope
Procedure
Part 1
Apply Open
Structure
Wind Load

With this box checked, additional wind forces are applied to
those members, ancillaries and equipment that have the Apply
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Property Description
Open Structure Wind Load property selected in their
properties.

NOTE This option is only displayed if at least one entity has
been selected to have open structure wind load applied.

For more information, see: The open structure wind method
(page 89)

Next Depending on whether you choose the Low-Rise or the Rigid
Buildings method, clicking Next takes you to either the Low rise
building - Geometry page, or the Rigid building of all heights -
Geometry page.

Envelope Procedure Part 1 - Low-Rise Buildings (Chapter 28)

The Low-Rise Building method is explicitly limited to buildings where the mean
roof height does not exceed the least horizontal dimension and is less than or
equal to 60 ft, (ASCE7-10 Clause 26.2). It is implied that the method should
only be used for simple rectangular box-shaped buildings, however, you are
given the final responsibility for determining the applicability of this method to
your model.

Failure to comply with any of the following conditions will explicitly prevent
access to this method:

• There must be 4 walls which must be connected sequentially and form a
"simple" quadrilateral in plan form, (all internal corners between 82.5° and
97.5°).

• Each wall must be almost vertical (>80°)

• Each wall must either have 4 sides, forming a "simple" quadrilateral in
elevation, or 5 sides forming a convex shape, (allowing for gable ends of
buildings).

• The roof system must be one of the following:-

• Single quadrilateral roof with type "Flat"

NOTE Where a building has a single roof with a low slope, (e.g. 2°), the
default will be "Pitched", but if you consider the building
suitable for the Low-Rise method, you can force the roof type to
"Flat" rather than "Monoslope".

• Two quadrilateral "Pitched" roofs which must have a single edge in
common. The roofs must face in opposite directions and have similar
slopes, (less than 3° difference).

• Two quadrilateral "Hip Main" roofs which must have a single edge in
common and either 1 or 2 hip gable roofs which must be triangular. The
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"Hip Main" roofs must face in opposite directions and have similar
slopes, (less than 3° difference).

• In particular, the Low-Rise Method is not allowed with Monoslope or
multi-span roofs.

Low Rise Buildings - Geometry (ASCE7 Wind Wizard)

The following geometry items are required for the Low Rise Buildings method.
You can override calculated dimensions using your engineering judgement.

Property/Buttons Description
Property  
Ground level If for some reason, the level 0.0 feet

in the Tekla Structural Designer
model does not correspond to the
ground level, e.g. you have used a site
datum rather than a building datum,
then this field allows you to set the
appropriate value so that the
reference heights for the wind can be
calculated correctly. The default is
zero. The allowed maximum is the
minimum wall or roof height.
Changing the value in this field will
cause the Mean Roof Height to be
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Property/Buttons Description
recalculated, unless you have chosen
to override that dimension.

Orientation of Longitudinal Direction
relative to axes (Figure 28.4-1)

This information is required to control
the orientation of the Transverse and
Longitudinal directions, and thus the
Tekla Structural Designer Wind
Directions. For simple roof shapes,
ASCE7- 10 Wind Wizard will calculate a
default value as below.

• Single flat roof - orient along
longest side,

• 2 Duopitch roofs - orient along
common edge,

• 2 Hip Main roofs - orient along
common edge.

• Changing the value in this field will
cause either or both of the
Longitudinal and Transverse
Dimensions to be recalculated,
unless you have chosen to
override them.

Roof Angle The field is always visible, even if
there are no roof panels in your
model. It is calculated as follows:

• No roof panels - θ = 0°.

• Else - use maximum angle for all
roof panels in the model.

You are able to override the
calculated value by checking the box;
The limits are 0° to 80°.

Mean Roof Height, h (Clause 26.2) The field is calculated as follows:

• No roof panels -h is maximum
reference height for walls,

• Else if θ <=10° - use maximum
eaves height, (h e), for all roof
panels in the model, (see Figure
28.4-1)

• Else - use maximum Mean Roof
height, (h), for all roof panels in
the model.

In the example below, h = (hu + hl)/2 -
g
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Property/Buttons Description

h is limited to a maximum of 60 ft or
the Least Horizontal Dimension,
whichever is lower. You are able to
override the calculated value by
checking the box.

Longitudinal and Transverse
Dimensions (Clause 26.3 and Figure
28.4-1)

These are similar to the Overall
building X dimension and overall
building Y dimension (Clause 26.3) for
the Rigid Buildings of All Heights
Method.

These dimensions are calculated from
the smallest enclosing rectangle
(considered over all roof and walls
only), relative to the given orientation
of the Longitudinal Direction. You are
able to override each calculated value
by checking its box. These values will
then be used to derive the L and B
dimensions for each wind direction.

For Longitudinal Wind Directions, L =
Longitudinal Dimension, B =
Transverse Dimension.

For Transverse directions, L =
Transverse Dimension, B =
Longitudinal Dimension.

Buttons  
Next Clicking Next takes you to the Basic

wind data page.
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Rigid Buildings of All Heights - Geometry (ASCE7 Wind Wizard)

The following geometry items are required for this method. You can override
calculated dimensions using your engineering judgement.

Property/Buttons Description
Property  
Ground Level in Model (Ignore Wind
Below)

If for some reason, the level 0.0 feet
in the Tekla Structural Designer
model does not correspond to the
ground level, for example you have
used a site datum rather than a
building datum, then this field allows
you to set the appropriate value so
that the reference heights for the
wind can be calculated correctly. The
default is zero. The allowed maximum
is the minimum wall or roof height.
Changing the value in this field will
cause the Mean Roof Height to be
recalculated, unless you have chosen
to override that dimension.

Orientation of Principal Axes This is similar to the Orientation of
Longitudinal Direction relative to axes
(Figure 28.4-1) (page 20) for Low-Rise
Buildings. Although there is no need
to distinguish between the
Longitudinal and Transverse axes for
this method, the wind X axis will be
aligned to this direction with the Y
axis at right angles. The vortex view
will be slightly different to the Low-
Rise one to reflect that.

Due to the potential complexity of the
model, the Wind Wizard... will only
attempt to determine the correct
angle for the axes if the building is
also suitable for Low Rise, otherwise
zero is used as the default.

Mean Roof Height, h (Clause 26.2) For this method, the actual reference
height is only be used for the
pressure on windward walls. For all
other walls, and roofs, a single height
is used to determine the pressure for
each direction.

By default, the height is calculated as
for Low-Rise Buildings except that
there is no single value of θ, so the
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Property/Buttons Description
eaves height is only used if all the
roof angles are <= 10°. You are able
to override the calculated value by
checking the box.

Level of Highest Opening in Building,
zi (Clause 27.4.1)

For this method, qi is evaluated at
height h for all cases except for
positive internal pressure in partially
enclosed buildings, where it should
be evaluated at the level of the
highest opening. However, the clause
allows h to be used even for this case,
so the default is for the box to be
checked and the level to be
automatically updated as the Mean
Roof Height changes.

Overall Building X Dimension and
Overall Building Y Dimension (Clause
26.3)

These dimensions are calculated from
the smallest enclosing rectangle
(considered over all roof and walls
only), relative to the given orientation
of the Principal Axes - see figure
below. You are able to override each
calculated value by checking its box.
These values will then be used to
derive the L and B dimensions for
each wind direction.

For X Axis, L = X Dimension, B = Y
Dimension.

For Y Axis, L = Y Dimension, B = X
Dimension:

Design Pressure Factor (Figure 27.4.8
and Clause 27.4.6)

This defaults to 75%, but the
commentary suggests that this may
not cover all cases so you are allowed
to change it. A single factor is used for
all Torsional loadcases.
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Property/Buttons Description
Eccentricity (Figure 27.4.8 and Clause
27.4.6)

This defaults to 15% but again, the
commentary suggests that this may
not cover all cases so you are allowed
to change it. A single factor is used for
all Torsional loadcases.

Buttons  
Next Clicking Next takes you to the Basic

wind data page.

Basic Wind Data (ASCE7 Wind Wizard)

Once the geometry has been confirmed, (for either method), you are then
required to enter the basic wind data. The only difference between the two
methods is that the Gust Effect Factor field is only shown for the All Heights
Method.

Property/
Buttons

Description

Property  
Basic Wind
Speed (Clause
26.5.1)

A strictly positive value is required with 90mph being the
default.

Hurricane-Prone
Region (Clause
26.2)

The default is cleared, i.e. region not prone to hurricanes.

Directionality
Factor, Kd
(Clause 26.6, and
Table 26.6-1)

The default is 0.85, range 0.85 to 1.0 inclusive.

NOTE There is no cross-checking to ensure that the
model has met the load combination criteria. If
that does not apply, then it is your own
responsibility to enter the correct value of 1.0.

Enclosure
Classification
(Clause 26.10)

Options are "Enclosed" and "Partially Enclosed" with
default being "Enclosed".

NOTE "Open" structures are not handled in the current
version of the program

Gust Effect
Factor (Clause
26.9.1)

This will only be shown for the All Heights Method. The
default value is 0.85.

Principal Axes There are always four directions shown for principal axes,
being based on the Orientation of the Longitudinal
Direction or Principal Axes depending on the method. You
are not able to add, delete or modify any direction.
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Property/
Buttons

Description

Exposure
Category (Clause
26.7.3)

Options are "B", "C" or "D" with default being "B".

Topographic
Feature (Clause
26.8 and Figure
26.8-1)

Options are as follows, with the default being "None":

• "None" - no feature, i.e. Kzt = 1.0.

• "2D Ridge"

• "2D Escarp" - 2D Escarpment

• "3D Hill" - 3D Axisymmetrical Hill
Crest Height, H
(Figure 26.8-1)

Height of the hill or escarpment relative to the upwind
terrain.

The behaviour of this field depends on the Feature type as
follows:

• "2D Ridge" - non-zero values allowed, (negative
indicates a valley).

• "2D Escarp" - strictly positive values allowed

• "3D Hill" - strictly positive values allowed
Crest Length, Lh
(Figure 26.8-1)

Distance upwind of crest to where the difference in ground
elevation is half the height of the hill or escarpment.

Distance to
Crest, x (Figure
26.8-1)

Distance upwind or downwind from the crest to the
building site.

The value may be positive to indicate downwind, or
negative to indicate upwind.

Buttons  
Next Clicking Next takes you to the Results page.

Results (ASCE7 Wind Wizard)

The final page of the Wind Wizard is a summary of the velocity pressure
results for the principal axes. You are able to use the Details... button to
obtain additional information, including the values of intermediate factors
used in the calculations.

Finishing the Wind Wizard

When you click Finish, the Wind Wizard... generates the wind zones for the
entire building for each of the specified wind directions.

Before moving on you should take a moment to inspect the Wind Model status
on the Project Workspace> Status tab, in order to check that no Limitations
(page 16) have been encountered.
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Related topics

Wind Zones - ASCE7 Low Rise Building Method (page 27)

Wind Zones - ASCE7 All Heights Method (page 28)

Wind Zones - ASCE7 Low Rise Building Method

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Wind Directions

Eight zone directions evenly spaced at 45 degree intervals about the
longitudinal direction are defined as follows:

• Long (B) 1 - (longitudinal direction + 22.5°, uses data for +X' principal axis)

• Trans (A) 1 - (longitudinal direction + 67.5°, uses data for +Y' principal axis)

• Trans (A) 1 - (longitudinal direction + 112.5°, uses data for +Y' principal axis)

• Long (B) 4 - (longitudinal direction + 157.5°, uses data for -X' principal axis)

• Long (B) 3 - (longitudinal direction + 202.5°, uses data for -X' principal axis)

• Trans (A) 3 - (longitudinal direction + 247.5°, uses data for -Y' principal axis)

• Trans (A) 2 - (longitudinal direction + 292.5°, uses data for -Y' principal axis)

• Long (B) 2 - (longitudinal direction + 337.5°, uses data for +X' principal axis)

These enable the modeling of two sets of zones per principal axis with the
correct reference corner in each case.

Wall Zones

The Wind Wizard automatically generates wall zones, where possible, for each
Direction of MWFRS Being Designed and Reference Corner in accordance with
Figure 28.4-1.

Roof Zones

The Wind Wizard... automatically generates roof zones, where possible, for
each Direction of MWFRS Being Designed and Reference Corner in accordance
with Figure 28.4-1.

For flat roofs and for MWFRS parallel to the ridge line we assume Note 8 is not
applicable.

Where Note 7 applies, we assume the dimension to the zone 2/3 boundary is
measured horizontally.
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Automatic Zoning

Automatic zoning only applies to all triangular roof panels and quadrilateral
roof panels that are not concave, that is that all of the internal angles < 180°.

Wind Zones - ASCE7 All Heights Method

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Wind Directions

Eight zone directions evenly spaced at 45 degree intervals starting from the
longitudinal direction are defined as follows:

• +X - (longitudinal direction, uses qz for 1st principal axis)

• +X+Y - (longitudinal direction + 45°, uses qz for 1st and 2nd principal axes)

• +Y - (longitudinal direction + 90°, uses qz for 2nd principal axis)

• -X+Y - (longitudinal direction + 135°, uses qz for 2nd and 3rd principal axes)

• -X - (longitudinal direction + 180°, uses qz for 3rd principal axis)

• -X-Y - (longitudinal direction + 225°, uses qz for 3rd and 4th principal axes)

• -Y - (longitudinal direction + 270°, uses qz for 4th principal axis)

• +X-Y - (longitudinal direction + 315°, uses qz for 1st principal axis)

The 4 directions +X,+Y,-X,-Y enable the modeling of design wind loadcases 1
and 2 from Figure 27.4-8. The 4 intermediate directions +X+Y etc. enable the
modeling of loadcases 3 and 4.

Wall Zones

The Wind Wizard... automatically generates wall zones, where possible, in
accordance with Figure 27.4-1.

Windward Walls are split horizontally over intermediate heights. Zones are
labelled with a 'W' followed by the height at top of zone rounded to nearest
foot (or meter if using metric units). Each zone uses the same Cp, (0.8 from
Wall Cp table in Figure 27.4-1), but a different velocity pressure, qz, z being
determined at the top of the zone.

Complex wall shapes are dealt with by splitting zones intelligently as illustrated
below:
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Leeward walls have a single zone, 'L', using a Wall Cp from the table in Figure
27.4-1, with interpolation for L/B. The velocity pressure, qh is used for all such
zones.

Side walls have a single zone, 'S', using the same Cp, (-0.7 from the Wall Cp
table in Figure 27.4-1). A single velocity pressure, qh is used for all such zones.

Skew Walls

There is no guidance in ASCE7-10 for walls not orthogonal to the principal
axes. However, the Wind Wizard... will apply zones in those cases and it is
your responsibility to check the wind loads adopted.

Roof Zones

The Wind Wizard... automatically generates Windward and Leeward roof
zones ('W' and 'L' respectively, where possible, in accordance with Figure
27.4-1. This is possible for Windward and Leeward roof panels with θ >= 10°,
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because there is only one zone. However, for θ < 10° and Side roof panels,
automatic zoning will not be carried out for all cases.

Negative and positive values of Cp are determined for each zone from the Roof
Cp table in Figure 27.4-1.

For non-principal axis directions, it is assumed that roof loads are not required
and so special zones are created, named "Zero". Such zones will result in zero
loading on the relevant roof panels. However, if the you choose to do so you
can change these to non-standard zones and enter coefficients to force loads
to be applied.

When calculating the area reduction factor we use the slope area not the plan
area.

Mansard roofs are not automatically detected, i.e. it is your responsibility to
set the Roof Type manually. Generally, Mansard roofs are handled exactly the
same as if they are:

• Flat (for slope < 0.1°)

• Pitched (for slope >= 0.1°)

There is no guidance on what to do with other multipitch roofs, so they are
treated as pitched roofs, whether they have been flagged as Mansard or not.

Side roofs are split into to 4 zones depending on the size of the roof. See the
Roof Cp table in Figure 27.4-1.

• Zone 1 - 0 to h/2, interpolating between 2 values for h/L if necessary.

• NOTE Upper value for interpolation can be reduced linearly with the
sloped area of this zone, (see ** in Figure 27.4-1).

• Zone 2 - h/2 to h, interpolate between -0.9 and -0.7 for h/L if necessary

• Zone 3 - h to 2h, interpolate between -0.5 and -0.7 for h/L if necessary

• Zone 4 - > 2h, interpolate between -0.3 and -0.7 for h/L if necessary

Automatic Zoning

Automatic zoning will apply to all Windward and Leeward roof panels with θ >
10°, because there is only one zone. However, for θ < 10° and Side roof panels,
automatic zoning will not be carried out for all cases.

EC1991 1-4 Wind wizard
This topic will discuss in detail the Wind wizard when using the Eurocode BS
EN1991-1-4

To access this configuration of the Wind Wizard the Wind Loading Code has to
be set to BS EN 1991-1-4.

Once the wall and roof panels are in place, you use the Wind Wizard... to
define sufficient site information to calculate the peak wind velocity and
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velocity pressures for the required wind directions and heights around the
building, (that is the Reference Heights (ze and zi) for each wall panel or roof
panel).

The wind velocity calculations are automated, with the data source for the
calculations being either:

• Input directly for the worst case,

• Input directly for each direction,

• taken directly from the BREVe database which is based upon the Ordnance
Survey data of Great Britain (only available for users working to the UK or
Ireland National Annex).

Topics in this section

Design Codes and References (page 31)

Scope (Eurocode EC1991-1-4 Wind wizard) (page 31)

Limitations (EC1991-1-4 Wind wizard) (page 32)

Using the EC1991-1-4 Wind wizard (page 35)

Using the EC1991 1-4 Wind Wizard with BREVe data (page 41)

EC1991 1-4 Wind Zones (page 49)

Design Codes and References

Unless explicitly stated all calculations in the EC1991 1-4 Wind Wizard are in
accordance with the relevant sections of EC EN1991 1-4 (Ref. 3) (page 89) and
the chosen National Annex. It is essential that you have a copy of the code and
National Annex with you while assessing wind on any structure.

We would recommend having the following books to hand when using the
software:

• Designers' Guide to EN 1991-1-4. Euro Code 1 : Actions on Structures,
General Actions Part 1-4 : Wind actions. (Ref. 6) (page 89)

• Wind Loading - a practical guide to BS 6399-2 Wind Loads on buildings.
(Ref. 7) (page 89)

In addition, you may find the following book useful:

• Background information to the National Annex to BS EN 1991-1-4 and
additional guidance. PD 6688 - 1-4:2009. (Ref. 5) (page 89)

• Unless explicitly noted otherwise, all clauses, figures and tables referred to
in this section of the handbook are from EC EN1991 1-4. (Ref. 3) (page 89)

Scope (Eurocode EC1991-1-4 Wind wizard)

There is no guidance in the standard for anything other than a cuboid
building. In order to develop a tool for engineers, we have extended this
capability to address non-rectilinear buildings. It is therefore the user's
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responsibility to ensure that the wind loading generated by the software
meets the needs of any building with a shape that is beyond the scope of BS
EN 1991-1-4:2005.

The scope of EN1991 1-4 Wind wizard encompasses:

• Enveloping the building with wall panels and roof panels is undertaken in
Tekla Structural Designer in the normal manner. There is only limited
validation of the envelope defined (for example connected wall panels
must have consistent normal directions). The onus is on you to model the
building shape as completely and as accurately as you determine
necessary.

• Basic Wind Velocity and Peak Velocity Pressure is determined.

• Having defined wall panels and roof panels (defaults are standard wall, flat
or monopitch roof depending on the slope), you are able to specify the
type in more detail e.g. multi-bay, monopitch / duopitch etc.).

• The main wind parameters, are calculated for you but conservatively, (for
example Crosswind Breadth, b, is determined for the enclosing rectangle of
the whole building). Wherever possible other parameters are determined
conservatively, but you are able to override the values should you need to.

• Given the above, zoning is semi-automatic, (not attempted for roofs with
more than 4 sides which are defaulted to single conservative coefficient),
with full graphical feedback.

• The software follows the UK NA (Ref. 3) (page 89) recommendation that
BS6399 roof zones and coefficients are used, including Mansard, Multipitch
and Multibay roofs.

• Load decomposition is fully automatic where valid, (wall panels and roof
panels need to be fully supported in the direction of span).

Limitations (EC1991-1-4 Wind wizard)
This page discusses the limitations to the wind wizard.

Throughout the development of the Wind wizard extensive reference has been
made to the References (page 89) and we consider it advisable that you are
fully familiar with these before using the software.

In addition, because wind loading is complex and its application to general
structures even more so, it is essential that you read and fully appreciate the
following limitations in the software:
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Geometry

WARNING You should seek specialist advice for building shapes that are not
covered by the Standard - BS EN 1991-1-4:2005.

• EC1 1-4 does not treat downwind re-entrant corners as special cases - see
BS6399 Clause 2.4.3.1 c). So, they are ignored in the software and no
warnings are given.

• EC1 1-4 does not handle stepped profiles, or inset storeys - see BS6399
clauses 2.4.4.2 and 2.5.1.7. Hence the software does not handle them
automatically, but does generate warnings if such cases are detected - so
you can manually edit the zones according to your engineering judgement.

• Open sided buildings are beyond scope.

• Free standing walls and sign boards are not considered.

• Canopies are not considered.

• Exposed members are not considered, for example lattices, trusses......

• Barrel-vault roofs and domes are not considered

• Dominant Faces are not explicitly handled - Clause 7.2.9 (5). However, you
can use Table 17 to calculate the necessary Cpi value or values and
manually apply to a loadcase or individual zone loads.

Loaded areas

The difference between the loaded area of wall panels and roof panels defined
at the centre-line rather than the sheeting dimension is ignored.

Wind direction

• All outward faces within 60 degs of being perpendicular to wind direction -
loads applied as windward normal to face. All inside faces within 60 degs to
wind direction - loads applied as leeward normal to face. All other faces
considered as side.

• Orthogonal wind directions at the definition of the user.

Overall loads

• Lack of correlation of pressures between the windward and leeward sides.
For Overall loadcases, the software automatically reduces the windward
and leeward wall pressures only. EC1 1-4 and the UK NA both suggest that
the reduction "may" be applied to roofs as well.

• Division by Parts rule for "slender" buildings -Clause 7.2.2 and Figure 7.4 -
not applied.
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• Friction Forces - Clause 5.3 (3), equation 5.7 and Clause 7.5.

During the "Update Zones" process, checks are performed to see if the
effects can be disregarded, (Clause 5.3 (4)), and a 'Friction needed' warning
is generated if not. When they cannot be disregarded you will need to
manually model the friction forces as lateral loads in a separate loadcase
and include them in your combinations.

Beneficial loads

• Asymmetric and Counteracting Pressures and Forces - Clause 7.1.2 and
NA.2.23. Beneficial loads are not automatically removed - instead you are
able to flag individual loads to be reduced to zero.

Singapore National Annex - Minimum horizontal loads

• The Foreword to the Singapore National Annex to EN 1991-1-4 Wind
Actions has a minimum horizontal load requirement (1.5% characteristic
dead weight). Therefore if this National Annex has been applied, it is the
users responsibility to check that this requirement has been met (by
ensuring that the horizontal component of the factored wind load is
greater).

Finland National Annex

• We do not consider thermal inversions for buildings > 100m tall

Norway National Annex

• We do not consider the transition zones between changes in terrain
category.

Wind loading on wall panels

Automatic zoning applies to all wall panels subject to the limitations described
below:

• Vertical Walls on rectangular buildings -Clause 7.2.2 - the assumption for
wall wind forces is that the building is rectangular or close to being
rectangular.

• Wall panels that are more than 15° from the vertical are outside the scope.

• Internal Wells are not covered by EC1 1-4 and in any case are not
automatically identified but you can manually edit the zones to apply the
roof coefficient or otherwise as you see fit - see BS6399 Clause 2.4.3.2a.

• EC1 1-4 does not specify how to treat recesses in side walls - see BS6399
clauses 2.4.3.2 b) and 2.4.3.3 and 3.3.1.5. So, they are ignored but warnings
are given.
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Wind loading on roof panels

• Automatic zoning only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, i.e. all of the internal angles
< 180°

• Special care should be taken for winds blowing on duopitch with slopes
that differ by more than 5°. If the wind is blowing on the steeper slope (that
is that the less steep slope is downwind of ridge), the downwind slope
should be set to be a flat roof with mansard at eaves for this wind
direction.

• Mansard and Multipitch Roofs are not detected automatically, although
certain special cases can be handled if you set the appropriate type
manually - see EC1991 1-4 Wind Zones.

• BS 6399 Table 8 curved and mansard eaves - zones start from edge of
horizontal roof.

• Roof Overhangs are not explicitly handled. It is suggested that you should
define two separate roof panels - one forming the overhang and the other
covering the inside of the building. For a small overhang, you can then
manually define Cpi values to be the same as Cpe for the adjacent wall
panel, (Clause 7.2.1 (3)). Reference 6 (page 89), p45, implies that larger
overhangs can be manually handled by using BS6399, Clauses 2.5.9.3 and
2.6.3, i.e. standard external coefficients for the top surface and Table 18 for
the internal coefficients.

NOTE The only slight issue here is that there are two sets of edge zones
which will occupy a slightly larger area than strictly necessary.

Additional wind loads

There may be situations when you perceive a need to manually define loads
that cannot be determined automatically. You can do this by defining
additional wind loadcases to contain these loads and then include these with
the relevant system generated loads in design combinations in the normal
way.

Using the EC1991-1-4 Wind wizard
This section runs through each page of the wizard and discusses the various
options.
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Data Source page

You can choose to enter one set of Worst-Case data or different values for
each direction to be considered.

TIP Additional options are provided for using BREVe data when working to
the UK or Ireland National Annex. For further details see: Using the
EC1991 1-4 Wind Wizard with BREVe data (page 41).

The remaining choices on the Data Source page are:

Property Description
Consider
Orography

If you select this check box, then the orographic data, (manually
entered), is used to determine the Orography Factor co as clause
A.3. When calculating calt, the altitude of the upwind base of the
orographic feature is used for each wind direction considered.
Otherwise the orographic data is ignored, co is 1.0 for all heights
and calt is the same for all directions, using the Site Altitude.

Consider
Tall
Neighbouri
ng
Structures

If the conditions in clause A.4 are met, then the wind loads need
to be based on height zn, see equation (A.14). With this box
checked, you are able to enter sufficient data to check if this
applies. If applicable, then zn will be used as the reference
height for all wall panels and roof panels in the model.

NOTE If working to the Sweden NA, Tall Neighbouring
Structures are not considered.

Consider
Obstruction
s

With this box checked, the obstruction data, (either defaulted by
BREVe depending on the roughness category for the site or
entered manually), is used to determine the Displacement
Height, hdis as (A15) in clause A.5. Otherwise the obstructions
are ignored and hdis is taken as zero.

NOTE If working to the Sweden NA, Obstructions are not
considered.

Apply Open
Structure
Wind Load

With this box checked, additional wind forces are applied to
those members, ancillaries and equipment that have the Apply
Open Structure Wind Load property selected in their
properties.

NOTE This option is only displayed if at least one entity has
been selected to have open structure wind load applied.

For more information, see: The open structure wind method
(page 89)

Next Clicking Next takes you to the Basic data page below.
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Basic data page

This page is used you to define the site details.

Property Description
Air density You need to enter air density at the site.
Ground
level

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground level, for
example a site datum may have been used rather than a
building datum, then this field allows you to set the appropriate
value so that the reference heights can be calculated correctly.

Fundament
al Basic
Wind
Velocity -
Clause 4.2
and NA.2.4

Reference should be made to the National Annex being worked
to when determining an appropriate basic wind speed.

Season
Factor,
cseason

Valid range 0.01 to 10.0 - default 1.0.

Probability
Factor,
cprob

Valid range 0.01 to 10.0 - default 1.0.

Default
Height for
Internal
Pressure
(zi)

Clause 7.2.9 (7) implies that all internal pressures should be
calculated using a single reference height, (zi), defaulting to the
height of the structure. Leaving Use Building Height checked
ensures that the value is automatically updated if the geometry
of wall panels or roof panels changes.

Peak
Factor, kp
(Sweden
NA only)

The Peak Factor was introduced by the Swedish EC NA (EK11)
update.

Using the default value (3.0) is the equivalent of the old
calculation method prior to the update.

Region
(Norway NA
only)

A Region is needed (Area 1, Area 2 or Area 3) representing three
different height zones in the country.

Site
Altitude
(Norway NA
only)

You need to enter the basic altitude that you want to use for the
site directly. This is the altitude of your model's base.

Next Depending on whether you chose worst case data, or data for
each direction on the Data Source page, clicking Next either
takes you to the Roughness and Obstructions (Worst case)
page or the Roughness and Obstructions (Data for each
Direction) page.
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Roughness and Obstructions (Worst case) page

If you select the Worst Case Data Source, then the next page of the Wizard
allows you to enter the data for ground roughness and obstructions yourself.

Property Description
Terrain
Category

Reference should be made to the National Annex being worked
to when determining an appropriate Terrain Category.

Depending on the terrain category selected and National Annex
being worked to, you may also be required to enter some of the
following data:

• Average height of upwind buildings,

• Upwind spacing of surrounding buildings,

• Upwind distance from sea to site,

• Upwind distance from edge of town to site.
Next Depending on your selections on the Data Source page, clicking

Next either takes you to the Orography (Worst Case) page, the
Tall Neighbouring Structure page, or the Results page.

Roughness and Obstructions (Data for each Direction) page

If you select the Other - Data for each Direction Data Source, then the next
page of the Wizard allows you to enter the data for ground roughness and
obstructions yourself. However, most of the data is then dependent on the
wind direction, so you must also make your choice of wind directions on this
page.

Property Description
Direction Initially there are 4 orthogonal wind directions relative to the

Tekla Structural Designer axes, (not geographical North), but
you are able to update these using the Dir. buttons and / or
changing the direction value as required. (Note: Minimum 1°
difference between directions). At least one direction must be
defined.

Each row of the grid operates in a similar manner to the
relevant fields of the Roughness and Obstructions (Worst
case) page.

Next Depending on your selections on the Data Source page, clicking
Next either takes you to Orography (Data for each Direction)
page, the Tall Neighbouring Structure page, or the Results
page.
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Orography (Worst Case) page

If Consider Orography was checked, then the next page of the Wizard for the
Worst Case Data Source allows you to enter the data for Orography.

Property Description
Orographic
Feature
(Clause A.3)

Options are:

• None - no feature, i.e. co = 1.0.

• 2D Escarp - Cliffs and Escarpments,

• 3D Hill - Hills and Ridges.
Altitude of
Upwind
Base of
Feature, A

This value is used to calculate Calt instead of the Site Altitude
because the Orography is significant.

NOTE Calt will be calculated at ze for each wall and roof panel,
not zs.

Effective
Crest
Height, H
(Figures A.2
& A.3)

Effective height of the feature.

Length of
Upwind
Slope, Lu
(Figures A.2
& A.3)

Actual length of the upwind slope in the wind direction.

Length of
Downwind
Slope, Ld
(Figures A.2
& A.3)

Actual length of the downwind slope in the wind direction.

Horizontal
Distance to
Crest, x
(Figures A.2
& A.3)

Distance upwind or downwind from the crest to the building
site.

Orography
factor, co(z)
and
Turbulence
factor, kl
(Norway NA
only)

When working to the Norway NA you are not required to enter
the above factors; instead you enter the orography factor and
turbulence factor directly for the defined 3D or 2D orographic
feature.

Next If on the Data Source page you chose to consider tall
neighbouring structures, clicking Next takes you to the Tall
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Property Description
Neighbouring Structure page , otherwise it takes you to the
Results page.

Orography (Data for each Direction) page

The wind directions defined on the previous page are maintained and you are
not able to update them.

Property Description
 Each row of the grid operates in a similar manner to the

relevant fields of the Orography (BREVe) page (page 46) page.
Next If on the Data Source page you chose to consider tall

neighbouring structures, clicking Next takes you to the Tall
Neighbouring Structure page , otherwise it takes you to the
Results page.

Tall Neighbouring Structure page

For all methods, if Consider Tall Neighbouring Structure was checked, the
penultimate page allows you to determine if tall neighbouring structures affect
the design of this structure. (Clause A.4)

Otherwise, the wizard will proceed directly to the Results page and the actual
heights of wall and roof panels are used throughout.

The parameters, Height of Tall Neighbour, hhigh, Largest Horizontal Dimension
of Tall Neighbour, dlarge and Distance to Tall Neighbour, x are all as described
on Figure A.4 of the code.

Property Description
Average
Height of
Neighbours
, have
(Figure A.4)

The default is calculated from the BREVe data or the values
entered for the Roughness & Obstructions. If Override
calculated dimension is cleared, then the value will be updated
whenever the wizard is run, otherwise the user-value is used.

Height of
this
structure,
hlow (Figure
A.4)

The field is for information only - difference between top of
highest wall / roof panel and ground level in the model.

Next Click Next to go to the Results page.
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Results page

The final page of the Wizard is a summary of the results - peak velocity
pressure ranges.

Initially there are 4 orthogonal wind directions relative to the Tekla Structural
Designer axes, (not geographical North), but except for the Other - Data for
Each Direction method, you are able to update this using the Dir. buttons
and / or changing the direction value as required. (Note : Minimum 1°
difference between directions). At least one direction must be defined.

You are able to use the <<Details>> button to obtain additional information,
including the values of intermediate factors used in the calculations.

Property Description
Other -
Worst Case
Data

The calculation of qp is very similar to the BREVe Method, (see
above), except that the worst case data has been entered by
you, and this page allows you to enter your own values for Cdir.

As there is no data for each 30° sector, the Vortex view only
shows the Peak Velocity Pressures calculated for each reference
height for each direction.

Other -
Data for
each
Direction

The calculation of qp is very similar to the BREVe Method, (see
above), except that the data has been entered by you for each
direction only so a direct calculation can be performed instead
of taking the worst case over a range of sectors. Also this page
allows you to enter your own values for Cdir.

As there is no data for each 30° sector, the Vortex view only
shows the Peak Velocity Pressures calculated for each reference
height for each direction.

Finishing
the Wind
Wizard

When you click Finish, the Wind Wizard generates the wind
zones for the entire building for each of the specified wind
directions.

NOTE Before moving on you should take a moment to inspect
the Wind Model status on the Project Workspace>
Status tab, in order to check that no Limitations
(page 32) have been encountered.

Using the EC1991 1-4 Wind Wizard with BREVe data
This page steps you through the EC1991-1-4 Wind wizard when using BREVe
data

NOTE This option is only available when either the UK or Ireland National
Annex has been selected.
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Data Source (BREVe) page

Assuming you choose to specify the site data using BREVe Grid Ref data the
remaining choices on the Data Source page are:

Property/
Buttons

Description

Property  
Consider
Orography

If you select this check box, then the orographic data,
(either recovered by BREVe for the site or manually
entered), is used to determine the Orography Factor co as
clause A.3. When calculating calt, the altitude of the upwind
base of the orographic feature is used for each wind
direction considered. Otherwise the orographic data is
ignored, co is 1.0 for all heights and calt is the same for all
directions, using the Site Altitude.

Consider Tall
Neighbouring
Structures

If the conditions in clause A.4 are met, then the wind loads
need to be based on height zn, see equation (A.14). With
this box checked, you are able to enter sufficient data to
check if this applies. If applicable, then zn will be used as
the reference height for all wall panels and roof panels in
the model.

Consider
Obstructions

With this box checked, the obstruction data, (either
defaulted by BREVe depending on the roughness category
for the site or entered manually), is used to determine the
Displacement Height, hdis as (A15) in clause A.5. Otherwise
the obstructions are ignored and hdis is taken as zero.

Apply Open
Structure Wind
Load

With this box checked, additional wind forces are applied
to those members, ancillaries and equipment that have
the Apply Open Structure Wind Load property selected
in their properties.

NOTE This option is only displayed if at least one entity
has been selected to have open structure wind
load applied.

For more information, see: The open structure wind
method (page 89)

Buttons  
Next If you have chosen to use BREVe Grid Ref data, clicking

Next takes you to the BREVe location page , otherwise it
takes you to the Basic Data page.
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BREVe location page

Property/
Buttons

Description

Property  
Grid Ref. This shows the grid reference of the site which you have

picked through BREVe, irrespective of the method you use
to define the site location.

Orientation of
building known

If you know the orientation of the building with respect to
North, then you can define this information by checking
this box. You can then define a value which relates the
building direction axes of your Tekla Structural Designer
model to geographic north.

Orientation of
North

The orientation of North is defined using the same
convention as is applied to the orientation of the Building
Direction Arrows.

This can best be understood by reference to a couple of
examples:

In the first example the building axes are aligned in the
default directions (Dir 1 = 0° = Global X), and the
orientation of North has been set to 315°.

The resulting relation between the building axes and North
is as shown below:
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Property/
Buttons

Description

In the second example the building direction has been
input with Dir 1 = 30° and the orientation of North has
been set to 250°

In this case the building axes are related to North as
shown below:

Buttons  
 Using BREVe, there are 2 methods available for you to

define the site location:
Site By Ref... You can define the grid reference of the site.

You define this either as a national grid reference, or by
specifying the Easting and Northing information for the
site. There are several Internet based tools available which
allow you to determine the Ordnance Survey grid
reference from a postcode or given location, for example
www.streetmap.co.uk or www.multimap.co.uk

Site By Map... You can pick the site from a Land / Town Map,

• You can pick the site from a Orography Map.
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Property/
Buttons

Description

• You can pick the site from a ground roughness Category
Map,

The site data is analysed fully by BREVe. Parameters are
either set automatically but conservatively (Safe
parameters within a 1 km square).

Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Basic Data (BREVe) page.

Basic Data (BREVe) page
This page allows you to review the site details taken from the BREVe database.

Property/
Buttons

Description

Property  
Site Altitude, A The basic site altitude of your model's base.
Air Density Air density at the site.
Ground Level If for some reason, the level 0.0m in the Tekla Structural

Designer model does not correspond to the ground level,
for example a site datum may have been used rather than
a building datum, then this field allows you to set the
appropriate value so that the reference heights can be
calculated correctly.

Fundamental
Basic Wind
Velocity (vb,map) -
Clause 4.2 and
NA.2.4

The value required is defined as "the characteristic 10
minutes mean wind velocity, irrespective of wind direction
and time of year, at 10m above ground level in open
country terrain with low vegetation such as grass and
isolated obstacles with separations of at least 20 obstacle
heights", but is the value before the altitude correction is
applied. (Valid range 1.0 to 1000 m/s).

Season Factor,
cseason

Valid range 0.01 to 10.0 - default 1.0.

Probability
Factor, cprob

Valid range 0.01 to 10.0 - default 1.0.

Default Height
for Internal
Pressure (zi)

Clause 7.2.9 (7) implies that all internal pressures should
be calculated using a single reference height, (zi),
defaulting to the height of the structure. Leaving Use
Building Height checked ensures that the value is
automatically updated if the geometry of wall panels or
roof panels changes.
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Property/
Buttons

Description

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Roughness and Obstructions

(BREVe) page.

Roughness and Obstructions (BREVe) page
This page of the Wizard automatically defaults the data for ground roughness
and obstructions for you.

Property/
Buttons

Description

Property  
Terrain Category Options available are:

• Sea - this setting is for sites where the distance to sea is
between 0 and 1 km, not for offshore sites. As the
worst case must be for wind blowing across the sea,
there is no need to specify data for upwind buildings or
distance in town.

• Country - the worst case must be for wind blowing
across open ground, there is no need to specify data
for upwind buildings or distance in town,

• Town - for this category you need to specify data for
upwind buildings and distance to the edge of the town,
so the relevant fields are active. If you want to ignore
obstructions, then you need to enter a zero value for
have For this category, the Upwind distance from edge
of town to site cannot be greater than the Upwind
distance from sea to site.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Orography (BREVe) page.

Orography (BREVe) page

NOTE When using Breve Data you should really leave it up to the system as
to whether orography is significant or not. If you chose not to consider
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orography, the actual factor is not applied; however the site data is
still displayed to allow you to check that your decision to ignore it is
reasonable.

Property/
Buttons

Description

Property  
Orographic
Feature (Clause
A.3)

Options available are:

• None - no feature, i.e. co = 1.0.

• 2D Escarp - Cliffs and Escarpments,

• 3D Hill - Hills and Ridges.
Altitude of
Upwind Base of
Feature, A

This value is used to calculate Calt instead of the Site
Altitude because the Orography is significant.

NOTE Calt will be calculated at ze for each wall and roof
panel, not zs.

Effective Crest
Height, H
(Figures A.2 &
A.3)

Effective height of the feature.

Length of
Upwind Slope, Lu
(Figures A.2 &
A.3)

Actual length of the upwind slope in the wind direction.

Length of
Downwind
Slope, Ld (Figures
A.2 & A.3)

Actual length of the downwind slope in the wind direction.

Horizontal
Distance to
Crest, x (Figures
A.2 & A.3)

Distance upwind or downwind from the crest to the
building site.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next If on the Data Source page you chose to consider tall

neighbouring structures, clicking Next takes you to the
Tall Neighbouring Structure, otherwise it takes you to
the Results (BREVe) page.
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Tall Neighbouring Structure page

For all methods, if Consider Tall Neighbouring Structure was checked, the
penultimate page allows you to determine if tall neighbouring structures affect
the design of this structure. (Clause A.4)

Otherwise, the wizard will proceed directly to the Results page and the actual
heights of wall and roof panels are used throughout.

The parameters, Height of Tall Neighbour, hhigh, Largest Horizontal Dimension
of Tall Neighbour, dlarge and Distance to Tall Neighbour, x are all as described
on Figure A.4 of the code.

Property/
Buttons

Description

Property  
Average Height
of Neighbours,
have (Figure A.4)

The default is calculated from the BREVe data or the values
entered for the Roughness & Obstructions. If Override
calculated dimension is cleared, then the value will be
updated whenever the wizard is run, otherwise the user-
value is used.

Height of this
structure, hlow
(Figure A.4)

The field is for information only - difference between top
of highest wall / roof panel and ground level in the model.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to got to the Results (BREVe) page.

Results (BREVe) page
The final page of the Wizard is a summary of the results - peak velocity
pressure ranges.

Initially there are 4 orthogonal wind directions relative to the Tekla Structural
Designer axes, (not geographical North), but you are able to update this using
the Dir. buttons and / or changing the direction value as required. (Note:
Minimum 1° difference between directions). At least one direction must be
defined.

You are able to use the <<Details...>> button to obtain additional information,
including the values of intermediate factors used in the calculations.

BREVe Data

BREVe determines the parameters required to calculate qp(z) for each height
in the building at 30° intervals, (0° to 330°).
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For each required wind direction the worst case qp is used for each height,
based on splitting the difference to the next direction, with a maximum of ±45
degrees. Within these ranges qp is not interpolated.

Theoretically, it is possible for a quadrant to use different 30° directions for
each height, so the critical wind direction is not displayed in the summary.

The Vortex view shows the Peak Velocity Pressures calculated for each
reference height for each 30° sector.

Finishing the Wind Wizard

When you click Finish, the Wind Wizard generates the wind zones for the
entire building for each of the specified wind directions.

Before moving on you should take a moment to inspect the Wind Model status
on the Project Workspace> Status tab, in order to check that no Limitations
(page 32) have been encountered.

EC1991 1-4 Wind Zones
Enter a short description of your topic here (optional).

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Basic Geometry

The basic building geometry is assessed as follows:

• Reference Height (ze) - is taken as the difference between highest point on
wall or roof panel and ground level.

• Wall height (h) - is taken as the difference between highest and lowest
points on the wall panel.

These definitions apply to wall panels without parapets and the actual
parapets. Wall panels with parapets above them will take their highest
point from the parapet. See the diagram below.
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• Roof height (h) - as ze - taken as the difference between highest point on
wall or roof panel and ground level. This definition does not handle the
upper roof of inset storey but is conservative.

• The Building Breadth, b is calculated from the smallest enclosing rectangle
around the whole building (considered over all roof and wall panels only)
for the given direction. You can override the calculated value in case the
Tekla Structural Designer model does not include the whole building.
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Wall Zones

Wall Type

We assess each wall panel to determine if it is a windward, leeward or side
wall. We classify the type of wall dependent on q:

• θ ≤ 60 deg - Windward,

• θ ≥ 120 deg - Leeward,

• Other walls are classed as Side.

Windward walls Windward walls have a single zone and Table 7.1 is used
with interpolation for h/d.

Leeward walls Leeward walls have a single zone and Table 7.1 is used
with interpolation for h/d.

Side walls In all cases, side walls have the relevant number of zones
from Figure 7.5 and Table 7.1 is used.

There is no guidance in the standard for Irregular
Flushed Faces, Recesses and Downwind Re-entrant
Corners that are covered in BS6399. However, it is
reasonable to automatically detect Irregular Flushed
Faces and process them as described in BS6399 Clause
2.4.4.1 and Figure 14. The program also detects potential
Recesses but only generates a warning and no special
handling occurs. Downwind re-entrant corners are
conservatively ignored.
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Parapets Parapets are assessed for return corners and then
classified as windward, windward oblique, leeward or
leeward oblique dependent on q.

Depending on the classification, parapets will either have
a single zone, or up to seven zones (determined by
extrapolation from Figure 7.19). Table 7.9 is used with
interpolation for Solidity and l/h.

NOTE An "r" suffix on zone name indicates return
corners have been detected.

Side Parapets are Special Zero zones, i.e. no nett
pressure.

Roof Zones

Roof zones are automatically generated where possible for each wind
direction. In essence each roof panel is assessed in its own right based on its
properties. The interconnectivity of touching roof panels is not generally
considered.

NOTE The Advisory note on page 34 of the UK NA is followed so that zones
and coefficients are generated according to BS6399.

Direction

Internally the roof slope vector (line of maximum slope) is determined from
the normal vector, with its direction always giving a positive slope angle, i.e.
the roof slope vector must always point up the slope.

We calculate the angle between the wind direction and projection of roof slope
vector onto horizontal plane ( q in range -180° to +180°).

Scaling Dimension, e

The scaling dimension e = min(b, 2h)

Automatic Zoning

Automatic zoning normally only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, that is that all of the internal
angles < 180°. However, additionally, it only applies to Hip Gable roofs if they
are triangular, and Hip Main roofs if they are quadrilateral. Further, Downwind
Slope Hip Gables must not have 2 upwind corners.
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Dimensions All zone dimensions are specified in plan.
Flat Roofs See BS 6399 Clause 2.5.1, Figure 16 and Table 8.
Monopitch Roofs See BS 6399 Clause 2.5.2.3, Figure 19 and Table 9.
Duopitch Roofs See BS 6399 Clause 2.5.2.4, Figure 20 and Table 10.
Hip Gable See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Hip Main See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Mansard Roofs If you manually set the connected roof types to

Mansard, then the program will correctly identify the
special cases in BS6399 Figures 17c, 22a and 22b, and
use the correct tables and values. See BS 6399
Clauses 2.5.1.6.2 & 2.5.4

Multi-bay Roofs We allow you to interpret BS 6399 Clause 2.5.5 and
Figure 23 as you think appropriate and manually
define the roof types and sub-types accordingly. You
also have the ability to manually set the multi-bay
position for each roof panel for each wind direction:

• Not Multi-Bay - for this wind direction
(conservative default),

• Upwind Bay - first bay of many for this wind
direction,

• Second Bay - for this wind direction,

• Third or more Bay - for this wind direction.

Where the reduction applies, the values of all
coefficients are reduced according to Table 12.

Non-Automatic Zoning

Where automatic zoning does not apply, the system creates a single zone
covering the entire roof as follows:
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• Hip Gable - B for upwind, B for downwind, D for side,

• Flat - B,

• Monopitch - B,

• Duopitch - B for upwind, A for downwind, B for side,

• Hip Gable - B for upwind, B for downwind, D for side,

• Hip Main - B for upwind, A for downwind, D for side.

BS6399-2 Wind wizard
This topic will discuss in detail the Wind wizard when using the British
Standard BS 6399-2.

To access this configuration of the Wind Wizard the Wind Loading Code has to
be set to BS 6399-2.

Once the wall and roof panels are in place, you use the Wind Wizard... to
define sufficient site information to calculate the effective wind speeds and
dynamic pressures for the required wind directions and heights around the
building, (that is the Reference Height (Hr) for each wall panel or roof panel).

The wind speed calculations are automated, the data source for the
calculations is either:

• taken directly from the BREVe database, which is based upon the Ordnance
Survey data of Great Britain,

• input directly.

It should be noted that BS6399-2:1997 recommends that the Standard Method
requires assessment of orthogonal loadcases for wind directions normal to
the faces of the building. The wizard permits you to create wind load for any
wind direction and thus it is up to you to create those loads for the directions
most appropriate to your structure.

Topics in this section

Design Codes and References (page 54)

Scope (BS6399-2 Wind wizard) (page 55)

Limitations (BS6399-2 Wind wizard) (page 56)

Using the BS6399-2 Wind Wizard with BREVe data (page 58)

Using the BS6399-2 Wind Wizard with other data (page 62)

Results page (BS6399-2 Wind Wizard) (page 65)

BS6399-2 Wind Zones (page 67)
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Design Codes and References

Unless explicitly stated all calculations in the BS 6399-2 Wind Modeller are in
accordance with the relevant sections BS 6399-2:1997 incorporating
Amendment 1 and corrigendum No. 1. (Ref. 4) (page 89) It is essential that
you have a copy of this code with you while assessing wind on any structure.

Your attention is particularly drawn to BS6399-2:1997 - Clause 1.1. For
building shapes which are not covered by the Standard you will need to
seek specialist advice.

We would recommend having the following books to hand when using the
software:

• Wind Loading - a practical guide to BS 6399-2 Wind Loads on buildings.
(Ref. 7) (page 89)

• Wind and Loads on buildings: Guide to Evaluating Design Wind Loads to
BS6399-2:1997. (Ref. 8) (page 89)

Unless explicitly noted otherwise, all clauses, figures and tables referred to in
this handbook are from reference 4 (page 89).

Scope (BS6399-2 Wind wizard)

In the main, BS6399-2:1997 addresses rectilinear buildings. In order to develop
a tool for engineers, we have extended this capability to address non-
rectilinear buildings using the standard method. For more information, please
refer to reference 7 (page 89) (section 2.5.3.2.4, page 82 and 2.5.4.3.3 pages
89-90).

The scope of BS 6399-2 Wind Modeller encompasses:

• Enveloping the building with wall panels and roof panels is undertaken in
Tekla Structural Designer in the normal manner. There is only limited
validation of the envelope defined (for example connected wall panels
must have consistent normal directions). The onus is on you to model the
building shape as completely and as accurately as you determine
necessary.

• Choice of method:

• BS6399-2:1997 - Standard Method - Standard effective wind speeds
with standard pressure coefficients,

• BS6399-2:1997 - Hybrid Method - Directional effective wind speeds with
standard pressure coefficients.

• Basic Wind Speed and Dynamic pressure is determined.

• Having defined wall panels and roof panels (defaults are standard wall, flat
or monopitch roof depending on the slope), you are able to specify the
type in more detail e.g. multi-bay, monopitch / duopitch etc.).

• The main wind parameters, are calculated for you but conservatively, (for
example Crosswind Breadth, B, is determined for the enclosing rectangle of
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the whole building). Wherever possible other parameters are determined
conservatively, but you are able to override the values should you need to.

• Given the above, zoning is semi-automatic, (not attempted for roofs with
more than 4 sides which are defaulted to single conservative coefficient),
with full graphical feedback.

• Load decomposition is fully automatic where valid, (wall panels and roof
panels need to be fully supported in the direction of span).

Limitations (BS6399-2 Wind wizard)
This page discusses the limitations to the wind wizard.

Throughout the development of the Wind Modeler extensive reference has
been made to the References (page 89) and we consider it advisable that you
are fully familiar with these before using the software.

In addition, because wind loading is complex and its application to general
structures even more so, it is essential that you read and fully appreciate the
following limitations in the software:

Geometry

DANGER You should seek specialist advice for building shapes that are not
covered by the Standard - see Clause 1.1 of BS6399-2:1997.

• Open sided buildings are beyond scope.

• Free standing walls and sign boards are not considered.

• Parapets and free-standing canopies are not considered.

• Exposed members are not considered, for example lattices, trusses......

• Barrel-vault roofs and domes are not considered.

• Dominant Openings are not explicitly handled - Clause 2.6.2. However, you
can use Table 17 to calculate the necessary Cpi values and manually apply
to a loadcase or individual zone loads.

Loaded areas

The difference between the loaded area of wall panels and roof panels defined
at the centre-line rather than the sheeting dimension is ignored.

Wind direction

• All outward faces within 60 degs of being perpendicular to wind direction -
loads applied as windward normal to face. All inside faces within 60 degs to
wind direction - loads applied as leeward normal to face. All other faces
considered as side.
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• Orthogonal wind directions at the definition of the user.

Beneficial loads

• No automatic reduction is made for beneficial load. When you edit the
Zone Load Data for a wind direction, having generated wind loadcases,
there is an option to allow for beneficial loads.

Wind loading on wall panels

Automatic zoning applies to all wall panels subject to the limitations described
below:

• Wall panels that are more than 15° from the vertical are outside the scope -
Clause 2.4.1.5.

• The inset storey clause 2.4.4.2 b) is not implemented. You can edit the
zones manually according to your engineering judgement to include zone E
if you consider this necessary.

• Wall panels of internal wells are not automatically identified - Clause
2.4.3.2a. You can manually edit the zones to apply the roof coefficient to
the wall panels.

Wind loading on roof panels

• Automatic zoning only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, i.e. all of the internal angles
< 180°

• The inset storey clauses 2.5.1.7 a) and b) are not implemented. In clause a)
the software sets Hr and H equal conservatively. You are obviously able to
edit the zones manually according to your engineering judgement to
include the further zones indicated in Figure 18 should you consider this
necessary.

• It should be noted that in Table 8 for curved and mansard eaves, the zones
start from edge of horizontal roof and not from the edge of the feature.

• Special care should be taken for winds blowing on duopitch with slopes
that differ by more than 5°. If the wind is blowing on the steeper slope (that
is that the less steep slope is downwind of ridge), the downwind slope
should be set to be a flat roof with mansard at eaves for this wind
direction.

• Mansard and Multipitch Roofs are not detected automatically, However,
you can manually apply the relevant roof type, apex type and bay position
parameters for each appropriate wind direction to match the requirements
of Figure 22 and Figure 23 - see BS6399-2 Wind Zones.

• Roof Overhangs are not explicitly handled. It is suggested that you should
define two separate roof panels - one forming the overhang and the other
covering the inside of the building. You can then define Cpi values manually
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to either have the same coefficient as the adjacent wall, (Clause 2.5.8.2
Small Overhangs), or as an open sided building (Clause 2.6.3).

Additional wind loads

There may be situations when you perceive a need to manually define loads
that cannot be determined automatically. You can do this by defining
additional wind loadcases to contain these loads and then include these with
the relevant system generated loads in design combinations in the normal
way.

Using the BS6399-2 Wind Wizard with BREVe data
Using the BS6399-2 Wind Wizard with BREVe data

Method page

This page allows you to specify the method that you want to use to calculate
the wind loading on the building, and the source of the wind data.

Property/
Buttons

Description

Property  
 There are two calculation methods available:
Standard Uses standard effective wind speeds with standard

pressure coefficients,
Hybrid Uses directional effective wind speeds with standard

pressure coefficients.
  
 Assuming you have are going to specify the site data using

BREVe Grid Ref data there are two options for the source
of the wind data:

• BREVe - UK National Grid Ref.

• BREVe - Irish Grid Ref
Buttons  
Next If BREVe is the data source, clicking Next takes you to the

BREVe location page; if Other is the data source clicking
Next takes you to the Other Location page.

BREVe location page

This page allows you to define the location of the site using the BREVe
database, and to define various options to be considered in the wind analysis.
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Once you have retrieved the data for a site from the BREVe database you can
edit these to take account of your local knowledge of the site.

Property/
Buttons

Description

Property  
Grid Ref. This shows the grid reference of the site which you have

picked through BREVe, irrespective of the method you use
to define the site location.

Site Altitude, A You are able to override the altitude determined by BREVe
by entering a value directly here.

Air Density You need to enter air density at the site.
Ground Level in
model

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground level,
for example you have used a site datum rather than a
building datum, then this field allows you to set the
appropriate value so that the reference heights for the
wind can be calculated correctly.

Orientation of
building known

If you know the orientation of the building with respect to
North, then you can define this information by checking
this box. You can then define a value which relates the
building direction axes of your Tekla Structural Designer
model to geographic north.

If you want to use the Hybrid method, then you must know
and define the building orientation.

For the Standard method, the orientation is not essential.
If you don't define the building's orientation then North is
not shown in graphics views and all the Sd values are set to
1.0.

Orientation of
North

The orientation of North is defined using the same
convention as is applied to the orientation of the Building
Direction Arrows.

This can best be understood by reference to a couple of
examples:

In the first example the building axes are aligned in the
default directions (Dir 1 = 0° = Global X), and the
orientation of North has been set to 315°.

The resulting relation between the building axes and North
is as shown below:
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Property/
Buttons

Description

In the second example the building direction has been
input with Dir 1 = 30° and the orientation of North has
been set to 250°

In this case the building axes are related to North as
shown below:
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Property/
Buttons

Description

Consider
Topography

If you select this check box, then BREVe uses the
topographic data it recovers for the site and determines
the Altitude Factor Sa in accordance with Clause 2.2.2.2.3.
Otherwise the topographic data is ignored and Sa is
calculated in accordance with Clause 2.2.2.2.2.

NOTE In theory the topography could be significant for
some directions and not for others.

Consider
Obstructions

With this box checked, BREVe uses the obstruction data it
recovers for the site and determines the Effective Height
He as defined in Clause 1.7.3.3. Otherwise the obstructions
are ignored and He is taken as Hr - see Clause 1.7.3.2.

Buttons  
 Using BREVe, there are 2 methods available for you to

define the site location:
Site By Ref... You can define the grid reference of the site.

You define this either as a national grid reference, or by
specifying the Easting and Northing information for the
site. There are several Internet based tools available which
allow you to determine the Ordnance Survey grid
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Property/
Buttons

Description

reference from a postcode or given location, for example
www.streetmap.co.uk or www.multimap.co.uk

Site By Map... You can pick the site from a Land / Town Map,

• You can pick the site from a Orography Map.

• You can pick the site from a ground roughness Category
Map,

The site data is analysed fully by BREVe. Parameters are
either set automatically but conservatively (Safe
parameters within a 1 km square).

Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Results page (BS6399-2 Wind

Wizard) (page 65).

Using the BS6399-2 Wind Wizard with other data
This section runs through the wizard when "other data" is specified.

Method page

This page allows you to specify the method that you want to use to calculate
the wind loading on the building, and the source of the wind data.

Property/
Buttons

Description

Property  
 There are two calculation methods available:
Standard Uses standard effective wind speeds with standard

pressure coefficients,
Hybrid Uses directional effective wind speeds with standard

pressure coefficients.
  
 The remaining topics in this section assume you have

chosen to enter the site data manually (Other).
Buttons  
Next Assuming Other is the data source, clicking Next takes you

to the Other Location page.
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Other location page

This page allows you to define the site details when information is not
available from the BREVe database, for instance if it is located outside of the
UK.

Property/
Buttons

Description

Property  
Site Altitude You are able to override the altitude determined by BREVe

by entering a value directly here.
Air Density You need to enter air density at the site.
Ground Level in
model

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground level,
for example you have used a site datum rather than a
building datum, then this field allows you to set the
appropriate value so that the reference heights for the
wind can be calculated correctly.

Buttons  
Cancel Click this button to cancel the wizard.
Previous Click this button to go back to the previous page of the

wizard.
Next Click Next to move to the Other Standard Wind data

page, or if the Hybrid method was selected to the Other
Hybrid Wind data page.

Other Standard Wind data page

If you select the Standard Method and Other Data Source, then the next page
of the Wizard allows you to enter the wind data yourself.

Property/
Buttons

Description

Property  
Basic Wind
Speed

You need to enter the basic wind speed at the site.

Ground
Roughness

The following settings are available:

• Sea - this setting is for sites where the distance to sea is
between 0 and 1 km, (see Clause 1.7.2), it is not for
offshore sites.,

• Country - the worst case must be for wind blowing
across open ground, there is no need to specify data
for upwind buildings or distance in town,

• Town - for this category you need to specify data for
upwind buildings and distance to the edge of the town,
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Property/
Buttons

Description

so the relevant fields are active. If you want to ignore
obstructions, then you need to enter a zero value for Ho
For this category, the 'Upwind distance from edge of
town to site' cannot be greater than the 'Upwind
distance from sea to site'.

Consider
Topography /
Altitude Factor,
Sa

When this box is checked, you need to use your own
topographic data and determine the Altitude Factor Sa in
accordance with Clause 2.2.2.2.3. Otherwise Sa is
calculated in accordance with Clause 2.2.2.2.2 and you are
not able to override it.

Season factor You need to enter the season factor (default 1.0).
Probability
factor

You need to enter the probability factor (default 1.0).

Buttons  
Next Click Next to move to the Results page (BS6399-2 Wind

Wizard) (page 65).

Other Hydrid Wind data page

If you select the Hybrid Method and Other Data Source then the next page of
the Wizard allows you to enter the data for ground roughness and
obstructions yourself. However, most of the data is then dependent on the
wind direction, so you must also make your choice of wind directions on this
page.

Property/
Buttons

Description

Property  
Direction Initially there are 4 orthogonal wind directions relative to

the Tekla Structural Designer axes, (not geographical
North), but you are able to update these using the Dir.
buttons and / or changing the direction value as required.
(Note: Minimum 1° difference between directions). At least
one direction must be defined.

Each row of the grid operates in a similar manner to the
relevant fields of the Other Standard Wind data page

Consider
Topography /
Altitude Factor,
Sa

Reference 8 (section 4.10, page 26) essentially
recommends using the Standard Method approach to
topography even for the Hybrid Method. So, when

Engineers Handbooks 64 Wind modeling handbook



Property/
Buttons

Description

calculating the Terrain and Building Factor, Sb, we ignore
the effects of topography, that is we take Sh = 0.

When the box is checked, you need to use your own
topographic data and determine the Altitude Factors Sa as
defined in Clause 2.2.2.2.3. Otherwise Sa is calculated as
defined in Clause 2.2.2.2.2 and you are not able to override
it.

NOTE In theory the topography could be significant for
some directions and not for others.

Season factor You need to enter the season factor (default 1.0).
Probability
factor

You need to enter the probability factor (default 1.0).

Buttons  
Next Click Next to move to the Results page (BS6399-2 Wind

Wizard) (page 65).

Results page (BS6399-2 Wind Wizard)
The final page of the Wizard is a summary of the results - peak velocity
pressure ranges.

This is the start of your topic.

BREVe Standard Method

Initially this method creates 4 orthogonal wind directions relative to the Tekla
Structural Designer axes, (not geographical North). Except for the Hybrid
Method with Other Data, you can update the wind directions either by using
the 'Dir.' buttons or by changing the direction value as required.

Separately, for each relevant parameter of the Standard Method, BREVe
determines the worst case over all its 30° sectors. If the orientation of the
building is not known, then Sd is taken as 1.0 for all directions. Otherwise we
determine the worst case Sd for each direction. You cannot override the
system value in either case.

The worst case Sd is based on splitting the difference to the next direction,
with a minimum of ±15° and maximum of ±45°. Within these ranges Sd is
interpolated.

For each reference height in the model, we then calculate the site wind speed
(Vs using equation 8) and thus the effective wind speed (Ve using equation 12)
and the dynamic pressure (qs using equation 1) for each direction. When
calculating actual loads on walls and roofs, we use the qs value for the relevant

Engineers Handbooks 65 Wind modeling handbook



reference height, but the Results page only shows the maximum values for
each direction.

The Vortex view shows the effective wind speed calculated for each reference
height for each 30° sector. Since a single worst case value is used for each
parameter, the speeds for different sectors only differ due to Sd provided that
the orientation of the building is known.

BREVe Hybrid Method

In this case, BREVe uses the directional method to determine the parameters
required to calculate Vs using equation 8, for each height in the building at 30°
intervals, (0° to 330°) taking the diagonal dimension `a' as the default 5.0m.
(The size effect factor is applied when determining individual loads). We then
use equation 27 to determine Ve and equation 16 for qs.

For each required wind direction the worst case Ve is used for each height,
based on splitting the difference to the next direction, with a maximum of ±45
degrees. Within these ranges Ve is not interpolated.

Theoretically, it is possible for a quadrant to use different 30° directions for
each height, so the critical wind direction is not displayed in the summary.

The Vortex view shows the effective wind speed calculated for each reference
height for each 30° sector.

Other Standard Method

The calculation of Ve and qs are very similar to the BREVe Standard Method,
(see above), except that the worst case data has been entered by you, and this
page allows you to enter your own values for Sd.

As there is no data for each 30° sector, the Vortex view only shows the
effective wind speed calculated for each reference height for each direction.

Other Hybrid Method

The calculation of Ve and qs are be very similar to the BREVe Hybrid Method,
(see above), except that the data has been entered by you for each direction
only so a direct calculation can be performed instead of taking the worst case
over a range of sectors. Also this page allows you to enter your own values for
Sd.

As there is no data for each 30° sector, the Vortex view only shows the
effective wind speed calculated for each reference height for each direction.

Finishing the Wind Wizard

When you click Finish, the Wind Wizard generates the wind zones for the
entire building for each of the specified wind directions.
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Before moving on you should take a moment to inspect the Wind Model status
on the Project Workspace> Status tab, in order to check that no Limitations
(page 56) have been encountered.

BS6399-2 Wind Zones

At the end of the Wind Wizard..., the system creates default zones for all the
walls and roof panels for each of the defined wind directions.

If any errors have occurred in this process, a red cross appears next to
Pressure Zones in the Project Workspace.

Basic Geometry

The basic building geometry is assessed as follows:

• Reference Height (Hr) - is taken as the difference between highest point on
wall or roof panel and ground level.

• Wall height (H) - is taken as the difference between highest and lowest
points on the wall panel.

These definitions apply to wall panels without parapets and the actual
parapets. Wall panels with parapets above them will take their highest
point from the parapet. See the diagram below.

Engineers Handbooks 67 Wind modeling handbook



• Roof height (H) - is taken as the difference between highest point on wall or
roof panel and ground level. This definition does not handle the upper roof
of inset storey but is conservative and only affects the scaling dimension, b
- see Clause 2.5.1.7.

• The Building Breadth, B is calculated from the smallest enclosing rectangle
around the whole building (considered over all roof and wall panels only)
for the given direction. You can override the calculated value in case the
Tekla Structural Designer model does not include the whole building.
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Wall Zones

Wall Type

We assess each wall panel to determine if it is a windward, leeward or side
wall. We classify the type of wall dependent on q:

• θ ≤ 60 deg - Windward,

• θ ≥ 120 deg - Leeward,

• Other walls are classed as Side.

Windward walls Windward walls have a single zone and Table 5 is used
with interpolation for D/H.

Leeward walls Leeward walls have a single zone and Table 5 is used.
Side walls Side walls are assessed for recesses (narrow or wide),

irregular flushed faces, downwind re-entrant corners. In
all cases, side walls have the relevant number of zones.
Table 5 is used.

Roof Zones

Roof zones are automatically generated where possible for each wind
direction. In essence each roof panel is assessed in its own right based on its
properties. The interconnectivity of touching roof panels is not generally
considered.

Direction

Internally the roof slope vector (line of maximum slope) is determined from
the normal vector, with its direction always giving a positive slope angle, i.e.
the roof slope vector must always point up the slope.

We calculate the angle between the wind direction and projection of roof slope
vector onto horizontal plane ( q in range -180° to +180°).

Automatic Zoning

Automatic zoning normally only applies to all triangular roof panels and
quadrilateral roof panels that are not concave, that is that all of the internal
angles < 180°. However, additionally, it only applies to Hip Gable roofs if they
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are triangular, and Hip Main roofs if they are quadrilateral. Further, Downwind
Slope Hip Gables must not have 2 upwind corners.

Dimensions All zone dimensions are specified in plan.
Flat Roofs See BS 6399 Clause 2.5.1, Figure 16 and Table 8.
Monopitch Roofs See BS 6399 Clause 2.5.2.3, Figure 19 and Table 9.
Duopitch Roofs See BS 6399 Clause 2.5.2.4, Figure 20 and Table 10.
Hip Gable See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Hip Main See BS 6399 Clause 2.5.3, Figure 21 and Table 11.
Mansard Roofs If you manually set the connected roof types to

Mansard, then the program will correctly identify the
special cases in BS6399 Figures 17c, 22a and 22b, and
use the correct tables and values. See BS 6399
Clauses 2.5.1.6.2 & 2.5.4

Multi-bay Roofs We allow you to interpret BS 6399 Clause 2.5.5 and
Figure 23 as you think appropriate and manually
define the roof types and sub-types accordingly. You
also have the ability to manually set the multi-bay
position for each roof panel for each wind direction:

• Not Multi-Bay - for this wind direction
(conservative default),

• Upwind Bay - first bay of many for this wind
direction,

• Second Bay - for this wind direction,

• Third or more Bay - for this wind direction.

Where the reduction applies, the values of all
coefficients are reduced according to Table 12.

Non-Automatic Zoning
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Where automatic zoning does not apply, the system creates a single zone
covering the entire roof as follows:

• Flat - B,

• Monopitch - B,

• Duopitch - B for upwind, A for downwind, B for side,

• Hip Gable - B for upwind, B for downwind, D for side,

• Hip Main - B for upwind, A for downwind, D for side.

IS 875 (Part 3) Wind Wizard
This topic discusses the wind wizard when using the IS 875 (Part 3) code.

To access this configuration of the Wind Wizard... the Wind Loading Code has
to be set to IS 875 (Part 3).

Once the wall and roof panels are in place, you use the Wind Wizard... to
define sufficient site information to calculate the effective wind speeds and
dynamic pressures for the required wind directions and heights around the
building.

The wizard permits you to create wind load for any wind direction, it is up to
you to create those loads for the directions most appropriate to your
structure.

Unless explicitly stated all calculations in the IS 875 (Part 3) Wind Modeller are
in accordance with the relevant sections of IS:875 (Part 3) - 1987 Second
Revision, Reaffirmed 2003 and including Amendments 1, 2 and 3.

Wind Options page
This page allows you to specify the method that you want to use to calculate
the wind loading on the building, and the source of the wind data.

Property/Buttons Description
Property  
Data Source The wind velocity calculations are automated, the data

source for the calculations is either:

• Input directly for the worst case,

• Input directly for each direction.
Consider
Topography

When this box is checked, you will be asked to enter
your own topographic data later in the Wizard.

Consider Cyclonic
Effect

Choose this option to have Cyclonic Effect considered.

Clad frame -
correlated pressure
and suction

Choose this option for correlated pressure and suction
in clad frames.
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Property/Buttons Description
Apply Open
Structure Wind
Load

With this box checked, additional wind forces are
applied to those members, ancillaries and equipment
that have the Apply Open Structure Wind Load
property selected in their properties.

NOTE This option is only displayed if at least one
entity has been selected to have open structure
wind load applied.

For more information, see: The open structure wind
method (page 89)

Buttons  
Next Click Next to go to the Basic Data page.

Basic Data page

Property/Buttons Description
Property  
Ground Level in
model

If for some reason, the level 0.0m in the Tekla Structural
Designer model does not correspond to the ground
level, for example you have used a site datum rather
than a building datum, then this field allows you to set
the appropriate value so that the reference heights for
the wind can be calculated correctly. This field also gives
the lowest level to which wind load is applied in the
structure.

Orientation IS 875 defines the zones assuming the longest principal
axis of the building is in the Tekla Structural Designer
global Y direction. Due to the potential complexity of the
model, Tekla Structural Designer will not attempt to
determine the correct angle for the axes, (i.e. default is
zero) but you are able to enter a more appropriate
value.

NOTE The convention for Wind Directions is: wind
along global +X is 0 degrees; along global +Y is
90 ; along global -X is 180 ; along global -Y is
270.

Building Height
Exposed to Wind

Calculated from difference between Ground Level and
max level of roof and wind wall panels in the model,
with 'override calculated' option to permit user editing.

Building Width and
Building Length

The smallest bounding rectangle is determined
(considered over all roof and walls only), relative to the
given orientation. The building length defaults to the
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Property/Buttons Description
maximum and the width to the minimum of the two
dimensions. The 'override calculated' options permit
user editing.

Building Type The following options are available:

• Temporary

• Low hazard to life

• All general buildings

• Important buildings
Building Class This is determined as follows:

• A if max(Building Height Exposed to Wind, Building
Width and Building Length) < 20m

• B if max(Building Height Exposed to Wind, Building
Width and Building Length) 50m

• C if max(Building Height Exposed to Wind, Building
Width and Building Length) > 50m

Basic Wind Speed You need to enter the basic wind speed at the site.
Probability factor The value of the probability factor is determined from

the following table (Table 1):

 Basic Wind Speed
Buil
ding
Typ
e

33 39 44 47 50 55

Tem
por
ary

0.82 0.76 0.73 0.71 0.70 0.67

Low
haz
ard

0.94 0.92 0.91 0.90 0.90 0.89

All
gen
eral

1.00 1.00 1.00 1.00 1.00 1.00

Imp
orta
nt

1.05 1.06 1.07 1.07 1.08 1.08

Buttons  
Next Click Next to go to the Terrain page.
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Terrain page
The next page of the Wizard allows you to enter the terrain data.

Property/Buttons Description
Property  
Terrain Category • Category 1 = Exposed open terrain few obstructions

(Default)

• Category 2 = Open terrain scattered obstructions

• Category 3 = Terrain with numerous closely spaced
obstructions

• Category 4 = Terrain with numerous large high
closely spaced obstructions

Fetch a distance The velocity profile for a given terrain category does not
develop to full height immediately and in this release
Tekla Structural Designer only deals with a single terrain
profile so you are warned if the velocity profile has not
developed over the fill height of the building for the
defined fetch.

Buttons  
Next Click Next to go to the Topography page.

Topography page
If Consider Topography was checked, then the next page of the Wizard allows
you to enter the topography data.

Property/Buttons Description
Property • None - no feature (default)

• 2D Escarp - Cliffs and Escarpments

• 3D Hill - Hills and Ridges
Feature Height, Z Effective height of the feature.
Site dist from crest,
X

Distance upwind or downwind from the crest to the
building site (-ve = upwind).

Site height above
mean ground level,
H

Height above mean ground level.

Upwind Slope
Length, L

Actual length of the upwind slope in the wind direction.

Downwind Slope
Length

Actual length of the downwind slope in the wind
direction.

Buttons  
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Property/Buttons Description
Next Click Next to go to the Results page.

Results page
The final page of the Wizard is a summary of the results.

The final page of the Wizard is a summary of the results.

Vz max = Vb x k1 x k2 x k3 (m/s)

pz max = 0.6 x Vz max2 (N/m2)

The above is for the highest point in the building only.

Property/Buttons Description
Buttons  
Finish When you click Finish, the Wind Wizard... generates the

wind zones for the entire building for each of the
specified wind directions.

Before moving on you should take a moment to inspect
the Wind Model status on the Project Workspace>
Status tab, in order to check that no issues have been
encountered.

Wind model loadcases
Once the wind wizard has been run, the next step is the creation of
appropriate wind loadcases. This is achieved using the Wind Loadcases dialog
which is accessed by clicking Wind Loadcases on the Load toolbar.

NOTE The Wind Loadcases dialog is only available after the wind wizard has
been run.

The Auto button within the Wind Loadcases dialog automatically generates
wind loadcases.

NOTE The Auto button is greyed out and hence unavailable, if wind
loadcases have already been defined. These would need to be deleted
to use the Auto button again.

Alternatively, you can create loadcases manually using the Add button and
proceeding as follows:

• specify which direction the loadcase will be created

• set default values for all the zone loads generated in the loadcase

• the loadcase is generated automatically, (but can be overwritten if
required)
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Try to use engineering judgment to identify the critical loadcases for design.
This ensures that the number of load combinations to be considered are
minimized. Use the Delete button to remove wind loadcases you do not wish
to consider.

Once generated, the wind loadcases are standard loadcases which can be
included in combinations in the normal manner.

Creating loadcases for the Low Rise Buildings method

It is not practical to automatically determine critical combinations and thus
required wind loadcases, therefore you control the generation of appropriate
Wind Loadcases manually. This is achieved via the Wind Loadcases dialog
(accessed from the Load tab).

The Auto button on the dialog provides various options to control the number
of loadcases before they are generated (its intention being to prevent
generation of very large numbers of loadcases). Alternatively you can create
loadcases manually using the Add button.

You then specify which direction the loadcase will be created for and set
default values for all the zone loads generated in the loadcase.

Once generated these loadcases are standard loadcases so you can include
them in combinations in the normal manner.

Try to use engineering judgement to identify the critical loadcases for design.
This ensures that the number of load combinations to be considered are
minimized. Use the Delete button to remove wind loadcases you do not wish
to consider.

Adding wind loadcases

By clicking the Add button you are able to generate loadcases one at a time.

• The loadcase name is auto generated from the other input parameters, but
it can be edited if required.

• The direction the loadcase will be created for is selected from the droplist.

• The internal pressure coefficient is entered directly.

NOTE Depending on the wind code you have selected, the default is the
negative value depending on the Enclosure Classification from:

• AISC 7-16: Table 26.13-1, p271

• AISC 7-10: Figure 26.11-1, p201

• AISC 7-05: Figure 6-5, p47

• You are able to flag if it is a Torsional Loadcase or not: when flagged,
reduced pressure loads are applied to parts of the standard zones (by
applying a net pressure factor of 25%).
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• You are able to flag if roof loads are to be generated for the loadcase or
not.

Auto generating wind loadcases

By clicking the Auto button you are able to control the total number of
loadcases generated.

Up to 4 loadcases can be generated for each direction, using positive and
negative GCpi derived from the Enclosure Classification, (see Figure 26.11-1,
p201). If a direction is included, but neither +ve GCpi or -ve GCpi have been
checked, then that is interpreted as a loadcase with GCpi of zero. You are also
given the option to include the torsional loadcases or not, (default not), but it
is assumed that Roof loads are required.

By clicking OK the loadcases are generated, but you can then make any
changes required before clicking OK once more to close the Wind Loadcases
dialog.

Creating loadcases for the All Heights method

It is not practical to automatically determine critical combinations and thus
required wind loadcases, therefore you control the generation of appropriate
Wind Loadcases manually. This is achieved via the Wind Loadcases dialog
(accessed from the Load tab).

The Auto button on the dialog provides various options to control the number
of loadcases before they are generated (its intention being to prevent
generation of very large numbers of loadcases). Alternatively you can create
loadcases manually using the Add button.

You then specify which direction the loadcase will be created for and set
default values for all the zone loads generated in the loadcase.

Once generated these loadcases are standard loadcases so you can include
them in combinations in the normal manner.

Try to use engineering judgement to identify the critical loadcases so that the
number of load combinations that need to be considered can be minimized.

Adding wind loadcases

By clicking the Add button you are able to generate loadcases one at a time.

• The loadcase name is auto generated from the other input parameters, but
it can be edited if required.

• The direction the loadcase will be created for is selected from the droplist.

• The internal pressure coefficient is entered directly.

NOTE Depending on the wind code you have selected, the default is the
negative value depending on the Enclosure Classification from:

• AISC 7-16: Table 26.13-1, p271
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• AISC 7-10: Figure 26.11-1, p201

• AISC 7-05: Figure 6-5, p47

• You are able to flag if it is a Torsional Loadcase or not: when flagged,
reduced pressure loads are applied to parts of the standard zones (by
applying a net pressure factor of 25%).

• For torsional loadcases, you are able to flag if positive or negative
eccentricity is applied.

• You are able to flag if loads are to be created for roof zones or not.

NOTE This option is provided to allow for the following note, (depending
on the wind code you have selected):

• AISC 7-16: Figure 27.3-1, Note 7, p276

• AISC 7-10: Figure 27.4-1, Note 9, p207

• AISC 7-05: Figure 6-6, Note 9, p49

• If loads are created for roof zones, you are able to flag if positive or
negative pressure coefficients are to be used for roof zones.

Auto generating wind loadcases

By clicking the Auto button you are able to control the total number of
loadcases generated.

Up to 8 loadcases can be generated for each direction. You may choose
positive and/or negative GCpi derived from the Enclosure Classification, (see
Figure 26.11-1, p201). If you include a direction, but have not checked either
+ve GCpi or -ve GCpi, then that is interpreted as a loadcase with GCpi of zero.
Similarly you may choose positive and/or negative Cp values for roof zones -
checking neither indicates Roof Loads to be ignored for this direction.
Torsional loadcases will not be included by default, but can be added with
positive or negative eccentricity.

By clicking OK the loadcases are generated, but you can then make any
changes required before clicking OK once more to close the Wind Loadcases
dialog.

Creating loadcases EC1991 1-4

It is not practical to automatically determine critical combinations and thus
required wind loadcases, therefore you control the generation of appropriate
Wind Loadcases manually. This is achieved via the Wind Loadcases dialog box
(accessed from the Load toolbar).

The Auto button on the dialog creates a default set of loadcases in each of the
directions, i.e.

• -0.3 for Cpi with -ve roof Cpe; not Overall
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• -0.3 for Cpi with +ve roof Cpe; not Overall

• +0.2 for Cpi with -ve roof Cpe; not Overall

• +0.2 for Cpi with +ve roof Cpe; not Overall

• Overall with zero for Cpi; -ve roof Cpe

Alternatively you can create loadcases manually using the Add button. You
then specify which direction the loadcase will be created for and set default
values for all the zone loads generated in the loadcase.

Once generated these loadcases are standard loadcases so you can include
them in combinations in the normal manner.

Try to use engineering judgement to identify the critical loadcases so that the
number of load combinations that need to be considered can be minimized.
Use the Delete button to remove wind loadcases you do not wish to consider.

Wind loadcases dialog

As well as specifying which direction the loadcase will be created for, this
dialog allows you to set default values for all the zone loads generated in the
loadcase.

Item Description
Fields  
Structur
al Factor
-
Automat
ically
calculate
seperate
cs and cd
factors

The UK NA states that the Structural Factor, cscd may be
separated into a size factor cs and a dynamic factor cd,
i.e. it is still acceptable to apply Clause 6.2 (1) a) to d) and
set cscd = 1, or use Annex D. Where Structural Factor -
Automatically calculate separate cs and cd factors is
checked, cd is calculated using Figure NA.9 and cs using
Table NA.3.

NOTE The option to automatically calculate cc and cd is
not available for other National Annexes.

Structur
al
damping

The δs value is used to determine the dynamic factor cd.
It is only visible if the Separate Factors box is checked.
See Table F.2.

Name The loadcase name is auto generated from the other
input parameters, but it can be edited if required.

Directio
n

The direction the loadcase will be created for is selected
from the droplist.
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Item Description
Overall You are able to flag if the loadcase is to be specifically

used for examining the overall behaviour of the
structure by checking this box.

NOTE It may be necessary for you to create a second
copy of the loadcase with this check box cleared
if the loadcase is also used for designing
elements.

b+h When designing elements, (beams, columns, braces etc),
Table NA.3 in the UK NA implies that b and h should be
the width and height respectively of an element. Due to
the nature of the loads in the program, it is not practical
to do this automatically, and so you should specify a
value to be used in the loads generated for this loadcase
(default 5.0m).

If separate factors are not to be used, (i.e. use combined
cscd), then this value is redundant.

If separate factors are to be used, but Overall is checked
on the row, then the b+h cell is marked inactive. In this
case, for each wall and roof, the program calculates b+h
using b & h from the zone properties for the relevant
wind direction.

Use +ve
Cpe

Where 2 sets of coefficients are given in a table for roof
zones, this field indicates if the negative or positive Cpe
value is to be used.

Cpi Default Internal Pressure Coefficient (-0.3, 0.0, +0.2 or
other value) - to be calculated by you from Clause 7.2.9.

Buttons  
Add Click this button to add a single wind loadcase.
Delete Click this button to delete a wind loadcase.
Auto Click this button to create a default set of loadcases in

each of the directions.

Wind model load decomposition
Click the links below to find out about decomposition options available for
panels when using the wind model method.

• Wall panel load decomposition (page 81)

• Roof panel load decomposition (page 85)

• Alternative wind load decomposition method for complex models
(page 87)
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• Limitations of wind decomposition to diaphragms (page 101)

Wall panel load decomposition
This topic will discuss the decomposition that occurs when considering wind
load applied to wall panels.

Decomposition options

Wind zone loads are decomposed on to the structure according to the
Decompose to wall panel property. The available options are:

• Members

• Nodes (default)

• Rigid Diaphragms

To demonstrate the effect of the different Decompose to values, consider a
braced steel frame clad in wind wall panels as shown below:

For wind direction 0, the wind model produces Zone loads as follows:
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The topics below illustrate how the zone loads shown above are decomposed
using the three different Decompose to values.

Decompose to Members

Decomposition to members is similar to the roof panel decomposition, the
span direction of the wind wall panel determines the direction of the one way
decomposition.

All element types within the wind wall plane are considered with the exception
of bracing members.

Decomposition to members allows the generation of UDL's on portal
stanchions and gable posts without the need to model side rails.

For the model shown above, choosing Decompose to Members produces the
following load decomposition:
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Decomposition to Members (rotation angle 0 degrees)

Decomposition to Members (rotation angle 90 degrees)

Decompose to Nodes

Decomposition to nodes is the default setting and results in nodal loads on
the supporting members. This setting is typically appropriate to avoid lateral
loads on simple beams.

All element types within the wind wall plane are considered with the exception
of bracing members.

The initial decomposition is the same as for members, with the direction of the
one way decomposition being specified by the span direction of the panel. A
second decomposition stage is then undertaken to convert the member loads
to nodal loads:

• Full/partial UDLs and VDLs on elements (lengths of beams/columns
between nodes) are distributed back to nodes as if the elements were
simply supported at either end.

• The final nodal load is the sum of all incoming element loads.

For the model shown above, choosing Decompose to Nodes produces the
following load decomposition:
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collapse

Decomposition to Nodes (rotation angle 0 degrees)

Decomposition to Nodes (rotation angle 90 degrees)

NOTE In the example above, when the rotation angle is 0 degrees, some of
the nodal loads are applied directly to supports.

Decompose to Rigid Diaphragms

Decomposition to rigid diaphragms does not consider the span direction of
the wall panel (so the rotation angle is irrelevant).

It is particularly useful for flat-slab structures, as the alternative Decompose
to Member or Node decomposition methods require supporting members
that may not exist in the model.
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NOTE All rigid diaphragms within the wind wall height are considered for
decomposition irrespective of whether they are physically connected
to the wind wall.

For the model shown above, choosing Decompose to Rigid Diaphagm
produces the following load decomposition:

Decomposition to Diaphragms - each Zone load is decomposed as a separate
point load on the diaphragm

Validation of Panels set to Rigid Diaphragm Decomposition

The following validation checks are performed on wind wall panels set to
Decompose to Rigid Diaphragms:

• Each panel must be rectangular

• The top level of every wall panel must align with a rigid diaphragm

• Each panel may be sub-divided into zones, but only by horizontal lines

• Unlike for Decompose to Member or Node, each wall panel does not
need to have supporting members along its edges.

Roof panel load decomposition
This topic will discuss the decomposition that occurs when considering wind
load applied to roof panels.

Roof panel load decomposition

The direction of the one way decomposition of the wind zone loads to roof
members is determined by the span direction (i.e. rotation angle) of the roof
panel.

All types of elements within the roof panel plane (except bracing) are
considered during the load decomposition.
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Zone loads on roof.

Roof panel decomposition (rotation angle 0 degrees)
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Roof panel decomposition (rotation angle 90 degrees)

Alternative wind load decomposition method for complex models

For complex models the placement of wind walls required by the Wind model
method can be a time consuming operation.

In such a situation (provided the model has suitable rigid diaphragms), the
following alternative offers a quicker and simpler way to apply approximate
wind loads:

• Use engineering judgment to clothe the structure with an arrangement of
simplified wind wall panels around its bounding box,

• set the wind walls to decompose to rigid diaphragms,

• proceed with the Wind model method

Simplified wind wall panels example

In theory, because wind walls set to Decompose to Rigid Diaphragms don't
have to physically connect to the diaphragms, even a very complex model
could be clothed with just four simplified wind walls defined along its
bounding box, as illustrated below:
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Such an approach could be used to rapidly establish approximate wind

Figure1.
Complex

model prior to
placement of

wind walls

Figure2.
Simplified

wind walls
placed around
the "bounding

box"

Figure3.
Simplified

zone loads
after running

the wind
wizard

Figure4.
Resulting

point loads on
rigid

diaphragms
after

decompositio
n
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loads (based on the rectangular building envelope) which could then be
refined at a later stage if necessary.

NOTE If this method is adopted you are strongly advised to review the wind
zones that are formed, and the resulting decomposed loads to ensure
they meet your expectations - it will not give good results for all
models.

If the decomposed loads produced by the above approach are not
satisfactory, you might decide to take greater control by applying the loads
manually.
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The open structure wind method
Tekla Structural Designer provides a quick means to apply wind loads to open
structures in the form of automatically calculated UDLs or point loads.

In this method, you select Apply open structure wind load in the properties
of those entities to be loaded and then determine the load values by running
the Wind Wizard with the Apply open structure wind load option selected.

The following entities can be loaded in this way:

• Structural members (beams, columns etc)

• Line ancillaries

• Area ancillaries

• Equipment

The above approach can be used in conjunction with the method for enclosed
structures if wall and roof panels have also been defined.

NOTE The open structure wind method is not currently available for the
British Standard BS 6399-2, or Australian AS:1170.2 wind code
variants.

Click the links below to find out more:

• Open structure wind method assumptions and limitations (page 90)

• Wind load on open structures calculations (page 91)

• Open structure wind method workflow (page 94)

Open structure wind method assumptions and limitations

Assumptions

• All wind loads are assumed to act perpendicular to the members,
equipment and ancillaries

• Applicable for all 1D structural members irrespective of their characteristic
except

• analysis elements

• DELTABEAM

• FABSEC beams

Limitations

• Only currently applicable for US, EC and IS wind codes

• Cannot be applied on structural walls

• Shielding effect is not considered

• There are no frictional wind forces accounted on any surfaces
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Wind load on open structures calculations

Members and ancillaries

Wind load is determined as two full length UDLs, one acting in local y (minor)
and one acting in local z (major) on the member.

Full
UDLMajor

 
 
=
 
 

z x Cf x Effective Areaxy x Cos(θ) x Sin(φ) / L

Full
UDLMinor

 
 
=
 
 

z x Cf x Effective Areaxz x Sin(θ) / L

where  
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z  
 
=
 
 

wind pressure calculated at the height of the
member for that wind direction (for vertical
member average is taken at top and bottom level)

Cf  
 
=
 
 

shape factor

Effective
Areaxy

 
 
=
 
 

effective area of member in xy

Effective
Areaxz

 
 
=
 
 

effective area of member in xz

θ  
 
=
 
 

angle of the wind to the member x axis projected
vertically into the horizontal plane

φ  
 
=
 
 

angle of the member to the horizontal plane

L  
 
=
 
 

length of the member

Equipment

Wind load is determined as a single point load acting on the equipment.
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The point load is applied to the CoG of the equipment at mid height.

FWind   =  z x Cf x Effective Areaxz x
Sin(θ) + Effective Areayz x
Cos(θ))

Fx   =  FWind x Cos(θ)

Fy   =  FWind x Sin(θ)

where  
z   =  wind pressure calculated

at the height of the
equipment for that wind
direction

Cf   =  shape factor

Effective Areaxy   =  effective area of
equipment in xy

Effective Areaxz   =  effective area of
equipment in xz

θ   =  angle of the wind to the
equipment x axis
projected vertically into
the horizontal plane

L   =  length of the equipment
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NOTE All wind loads considered are horizontal, no vertical loading is
considered.

Shape factors and effective area factors

The default shape factors ( Cf) come from the document ‘Wind Loads For
Petrochemical And Other Industrial Facilities’ published by ASCE

The default shape factors and effective area factors assigned to new
members/ancillaries can be edited from Model Settings > Loading > Wind
Loading.

The shape factors and effective area factors for existing members and
ancillaries can be edited in the properties window.

Open structure wind method workflow
The basic steps required to apply this method are as follows:

Select members to have open structure wind load applied

The first step is to confirm the Apply open structure wind load property is
set as required for those structural members, ancillaries, and equipment to
which the loads are to be applied. (By default this property is off for structural
members, but on for ancillaries and equipment.)

It can be toggled on and off directly in the properties window as above, or it
can be set graphically via Show/Alter State > .

For members and ancillaries, when it set on, additional properties become
available, allowing the shape factor and effective area factors used in the wind
load calculation to be customized.

For members only, each of these properties can be set for all stacks/spans, or
individual stacks/spans.
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Run the wind wizard

Having selected the members to have open structure wind loads applied, the
next step is to run the Wind Wizard.

On the first page of the wizard you must select the Apply Open Structure
Wind Load option.

NOTE The above option is only available if at least one entity has been
selected to have open structure wind load applied.

Step-through the remaining pages of the wizard to generate wind model.

The wizard uses databases where appropriate (depending on the wind code)
to determine the appropriate wind details for your structure location.

Related topics

EC1991 1-4 Wind wizard (page 30)

ASCE 7 Wind wizard (page 15)

BS6399-2 Wind wizard (page 54)

IS 875 (Part 3) Wind Wizard (page 71)

Define the wind loadcases

The Wind Loadcases dialog can then be used to define the loadcase
information for the directions you require.

NOTE If you have a totally open structure without any wall or roof panels the Cpi
values are immaterial and can be set to 0.0.

Once the loadcases have been defined, wind loads (page 91) are automatically
calculated for those entities selected to have open structure wind load.

NOTE It is assumed that the wind loads are developed to assess the overall stability
of the structure and for member design. The wind loads have not been
specifically developed for the design of cladding and fixings.

Related topics

Wind model loadcases (page 75)

Review wind loads

The open structure wind loads on members, ancillaries and equipment can be
reviewed by opening a wind view for the required direction from the Project
Workspace Wind tab and selecting the required loadcase.

Hovering the cursor over an entity provides displays wind loading information
in the Select Entity tooltip. The shape factor, wind pressure and wind force are
all listed.
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For members, the same information is displayed by hovering over the
required stack/span.
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Combine the wind loadcases into design combinations

Combine the wind loadcases into design combinations in the usual way.

Perform the static design

Run a static design from the Design toolbar.

Create an open structure wind loads report

These loads are automatically included in the .

Manually applied wind loads and simple wind loads
This is a quick method of applying wind to open or enclosed structures
without requiring you to create a wind model.

The loads are applied manually, either as panel, member, or structure loads in
the usual way, or as simple wind which are then decomposed to diaphragms
during the analysis.

Click the links below to find out more:

•

• Limitations of wind decomposition to diaphragms (page 101)

• Simple wind example (page 97)

Simple wind example
Each simple wind load is defined as an area load over a defined width and
height.

In the two story example shown below, a 1kN/m2 load is applied over the full
22.5m width and 6m height of the building.
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• The load defaults to being uniform over the full height (as shown above),
but levels can be inserted to cater for a stepped loading profile if required.
The inserted levels do not have to coincide with actual building levels.

• The top of the load should align with a rigid diaphragm - if not a validation
error is generated - this is to ensure the loading is distributed as correctly
as possible.

• During decomposition an imaginary 'bounding box' is formed around the
building - only the load width within the building profile is considered for
decomposition.

• Load within the bounding box that hits the structure (the blue shaded area
above) is decomposed to point loads on rigid diaphragms only - it does not
get decomposed to semi-rigid diaphragms.

• All rigid diaphragms on the top or bottom level or anywhere in-between
are considered, with the area load being divided between the levels before
it is decomposed. In the example the area load is split between 1st and 2nd
floor levels so that a total of 22kN is to be decomposed above and 90kN
below.

Engineers Handbooks 98 Wind modeling handbook



• The load is then decomposed to the diaphragms at each level in proportion
to the width of each diaphragm. Each load being applied as a nodal load in
the direction of the simple wind load at the mid point of the projected load.

• If there are no suitable diaphragms on the top level, the load is applied at
the next level down.

• Similarly if the 'Ignore diaphragms on lowest level' box is checked on the
Simple Wind Loading dialog or there are no suitable diaphragms on the
bottom level, the load is applied at the next level up.

NOTE If for some reason there are diaphragms at the ground level, then you
may decide to check the 'Ignore diaphragms on lowest level' box in
order to ensure no load is lost directly to the foundations.

Situations where rigid diaphragms are ignored

If the projected width of a rigid diaphragm in the direction that the load is
acting is less than 5% of the simple wind load width it is assumed to be
ineffective.

In the below example, at first floor level the width of the diaphragm
perpendicular to the load exceeds the width of the load, so the diaphragm is
effective.
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This changes at roof level, as the width of the diaphragm is now significantly
smaller than the width of the load. If the diaphragm width is less than 5% of
the load width, the diaphragm is ignored.
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Furthermore, as this is the only diaphragm at the top level you would be
prevented from applying the load, as a "Top level of Simple Wind Load must
align with a rigid diaphragm" error message would be displayed.

A workaround would be to reduce the top level of the simple wind load so that
it hits a diaphragm at a lower floor of sufficient width, as shown below.
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Limitations of wind decomposition to diaphragms
Certain building shapes need extra consideration if simple wind loads have
been applied, or if wind loads have been applied to wall panels set to
decompose to diaphragms.

As illustrated by the following examples, buildings containing discrete towers
(and thus containing disconnected rigid diaphragms) are a particular concern.

Wind load perpendicular to disconnected diaphragms

In this example wind load is to be applied in the Global Y direction,
perpendicular to the disconnected diaphragms that exist in the highlighted
slabs at the second floor level shown below.

An issue arises when the wind load is applied as an area load that has to be
decomposed to both diaphragms. This could happen when the load is applied
either via a Simple Wind load, or a wind wall panel:
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Irrespective of the method used to apply it, the area load within the building
profile is shared between levels prior to decomposition.

The load is then decomposed to the diaphragms at each level in proportion
to the width of each diaphragm.

In this case because both diaphragms the second floor level are of equal
width, the load is shared equally between them. This is not satisfactory as
more of the load should have been applied to the left hand diaphragm in this
case.
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The workaround varies according to the method of loading, but basically
involves replacing the original load with separate loads in each bay:
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In both the above cases, the load is then decomposed as originally intended.
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Wind load parallel to disconnected diaphragms

In this example although the two blocks are now the same height, another
issue arises when the wind load is applied in the Global X direction, i.e. parallel
to the disconnected diaphragms at the second floor level:

The issue arises because one diaphragm is ‘hidden’ from the applied load by
the other diaphragm. The issue occurs irrespective of whether the load is
applied via a Simple Wind load, or a wind wall panel:
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The area load within the building profile is first shared between levels prior to
decomposition.

At the second floor level, instead of all the load being decomposed to the
diaphragm facing the wind; because it is decomposed in proportion to the
width of each diaphragm at that level, it ends up being shared equally to
both.
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To avoid the load being shared equally:

• if using wind wall panels - you would need to decompose to members or
nodes instead of to diaphragms

• if using Simple Wind loads - there is no workaround, you would have to
manually input the loads as diaphragm loads instead.

Wind tunnel testing and diaphragm loads
Tekla Structural Designer permits the easy flow of information required for
wind tunnel testing of tall structures.

This includes:

1. The information out from Tekla Structural Designer to the wind specialists

2. The relevant results from wind specialists back into Tekla Structural
Designer

Click the links below to find out more:

• Wind tunnel testing overview (page 108)

• Exporting wind tunnel data workflow (page 109)

• Using imported wind tunnel information (page 111)
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Wind tunnel testing overview
There are four steps required in the process of using Tekla Structural Designer
design within the process of wind tunnel testing.

1. Tekla Structural Designer creates a “Tekla Structural Designer - Wind
Tunnel Report” from a vibration analysis to be used by the wind
specialists.

See: Exporting wind tunnel data workflow (page 109)

2. The “Tekla Structural Designer - Wind Tunnel Report” is sent to the wind
specialists who undertake the wind tunnel tests. At the end of the tests,
they create a “Wind Tunnel - Load Report” which they send back to the
structural designer.

3. The designer manipulates the “Wind Tunnel - Load Report” to generate 24
loadcases with FDir1, FDir2 & MZ loads applied to the centres of mass of the
rigid diaphragms at each floor/level.

See: Using imported wind tunnel information (page 111)

4. The 24 wind loadcases are combined in regular combinations to be
included as part of the design process in Tekla Structural Designer

Exporting wind tunnel data workflow
Once the model has been created and had loads applied in Tekla Structural
Designer, the basic workflow for generating and exporting wind tunnel data is
described below.

Display the Wind Tunnel Data ribbon

The workflow is initiated by clicking Wind Tunnel on the Analyze ribbon.

• This enables the Wind Tunnel Data ribbon below:

• You can work through this from left to right...
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Add modal mass combinations

1. On the Wind Tunnel Data tab, click  Add. 

The opens on the Combinations page with a new Modal Mass class of
combination added in the left hand pane.

2. Rename the combination as required.

3. Select the loadcases that you want to add in the combination, and click >>

4. On the Applied mass tab, set the directions to be considered, and if
necessary, specify the level below which mass can be ignored.

5. Click OK to save the mass combination. 

Tekla Structural Designer adds the mass combination to the list of
combinations in the Loading list.

Review the modal analysis settings

1. On the Wind Tunnel Data tab, click Settings 

The Analysis Settings dialog opens on the 1st Order Modal page.

2. Select the total number of modes to be calculated.

3. Review and modify the other analysis settings according to your needs.

Run a modal analysis

1. On the Wind Tunnel Data tab, click Run Modal Analysis. 

Tekla Structural Designer analyzes the model.

Review the results

After modal analysis the following results are available and can be reviewed as
tabular data:

• Masses, Center of Mass, and Mass Moment of Inertia by level,

• Modal Frequencies,

• Mode shape by level

Mode shapes can also be displayed graphically if required by switching to a
Results View.

Export the report

To export all the tabular results that can be viewed in the Wind Tunnel Data
View, click Export full report.

Alternatively, you can export just the tabular results that are displayed in the
current view by clicking Export current view.
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Using imported wind tunnel information
The Tekla Structural Designer workflow for importing and using the wind
tunnel information provided by wind specialists is as follows:

Create loadcases for the diaphragm loads

The wind tunnel report typically contains 24 loadcases with FDir1, FDir2 & MZ
loads applied to the centres of mass of the rigid diaphragms at each floor/
level.

Before the loads can be imported from the report, the engineer has to
manually create wind loadcases to hold them.

Apply the diaphragm loads in each loadcase

Diaphragm loads can either be pasted into Tekla Structural Designer or
entered manually.

NOTE Diaphragm loads can only be pasted at floors/levels with one or more
horizontal rigid or semi rigid diaphragm.

See:

Create load combinations

Load combinations are created manually. The Wind Tunnel loadcases behave
as any other "Wind" type loadcase when being used in combinations.

Analysis and design

A standard analysis and design process is followed, in which:

• the graphical analysis results for wind tunnel loadcases and combinations
being shown in exactly the same way as for any other wind type loadcases
and combination,

• wind tunnel loadcases are used in drift checks in the same way as other
wind type loadcases,

• wind tunnel loadcases are used in design combinations in the same way as
other wind type loadcases.

1.2 Stability and imperfections handbook
This handbook introduces you to the following topics:

• The four sources of stability requirements that may need to be considered,
see Overview of stability requirements (page 112).
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• Choosing the correct analysis type for your model and head code, see
Allowing for global second-order effects (page 116).

• Catering for global imperfections, see Allowing for global imperfections
(page 127).

• Catering for member imperfections, see Allowing for member
imperfections (page 129).

Overview of stability requirements
The analysis and design process has to allow for the differences between a
theoretical mathematical model of a building and a more realistic
representation. For example, buildings are not truly vertical when first built
nor do they remain so when subject to load. These are called stability
requirements and are from four sources:

1. Global second-order (P-∆) effects to allow for deformation of the
structure under load,

2. Member second-order (P-δ) effects to allow for deformation of the
members under load,

3. Global imperfections due to the structure not being built plumb and
square,

4. Member imperfections due to initial lack of straightness of the member.

There are various methods of allowing for each of these and they can be
different for steel and concrete. There is also some variation based on country
code.
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Global second-order (P-∆) effects
If gravity loads are applied to the deflected shape of a structure the load P
applied at eccentricity ∆ generates additional forces.

Provided the deflection is small:

• Structure is 'Non-sway'

• Second order effects can be ignored.

At some level these effects are no longer ignorable:

• Structure is 'Sway sensitive'

• And you have to do something to account for the second order effects.

NOTE The terminology: 'Non-sway' and 'Sway sensitive' can vary between codes.

Related concept

Allowing for global second-order effects (page 116)
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Member second-order (P-δ) effects
Under load members will deform between their ends:

• Member curvature introduces a displacement δ between the member
ends.

• The member axial loads applied at eccentricity δ generates additional
forces.

In concrete structures:

• Where deflections are small :

• Member is 'Short' or 'Stocky' or 'Non-Slender'

• member second order effects are considered ignorable

• At some level they are no longer ignorable:

• Member is 'Slender'

• effects must be catered for in the design calculations

In steel structures: these effects are intrinsically allowed for in the design
equations.

NOTE The terminology: 'Short' , 'Stocky' and 'Non-slender' can vary between codes.

When must global and member second order effects be considered?
Depending on the building's overall sway classification and each member's
slenderness, global and member effects must be considered as follows:

Member Effects Global Effects
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Non-sway Sway
Short Member A C
Slender Member B D

A - All second order effects can be ignored

B - Global effects can be ignored - member effects must be considered

C - Global effects must be considered - member effects can be ignored

D - Global effects must be considered - member effects must be considered

NOTE REMEMBER - every structure and every member has 2 directions!

Global imperfections
When the design code requires it you need to account for some degree of
inclination (slope); typically in the range 0.2 to 0.5%

The codes allow you to cater for this in different ways:

• You could build multiple analysis models that are inclined

• You could have a single analysis model where you apply Equivalent
Horizontal Forces [Eurocodes] / Notional Loads [AISC/ACI] / Notional
Horizontal Forces [AUS/BS/IS] that will induce the same effect. Basically this
means applying horizontal forces = 0.2 to 0.5% of the vertical forces in any
combination.

In Tekla Structural Designer we use the second option.
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NOTE Global Imperfections apply regardless of whether the structure is 'Non-sway'
or 'Sway sensitive'.

Related concept

Allowing for global imperfections (page 127)

Member imperfections
Member Imperfections apply regardless of whether members are slender or
not. They are normally dealt with as part of the member design.

Related concept

Allowing for member imperfections (page 129)

Allowing for global second-order effects
The type of analysis required to meet stability requirements and the checks
performed will vary depending on the head code and material.

Choice of analysis type (ACI/AISC)
In Tekla Structural Designer on the Analysis page of the Design Options dialog
you have the choice of two analysis types. These are,

• First-order analysis (not suitable for the final design of steel structures),

• Second-order analysis.

For steel structures: - Unless a number of specific criteria can be met, it is
essential that your final design utilizes second-order analysis. However,
second order analysis can be more sensitive to parts of your model that lack
stiffness. For this reason it is recommended that you initially use first-order
analysis to obtain sections and an overall building performance with which
you are satisfied before switching to second-order analysis.

For concrete structures: - By choosing second-order analysis the global
second-order effects are automatically catered for. However, if you determine
that the structure is non-sway (see When should a concrete building be
classed as non-sway? (page 116)) you may instead opt for the design to be
based on the first order analysis.

The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. It is therefore important that appropriate member type
specific modification factors have been specified - see Use of Modification
Factors (page 127).
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When should a concrete building be classed as non-sway?

ACI 318-11 clause 10.10.5.2 states that a story can be considered as non-sway
when the stability index Q is less than or equal to 0.05. (Basically, second order
effects can be ignored below this value.)

Tekla Structural Designer does not report Q directly, but the Drift report does
calculate an indicative stability coefficient (Δ2/Δ1) which is effectively the same
as a moment magnifier.

From ACI Eq. (10-20):

Moment magnifier, δs = 1/(1-Q)

Equating this to the stability coefficient gives

1/(1-Q) = (Δ2/Δ1)

1-Q = 1/(Δ2/Δ1)

Q = 1 - 1/(Δ2/Δ1)

For Q < 0.05

1 - 1/(Δ2/Δ1) < 0.05

(Δ2/Δ1) < 1/0.95

(Δ2/Δ1) < 1.0526

Therefore, if the Drift report determines an indicative stability coefficient
(Δ2/Δ1) less than 1.05 it can be assumed non-sway; whereas if greater than this
value a second-order analysis is required.

NOTE The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. It is therefore important that appropriate member type
specific modification factors have been specified - see Use of Modification
Factors (page 127).

Choice of analysis type (BS)
In Tekla Structural Designer on the Analysis page of the Design Options dialog
you have the choice of three analysis types. These are,

• First-order (Elastic) analysis,

• Amplified forces (kamp) method (uses first-order analysis),

• Second-order analysis.
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First-order (Elastic) analysis

For both steel and concrete, first-order analysis is only acceptable providing
second order effects are small enough to be ignored - - see: A practical
approach to setting the analysis type below.

Amplified forces (kamp) method

Both steel and concrete can use the amplified forces method to determine
second-order effects although for steel this does have restrictions on use
(regular frameworks with λcr > 4).

If the amplified forces method is selected you must also indicate which
formula to use for determining the amplification factor,

If the structure is clad and if the stiffening effect of cladding is not taken into
account explicitly:

kamp = λcr/(1.15λcr - 1.5)

If the structure is unclad or clad with a direct allowance made for the stiffening
effect:

kamp = λcr/(λcr - 1)

During the design process for both steel and concrete members, the member
end forces from the analysis of the lateral loadcases are amplified by the
'appropriate' value of kamp. Since the analysis is first-order this is carried out as
part of summing the load effects from each loadcase (multiplied by their
appropriate load factor given in the design combination). The 'appropriate'
value is the worse of kamp,Dir1 and kamp,Dir2 based on the worst value of λcr for
all stacks in the building.

The kamp results are summarized for each column in both directions. These
can be viewed as follows:

1. Open a Review View, and select Tabular Data from the Review toolbar.

2. Select 'kamp' from the View Type drop list on the Review toolbar.

3. The kamp results in both directions are tabulated for each column in the
building.

Second-order analysis

Full second-order analysis is not restricted to regular frameworks, but requires
λcr > 2.

The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. This is a significant issue for both the amplified forces
method and second-order analysis. It is therefore important that appropriate
member type specific modification factors have been specified - see Use of
Modification Factors (page 127).
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A practical approach to setting the analysis type

Unless λcr is greater than 10 (in which case second-order effects can be
ignored), it is essential that your final design utilizes one of the second-order
analysis approaches. During the initial sizing process you may however choose
to run a first-order analysis. Proceeding in this way you can obtain sections
and an overall building performance with which you are satisfied, before
switching to P-∆ analysis.

Note: If the rigorous second-order (P-∆) analysis approach is used during the
initial sizing process, you may find that it can be more sensitive to parts of
your model that lack stiffness.

The following approach to setting the analysis type is suggested:

1. On the Analysis page of the Design Options dialog, initially set the analysis
type to First-order analysis.

2. Perform Design All (Gravity) using first-order analysis in order to size
members for the gravity loads.

3. Once the members are adequately sized for the gravity combinations
obtain a figure for the building's elastic critical load factor, λcr. See: How
do I assess the worst elastic critical load factor for the building?
section below.

4. If the λcr that has been determined is greater than 10 you can continue to
perform Design All (Static) with the analysis type set to First-order
analysis.

5. If λcr is less than 10 you will need to proceed with one of the second-order
approaches - and if it is very low (i.e. less than 2.0) some remodelling is
required:

• Either, refine the design until λcr is greater than 2.0 to make the
structure suitable for a final design using the full second-order
approach, (which is the only method permitted if the structure
contains non-linear members such as tension only braces - see below),

• Or, in order to use the amplified forces (kamp) approach, refine the
design further until λcr is greater than 4.0.

6. When a suitable λcr has been achieved change the analysis type to the full
second-order, or the amplified forces method as appropriate. (If the kamp
approach is selected you must also indicate which formula to use for
determining the amplification factor, This will depend on whether the
structure is clad or not and if the cladding is taken into account explicitly
or not.)
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7. With the analysis type still set to the full second-order, or the kamp
approach perform Design All (Static).

If you use the kamp approach be aware that BS5950-1:2000 classes certain
structures outside the scope of this method. e.g. tied portals, or structures
containing tension only braces. For such structures, you would need to ensure
that λcr is greater than 2.0, and use the full second-order analysis approach for
the static design.

How do I assess the worst elastic critical load factor for the building?

To determine the sway sensitivity for the building as a whole, the worst stack
(storey) in the worst column throughout the building in both directions has to
be identified - this can be done as follows:

1. On completion of the analysis, open a Review View and select Tabular
Data from the Review toolbar.

2. Select 'Sway' from the View Type drop list on the Review toolbar.

3. The elastic critical load factor in both directions ( (λDir1 & (λDir2) is
tabulated for each column in the building.

4. Make a note of the smallest λ value from all of the columns in either
direction.

NOTE If there are a lot of columns in the building - in order to quickly determine the
smallest elastic critical load factor in each direction, simply click the λDir1
header until the columns are arranged in increasing order of λDir1, then
repeat for λDir2.

In BS 5950-1:2000 a building can be considered as 'non-sway' when λcr ≥ 10
else it is 'sway sensitive' and (global) second-order effects must be taken into
account.

Note however that you are not restricted in your choice of analysis type
irrespective of the value of λcr (it is your call, although we will warn you about
it).

How is the elastic critical load factor calculated?

In order to determine whether a building is 'non-sway' or 'sway sensitive',
Tekla Structural Designer calculates the elastic critical buckling load factor, λcr.
It is calculated in the same manner for steel and concrete. The approach
adopted is that for each loadcase containing gravity loads (Dead, Imposed,
Roof Imposed, Snow) a set of Notional Horizontal Forces (NHF) are
determined. It uses 0.5% of the vertical load at the column node applied
horizontally in two orthogonal directions separately (Direction 1 and Direction
2). From a first order analysis of the NHF loadcases the deflection at each
storey node in every column is determined for both Direction 1 and Direction
2. The difference in deflection between the top and bottom of a given storey
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(storey drift) for all the loadcases in a particular combination along with the
height of that storey provides a value of λcr for that combination as follows,

λcr =h/(200 * δs)

Where

h= the storey height

δs =the storey drift in the appropriate direction (1 or 2) for the particular
column under the current combination of loads.

NOTE Within each column's properties, a facility is provided to exclude particular
column stacks from the sway check calculations to avoid spurious results
associated with very small stack lengths.

Choice of analysis type (Eurocode)
In Tekla Structural Designer on the Analysis page of the Design Options dialog
you have the choice of three analysis types. These are,

• First-order (Elastic) analysis,

• Amplified forces (kamp) method (uses first-order analysis),

• Second-order analysis.

First-order (Elastic) analysis

For both steel and concrete, first-order analysis is only acceptable providing
second order effects are small enough to be ignored - see: A practical
approach to setting the analysis type below.

Amplified forces (kamp) method

Both steel and concrete can use the amplified forces method to determine
second-order effects although for steel this does have restrictions on use
(basically regular frameworks with αcr > 3 - see Validity of the amplified
forces method section below). Full second-order analysis is preferred for
steelwork and since it is not precluded by EC2 it can be used for concrete.

The amplified forces method is described differently in EC3 compared to EC2,
whilst the presentations are different, they are both based on the amplifier,
kamp given as,

kamp = 1/(1 - 1/αcr)

During the design process for both steel and concrete members, the member
end forces from the analysis of the lateral loadcases are amplified by the
'appropriate' value of kamp. Since the analysis is first-order this is carried out as
part of summing the load effects from each loadcase (multiplied by their
appropriate load factor given in the design combination). The 'appropriate'
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value is the worse of kamp,Dir1 and kamp,Dir2 based on the worst value of αcr for
all stacks in the building.

The kamp results are summarized for each column in both directions. These
can be viewed as follows:

1. Open a Review View, and select Tabular Data from the Review toolbar.

2. Select 'kamp' from the View Type drop list on the Review toolbar.

3. The kamp results in both directions are tabulated for each column in the
building.

NOTE The amplified forces method is not recommended for non-linear structures -
a full second-order analysis should be performed instead.

Validity of the amplified forces method

EC3 Clause 5.2.2 (6)B lists limitations on the applicability of the Amp. Forces
method. It is therefore your responsibility when selecting this method to
ensure all of the following:

• all storeys have a similar distribution of vertical load

• all storeys have a similar distribution of horizontal load

• all storeys have a similar distribution of frame stiffness with respect to the
applied storey shear forces

Also according to clause 5.2.1 (4)B limitation:

• roof slope shallow - not steeper than 1:2 (26 degs)

• axial compression in beams or rafters - Ncr / Ned <= 11.1

Second-order analysis

Full second-order analysis is more widely applicable for steelwork structures
and since it is not precluded by EC2 it can be used for concrete.

The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. This is a significant issue for both the amplified forces
method and second-order analysis. It is therefore important that appropriate
member type specific modification factors have been specified - see Use of
Modification Factors (page 127)

A practical approach to setting the analysis type

Unless αcr is greater than 10 (in which case second-order effects can be
ignored), it is essential that your final design utilizes one of the second-order
analysis approaches. During the initial sizing process you may however choose
to run a first-order analysis. Proceeding in this way you can obtain sections
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and an overall building performance with which you are satisfied, before
switching to one of the P-∆ analysis methods.

The following approach to setting the analysis type is suggested:

1. On the Analysis page of the Design Options dialog, initially set the analysis
type to First-order analysis.

2. Perform Design All (Gravity) using first-order analysis in order to size
members for the gravity loads.

3. Once the members are adequately sized for the gravity combinations
obtain a figure for the building's elastic critical load factor, αcr. See How
do I assess the worst elastic critical load factor for the building?
section below.

4. If the αcr that has been determined is greater than 10 you can continue to
perform Design All (Static) with the analysis type set to First-order
analysis.

5. If αcr is less than 10 you will need to proceed with one of the second-order
approaches - and if it is very low (i.e. less than 2.0) some remodelling is
required:

• Either, refine the design until αcr is greater than 2.0 to make the
structure suitable for a final design using the full second-order
approach, (which is the only method permitted if the structure
contains non-linear members such as tension only braces),

• Or, in order to use the amplified forces approach, refine the design
further until αcr is greater than 3.0.

6. When a suitable αcr has been achieved change the analysis type to the full
second-order, or the amplified forces method as appropriate.

7. With the analysis type still set to the full second-order, or the amplified
forces method, perform Design All (Static).

NOTE If full second-order analysis is used during the initial sizing process, you may
find that it can be more sensitive to parts of your model that lack stiffness.

NOTE If you use the 'Second-order analysis - Amp. forces method' be aware that EC3
classes certain structures outside of its scope (see above section: Validity of
the amplified forces method). Such structures would need to be refined
during gravity sizing until the elastic critical load factor is at least greater than
2.0, so that the full second-order approach can be used for the full design.
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When should a building be classed as sway sensitive?

Susceptibility to second order effects is a general characteristic and is not
material specific, it has just been presented differently in EC3 and EC2:

• In EC3 a building can be considered as 'non-sway' when the elastic critical
load factor αcr ≥ 10, else the building is 'sway sensitive' and (global) second-
order effects must be taken into account.

• In EC2 the definition is slightly different - it does not use the terms 'non-
sway' and 'sway sensitive'. Rather it simply defines when second-order
effects are small enough to be ignored. The principle is given in Clause
5.8.2 (6) which states that they can be ignored if they are less than 10% of
the corresponding first order effects. Because of the way in which the
amplification factor, kamp is calculated the change point is at an αcr of 11
not 10. See: Derivation of the kamp formula for concrete structures
section below.

However, the intent is the same in both cases and so in Tekla Structural
Designer αcr ≥ 10 is taken as the change point. In any event, you are not
restricted in your choice of analysis type irrespective of the value of αcr (it is
your call, although we will warn you about it)

How do I assess the worst elastic critical load factor for the building?

To determine the sway sensitivity for the building as a whole, the worst stack
(storey) in the worst column throughout the building in both directions has to
be identified - this can be done as follows:

1. On completion of the analysis, open a Review View and select Tabular
Data from the Review toolbar.

2. Select 'Sway' from the View Type drop list on the Review toolbar.

3. The elastic critical load factor in both directions (αDir1 & αDir2) is tabulated
for each column in the building.

4. Make a note of the smallest elastic critical load factor from all of the
columns in either direction - this is the αcr value for your building.

NOTE If there are a lot of columns in the building - in order to quickly determine the
smallest elastic critical load factor in each direction, simply click the αDir1
header until the columns are arranged in increasing order of αDir1, then
repeat for αDir2.

Having determined an αcr for your building, you then use it when deciding
which is the most appropriate analysis type for design.

How is the elastic critical load factor calculated?

The elastic critical load factor, αcr is calculated in the same manner for steel
and concrete. The approach adopted is that for each loadcase containing
gravity loads (Dead, Imposed, Roof Imposed, Snow) a set of Equivalent
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Horizontal Forces (EHF) are determined. These consist of 0.5% of the vertical
load at each column node applied horizontally in two orthogonal directions
separately (Direction 1 and Direction 2). From a first order analysis of the EHF
loadcases the deflection at each storey node in every column is determined
for both Direction 1 and Direction 2. The difference in deflection between the
top and bottom of a given storey (storey drift) for all the loadcases in a
particular combination along with the height of that storey provides a value of
αcr for that combination as follows,

αcr = h/(200 * δEHF)

Where

h = the storey height

δEHF = the storey drift in the appropriate direction (1 or 2) for the particular
column under the current combination of loads

NOTE Within each column's properties, a facility is provided to exclude particular
column stacks from the sway check calculations to avoid spurious results
associated with very small stack lengths.

Derivation of the kamp formula for concrete structures

EC2 provides two specific approaches to determine the change point below
which second-order effects are small enough to be ignored:

The first specific approach is contained in Clause 5.8.3.3 which provides a
pass/fail criterion to check whether the global second-order effects may be
ignored. It is given as,

FVEd = k1 * ns/(ns + 1.6) * S(Ecd * Ic)/L2

where

FVEd = the total vertical load (on 'braced' and 'bracing' members)

k1 = a factor that allows for cracking in the concrete of the LLRS and is a
Nationally Determined Parameter (NDP)

* ns = number of storeys

Ecd = the design value of the modulus of elasticity of the concrete

Ic = the second moment of area of the uncracked bracing members

L = the total height of the building

However, the above approach has a number of restrictions in its application
and as a result it is not applied in Tekla Structural Designer.

The second specific approach is given in Annex H.

The method given in Annex H.1.2 is the background for the more limited
method given in Clause 5.8.3.3 as described above, but it does not apply
where there is significant shear deformation in the LLRS e.g. for shear walls
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with significant openings, hence again it is not considered in Tekla Structural
Designer.

Instead, recourse is made to determining the level of second-order effect
using Annex H.2. Using this approach, by rearranging Equation H.8 it is
possible to provide a 'stability coefficient' 1/αcr which can be applied as the
change point between non-sway and sway sensitive structures.

FHEd = FH0Ed /(1-FH1Ed/FH0Ed) Equation H.8

Where:

FH1Ed = fictitious horizontal force, giving the same bending moments as vertical
load NVEd acting on the deformed structure, with deformation caused by FH0Ed
(first order deformation), and calculated with nominal stiffness values
according to 5.8.7.2

Considering how this definition of FH1Ed might apply to an imaginary cantilever
of height, h, we arrive at:

1. The moment due to FH1Ed is the same as that due to the vertical load NVEd,
so:

FH1Ed * h = NVEd * δ

which can be rearranged to:

FH1Ed = (NVEd * δ)/h

2. Substituting for FH1Ed in Equation H.8, we have:

FHEd = FH0Ed /(1 - (NVEd * δ)/(FH0Ed * h)

3. By defining kamp = FHEd/FH0Ed the above can be rearranged to:

kamp = 1/(1 - (NVEd * δ)/(FH0Ed * h)

4. Now, the EC3 Equation 5.2 for the elastic critical buckling load is:

αcr = HEd/VEd * h/δHEd
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which, when re-expressed in the terminology used in H.2 becomes:

αcr = FH0Ed /NVEd * h/δHEd

and when further rearranged becomes:

1/αcr = (NVEd *δHEd)/(FH0Ed * h)

5. Hence 1/αcr can be substituted into the above equation for kamp so that we
arrive at the more well-known formula for amplification:

kamp = 1/(1 - 1/αcr)

NOTE Strictly, the watershed for concrete structures should be at a kamp factor of 1.1
(amplification of no more than 10% due to second-order effects). Setting kamp
to be 1.1 and rearranging gives αcr ≥ 11 i.e. a stability coefficient ≤ 0.0909 not
0.1

NOTE It is important to note that the resulting values of αcr and kamp are very
dependent upon the analysis properties that are used and the you therefore
need to carefully consider the modification factors you choose to apply via the
Analysis Options.

Use of modification factors
The accuracy of determination of the second-order effects for concrete
structures is dependent upon a reasonable estimation of the concrete long
term properties. Consequently design codes can require that analysis stiffness
adjustment factors are applied (as the appropriate properties to use in
analysis are load and time dependent).

These modification factors can be applied for each of the different materials
from the Modification Factors page of the Analysis Options dialog. (which is
located on the Analyse toolbar).

For non-concrete members it is also possible that you will want to apply an
adjustment to material properties for various other investigations. One
suggested example is the assessment of structures subject to corrosion.
Another classic requirement in this regard relates to torsion, it is common
engineering practice to assume that if it will work without assuming any
torsional strength, then torsion can be ignored.

Allowing for global imperfections
These are typically represented by the application of Notional Loads \
Equivalent Horizontal Forces.
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Allowing for global imperfections (ACI/AISC)
Steel code

Steelwork design to AISC 360-10 requires an allowance for global
imperfections. Columns are assumed to be out of plumb by some amount and
this is replicated by applying Notional Loads, (NL), in the analysis. The
requirements are given in Clause C2.2b and the value of NL is given as 0.2%.
However, to accommodate the requirements of Clause C2.3 an additional 0.1%
has been included - so that the actual NL used is 0.3%.

Concrete code

For concrete design to ACI 318-11 there are no requirements. However, given
that a building can use mixed materials, (and even for an entirely concrete
building), you have the choice to include the NLs via the combinations. By
default these are to the AISC requirements - i.e. 0.3%

Allowing for global imperfections (Eurocode)
The formula to calculate the global imperfections (using EHFs) is the same for
both steel and concrete, see : EC2 Cl 5.3.2 (3) a) and EC3 Cl 5.2 (5)

φ = φ0 αh αm

Where:

φ0 is the basic value of inclination.

αh is the reduction factor for length or height : αh= 2/√h ; 2/3 ≤ αh ≤ 1

h is the length or height of the structure.

When height = 9m the maximum reduction of 2/3 will apply.

αm is the reduction factor for number of members (EC2) or columns in a row
(EC3), : αm= √(0.5(1+1/m))

m is the number of vertical members contributing to the total effect (EC2), or is
the number of columns in a row including only those columns which carry a
vertical load not less than 50% of the average value of the column in the plane
considered (EC3).

m = 1 5 10 1000
αm = 1 0.775 0.742 0.707

Guidance on how to count 'm' is vague and varied - however as demonstrated
above, once you get above 5 or 10 it starts to make very little difference.

In Tekla Structural Designer the allowance is applied in the same manner for
steel and concrete - being controlled in Model Settings as shown below:
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It does require some user intervention to provide structure height and
number of columns to consider. These user inputs cause adjustment of the
default value of imperfection of 0.5% of the vertical load and this can be a
different adjustment in the two orthogonal directions (Direction 1 and
Direction 2). For example, the adjustment factor might give an EHF of 0.4% in
the X-direction and 0.3% in the Y-direction.

Allowing for global imperfections (BS)
Steel code

BS5950 requires up to 0.5% of vertical loading.

Concrete code

BS8110 does not have a requirement (minimum lateral load is not the same
thing).

Allowing for member imperfections

Allowing for member imperfections (ACI/AISC)
Steel code

AISC indicates that these are inherently catered for in the strut design.

Concrete code

For concrete design to ACI 318-11 there are no requirements.
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Allowing for member imperfections (Eurocode)
Steel code

For steel structures designed to EC3, member imperfections are intrinsically
included in the design routines for all members (beams, columns, braces).
Apart from one explicit requirement, carrying out the design is all that is
necessary.

The explicit requirement is from Clause 5.3.2 (6) in which member
imperfection should be included as part of the analysis when the frame is
sway sensitive and the axial force in members with moment connections is
above a certain limit. If this situation arises Tekla Structural Designer issues a
warning.

Concrete code

For concrete structures designed to EC2, explicit calculations which consider
an imperfection effect are carried out as part of the design.

In Tekla Structural Designer this is achieved by adding an additional moment
to the analysis results before starting design.

Allowing for member imperfections (BS)
Steel code

BS5950 inherently caters for member imperfections in the strut design curves.

Concrete code

BS8110 does not have a requirement (minimum eccentricity is not the same
thing).

1.3 Static analysis and design handbook

NOTE The aim of this handbook is describe the processes that occur when running
one of the combined analysis and design commands, i.e:

• Design Steel (Gravity), Design Concrete (Gravity), Design All (Gravity)

• Design Steel (Static), Design Concrete (Static), Design All (Static)

You can find the following information in this handbook:

• Overview of the combined analysis and design processes (page 131)

• 3D pre analysis processes (page 136)

• 3D analysis (page 143)

• Grillage chasedown analysis (page 144)

• FE chasedown analysis (page 144)
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• Reasons for performing chasedown analyses (page 145)

• Overview of stability requirements (page 112)

• Member design stage of the combined analysis and design process...
(page 152)

• Features of the three analysis types used for static design... (page 154)

Overview of the combined analysis and design processes

Overview of Design Steel (Gravity)

St
e
p

Process Description

1 Model
validation

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 136)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 143)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.

NOTE For the above analysis, lateral translational fixed
supports can optionally be applied to column nodes
in order to remove unwanted lateral displacements
that may prevent the analysis from completing and/
or produce unrealistic forces. This is specified via
Design Options> General.

4 Member
design
stage
(page 152)

Steel members are designed or checked for active gravity
combinations only.

NOTE At this point design may not fully satisfy the code
requirements. To achieve this a full static design is
required.
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Overview of Design Steel (Static)

St
e
p

Process Description

1 Model
validation

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 136)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 143)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.

4 Member
design
stage
(page 152)

Steel members are designed or checked for all active static
combinations.

5 Stability
checks

Sway/Drift checks and Wind Drift checks are performed for
all columns and walls, (apart from any that have been
manually excluded from the check

Overview of Design Concrete (Gravity)

St
e
p

Process Description

1 Model
validation

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 136)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 143)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.
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St
e
p

Process Description

NOTE For the above analysis, lateral translational fixed
supports can optionally be applied to column nodes
in order to remove unwanted lateral displacements
that may prevent the analysis from completing and/
or produce unrealistic forces. This is specified via
Design Options> General.

4 FE
chasedown
analysis
(page 144)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.

5 Grillage
chasedown
analysis
(page 144)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
those levels where they have also been meshed in 3D
Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.

6 Member
design
stage
(page 152)

Concrete members and concrete walls are designed or
checked for active gravity combinations only.

NOTE At this point design may not fully satisfy the code
requirements. To achieve this a full static design is
required.

Overview of Design Concrete (Static)

St
e
p

Process Description

1 Model
validation

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 136)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.
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St
e
p

Process Description

3 3D analysis
(page 143)

A traditional frame analysis of the entire 3D model is run
(excluding pattern loading) to establish a set of design forces
for the steel members.

NOTE The analysis type (i.e. first, or second order) is
specified via Design Options> Analysis.

NOTE For the above analysis, lateral translational fixed
supports can optionally be applied to column nodes
in order to remove unwanted lateral displacements
that may prevent the analysis from completing and/
or produce unrealistic forces. This is specified via
Design Options> General.

4 FE
chasedown
analysis
(page 144)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.

5 Grillage
chasedown
analysis
(page 144)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
those levels where they have also been meshed in 3D
Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.

6 Member
design
stage
(page 152)

Concrete members and concrete walls are designed or
checked for active gravity combinations only.

7 Stability
checks

Sway/Drift checks and Wind Drift checks are performed for
all columns and walls, (apart from any that have been
manually excluded from the check
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Overview of Design All (Gravity)

St
e
p

Process Description

1 Model
validation

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 136)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 143)

A traditional frame analysis of the entire 3D model, with an
option to mesh floors.

4 FE
chasedown
analysis
(page 144)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.

5 Grillage
chasedown
analysis
(page 144)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
those levels where they have also been meshed in 3D
Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.

6 Member
design
stage
(page 152)

All steel and concrete members and all concrete walls are
designed or checked for all active gravity combinations.

NOTE Concrete slab design is not performed

NOTE At this point design may not fully satisfy the code
requirements. To achieve this a full static design is
required.

7 Stability
checks

Sway/Drift checks and Wind Drift checks are performed for
all columns and walls, (apart from any that have been
manually excluded from the check
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Overview of Design All (Static)

St
e
p

Process Description

1 Model
validation

Checks are performed to detect specific issues before the
analysis and design process begins.

2 3D
preanalysis
processes
(page 136)

A number of pre-analysis processes are undertaken as
necessary in preparation for the full analysis.

3 3D analysis
(page 143)

A traditional frame analysis of the entire 3D model, with an
option to mesh floors.

4 FE
chasedown
analysis
(page 144)

Requirements: Only performed if two-way slabs exist.

For a series of 3D sub models each containing the members
between two horizontal planes with fully meshed floors. The
complete series of models is chased down from top to
bottom so loads are carried from the level above to the level
below. The results are always used for slab design and
optionally used for beam, column and wall design.

5 Grillage
chasedown
analysis
(page 144)

Requirements: Only performed if concrete members exist.

For a series of 3D sub models each containing the members
between two horizontal planes, floors only being meshed at
those levels where they have also been meshed in 3D
Analysis. The complete series of models is chased down
from top to bottom so loads are carried from the level above
to the level below.

6 Member
design
stage
(page 152)

All steel and concrete members and all concrete walls are
designed or checked for all active static combinations.

NOTE Concrete slab design is not performed

7 Stability
checks

Sway/Drift checks and Wind Drift checks are performed for
all columns and walls, (apart from any that have been
manually excluded from the check

3D pre analysis processes
Pre-Analysis consists of a number of processes, such as:

• Decomposing slab and wall loads

• Preparing loadcases and combinations

• Meshing and diaphragms

• First-order gravity analysis
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• Resolving vertical loads for application of global imperfections

• Generation of pattern loading

The actual pre-analysis processes performed will vary depending on the
specific model that has been defined.

Overview of slab load decomposition
Decomposition of slab loads on to supporting members is automatically
performed where necessary during pre-analysis.

Decomposition is not just performed for beam and slab models, the program
may also need to decompose flat slab loads onto supporting columns and
walls.

NOTE In Tekla Structural Designer the term "Decomposed Loads" refers to the
loading on beams, columns, and walls that comes from slabs

Whether load decomposition is performed or not will depend on the analysis
model, the slab properties and the Mesh 2-way slabs in 3D Analysis setting
as follows:

Decomposi
tion

method
specified in

Slab
properties

3D Analysis and Grillage chasedown
models

FE chasedown
model

Two-way Mesh 2-way slabs in 3D Analysis option
not selected (default):

• loads on two-way slabs decomposed
prior to analysis

• it is not
necessary to
decompose
the loads on
two-way slabs
prior to
analysis

Mesh 2-way slabs in 3D Analysis option
selected:

• it is not necessary to decompose the
loads on two-way slabs prior to analysis

One-way • loads on two-way slabs decomposed
prior to analysis

• loads on two-
way slabs
decomposed
prior to
analysis

Potential Load Decomposition Methods

Traditionally a "tributary area" (sometimes called "yield line") loading approach
would have been adopted to determine the decomposed loads, but this has
limitations when dealing with complex geometry such as:
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• Slabs not supported on all edges

• Complex panel shapes

• Panels with openings

Also the "tributary area" approach can only approximately handle point, line,
and patch loads (by converting them to area loads).

Because of these limitations the "tributary area" method is not used in Tekla
Structural Designer - instead a method referred to as FE Decomposition is
applied instead. This is based on finite element analysis.

FE Decomposition Model

The FE decomposition model can be demonstrated using the following two-
way slab on beams example.

For this type of structure:

• A separate FE decomposition model is created for every floor (or sloped
plane).

• Beam column and wall nodes in each FE decomposition model (shown
selected in pink below) are all rigidly supported.
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• Each FE decomposition model is analysed and the reactions at the rigidly
supported nodes are turned back into VDLs along beams and walls, and point
loads on columns.

A Common Question

So if the slabs have to be meshed for the FE decomposition during pre-
analysis, why not do away with decomposition entirely and just mesh the slabs
when performing 3D analysis of the entire model instead?

Because this gives results that you don't like....
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In the first run of the model below the slabs are left unmeshed, this requires
the loads on the two-way slabs to be FE decomposed prior to analysis. The
bending moments from the resulting 3D Analysis are as shown, (max hogging
-198, max sagging 165):

The above results can be compared against a second run of the model in
which the 2-way slabs are set to be meshed in the 3D analysis. FE
decomposition is no longer required and the bending moments from the
resulting 3D Analysis are as shown, (max hogging -89, max sagging 82)
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In this second run, because the slabs are included in the 3D analysis model,
some of the load is being transferred directly to the supporting columns and
walls via the slabs themselves. While this is not wrong, it goes against the
engineer's expectation - which would be to design the beams on the basis that
they transfer all the load to the supporting members.

Overview of global imperfections
Equivalent notional horizontal loads are determined and applied during pre-
analysis to cater for global imperfections (additional second order effects due
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to the structure not being built plumb and square). These loads are also used
in seismic design to establish the base shears.

Following a first-order analysis of all gravity loadcases, the forces at the nodes
at the top/bottom of each column stack/wall panel are resolved vertically. A
proportion of the vertical load is determined which gives the value of the
horizontal load at each point. The proportion is code dependent.

These horizontal loads are applied to the nodes in a particular direction
(Direction 1 or Direction 2 or both) as specified in an individual design
combination.

Overview of live/imposed load reductions
Live load reductions (US), or imposed load reductions (other head codes) are
established during pre-analysis for use in subsequent column and wall design,
and when the head code is set to ACI/AISC - beam design also.

• For head codes other than ACI/AISC, the level of imposed load reduction to
consider for beams can be set manually in the beam properties. This is
especially useful for more economic design of transfer beams supporting a
number of floors.

Reductions are only applied to those live/imposed loadcases that have had the
Live/Imposed Load Reductions box checked in the Loading dialog.

The reduction percentage to be applied is specified on the page in Model
Settings. This percentage can differ depending on the number of floors being
supported.

To cater for additional floors that are carried but that have not been included
in the model an Assume extra floors supported value can be specified in the
column and wall properties.

The methodology for live/imposed load reduction differs between national
codes of practice:

Head Code: EC or BS

Levels can be designated either as "to be" or "not to be" included in the
determination of the load reductions through Count floor as supported check
boxes for each level in the column and wall properties. This feature enables
what appears to be a roof to be counted as a floor, or conversely allows a
mezzanine floor to be excluded from the number of floors considered for any
particular column or wall. The moments from fixed ended beams framing into
a column or wall are never reduced.

For more information, see: and

Head Code: ACI/AISC

Before undertaking member design, Live and Roof Live loads are multiplied by
a reduction factor R for roof live loads and other live loads independently. This
reduced load is then used in combination to create design forces. The
reduction factor is related to the tributary area of load carried by the particular
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member and also the KLL factor, where KLL comes from Table 4-2 in ASCE7-05/
ASCE7-10 or Table 4.7-1 in ASCE7-16 .

Essentially:

• Interior and exterior cols (no cantilever slabs) KLL = 4

• Edge and interior beams (no cantilever slabs) KLL = 2

• Interior beams (with cantilever slabs) KLL = 2

• Cantilever beams KLL = 1

• Edge cols (with cantilever slabs) KLL = 3

• Corner cols (with cantilever slabs) KLL = 2

• Edge beams (with cantilever slabs) KLL = 1

As it is not possible to assess where cantilever slabs are and what they are
attached to - you are able to change the KLL factor for all column/wall stacks
and beam spans as required in the Properties Window.

The default settings are:

• Columns/walls = 4

• Beams = 2

• Cantilevers = 1

For more information, see:

Head Code: AS

Before undertaking member design, imposed loads are multiplied by a
reduction factor ψa.

This reduced load is then used in combination to create design forces. The
reduction factor is related to the tributary area of load carried by the particular
member.

For more information, see:

Overview of pattern loading
If combinations of pattern load exist then the pattern loading is automatically
generated prior to analysis. See:

3D analysis
A traditional frame analysis of the complete structure is always the first
analysis that Tekla Structural Designerperforms in any combined analysis and
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design. This analysis generates a first set of results for the design of beams,
columns and walls.

First Order or Second Order Analysis?

You can control whether a first, or a second order 3D Analysis is run by making
the appropriate selection on the Analysis page of the Design Options dialog.
The actual options that are presented will vary depending on the design code
being worked to.

Linear or Non Linear Analysis?

The choice of linear or non-linear analysis is made automatically:

• if the model has entirely linear properties a linear analysis is performed,

• else if any non-linear properties are detected a non-linear analysis is
performed.

Grillage chasedown analysis
We know from experience that 3D Analysis on its own does not give the gravity
results engineers have traditionally used or want - staged construction
analysis reduces but doesn't resolve this. Therefore, Design All (Static) will also
automatically undertake a grillage chasedown analysis provided concrete
members exist anywhere in the model (beams, columns, or walls).

The Solver Model used for Grillage Chasedown emulates a traditional analysis
and establishes an alternative second set of design forces for beams, columns
and walls.

See also

Accounting for lateral loading in chasedown results (page 152)

FE chasedown analysis
The Solver Model used for FE Chasedown is generated as part of the combined
analysis and design process if the model contains flat slabs, or two way
spanning slabs on beams - the results from this analysis being required for the
design of these slabs.

By default the same results are also used to generate a third set of design
forces for the cast-in-place beams, columns and walls. (Whether the results
are used for this purpose is controlled by a setting under Design > Settings >
Concrete > Cast-in-place > Beam, Column, Wall > General Parameters).

A significant consideration when opting to design for the FE chasedown results
is that the slabs will tend to carry a significant proportion of the load direct to
the columns.
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Consequently, for beam design in particular, it is unlikely that an FE
chasedown could result in a more critical set of design forces than would be
already catered for by the Grillage chasedown.

NOTE If duplicate levels have been specified in the Construction Levels dialog
separate sub models are created and analyzed for the source and every
duplicate level. This ensures that the increasing load carried by the vertical
members in the lower sub models is catered for. In turn this can cause small
differences in the analysis results (and consequently the design) for these sub
models.

See also

Accounting for lateral loading in chasedown results (page 152)

Reasons for performing chasedown analyses
As the 3D Analysis determines a set of design forces which can then be used
to design the members - why does Design (All) then carry on and do other
"Chasedown" analyses?

The answer relates to expectation of results - in particular with regard to the
following:

• Sway Effects under pure gravity loading

• Transfer beam designs

• Differential axial deformation
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Sway Effects under pure gravity loading
Consider this 8 story model, when you click Design All, grillage and FE
chasedown solver models are created in addition to the 3D Analysis model.

The Identified end frame below is resisting the sway - the design moments
shown would be given by any analysis software.

It is an extreme example - but this result does not fit with traditional
engineering expectation
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The 3D Analysis results (below left) can be compared with those from Grillage
Chasedown (below right).
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The Grillage Chasedown results are more in line with expectation:

• -ve moment at LH end

• Similar moment profile at every level

Another example of why chasedown is wanted follows below....

Transfer beam designs
Focus on the transfer beam in the highlighted frame.

At first glance the results look ok, but lets look more closely...

The 3D Analysis results (below left) can be compared with those from Grillage
Chasedown (below right).
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• 3D Analysis - frame deflects and loads are shared according to stiffness.

• Grillage chasedown - loads are collected floor by floor and then applied to
the transfer beam - much higher moment in the transfer beam. Once again
this is more in line with traditional expectation.

A third example of why chasedown is wanted follows below....

Differential axial deformation (axial shortening)
In this case a two span beam sits on walls at each end and a column in the
center.

3D Analysis Results:
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• Column is more highly stressed than walls and deflects downwards
shedding load back to the walls.

• You end up with completely different moment profiles on beams that
would traditionally be considered and designed as identical.

Grillage chasedown Results:
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• the sub-models at each level are almost identical and you get very similar
results over the height of the building.

Findings from the above examples
• Grillage chasedown emulates a more traditional design style where

continuous beams or sub-frames are considered in isolation.

• The 3 examples show where 3D Analysis gives results that are not liked
(based on traditional design expectation).

• But once you start to think about it you may conclude that actually, the 3D
Analysis result should not be ignored.
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• By running Design All each analysis type is performed and members are
simultaneously designed for each set of results.

NOTE Deliberately extreme examples have been used to illustrate these effects and
in real models the differences between the sets of results might not be as
dramatic.

Accounting for lateral loading in chasedown results
It is important to note that the chasedown analysis procedure is only valid for
gravity loads. The chasedown analysis results for any lateral loadcase (wind /
EHF) or from the direct analysis of any combination that includes a lateral
loadcase are not valid.

Therefore in order to generate the design forces mentioned above, the
chasedown analysis results are merged with the 3D building analysis
combination results as follows:

1. Start with the building analysis combination result

2. Identify all gravity cases used in the combination and the relevant load
factor

3. For each included gravity loadcase:

a. Subtract the 1st order linear building analysis result multiplied by the
relevant load factor

b. Add the chasedown result multiplied by the relevant load factor

4. For results with Imposed load reduction, subtract the relevant % of the
chasedown result for each reducible loadcase.

Following this procedure means that chasedown analysis of lateral loadcases
or combinations is not required.

NOTE This procedure is only applied to beam, column, and wall-line results, but not
to 2D nodal results. For this reason it is not possible to calculate or display 2D
element chasedown results for combinations that include lateral loadcases.

Member design stage of the combined analysis and design
process
The final step in the Design All (Static) process is member design for all
members for all available sets of design forces.

Steel Member Design Forces

The 3D Analysis results are the only results set used in steel member design.
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Concrete Member Design Forces

Up to three sets of analysis results will exist for concrete member design as
follows:

• 3D Analysis results will always be used to design all beams, columns and
walls.

• Grillage Chasedown results will exist for gravity loadcases if the model
contains any concrete beams, in which case they will also be used to design
all beams, columns and walls.

• FE Chasedown results for gravity loadcases will also exist if the model
contains 2-way spanning slabs.

Concrete beams can be designed for this set of results by checking the
'Design Beams for FE Chasedown analysis results' box under Design >
Design Options > Concrete > Beam > General Parameters

Columns and walls can also be designed for this set of results by checking
similar boxes on their respective General Parameters pages.

Reset Autodesign

On completion of your chosen design process, the original member design
mode assigned to each member can either be retained or updated. (For
example, you might typically reset auto-designed steel members into check
mode if they have a pass status.) The action that is taken is controlled via
Design Options > Autodesign.

Design Review

On completion of the Design All (Static) process the Review View and Review
toolbar open automatically.

In this view a color coded version of the model is displayed so that the pass/
fail status and utilization ratio of each beam, column and wall can be reviewed
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graphically. Various other parameters can also be graphically interrogated
and/or modified.

See also

Accounting for lateral loading in chasedown results (page 152)

Features of the three analysis types used for static design
The following table can be used to compare the features of the three analysis
types used in the static design process.

Feature 3D Analysis Grillage
Chasedown

FE Chasedown

Examples / When
useful?

Gravity and
Lateral analysis
(Notional/Wind/
Seismic)

“Beam & Slab”
buildings

Flat slab and
“Beam & Slab”
buildings

Special Features • Pattern
loading

• Automatic EC2
sway
sensitivity
assessment
and sway
amplification

• Automatically
centralised
analysis wires
(improved
rigid offsets /
rigid zones)

• Option to
mesh slabs in
the 3D analysis

• Mimics
traditional
design
approach (sub-
frame analysis)

• Pattern
loading

• Mimics
traditional
design
approach
(isolated floor
analysis)

• Slab Pattern
loading

Benefits • Member
Design
considers sway
and
differential
axial
deformation
effects.

• Caters for
slabs that

Member design
based on
traditional sub
frame is
considered
simultaneously
with that for 3D
Analysis

• Member
design based
on traditional
sub frame is
considered
simultaneously
with that for
3D Analysis

• Irregular slab
panel design
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Feature 3D Analysis Grillage
Chasedown

FE Chasedown

contribute to
the lateral load
resisting
system

automatically
catered for

Analysis Model 3D model of
entire building:

• either meshed
2-way slabs,

• or, slab loads
decomposed
to beams

series of 3D sub
models:

• all column and
wall stacks
immediately
above and
below the sub-
model

• either meshed
2-way slabs,

• or, slab loads
decomposed
to beams

series of 3D sub
models:

• all column and
wall stacks
immediately
above and
below the sub-
model

• all 2-way slabs
meshed

Analysis Method Whole model in
one pass

Each sub model
sequentially from
top to bottom –
chasing member
loads down

Each sub model
sequentially from
top to bottom –
chasing member
loads down

Analysis Type • First order

• First order -
Kamp

• Second order -
P-D

First order First order

Supports External supports
as defined by the
user

Ends of members
above/below each
sub model are
automatically
supported

Ends of members
above/below each
sub model are
automatically
supported

Loading Gravity and
Lateral Loads

Gravity Loads only Gravity Loads only

Forces for design
RC Slab Yes– All Combs No forces Yes – All Gravity

loadcases
RC Beam Yes– All Combs Yes – All Gravity

loadcases
Optional – All
Gravity loadcases

RC Column Yes– All Combs Yes – All Gravity
loadcases

Optional – All
Gravity loadcases
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Feature 3D Analysis Grillage
Chasedown

FE Chasedown

RC Wall Yes– All Combs Yes – All Gravity
loadcases

Optional – All
Gravity loadcases

Steel/Composite
Members

Yes – All Combs
except patterns

Not required Not required

Foundation
design

Yes – All Combs
except patterns

Yes – All Gravity
loadcases

Yes – All Gravity
loadcases

See also

3D analysis (page 143)

Grillage chasedown analysis (page 144)

FE chasedown analysis (page 144)

Reasons for performing chasedown analyses (page 145)

1.4 Seismic analysis and design handbook
You can find the following information in this handbook:

• Introduction to seismic analysis and design (page 156)

• Limitations of Seismic Design (page 164)

• Seismic force resisting systems (page 165)

• Seismic design methods (page 168)

Introduction to seismic analysis and design

Definitions
The actual method applied to a specific beam will depend upon whether it is
required to support sensitive finishes.

Various terms used in Tekla Structural Designer's seismic processes are
described below:

Code Spectra

The spectra specified in a country's loading and design codes for use in ELF
and RSA analysis.

Site Specific Spectra

Engineers Handbooks 156 Seismic analysis and design handbook



User defined spectra for ELF and RSA which are required for locations which
use another country's loading and design codes where the code spectra are
not relevant.

Base Shear Combination

Also referred to as the Effective Seismic Weight Combination (ASCE7/UBC) or
the Seismic Inertia Combination (Eurocode). This combination is used for
modal analysis, and in the calculation of base shears, during the Seismic
Analysis Process. This combination is created and modified by the Seismic
Wizard only.

RSA Seismic Combinations

These combinations are created by the Combination Generator at the end of
the Seismic Wizard, but can also be modified in the standard Combination
dialog. They consist of 3 kinds of loadcases: Static, RSA Seismic and RSA
Torsion. The Base Shear Combination is not included in this category of
combination.

Static Loadcase

Standard loadcases, e.g. "Self weight - excluding slabs", "Dead", etc., and
derived cases for NHF/EHF, but no patterns.

RSA Seismic Loadcase

Two loadcases, i.e. "Seismic Dir1" and "Seismic Dir2", which cannot be edited.
These are created at the end of the Seismic Wizard. being derived from
information supplied in the Seismic Wizard and the results of the modal
analysis. No actual loads are available for graphical display.

RSA Torsion Loadcase

These cases can be generated by the Seismic Wizard and are regenerated
whenever RSA Seismic Combinations are modified.

Fundamental Period (T)

Separately for Dir 1 & Dir 2, this is either defined in the Seismic Wizard, (user
value or calculated), or determined in the modal analysis for the Base Shear
Combination.

Level Seismic Weight

For each relevant level, this is the sum of the vertical forces in nodes on that
level, for the Base Shear Combination.

Effective Seismic Weight

This is the sum of the level seismic weights for all relevant levels for the Base
Shear Combination.

Seismic Base Shear

The base shear is calculated separately for Dir 1 & Dir 2, for the Base Shear
Combination.
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NOTE In Tekla Structural Designer the base shear is displayed when you for
Cumulative Story Shear

Square root of Summation of Square (SRSS)

The SRSS formula for combining modes in RSA is as follows:

λ = Absolute value of combined "response"

λk = "response" value for Relevant Mode k

n = Number of Relevant Modes

Complete Quadratic Combination (CQC)

The CQC formula for combining modes in RSA is as follows:

λ = Absolute value of combined "response"

λi = "response" value for Relevant Mode i

λj = "response" value for Relevant Mode j

n = Number of Relevant Modes

ρij = Cross modal coefficient for i & j

Cross Modal Coefficient

This co-efficient is used in the CQC method for combining modes in RSA.
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ζ = modal damping ratio

IBC/ASCE assumed = 5% (ASCE Figs 22-1 to 6)

EC8 assumed = 5% where q accounts for the damping in various materials
being different to 5% (EC8 Cl 3.2.2.5)

IS codes the user can define the level of damping and this is accounted for in
the above equation.

β = Frequency ratio = ωi / ωj

ωi = Frequency for Relevant Mode i

ωj = Frequency for Relevant Mode j

Overview
All seismic codes work in a similar manner from the loading view point with
relatively minor differences in terminology and methodology.

It is worth noting at the start that seismic analysis determines a set of forces
for which it is expected (statistically) that if those forces are designed for and
other design precautions taken (additional seismic design) then in the event of
an earthquake the structure may well suffer extensive damage but will not
collapse and for some categories of building should actually remain
serviceable.

In Tekla Structural Designer a seismic wizard gathers all the information
together to setup the requirements for a seismic analysis.

From this information a number of things are determined:

• If working to ASCE7 - the seismic design category (SDC) for the building -
giving amongst other things the permissible type of analysis

• The Base Shear Combination to determine the seismic base shear in the
building

• The natural frequencies of the building in two horizontal directions

• The combination of the gravity and other lateral forces with the seismic
load cases

Earthquakes load a building by a random cyclic acceleration and deceleration
of the foundations. These are in both horizontal directions (Dir1 and Dir2) but
can also be in a vertical direction too. This ground acceleration excites the
building in its natural and higher frequencies.

As a result if the building is:

• In an area of low seismic acceleration, low in height and poses limited risk
to life then a gross approximation can be used in analysis - assuming a % of
gravity loading is applied horizontally to the building to represent the
earthquake (US codes 1%, Australian codes 10%).
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• In an area of moderate to low seismic acceleration, medium to low in
height and does not house a significant number of people - the
predominant mode excited is the 1st mode. An equivalent lateral force
(ELF) approximation can be used that applies static horizontal loading
distributed up the building to mimic the shape of the 1st mode of vibration
in a static analysis.

• Anything else, in an area of high acceleration, tall in height and could be
holding many people or be critical post-earthquake then a "more
representative" analysis method of Response Spectrum Analysis (RSA)
should be used. This analysis is based upon a modal analysis considering
all mode shapes in the two horizontal directions in which typically 90% of
the structure's mass is mobilized.

The results from the chosen method of seismic analysis are used in
combination with other gravity and lateral loadcases to design both normal
members and those members in seismic force resisting systems (SFRS). These
latter members need additional design and detailing rules to ensure they
resist the seismic forces that they subjected to during an earthquake. If
working to ASCE7, the extent of these rules are determined by the SDC noted
above (the higher the demand, the ‘better’ the SFRS that will be required).

NOTE The additional design and detailing requirements of “seismic” design are only
supported in Tekla Structural Designer for the ACI/AISC and the Indian Head
Codes.

Seismic Wizard
In Tekla Structural Designer the Seismic Wizard sets up the information
required for seismic analysis - the main parameters to be input being:

• Ground acceleration - strength of the earthquake

• The Importance Level (or Importance Class) of the building - the use to
which the building is being put - typically

• I= very minor, farm and temporary buildings,

• II= general buildings occupied by people,

• III = buildings occupied by a large number of people

• IV = critical buildings with a post-disaster function eg hospitals, police
stations, fire stations and buildings along access route to them)

• The ground conditions upon which the building is founded (typically Hard
Rock, Rock, Shallow soil, Deep Soil, Very Soft Soil)

• Building height - for low buildings the first mode is totally dominant in
taller buildings other modes become significant

• Plan and vertical irregularities in the building
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From this input the Seismic Wizard determines the seismic design category for
ASCE7, and also the elastic design response spectrum to be used for the
building.

Additionally the Wizard sets up the Base Shear Combination - the combination
of loads likely to be acting on the building when the earthquake strikes.

Vertical and Horizontal Irregularities
There are typically 5 types of horizontal irregularity and 5 types of vertical
irregularity - all are defined to pick up structures that have lateral framing
systems and shapes in plan that will preclude the structure naturally
developing a simple first mode of vibration. Since this is a basic assumption of
ELF - the presence of these irregularities may preclude the use of ELF.

Torsion
When a structure's center of mass at a level does not align with the position of
the center of rigidity then torsion is introduced in the structure at that level
when an earthquake excites the structure. To account for this, there are three
types of torsion potentially applied to levels with non-flexible diaphragms
during a seismic analysis

• Inherent torsion - in a 3D analysis when the center of mass and center of
rigidity at a level do not align, this is taken account of automatically

• Accidental torsion - to allow for the "miss positioning" of loads in a
structure, an additional eccentricity of usually 5% of the structure's width in
all relevant directions - this is accounted for with a torsion loadcase in the
analysis

• Amplified accidental torsion - structures with certain SDCs and certain
horizontal irregularities require an amplified accidental torsion to allow for
extra effects

Modal Analysis
Using the Base Shear Combination, a modal analysis is run for two purposes:

• the natural frequencies of the building in two directions are determined to
assist with the calculation of the seismic base shear that in turn is used to
determine the distribution of applied loads up the building for an ELF
analysis

• the frequencies and mode shapes of the building are determined that need
to be included in an RSA analysis so that typically 90% of the mass in the
building is mobilised during the RSA analysis
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% of Gravity Load Method
The % of gravity load method is used as a means of a gross approximation of
the earthquake and is only used in situations where seismic effects are
considered to be low. This loadcase is combined with the relevant load factor
with other gravity and lateral loadcases to determine the design forces and
moments to be considered in conventional design.

NOTE This method is not applicable when working to Eurocodes.

Equivalent Lateral Force Method
The ELF method assumes that the first mode shape is the predominant
response of the structure to the earthquake.

Based on the natural frequency and the Base Shear Combination, a total base
shear on the structure is determined and this is then set up as a series of
forces up the structure at each level (in the shape of an inverted triangle) and
these deflect the structure in an approximation to the shape of the first mode.

The resulting seismic loadcases are combined with the correct combination
factors with the other gravity and lateral loadcases in the seismic
combinations to give the design forces and moments which are used in both
the conventional design of all steel and concrete members, and the seismic
design of any steel or concrete members that have been identified as part of a
seismic force resisting system.

Response Spectrum Analysis Method
The RSA method uses a set of vibration modes that together ensure that the
mass participation is typically 90% in the structure in a particular direction.

The response of the structure is the combination of many modes that
correspond to the "harmonics". For each mode, a response is read from the
design spectrum, based on the modal frequency and the modal mass, and
they are then combined to provide an estimate of the total response of the
structure.

Combination methods include the following:

• Square root of Summation of Square (SRSS)

• Complete Quadratic Combination (CQC) - a method that is an
improvement on SRSS for closely spaced modes

As a result of the combination methods (SRSS and CQC), the resulting seismic
loadcases are without sign and so they are applied with the correct
combination factors both + and - around the "static" results of the other
gravity and lateral loadcases in the seismic combinations to give the design
forces and moments which are used in both the conventional design of all
steel and concrete members, and the seismic design of any steel or concrete
members that have been identified as part of a seismic force resisting system.
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Summary of RSA Seismic Analysis Processes

RSA Seismic Analysis (1st or 2nd order) is run as a stand-alone analysis from
the Analyze tab, or as part of the Design (RSA) process. In the latter, the use of
1st order or 2nd order is set for the static analysis is set via Design Settings >
Analysis.

The process consists of the following steps:

St
ep

Process Description

1 Model
Validation

Run to detect any design issues which might exist.

This is similar to standard model validation but also
checks:

• Base Shear Combination must exist

• At least one RSA Seismic Combination must exist
including at least one RSA Seismic Loadcase.

2 Modal
Analysis

A 1st order modal analysis for the Seismic Inertia
Combination only, which returns the standard results for
that analysis type, but also the fundamental periods for
directions 1 & 2.

3 Pre-Analysis
for Seismic

Performs calculations for RSA Torsion Loadcases.

The seismic weight and seismic torque are both
calculated at this stage.

4 Static Analysis 1st Order Linear or 2nd Order Linear analysis is
performed for all RSA Seismic Combinations and all their
relevant loadcases, i.e. this includes Static Loadcases, but
does not include RSA Seismic and RSA Torsion
Loadcases.

5 RSA Analysis A set of results is generated for a sub-set of vibration
modes for each RSA Seismic Loadcase.

6 Accidental
Torsion
Analysis

Analysis of any RSA Torsion Loadcases that exist.

Seismic Drift
Seismic drift is assessed on a floor to floor horizontal deflection basis and
there are limits for acceptability of a structure.

When working to the ASCE7 code, the engineer can directly define the shear
demand / capacity ratio (beta) for columns and walls. The default value of 1.0
could be over-conservative. This option is located in the “Seismic” group of
member properties, and can be set separately for 'Direction 1' and 'Direction
2' and for each stack/panel, as shown in the picture below.
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• The setting is applicable to all years of the ASCE7 code and has the
following default and limits: Default = 1; Min = 0.001; Max = 10.

The building's overall seismic drift status is displayed in the Design branch of
the Status Tree in the Project Workspace.

Full details for all columns are presented in a table accessed from the Review
ribbon.

These details can be included in printed output by adding the Analysis>Seismic
Drift chapter to your model report.

Design Coefficients and Factors (ASCE7/UBC)
Typically three factors are determined based on the lateral force resisting
systems in the structure and which account approximately for the inelastic
response that occurs during the earthquake which is not accounted for
directly in the analysis.

• The response modification coefficient which affects the seismic base shear.

• The overstrength factor accounts for the reinforcement steel yielding
overstrength and is utilized in the concrete beam and column capacity
calculations.

• The deflection amplification factor which is used in the calculation of
seismic drift.

Limitations of Seismic Design
The following limitations apply:

• Where seismic design and detailing is required this is only supported in
Tekla Structural Designer for the ACI/AISC and Indian Head Codes.

• It is up to the user to assess whether framing is split horizontally or
vertically, whether system specific requirements need to be assessed - like
mixed system moment frames, whether diaphragms are rigid or flexible -
in all instances, the user will need to make the necessary adjustments for
the situation in hand. The software does not handle these situations
automatically.
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• Linear modal analysis with non-linear element properties - currently the
modal analysis is limited to a linear model so all non-linear elements are
set to be linear.

• ELF can be run as 1st or 2nd order analyses, however if the Fundamental
Period is determined using modal analysis the modal analysis is always run
as 1st order.

• The RSA analysis itself is a 1st order linear process. For the 2nd Order RSA
Seismic analysis, the peak responses are enveloped around the static
results for 2nd Order Linear Analysis. Thus when the analysis is set to 2nd
order in Design Options, in real terms the results are actually RSA Seismic +
2nd Order.

• Structures with linear members and supports are run using linear analyses.
Structures with non-linear supports and /or members are run as non-linear
in ELF but linear in modal and RSA.

• We do not consider any of the standard methods for structurally
accommodating seismic actions - e.g. base isolators, damping systems

• We do not consider more accurate methods of analysis like time history
analysis. As a result there are some situations with very tall buildings and
very irregular buildings that Tekla Structural Designer does not cater for.

• Diaphragms - rigid and semi-rigid diaphragms (meshed floors) are available
and it is the user's responsibility to ensure they are modelled suitably. Rigid
diaphragms are only allowed in limited circumstances and, so called,
'flexible diaphragms' can be modelled as semi-rigid diaphragms with
extremely low stiffness. Force transfer into and out of the diaphragm is not
checked.

• Collector elements - no checks included.

• Non-structural elements - no checks included.

Specific limitations of steel seismic design

• Coincident V & A braces giving X type are beyond scope

• Various other requirements not checked

• e.g. V & A braces are restrained at their intersection

• e.g. tension braces resist between 30% and 70% of total horizontal force

• e.g. forces in restraining members not checked

• Connections are not designed

A specific limitation of RC seismic design

• While checks can be done in both directions they are direction specific
where applicable - there are no biaxial checks.

Seismic force resisting systems
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Available SFRS types
The seismic design requirements for a particular member are based upon
which Seismic Force Resisting System (SFRS) the member forms part. Hence, in
Tekla Structural Designer you can set appropriate members as part of one of
the following systems:

SFRS types included for steel members

Moment Frame Systems

• Special Moment Frames (SMF)

• Intermediate Moment Frames (IMF)

• Ordinary Moment Frames (OMF)

Braced Frame and Shear Wall Systems

• Ordinary Concentrically Braced Frames (OCBF)

• Special Concentrically Braced Frames (SCBF)

• Special Concentrically Braced Frames (SCBF)

Other Seismic Frame Type

• Not specified - this is a 'catch all' for all other types- but no seismic design
performed.

SFRS types available for concrete members

Moment Frame Systems

• Special Moment Frames (SMF) - limited design.

• Intermediate Moment Frames (IMF)

• Ordinary Moment Frames (OMF)

Walls

• Special reinforced concrete structural wall - limited design

• Intermediate precast structural wall - no seismic design performed

• Ordinary reinforced concrete structural wall

Other Seismic Frame Type

• Not specified - this is a 'catch all' for all other types- but no seismic design
performed.

SFRS types excluded

Everything else

• e.g. Eccentrically Braced Frames
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Members allowed in the SFRS
The following member types are allowed to be part of a SFRS in Tekla
Structural Designer

• Steel columns

• Steel beams

• Steel braces

• Concrete columns

• Concrete beams

• Concrete walls

The following member types are not allowed to be part of a SFRS in Tekla
Structural Designer

• Any timber, cold-formed, general

• All other “Characteristics”, e.g. steel joists, truss members, purlins

• Composite members

• Plated, Westok, Fabsec, concrete filled, concrete encased – selectable but
no design (i.e. only rolled)

Assigning members to the SFRS
The choice of members to be part of a SFRS is entirely the engineer’s
responsibility.

• It is expected that all members in a frame are assigned to the SFRS.

• The assigned members should be specified to act in building Direction 1 or
Direction 2

Special Moment Frames - assigning connection types at steel beam
ends
For SFRS comprising of steel SMF it is necessary to ensure that the beams fail
before the columns. To this end, an assessment of plastic moment capacity is
made at each floor. The moment capacity is dependent upon the position of
the plastic hinge, typically (dcol + dbeam)/2. These locations can be selected
appropriate to each beam end either in the beam properties.

Options are provided as follows:

• Plastic hinge position at start

• Plastic hinge position at end

Either, (dcol + dbeam)/2 (default)

or, dcol /2 + L

L = 0 (default)
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Validation of the SFRS
There is only a small amount of validity checking for an SFRS that can be
performed automatically; it remains in large part the user’s responsibility to
ensure that each SFRS is defined appropriately.

The following validation conditions are however detected:

1. Any A or V brace in a Seismic Force Resisting System must have the A or V
as vertically released. A warning is provided in validation if this is not the
case.

2. X type bracing is defined as more than one V or inverted V (A) type brace
pair on the beam. When more than one A or V brace pair is detected, the
additional checks required by AISC 341-05 and AISC 341-10 given in
Section 8.3 are out of scope. This situation is not detected during
validation, but it is identified in the seismic design, so that the beam is
given a “beyond scope” status.

3. The use of K braces is not allowed in AISC 341. An error is provided in
validation.

4. Tension only braces were permitted to the 05 version but had no
additional requirements. In the 10 version they are only are allowed for
OCBF. Thus, an error is provided in validation when a tension only brace is
set as part of a SCBF and the code is the 10 version. (The same validation
is also applied to compression only braces.)

5. If seismic loadcases are included in combinations and there is not at least
one member assigned to each of Direction 1 and Direction 2 then a
warning is issued.

Auto design of SFRS members
All SFRS members can be auto-designed to the conventional design
requirements both for seismic and non-seismic combinations;

During the automatic design procedure, besides the conventional auto-design,
and for seismic combination results only:

• Steel members in the SFRS are checked for seismic provisions;

• Normal weight reinforced concrete members in the SFRS are auto-
designed for seismic provisions

Seismic design methods
To design members and walls for the results of a seismic analysis:

• For geographic regions categorised as “low seismicity” it is acceptable to
assume “ductility class low” applies. Under these conditions the seismic
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analysis results can be fed into “conventional” design, see Seismic analysis
and conventional design (page 169)

• Certain conditions (e.g. “high seismicity”) necessitate that a “seismic” design
is performed - additional design and detailing requirements have to be
applied in this situation, see Seismic analysis and seismic design (page 170)

NOTE The additional design and detailing requirements of “seismic”
design are only supported in Tekla Structural Designer for the ACI/
AISC and the Indian Head Codes.

Seismic analysis and conventional design

ELF seismic analysis and conventional design

The overall modelling, analysis and conventional design process using the ELF
method is summarised as follows:

1. Modelling

• No additional seismic modelling requirements

• There is no need to assign members to a SFRS

2. Loading and Analysis

Run the Seismic Wizard to:

a. Determine building height to the highest level and adjust it if required

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select ELF method of analysis (note some vertical or horizontal
irregularities can prevent the use of this method

d. Set up the relevant seismic combinations

3. Static Design

Run the Design (Static):

• the results of the ELF seismic combinations are fed into the design and
considered in the same way as other combinations.

4. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked
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RSA seismic analysis and conventional design

The overall modelling, analysis and conventional design process using the RSA
method is summarised as follows:

1. Modelling

• No additional seismic modelling requirements

• There is no need to assign members to a SFRS

2. Loading and Analysis

Run the Seismic Wizard to:

a. Determine building height to the highest level and adjust it if
required.

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select RSA method of analysis

d. Set up the relevant seismic combinations

3. Static Design

Run the Design (Static):

• Results of the static combinations are fed into conventional design.

4. RSA Seismic Design

Run the Design (RSA):

• Results of the RSA seismic combinations are fed into conventional
design and considered in the same way as the static combinations.

• No additional seismic design is required

5. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked

See also

Seismic analysis and design handbook (page 156)

Seismic analysis and seismic design

NOTE The additional design and detailing requirements of “seismic” design are only
supported in Tekla Structural Designer for the ACI/AISC and the Indian Head
Codes.

These requirements vary depending upon the 'sophistication' of the SFRS. For
example OMF have less stringent requirements than SMF.
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ELF seismic analysis and seismic design

The overall modelling, analysis and seismic design process using the ELF
method is summarised as follows:

1. Modelling

Identify the primary seismic members, i.e. those members that are part of
the seismic force resisting system, and assign them an SFRS direction and
SFRS type.

2. Loading and Analysis

Run the Seismic Wizard to:

a. Determine building height to the highest level and adjust it if
required.

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select ELF method of analysis (note some vertical or horizontal
irregularities can prevent the use of this method.

d. Set up a modal mass combination

e. Set up the relevant seismic combinations

3. Static Design

Run Design (Static) to:

a. Conventionally design all members for all non-seismic (gravity and
lateral) combinations

b. Conventionally design all members for all seismic combinations in the
same way as the other combinations.

c. Perform additional seismic design for the seismic combinations for
those members assigned to a SFRS

4. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked

RSA seismic analysis and seismic design

The overall modelling, analysis and seismic design process using the RSA
method is summarised as follows:

1. Modelling

Identify the primary seismic members, i.e. those members that are part of
the seismic force resisting system, and assign them an SFRS direction and
SFRS type. These members will be designed and detailed according to the
seismic provisions.

2. Loading and Analysis

Run the Seismic Wizard to:
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a. Determine building height to the highest level and adjust it if
required.

b. Set the site class (ASCE7), or ground type (Eurocode)

c. Select RSA method of analysis

d. Set up a modal mass combination

e. Set up the relevant seismic RSA combinations

3. Static Design

Run the Design (Static) to:

• Conventionally design all members for all non-seismic (gravity and
lateral) combinations .

4. Modal Analysis

At this point it is recommended that you run a 1st order modal analysis in
order to confirm the model converges on a solution, (until it is able to do
so, it is pointless proceeding with a full RSA Seismic Design).

5. RSA Seismic Design

Run the Design (RSA) to:

a. Conventionally design all members for all RSA seismic combinations
in the same way as the other combinations.

b. Perform additional seismic design for the RSA seismic combinations
for those members assigned to a SFRS

6. Calculation Output

• A Seismic Design Report is available

• Drift limitations are checked

See also

Seismic analysis and design handbook (page 156)

1.5 Steel design handbook
To get started with designing steel structures in Tekla Structural Designer see:

• Combined analysis and design choices for steel structures (page 173)

• Steel member autodesign (page 174)

• Steel member design groups (page 176)

• Steel beam design (page 178)

• Composite beam design (page 193)

• Steel column design (page 218)
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• Column base plate design (page 231)

• Steel brace design (page 235)

• Steel joist design (page 238)

• Steel truss design (page 243)

• Portal frame design (page 247)

Combined analysis and design choices for steel structures

Gravity design
For many steel structures a separate gravity design is not necessary and you
can simply proceed directly to a Static design.

In some circumstances however, you may find it preferable to adopt a two-
stage workflow in which gravity members are sized prior to the full design.

The benefits of this are:

• For larger models it can significantly speed up the analysis and design time

• If lateral resisting systems are not modeled, then mechanisms can result
and the analysis may not find a solution. Since these lateral resisting
systems are perhaps unknown early in the project (or insufficient systems
have been provided), running a gravity design has the added benefit of
automatically fixing column nodes (not attached to a diaphragm)
horizontally, which stabilizes the model.

The gravity design stage enables you to design all members (and hence size
those members with the Autodesign property checked), for only the active
gravity combinations (this will include the Construction Stage combination). As
an example, beams within a rigid floor diaphragm are unaffected by lateral
load, and hence they can be sized using only the gravity combinations.

Gravity design is initiated by clicking Design Steel (Gravity).

After the gravity design has been completed, by default all steel members are
reset to check design mode.

You may then decide to reset certain members to auto design e.g. columns
and beams in 'moment frames', columns and braces in vertical or horizontal
braced bays. In such cases, when the full static design is performed member
'pre-sizing' will take place and for members resisting lateral loads the new
section size will be used if it is larger than that which resulted from the gravity
design.

Static design
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Full static design is initiated by clicking Design Steel (Static) or Design All
(Static) on the Design toolbar.

All beams, columns and braces that do not have the Gravity only property
checked, are designed or checked for all active combinations; Gravity only
design members are designed or checked for the active gravity combinations
only.

As part of the full design process a 3D Analysis is performed, for which you
must select (via Design Options) the analysis type. The choice of analysis type
will depend on the code being designed to.

Designing individual members for gravity only
By default, when a full static design is run, all members are designed for both
gravity and lateral combinations.

You can however tell Tekla Structural Designer to only consider gravity
combinations for the design of specific members. This is achieved by checking
Gravity only in an individual member's properties, i.e.

• Gravity only checked - designed for gravity combinations only

• Gravity only unchecked - designed for all combinations types: gravity,
lateral and seismic

Setting columns that do not help resist lateral loads to be designed for gravity
loads only, will reduce the overall design time.

Engineering judgement will be required when identifying members as being
'gravity only'.

For example:

• if an inclined braced member connects to a beam, axial force in the brace
(from both gravity and lateral loads) puts the beam into bending and
therefore the beam should be designed for both gravity and lateral loads.

• potentially, beams in a sloping roof would also need to be designed for
both gravity and lateral load

NOTE If a composite beam is identified as being designed for both gravity and
lateral combinations, they are only designed for gravity loads acting through
the web only. Minor axis bending and axial loads are not considered. Hence a
warning is provided, if the ignored loads exceed a preset limit.

Steel member autodesign
The design mode for each member is specified in its properties.

• When Autodesign is not selected (i.e. check mode), you assign your
desired section size to the member and Tekla Structural Designer
determines if the section is sufficient.
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• When Autodesign is selected the section type to be used is specified from
a Design Section Order and Tekla Structural Designer attempts to
automatically determine a suitable section.

The following controls can be applied to further limit the sections
considered:

• Size constraints (page 175)

• Design section orders

NOTE If a member type has been set to be designed using Design groups,
then if at least one member of the group is set to autodesign, the
whole group will be automatically designed.

Size constraints
When undertaking an Autodesign, the Size Constraints property allows you to
ensure that the sections proposed by Tekla Structural Designer match any
particular size constraints you may have.

For instance:

• Minimum width - you may want to ensure a minimum flange width to
satisfy bearing requirements for any supported beams. To achieve this, you
would enter a value as the Minimum width, and Tekla Structural Designer
would not consider sections with flanges less than the specified minimum
width for the design of the beam.

• Maximum depth - you may want to ensure that the maximum beam depth
is specified to ensure that it fits within a floor zone. To achieve this, you
would enter a value as the Maximum depth and Tekla Structural Designer
would not consider sections with depths greater than the specified value
for the design of the beam.

• Max span/depth ratio (beams only) - you may want to set a max span/
depth ratio limit above which autodesign will reject sections that are of
insufficient depth.

• The depth is taken as the depth from the section properties - for single
and double angles this is the vertical leg length.

• Limit is not applied to any member which has rotation.

NOTE Size constraints only work when undertaking an Autodesign

Applying a size constraint to an element
You can control which sections in a design order list are considered, by
following the procedure below.
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1. Select the required element or elements. 

The properties of the selected elements are displayed in the Properties
window

2. Expand All spans/stacks or the individual span/stack as required to reveal
Size Constraints

3. Expand Size Constraints and set the Max depth, Min depth, Max width,
Min width, or Apply max/span/depth ratio as required.

When an Autodesign is performed, the section selected from the section
order list will fall within any size constraint limits set.

Steel member design groups

Why use steel design groups?
Steel members are not automatically placed into design groups. They are
however, automatically put into groups, primarily for editing purposes. In this
way, individual groups can be selected and displayed graphically so that their
properties can be changed as a group in the properties window.

If required, grouping can also (optionally) be utilized in order to design steel
member types according to their groups.

In order to use grouping for this second purpose, you should first ensure that
your groups are configured so that each group only contains those members
that you intend to eventually have the same section size applied.

NOTE Grouped design is optional and can be activated if required, via Design
Options> Design Groups

NOTE A fixed set of rules are initially used to determine the automatic member
grouping: for example beams are designated as either direction 1 or
direction 2, are of a similar span, material grade and construction type,
columns have the same number of stacks etc. You can manually edit
groups.

What happens in the group design process?
When the option to design a specific steel member type using groups is
checked, for that member type:

• In each design group the first member to be designed is selected
arbitrarily. A full design is carried out on this member and the section size
so obtained is copied to all other members in the group.

• These other members are then checked one by one to verify that the
section size is adequate for each and if this proves not to be the case, it is
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increased as necessary and the revised section size is copied to all
members in the group.

• This process continues until all members in the group have been
satisfactorily checked.

• A final check design is then carried out on each group member. During this
process peak and individual utilizations are established.

NOTE When performing the design of a group of composite beams the changes in
section size may mean that for some beams the existing stud layout will no
longer remain adequate. To ensure the safe and rational design of the studs,
the stud design routine is re-run at the end of the group design for all beams
with the stud auto-layout active in the beam properties.

Steel design group requirements
Steel member design groups are formed according to the following rules:

Member type Design group rules
Steel beam • A beam element may only be in one design group

• All beam elements in the group must have the
same Construction/Fabrication i.e. Non-composite
Rolled,

• All beam elements in the group must have the
same material properties

Automatic grouping uses the following rules to
automatically generate the groups, however, when
manually editing the groups these are not enforced:

• All beam elements in the group are of a similar
span.

• All beam elements have a similar direction i.e.
beams are grouped as Direction 1 or 2 if they lie +/-
45 degrees to the directional axis

Steel column • A column element may only be in one design group

• All column elements in the group must have the
same Construction/Fabrication i.e. Non-composite
Rolled,

• All column elements in the group must have the
same material properties

• All column elements in the group must have the
same number of stacks
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Group management
Automatic Grouping

Steel members are grouped automatically.

In Model Settings the user defined Maximum length variation is used to
control whether elements are sufficiently similar to be considered equivalent
for automatic grouping purposes.

Manual/Interactive Grouping

It is recommended that you manually edit the groups for steel members, since
members can be placed into any group without the need for similar span
lengths or directional requirements. For example, edge beams, primary
beams, secondary beams etc. could have different span length and directions,
and be placed into the same design group using manual editing.

NOTE A member can only be placed into a single design group.

To manually reassign a member to a different group, locate it in the Project
Workspace,Groups taband drag it to a different group

NOTE A cross will appear if the element does not meet the Group requirements.

Regroup ALL Model Members

If you have made changes in Design Options that affect grouping, you can
update the groups accordingly from the Groups tab of the Project Workspace
by clicking Re-group ALL Model Members.

NOTE Any manually applied grouping will be lost if you elect to re-group!

Steel beam design
Click the following links to find out more:

• Steel beam overview (page 179)

• Steel beam fabrication (page 179)

• Steel beam restraints (page 184)

• Deflection limits (page 185)

• Camber (page 186)

• Instability factor (page 187)

• Beam web openings (page 187)

• Steel beam torsion (page 192)

• Fire check (Eurocode only) (page 193)
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Steel beam overview
Tekla Structural Designer will design steel beams for an international range of
doubly symmetric I-sections, C-sections, rectangular and square hollow
sections, single angles, double angles and tees for many different countries
and also for many specific manufacturers. Plated beam design is also available
for some head codes.

Steel beams are designed using a set of design forces obtained from 3D
Analysis. (Grillage Chasedown Analysis and FE Chasedown Analysis results are
not required.)

In addition to major axis bending, minor axis bending and axial loads are also
considered.

In its simplest form a steel non-composite beam can be a cantilever, or a
single member between supports to which it is pinned.

It can also be a continuous beam consisting of multiple members that do not,
with the exception of the remote ends, transfer moment to the rest of the
structure. Each span of a continuous beam can be of different section size,
type and grade.

At the remote ends of the beam there are a number of options for the end
fixity depending upon to what the end of the beam is connected. These are:

• Free end

• Moment connection

• Pin connection

• Fully fixed

• Partially fixed (% of 4EI/L)

• Partially fixed (linear spring)

The beam may have incoming beams providing restraint and may or may not
be continuously restrained over any length between restraints.

Steel beam fabrication

Fabrication types summary - all head codes

The fabrication types that can be designed as non-composite steel beams in
Tekla Structural Designer are dependent on the design code.

Refer to the following table for details.

Rolled Plated Westok
cellular

Westok
plated

FABSEC DELTABEA
M

AISC Yes Yes No No No No
Eurocode Yes Yes Yes Yes No No
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BS Yes Yes Yes Yes No No
IS Yes Yes No No No No
AS Yes Yes No Yes No No

Plated beams - AISC head code

When the Fabrication type is set to Plated, only Plated Beams can be
designed to the AISC 360-05, 360-10 and 360-16. While one plated section has
been provided as a default, you can define (and save) your own plated
sections by clicking the Add... button shown below.

NOTE Autodesign requires a Design section order to be specified, a new design
section order can be created specifically for plated sections once these have
been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections with the following current limitations:

• The design is for non-composite sections only.

• Slender Sections are beyond scope.
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• Only parallel flange sections can be used.

Plated beams - Eurocode head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to Eurocodes. While one plated section has been
provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.

NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created specifically for plated sections
once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Plated beams - BS head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to BS 5950. While one plated section has been
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provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.

NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created specifically for plated sections
once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Plated beams - Indian head code

When the Fabrication type is set to Plated, a range of steel compound sections
can be designed to the Indian design code.
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The section shapes supported are:

• Rolled Channels back to back

• Rolled Channels toe to toe

• Doubled rolled I sections

• Doubled rolled I sections with plates

The scope of design of these compound sections includes both beams and
columns and autodesign.

NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created specifically for compound
sections once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections with the following current limitations:

• The design is for non-composite sections only.

• Slender Sections are beyond scope.

• High Shear case with minor axis moment is beyond scope.

• Design of the lacing or battening system is beyond scope.
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• Only parallel flange sections can be used.

Plated beams - Australian head code

When the Fabrication type is set to Plated, only welded doubly symmetric I-
section beams can be designed to the Australian code.

A pre-defined range of these is available from the Welded Beams page of the
Select Section dialog - these can be both checked and autodesigned.

NOTE Autodesign requires a Design section order to be specified, the Welded
Beams design section order is provided for this purpose.

While you can add to the range of welded beams the Select Section dialog by
clicking the Add... button, any such user-defined beams can only be analyzed,
but are not designed.

Plated beams available on other pages of the Select Section dialog can be
analyzed, but are not designed.
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Steel beam restraints
Each beam may have incoming beams providing restraint and may or may not
be continuously restrained over any length between restraints.

Conditions of restraint can be defined in- and out-of-plane for compression
(strut) buckling and top and bottom flange for lateral torsional buckling (LTB).
The effective lengths used in the buckling checks depend on the type of
restraint, particularly at supports.

In all cases, the program sets the default effective length to 1.0L, it does not
attempt to adjust the effective length (between supports for example) in any
way. You are expected to adjust the effective length factor (up or down) as
necessary. Any compression or LTB effective length can take the type
“Continuous” to indicate that it is continuously restrained over that length.

LTB and Compression restraints

LTB and Compression restraints are determined from the incoming members
described within the Tekla Structural Designer model.

The default assumption is that an incoming member connecting to either side
of the beam provides lateral restraint to the top flange only, and compression
restraint about the minor axis. An incoming member connecting from above
or below doesn't provide lateral restraint but provides compression restraint
about the major axis.

By right-clicking a member to edit its properties in the Property dialog, you are
then able to edit the restraints. You can indicate also continuously restrained
sub-beams and edit length factors.

Note that the same level of restraint editing is not provided in the Properties
Window (although it does allow you to independently set both the top and
bottom flanges as continuously restrained for the entire member length via
the Top/Bottom flange cont. rest. properties).

TIP As an alternative to using the Steel Beam Property dialog, restraint settings for
steel beams can be easily reviewed and adjusted graphically via Review View >
Show/ Alter State. For more details see: Review and modify restraints

Torsion restraints

Torsion restraints are currently displayed in the Property dialog for
information only. In design the beam is treated as unrestrained against
warping and restrained against torsion.

Continuously Restrained Flanges

In the Properties Window you can independently set both the top and bottom
flanges as continuously restrained. By setting ‘Top flange cont. rest.’ and/or
‘Bottom flange cont. rest.’ to ‘Yes’ the relevant buckling checks are not
performed during the design process.
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Deflection limits
Serviceability criteria often control the design of normal composite beams.
This is because they are usually designed to be as shallow as possible for a
given span.

Deflection Limits allow you to control the amount of deflection in both
composite beams and steel beams by applying either a relative or absolute
limit to the deflection under different loading conditions.

A typical application of these settings might be:

• not to apply any deflection limit to the slab loads, as this deflection can be
handled through camber,

• to apply the relative span/over limit for live load deflection, to meet code
requirements,

• possibly, to apply an absolute limit to the post composite deflection to
ensure the overall deflection is not too large.

Camber
Camber is primarily used to counteract the effects of dead load on the
deflection of a beam. This is particularly useful in long span composite
construction where the self-weight of the concrete is cambered out. It also
ensures little, if any, concrete over pour occurs when placing the concrete.

The amount of camber can be specified either:

• As a value

• As a proportion of span

• As a proportion of deflection

• If this option is selected, the engineer should identify the combination
to be used for the calculations by selecting Camber adjacent to the
appropriate gravity combination on the Loading combination dialog
page.

• If no combination is selected then the first gravity combination in the
combination list is used.

In the latter case, if 100% of the dead load deflection is cambered out, it is also
possible to include a proportion of the live load deflection if required.

Lower limits can be set for span length and calculated camber below which
camber is not applied. This ensures that unwanted or impractical levels of
camber are not specified.

Limits to the maximum allowable camber as well as to the minimum section
web thickness to avoid web crippling can also be defined. These will be
accounted for in the automatic design process affecting the section size
selection.
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Related information

See also

Support article: Composite Beam deflections including camber

Instability factor
Long members in a model that have axial force in them can be unstable
during second-order analysis because their individual elastic critical buckling
load factor is lower than the elastic critical buckling load factor of the building
as a whole and is less than 1.0.

However, often such members, for example the rafters in a portal frame, are
stable in design because, for example, there are many smaller members or
sheeting, that restrain the member in reality. They fail in the analysis because
it is too resource intensive to model all the individual restraining members in
the model which would also add unwanted clutter.

To prevent or to reduce the incidence of such failures during the analysis a
multiplier can be applied to the minor axis inertia of these members which
caters for the effect of the restraining members.

This multiplier can be applied to steel beams, composite beams and steel
columns. It is defined in the properties window by selecting Prevent out of
plane instability and then entering a suitable value in the Instability factor
field.

NOTE This multiplier is applied to prevent unwanted behaviour in the analysis
model. While the analysis results may be affected by this adjustment, there is
no amplification of the minor axis inertia in the design of the member.

Beam web openings
You cannot currently automatically design sections with web openings, you
must perform the design first to get a section size, and then add and check the
openings. This gives you complete control of the design process, since you can
add appropriate and cost effective levels of stiffening if required, or can
choose a different beam with a stronger web in order to reduce or remove any
stiffening requirement.

When openings are added they can be defined as rectangular or circular and
can be stiffened on one, or on both sides.

Openings cannot be defined from the Properties Window, they can only be
defined from the Properties Dialog, (by right-clicking on the member and
selecting Edit...)

For guidance in relation to a specific head code, see:

• Beam web openings to AISC (page 188)
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• Beam web openings to SCI P355 (page 188)

• Beam web openings to SCI P068 (page 191)

Beam web openings to AISC

Web Opening design limitations

• Simple beams only (single span, pin ended). Although web openings can be
defined on multi-span beams design is beyond scope.

• Cantilevers are excluded.

• Curved beams are excluded.

• Haunched and tapered members are excluded.

• Section type: rolled symmetrical compact I sections.

• Plated sections are excluded.

• Steel yield strength is limited to 65 ksi

• Web opening placement and sizes: Opening depth is limited to 70 percent
of beam depth. There are also two control parameters which dictate the
dimensions of the opening, one being the aspect ratio, ao/ho, of the
opening and the other being the opening parameter po. Both should meet
the required limits.

• Multiple openings. Checks are performed to ensure that openings are
spaced far enough apart so that design expressions for individual openings
may be used.

• Openings cannot be placed closer than the section height to a support.

• Openings can be defined as rectangular or circular; circular openings are
designed as equivalent rectangular openings.

• Openings can be reinforced on one side or both sides but always top or
bottom, but no checks are performed on the reinforcement and its welds.

• No concentrated loads should be placed above an opening. If there is a
point load above the opening then that combination gets a Beyond Scope
status, (but only if the concentrated load is greater than 25% of the shear
strength of the two tee sections).

• The nearest concentrated load should be placed at least d/2 from the edge
of the opening.

• A check is performed to determine whether bearing stiffeners are
necessary, if so these are not designed but a warning is shown.

• ASD design i.e. LRFD only.

NOTE For details of the web opening design checks performed see

Beam web openings to SCI P355
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NOTE When the Head Code has been set to Eurocode, Tekla Structural Designer
adopts the following approach to web openings which is specific to the UK
National Annex.

As each web opening is added it is checked against certain geometric and
proximity recommendations taken from Table 2.1 of SCI Publication P355 (see
below).

Guidance on size and positioning of openings

The following general guidance on size and positioning of openings is taken
from Table 2.1 Section 2.6 of the SCI Publication P355

NOTE These geometric limits should normally be observed when providing
openings in the webs of beams. It should be noted that these limits relate
specifically to composite beams and caution should be used in applying these
limits to non-composite beams.

Parameter Limit
Circular Opening Rectangular Opening

Max. depth of opening: <= 0.8h <= 0.7h
Min. depth of Tee, >= tf +30 mm >= 0.1h

Min. depth of Top Tee: As above As above and >= 0.1 lo

if unstiffened
Max. ratio of depth of
Tees: hb/ht

hb/ht

<= 3

> = 0.5

<=2

>= 1

Max. unstiffened
opening length, lo

Max. stiffened opening
length, lo

-

-

-

-

<= 1.5 ho high shear*

<= 2.5 ho low shear

<= 2.5 ho high shear*

<= 4 ho low shear

Min. width of web post:

- Low shear regions

-High shear regions

>= 0.3h o

>= 0.4h o

>= 0.5 lo

>= lo

Corner radius of
rectangular openings:

- ro >= 2 tw

but ro >= 15 mm

Min. width of end post,
se:

>= 0.5 ho >= lo

and >= h
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Parameter Limit
Circular Opening Rectangular Opening

Min. horizontal distance
to point load:

- no stiffeners

- with stiffeners

>= 0.5 h

>= 0.25 ho

>= h

>= 0.5 ho

* A high shear region is where the design shear force is greater than half the
maximum value of design shear force acting on the beam.

Symbols used in the above table:

h = overall depth of steel section

ho = depth of opening [diameter for circular openings]

ht = overall depth of upper Tee [including flange]

hb = overall depth of lower Tee [including flange]

lo = (clear) length of opening [diameter for circular openings]

se = width of end post [minimum clear distance between opening and support]

tf = thickness of flange

tw = thickness of web

ro = corner radius of opening

In addition, the following fundamental geometric requirements must be
satisfied.

do <= 0.8*h for circular openings

do <= 0.7*h for rectangular openings

do < 2 * (doc - tt - rt)

do < 2 * (h - doc - tb - rb)

d2 < doc - do/2 - tt- ts/2

d2 < h - tb- doc - do - ts/2

lo < 2 * Lc

lo < 2 * (L - Lc)

Ls < 2 * Lc

Ls < 2 * (L - Lc)

where

dt= the depth of the web of the upper tee section measured from the
underside of the top flange
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doc = the distance to the centre line of the opening from the top of the steel
section

d2 = the distance from the edge of the opening to the centre line of the
stiffener

ts = thickness of stiffener [constrained to be the same top and bottom]

tt = the thickness of the top flange of the steel section

tb = the thickness of the bottom flange of the steel section

rt = root radius at the top of the steel section

rb = root radius at the bottom of the steel section

Lc = the distance to the centre line of the opening from the left hand support

L = the span of the beam

NOTE Dimensional checks - The program does not check that openings are
positioned in the best position (between 1/5 and 1/3 length for udls and in a
low shear zone for point loads). This is because for anything other than
simple loading the best position becomes a question of engineering judgment
or is pre-defined by the service runs.

NOTE Adjustment to deflections - The calculated deflections are adjusted to allow
for the web openings

Beam web openings to SCI P068

As each web opening is added it is checked against certain geometric and
proximity recommendations taken from SCI Publication P068.

Guidance on size and positioning of openings

We advise you to comply with the following positional recommendations for
web openings:

• Web openings are designed using the bending moment and vertical shear
values at the side of the opening where the moment is lower,

• Openings should preferably be positioned at the mid-height of the section.
If not, the depth of the upper and lower sections of web should differ by
not more than a factor of two,

• Openings should not be located closer to the support than two times the
beam depth or 10% of the span whichever is the greater,

• The best location for any opening is between 1/5 and 1/3 of the span from
a support in uniformly loaded beams, or in lower shear zone of beams
subject to point loads,

• Openings should be not less than the beam depth, D, apart,
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• Unstiffened openings should not generally be deeper than 0.6D or longer
than 1.5D,

• Stiffened openings should not generally be deeper than 0.7D or longer
than 2D,

• Point loads should not be applied at less than D from the side of the
adjacent opening.

NOTE Dimensional checks - The program does not check that openings are
positioned in the best position (between 1/5 and 1/3 length for udls and in a
low shear zone for point loads). This is because for anything other than
simple loading the best position becomes a question of engineering judgment
or is pre-defined by the service runs.

NOTE Adjustment to deflections - The calculated deflections are adjusted to allow
for the web openings

Steel beam torsion
Torsion can only be checked to the AISC or Eurocode head code and only
under the following conditions:

• Section geometry

• doubly symmetric rolled I-sections

• closed RHS/SHS/CHS sections (steel and cold formed)

• closed HSS sections

• pinned

• single span beams

• applied torsion moment

• no web openings

If any of the above conditions are contravened the check is beyond scope.

Only a check design is performed, (no auto-design for torsion).

The procedure and scope are different for Open sections (I’s) vs closed
sections (HSS’s)

• Open Sections:

• Torsion design and angle rotation check will be carried out for applied
torsion forces only. “Inherent” torsion is not checked

• Closed Sections

• “Inherent” torsion and/or physically applied torsion loads checked

• Angle of rotation check carried out for applied forces only
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Fire check (Eurocode only)
The mechanical resistance of a steel beam in case of fire can be checked in
accordance with EN 1993 & national annex for the UK, Ireland, Singapore,
Malaysia, Sweden, Norway, Finland or the recommended Eurocode values.

The fire check is activated via the beam properties, after which the user is
required to specify:

• Load reduction factor for fire

• Required time of fire exposure

• Exposure

• Protected, or unprotected

• If the protected option is selected, the engineer is then required to
specify the fire protection material details.

The time interval for critical temperature iteration is specified in Design
Settings, for both 'unprotected' and 'protected' situations.

The check compares the design shear force against the design resistance at
the required time of fire exposure.

For the scope of the check and the limitations that apply, see:

Composite beam design
Click the following links to find out more:

• Composite beam overview (page 194)

• Composite beam loading (page 194)

• Composite beam fabrication (page 196)

• Composite floor construction (page 198)

• Precast concrete planks (Eurocode only) (page 205)

• Concrete slab (page 208)

• Metal deck (page 208)

• Stud strength (page 208)

• Connector layout (page 209)

• Composite beam restraints (page 216)

• Composite beam natural frequency (page 216)

• Composite beam transverse reinforcement (page 217)

• Allow non-composite design (page 218)

• Deflection limits (page 185)
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• Camber (page 186)

• Instability factor (page 187)

• Beam web openings (page 187)

Composite beam overview
Composite beams are designed using a set of design forces obtained from 3D
Analysis. (Grillage Chasedown Analysis and FE Chasedown Analysis results are
not required.)

The beams must be simply supported, single span unpropped structural steel
beams.

The following are beyond scope:

• continuous or fixed ended composite beams,

• composite sections formed from hollow rolled sections,

• composite sections where the concrete slab bears on the bottom flange,

• the use of fibre reinforcement.

Beams are designed for gravity loads acting through the web only. Minor axis
bending and axial loads are not considered.

NOTE If either minor axis bending or axial loads exist which exceed a limit below
which they can be ignored, a warning is given in the beam design summary.

Profiled steel sheeting can be perpendicular, parallel and at any angle in
between relative to the supporting beam web.

Tekla Structural Designer will determine the size of beam which:

• acting alone is able to carry the forces and moments resulting from the
Construction Stage,

• acting compositely with the slab using profile steel decking (with full or
partial interaction) is able to carry the forces and moments at Composite
Stage,

• acting compositely with the slab using profile steel decking (with full or
partial interaction) is able to provide acceptable deflections, service
stresses and natural frequency results.

Alternatively you may give the size of a beam and Tekla Structural Designer
will then determine whether it is able to carry the previously mentioned forces
and moments and satisfy the Serviceability requirements.

An auto-layout feature can be used for stud placement which caters for both
uniform and non-uniform layouts.
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Composite beam loading
All loads must be positive since the beam is considered as simply supported
and no negative moment effects are accommodated.

Construction stage loading

You define these loads into one or more loadcases as required.

The loadcase defined for construction stage slab wet concrete has a Slab wet
loadcase type specifically reserved it. Clicking the Calc Automatically check box
enables this to be automatically calculated based on the wet density of
concrete and the area of slab supported. An allowance for ponding can
optionally be included by specifying it directly in the composite slab
properties.

If you uncheck Automatic Loading, this loadcase is initially empty - it is
therefore important that you edit this loadcase and define directly the load in
the beam due to the self weight of the wet concrete. If you do not do this then
you effectively would be designing the beam on the assumption that it is
propped at construction stage.

It is usual to define a loadcase for Live construction loads in order to account
for heaping of the wet concrete etc.

Having created the loadcases to be used at construction stage, you then
include them, together with the appropriate factors in the dedicated
Construction stage design combination. You can include or exclude the self-
weight of the beam from this combination and you can define the load factors
that apply to the self weight and to each loadcase in the combination.

NOTE You should include the construction stage slab wet concrete loadcase in the
Construction stage combination, it cannot be placed in any other combination
since it’s loads relate to the slab in its wet state. Conversely, you cannot
include the Slab self weight loadcase in the Construction stage combination,
since it’s loads relate to the slab in its dry state. The loads in the Construction
stage combination should relate to the slab in its wet state and any other
loads that may be imposed during construction.

NOTE TIP: If you give any additional construction stage loadcases a suitable title you
will be able to identify them easily when you are creating the Construction
stage combination.

Composite stage loading

You define the composite stage loads into one or more loadcases which you
then include, together with the appropriate factors in the design combinations
you create. You can include or exclude the self-weight of the steel beam from
any combination and you can define the load factors that apply to the beam
self weight and to each loadcase in the combination.

The Slab self weight loadcase is reserved for the self weight of the dry concrete
in the slab. Clicking the Automatic Loading check box enables this to be
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automatically calculated based on the dry density of concrete and the area of
slab supported. An allowance for ponding can optionally be included by
specifying it directly in the composite slab properties.

If you uncheck Automatic Loading, the Slab self weight loadcase is initially
empty - it is therefore important that you edit this loadcase and define directly
the load in the beam due to the self weight of the dry concrete. For each other
loadcase you create you specify the type of loads it contains – Dead, Live or
Wind.

For each load that you add to an Live loadcase you can specify the percentage
of the load which is to be considered as acting long-term (and by inference
that which acts only on a short-term basis).

All loads in Dead loadcases are considered to be entirely long-term while
those in Wind loadcases are considered entirely short-term.

Composite beam fabrication

Fabrication types summary - all head codes

The fabrication types that can be designed as composite steel beams in Tekla
Structural Designer are dependent on the design code.

Refer to the following table for details.

 Rolled Plated Westok
cellular

Westok
plated

FABSEC DELTABE
AM

AISC Yes No No No No No
Eurocode Yes Yes Yes Yes No No
BS Yes Yes Yes Yes No No
IS N/A - Design of composite beams to IS codes is currently beyond

scope
AS N/A - Design of composite beams to AS codes is currently beyond

scope

Plated beams - Eurocode head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to Eurocodes. While one plated section has been
provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.
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NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created specifically for plated sections
once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Plated beams - BS head code

When the Fabrication type is set to Plated, only Plated Beams can be
autodesigned or checked to BS 5950. While one plated section has been
provided as a default, you can define (and save) your own plated sections by
clicking the Add... button shown below.
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NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created specifically for plated sections
once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections.

Composite floor construction

Deck Type, Angle and Condition

The deck type and angle used in the beam design are determined from the
properties of an adjacent slab item. If there are multiple adjacent slab items
with different properties, it is the users responsibility to indicate which one
governs.

• When specifying the slab item properties you will find that a wide range of
profiled metal decks have been included for manufacturers from many
countries. PC Planks are also available, but only for the EC Head Code.
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• The slab item’s rotation angle relative to the global X axis is used to set the
profiled metal deck as spanning at any angle between 0° (parallel) and 90°
(perpendicular) to the direction of span of the steel beam.

The beam’s “condition” is:

• restricted to internal if it has composite slabs attached along its full length
on both sides,

• restricted to edge if it has no composite slabs on one side,

• defaulted to edge (but editable) if it has composite slabs on both sides but
not along the full length.

Shear connector type

The shear connection between the concrete slab and the steel beam is
achieved by using shear studs.

NOTE The use of channel connectors or Hilti™ connectors is currently beyond the
program scope.

Head Code: Eurocode, BS

19mm diameter studs with 100 and 125 nominal height (95 and 120 as welded
height) are offered. 22mm diameter studs are also offered but only for precast
plank decks. Studs do not have a given capacity as their resistance is derived.

Effective width used in the design - Head Code: ACI/AISC

The effective width can either be entered manually, or be calculated
automatically either as a one time process or each time a design is performed.

To manually enter the effective width:

1. Specify the Floor construction > Effective width value you wish to use.

NOTE If any amendments are made to the geometry of the model then
you would need to amend the effective width value as necessary.

The Calculate button shown below the effective width property
can be used as a helper to determine the code based values.

To calculate the effective width automatically as a one time process:

1. First select Calculate effective width in the properties.

2. Then click the [...] box that appears next to Calculate.

3. The calculated value is reported in the effective width property.

Tekla Structural Designer will calculate the effective width of the compression
flange, be for each composite beam as per Section I3.1a (360-05/-10).

For each side of the beam, it is taken as the smaller of:

• beam span/8 – span taken as the center to center of supports
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• one half of the distance to the center line of the adjacent beam

• the distance to the edge of the slab

Although the program calculates be, it is your responsibility to accept the
calculated figure or alternatively to adjust it. Engineering judgment may
sometimes be required.

For example consider the beam highlighted below:

The program calculates the effective width as the sum of:

• to the right of the beam, be(right) = beam span/8

• to the left of the beam, be(left) = one half of the shortest distance to the
center line of the adjacent diagonal beam

To the left of the beam, some engineers might prefer to use one half of the
mean distance to the adjacent beam. To do so you would need to manually
adjust the calculated value via the Floor construction page of the Beam
Properties.

NOTE If any amendments are made to the geometry of the model then you
would need to use Calculate again or use the procedure below.

To automatically calculate the effective width each time a design is
performed:

To combat the possibility of model edits and the need to recalculate the
effective width for individual beams it is possible to automatically perform the
Calculate process discussed above automatically to all beams prior to a Design
command.

1. Ensure Update effective width prior to design check is checked on in
Design > Settings > Steel > Composite beam

2. The floor construction properties will then display an Override effective
width option.
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a. With this unchecked, the effective width will be determined when a
Design command is performed and the value is reported to you in the
Effective width property which is not editable.

b. With this checked, you can override the effective width value and the
value you input into the effective width property is used for design.
The Calculate button can still be used to advise the code based
values.

Effective width used in the design - Head Code: Eurocode

The effective width can either be entered manually, or be calculated
automatically either as a one time process or each time a design is performed.

To manually enter the effective width:

1. Specify the Floor construction > Effective width value you wish to use.

NOTE If any amendments are made to the geometry of the model then
you would need to amend the effective width value as necessary.

The Calculate button shown below the effective width property
can be used as a helper to determine the code based values.

To calculate the effective width automatically as a one time process:

1. First select Calculate effective width in the properties.

2. Then click the [...] box that appears next to Calculate.

3. The calculated value is reported in the effective width property.

Tekla Structural Designer will calculate the effective width of the compression
flange, beff, for each composite beam as per Clause 5.4.1.2 of EC4.

Unless hollowcore units are used, it is taken as the smaller of:

• Secondary beams: the spacing of the beams, or beam span/4

• Primary beams (conservatively): 80% of the spacing of beams, or beam
span/4

• Edge beams: half of above values, as appropriate, plus any projection of
the slab beyond the centerline of the beam.

For hollowcore precast plank units only, we calculate the effective width for
each side of the beam as the minimum of:

• Assumed concrete fill (500 mm) + recommended gap

• beam span/8 – span taken as the center to center of supports

• one half of the distance to the center line of the adjacent beam

• the distance to the edge of the slab

These effective breadths are used in both strength and serviceability
calculations.
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Although the program calculates beff, it is your responsibility to accept the
calculated figure or alternatively to adjust it. Engineering judgment may
sometimes be required.

For example consider the beam highlighted below:

The program calculates the effective width as the sum of:

• to the right of the beam, beff(right) = beam span/8

• to the left of the beam, beff(left) = one half of the shortest distance to the
center line of the adjacent diagonal beam

To the left of the beam, some engineers might prefer to use one half of the
mean distance to the adjacent beam. To do so you would need to manually
adjust the calculated value via the Floor construction page of the Beam
Properties.

NOTE If any amendments are made to the geometry of the model then you
would need to use Calculate again or use the procedure below.

To automatically calculate the effective width each time a design is
performed:

To combat the possibility of model edits and the need to recalculate the
effective width for individual beams it is possible to automatically perform the
Calculate process discussed above automatically to all beams prior to a Design
command.

1. Ensure Update effective width prior to design check is checked on in
Design > Settings > Steel > Composite beam

2. The floor construction properties will then display an Override effective
width option.

a. With this unchecked, the effective width will be determined when a
Design command is performed and the value is reported to you in the
Effective width property which is not editable.
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b. With this checked, you can override the effective width value and the
value you input into the effective width property is used for design.
The Calculate button can still be used to advise the code based
values.

Effective width used in the design - Head Code: BS

The effective width can either be entered manually, or be calculated
automatically either as a one time process or each time a design is performed.

To manually enter the effective width:

1. Specify the Floor construction > Effective width value you wish to use.

NOTE If any amendments are made to the geometry of the model then
you would need to amend the effective width value as necessary.

The Calculate button shown below the effective width property
can be used as a helper to determine the code based values.

To calculate the effective width automatically as a one time process:

1. First select Calculate effective width in the properties.

2. Then click the [...] box that appears next to Calculate.

3. The calculated value is reported in the effective width property.

Tekla Structural Designer will calculate the effective width of the compression
flange, be, for each composite beam as per section 4.6 of BS 5950 : Part 3 :
Section 3.1 : 1990.

For each side of the beam, it is taken as the smaller of:

• beam span/8 – span taken as the centre to centre of supports

• one half of the distance to the centre line of the adjacent beam (for slabs
spanning perpendicular)

• 40% of the distance to the centre line of the adjacent beam (for slabs
spanning parallel)

• the distance to the edge of the slab

Although the program calculates be, it is your responsibility to accept the
calculated figure or alternatively to adjust it. Engineering judgment may
sometimes be required.

For example consider the beam highlighted below:
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The program calculates the effective width as the sum of:

• to the right of the beam, be(right) = beam span/8

• to the left of the beam, be(left) = one half of the shortest distance to the
centre line of the adjacent diagonal beam

To the left of the beam, some engineers might prefer to use one half of the
mean distance to the adjacent beam. To do so you would need to manually
adjust the calculated value via the Floor construction page of the Beam
Properties.

NOTE If any amendments are made to the geometry of the model then you
would need to use Calculate again or use the procedure below.

To automatically calculate the effective width each time a design is
performed:

To combat the possibility of model edits and the need to recalculate the
effective width for individual beams it is possible to automatically perform the
Calculate process discussed above automatically to all beams prior to a Design
command.

1. Ensure Update effective width prior to design check is checked on in
Design > Settings > Steel > Composite beam

2. The floor construction properties will then display an Override effective
width option.

a. With this unchecked, the effective width will be determined when a
Design command is performed and the value is reported to you in the
Effective width property which is not editable.

b. With this checked, you can override the effective width value and the
value you input into the effective width property is used for design.
The Calculate button can still be used to advise the code based
values.
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Precast concrete planks (Eurocode only)

NOTE The design of composite beams with precast concrete planks is only available
for Eurocodes. It is not currently supported for other Head Codes.

General limitations and assumptions

The following limitations and assumptions apply to the use of precast concrete
planks:

Cross-section classification is restricted to Classes 1 & 2.

As per normal composite beams there is no requirement to check for
transverse force as it is assumed there are no loads or support conditions that
would necessitate this.

A balanced condition is assumed during the construction stage and the top
flange of the beam is treated as laterally restrained in construction. This
condition should be evaluated against the particular application, if it is not
suitable then it should be cleared.

Both hollow core units and solid planks are assumed to act compositely only
with perpendicular secondary beams and not primary beams parallel to the
span of the PC units. Beams neither parallel nor perpendicular to the PC slab
are termed angled and are also designed non-compositely.

Precast unit

Design of the precast units themselves is not carried out. It is assumed that
the application and loading conditions of the particular precast unit is justified
before design of the composite beam is carried out.

The ability to model slab openings is not restricted. The effect an opening has
on the behaviour of the precast plank is however, not taken into account and
the engineer should verify this to be safe.

P401 restricts the design of composite beams with precast concrete units to
the following:

• Hollow core units with circular or circular elongated openings along their
length (150mm – 260mm deep). It is assumed all hollow core units
modelled will have circular or circular elongated cores. Cores with other
cross-sectional geometries may need additional design and verification,
this is beyond the scope of SCI P401

• Solid precast planks (75mm – 100mm deep)

• Downstand beams

Deeper units can be chosen than the sizes stated above, however design will
not be carried out.

It is assumed that the concrete infill does not contribute to the overall weight
of the slab.
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If a solid slab is chosen, the contribution of the precast slab is ignored in
resistance and stiffness calculations.

If a hollow core unit is chosen, the contribution of the concrete topping is
ignored in resistance and stiffness calculations.

Steel Beam

The following applies to steel beam sections:

• Minimum flange width

• Internal beam - 220mm for shop-welded and 235 for site welded shear
connectors.

• Edge beam – 2 * (6 * stud diameter)

These recommendations can be reduced by decreasing the bearing -
special provisions must be made after consultation with both the precast
manufacturer and the steelwork providers*

• Web openings are ignored in design*

• No significant point loads are applied to the composite beam*

• Beam must not behave as a cantilever

• For solid precast units only the topping is to be included as the joints
between the units may not be in good contact

• For hollow core units only the precast plank will be taken into account
during design

• A warning is issued in this case and subsequent design is carried out
assuming that the engineer has justified the particular condition as safe.

Bearing

A default bearing of 75mm minimum is used. This can be reduced but the
engineer must consult the precast manufacturer and steelwork provider. The
minimum flange width is therefore also reduced.

Concrete properties

Overall properties of the slab should be specified. It is up to the engineer to
decide those that govern the overall slab (PC plank + topping). It is these
properties that are used to carry out design calculations and slab self-weight.

Loading

Slab self-weight

The concrete infill in the hollow cores is not taken into account in the
calculation of the overall weight of the slab.

Where either no topping or structural topping is used, both dry and wet
overall self-weight is calculated from the self-weight of the precast unit plus
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any topping. Where a non-structural topping is used, the engineer is expected
to input the overall self-weight of the slab themselves.

Significant Point Loads

Significant point loads are beyond the scope of design in SCI P401. A warning
is issued if a significant point load is present on the composite beam.
Subsequent design calculations are carried out assuming the point load has
no effect on the composite behaviour of the beam. The engineer must carry
out additional hand calculations to justify this assumption is safe.

Shear Connectors

19mm and 22mm diameter shear studs are allowed in composite design with
precast planks.

Should the engineer choose to place shear connectors in pairs, no
dimensional check is carried out. It is assumed that the engineer has justified
their use in pairs.

Longitudinal Shear

It is assumed the shear force is divided equally between the two sides of the
beam flange.

The factors that influence the longitudinal shear capacity of your composite
beam are:

• Concrete strength, slab depth and slab width – you cannot change these
independently for the longitudinal shear check, since they apply equally to
the entire composite beam design,

• The areas of Transverse and Other reinforcement which you provide in
your beam

Transverse

Transverse reinforcement is designed to ensure VEd ≤ VRd. Additional
reinforcement to that detailed in design may be required for other purposes.

Refer to SCI P401 for recommended minimum bar sizes and spacing of
transverse reinforcement. In the case of a solid slab, the additional mesh is
ignored in transverse reinforcement calculations as only either mesh or loose
bars can be chosen. Additional mesh, however, can be applied to the slab
reinforcement – see “Other”.

It is possible to increase the maximum spacing of transverse reinforcement
from that shown in SCI P401 Table 3.1, however it must be noted that this is
being done under the engineer’s own judgement.

EN 1992-1-1, 6.2.4 is used to determine the design resistance VRd to the
longitudinal shear at the potential failure surface a-a (shown in Figure 4.7 in
SCI P401). Failure surface b-b however is not checked in design.

Refer to SCI P401 for recommendations on the detailing of transverse
reinforcement and minimum bar length.
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Other

Any “other” slab reinforcement in the topping applied to a hollow core unit is
ignored in design.

Composite Moment of Inertia

When determining the moment of inertia of a composite section with a hollow
core unit, the section is taken as a solid slab (i.e. hollow cores aren’t taken into
account).

For stiffness calculations the concrete below the neutral axis is considered as it
will contribute some stiffness. However when carrying out resistance
calculations, this concrete is ignored.

Concrete slab

NOTE While you can define concrete slabs in both normal and lightweight concrete,
design using lightweight slabs is only available for the Eurocode.

Eurocode

Warnings are issued in the design if you do not comply with the following
constraints:

• Normal weight concrete range C20/25 - C60/75 - See EN 1994-1-1:2004
Clause 3.1(2),

• Lightweight concrete range LC20/22 - LC60/66 - See EN 1994-1-1:2004
Clause 3.1(2),

• Minimum density for lightweight concrete 1750 kg/m3 - see EN
1994-1-1:2004 Clause 6.6.3.1(1).

Metal deck
Minimum lap distance

The position and attachment of the decking is taken into account in the
longitudinal shear resistance calculations.

The applied longitudinal shear force is calculated at the center-line of the
beam, and at the position of the lap (if known). If the position of the lap is not
known, then the default value of 0mm should be used (that is the lap is at the
center-line of the beam) as this is the worst case scenario.

Stud strength
The stud properties you can choose from are appropriate to the stud source.

All types of stud may be positioned in a range of patterns.
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Stud groups - Head Code ACI/AISC

You can allow group sizes of 1, 2, 3 or 4 studs - any group sizes that you don't
want to be considered can be excluded.

For example, if you do not set up groups with 3 or 4 studs, then in auto-design
the program will only try to achieve a successful design with a maximum of 2
studs in a group.

For each group that you allow you must enter the 'Set distance emid to' - as
either >= 2in or < 2in and you also specify the pattern to be adopted (e.g.
along the beam, across the beam, or staggered).

Stud groups - Head Code Eurocode or BS

You can allow group sizes of 1 or 2 studs - any group sizes that you don't want
to be considered can be excluded.

For example, if you do not set up groups with 2 studs, then in auto-design the
program will only try to achieve a successful design with a maximum of 1 stud
in a group.

For groups with 2 studs you must specify the pattern to be adopted (e.g. along
the beam, across the beam, or staggered).

NOTE It is up to you to check that a particular pattern fits within the confines of the
rib and beam flange since Tekla Structural Designer will draw it (and use it in
design) anyway.

Optimize shear interaction

If you choose the option to optimize the shear interaction, then Tekla
Structural Designer will progressively reduce the number of studs either until
the minimum number of studs to resist the applied moment is found, until the
minimum allowable interaction ratio is reached or until the minimum spacing
requirements are reached. This results in partial shear connection.

Connector layout
When running in Auto-design mode you may not want to specify the stud
layout at the start of the design process. To work in this way check Auto-layout
to have the program automatically control how the stud design will proceed.
When the beam is subsequently designed Auto-layout invokes an automatic
calculation of the required number of studs, which is optimized to provide an
efficient design.

NOTE 'Auto layout' can actually be checked regardless of whether you are auto
designing the beam size or checking it. The combination of 'Check' design with
'Auto layout' of studs can be used to assist you to rationalize your designs e.g.
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to force a beam to be the same size as others in the building but have Tekla
Structural Designer determine the most efficient layout of studs.

You may choose to perform the initial design with Auto-layout checked and
then refine the spacing with Auto-layout cleared if the spacing is not exactly as
you require. This may arise if for instance the theoretical design needs to be
marginally adjusted for practical reasons on site.

Auto-layout for perpendicular decks

For perpendicular decks, the Auto-layout dialog provides two options for
laying out the studs:

• Uniform

• Non-uniform

Uniform

The Uniform option forces placement in ribs at the same uniform spacing
along the whole length of the beam.

Whether the stud groups are placed in every rib (as shown above), alternate
ribs, or every third rib etc. can be controlled by adjusting the limits you set for
Minimum group spacing ( ) x rib and Maximum group spacing ( ) x rib.

The number of studs in each group will be the same along the whole length of
the beam, this number can be controlled by adjusting the limits you set on the
Stud strength page.

NOTE Example:

If you set Minimum group spacing 2 x rib and Maximum group spacing 3 x rib,
then the program will only attempt to achieve a solution with studs placed in
alternate ribs, or studs placed in every third rib. It will not consider a solution
in which studs are placed in every rib.

Additionally, if on the Studs - Strength page, you have allowed groups of 1
stud and 2 studs; then if 1 stud per group proves to be insufficient the
program will then consider 2 studs per group.

Non-uniform

If optimization has been checked (see Optimize shear interaction (page 208))
studs are placed at suitable rib intervals (every rib, alternate ribs, every third
rib etc.), in order to achieve sufficient interaction without falling below the
minimum allowed by the code.
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NOTE The optimum and minimum amounts of shear connection are defaulted to
50% and 25% respectively. These can be adjusted if required.

If optimization has not been checked, studs are placed at suitable rib intervals
in order to achieve 100% interaction.

Knowing the number of studs necessary to achieve the required level of
interaction, it is possible that placement at a given rib interval could result in a
shortfall; the program will attempt to accommodate this by working in from
the ends, (as shown in the example below). If every rib is occupied and there is
still a shortfall, the remainder are 'doubled-up', by working in from the ends
once more.

In this example the point of maximum moment occurs one third of the way
along the span, this results in an asymmetric layout. If you prefer to avoid such
arrangements you can select Adjust layout to ensure symmetrical about
centerline. A redesign would then result in the symmetric layout shown below.

For both Uniform and Non-uniform layouts, if the minimum level of interaction
cannot be achieved this is indicated on the design summary thus: “Not able to
design stud layout”.

Auto-layout for parallel decks

For parallel decks, the Auto-layout again provides Uniform and Non-uniform
layout options, but the way these work is slightly different.

Uniform

The Uniform option forces placement at a uniform spacing along the whole
length of the beam. The spacing adopted will be within the limits you set for
Minimum group spacing distance and Maximum group spacing distance. If the
point of maximum moment does not occur at mid span, the resulting layout
will still be symmetric.

The number of studs in each group will be the same along the whole length of
the beam, this number can be controlled by adjusting the limits you set on the
Stud strength page.
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Non-uniform

If optimization has been checked (see Optimize shear interaction (page 208))
studs are placed at a suitable spacing in order to achieve sufficient interaction
without falling below the minimum allowed by the code.

If optimization has not been checked, studs are placed at a suitable spacing in
order to achieve 100% interaction.

If the point of maximum moment does not occur at mid span, the resulting
non-uniform layout can be asymmetric as shown below.

For both Uniform and Non-uniform layouts, if the minimum level of interaction
cannot be achieved this is indicated on the design summary thus: “Not able to
design stud layout”.

Manual Stud Layout

You may prefer to manually define/adjust the group spacing along the beam.
This can be achieved by unchecking Auto layout.

NOTE If you specify the stud spacing manually, then it is most important to note:

• the resulting design may not be the optimal design possible for the beam,
or

• composite design may not be possible for the stud spacing which you
have specified.

To generate groups of studs at regular intervals along the whole beam use the
Quick layout facility. Alternatively, if you require to explicitly define the stud
layout to be adopted for discrete lengths along the beam use the Layout table.

Manual layout for Perpendicular decks

For perpendicular decks, the dialog for manual layouts is as shown:
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To use Quick layout, proceed in one of two ways:

• Choose to position groups in either every rib, or alternate ribs, then specify
the number of studs required in the group and click Generate.

• Alternatively: specify the total number of studs, then when you generate, if
the number specified is greater than the number of ribs, one will be placed
in every rib and the remainder will be 'doubled-up' in the ribs at each end
starting from the supports. Similarly if the number specified is less than the
number of ribs, but greater than the number of alternate ribs, one will be
placed in every alternate rib and the remainder will be placed in the empty
ribs. Limits of 600mm or 4 x overall slab depth, (whichever is less), are
considered.

To use the Layout table:

• For each segment you should define the following parameters: No. of
connectors in length and No. of connectors in group; Group spacing x rib.
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Your input for these parameters is used to automatically determine Distance
end 2 - this latter parameter cannot be adjusted directly, hence it is dimmed.

• If required click Insert to divide the beam into additional segments.
(Similarly Delete will remove segments). You can then specify a different
stud layout for each segment.

• We would advise that having entered No. of studs in length, group and
spacing and ignoring Distance ends 1 and 2 you click Update, this will
automatically fill in the missing fields.
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Manual layout for Parallel decks

For parallel decks, the dialog for manual layouts is as shown:

To use Quick layout, proceed in one of two ways:

• Choose to position groups at a set repeat distance, then specify the
number of studs required in the group and click Generate.
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• Alternatively: specify the total number of studs, then click Generate - the
program calculates the repeat distance automatically, subject to the code
limits.

To use the Layout table:

• The preferred method is to choose the option Spacing distance automatic,
in which case you can adjust the No. of connectors in length and No. of
connectors in group. Alternatively you could choose the option Number in
length automatic and then adjust No. of connectors in group and Group
spacing dist.

• If required click Insert to divide the beam into additional segments.
(Similarly Delete will remove segments). You can then specify Distance end
1 for each new segment and it’s own stud layout.

Composite beam restraints
You can independently set both the top and bottom flanges of a composite
beam as continuously restrained in the Properties window.

When the beam is initially created the decking direction is unknown until the
beam is actually placed and the floor slab and direction are also created.
Hence defaults are provided for each eventuality.

The defaults are:

• for perpendicular decks the deck restrains the beam top flange

• for parallel decks the deck does NOT restrain the beam top flange

• for precast decks the deck restrains the beam top flange

• for all decks the deck does NOT restrain the beam bottom flange

By setting the top flange as continuously restrained and/or the bottom flange
as continuously restrained the relevant buckling checks are not performed
during the design process.

When not continuously restrained, LTB and Compression restraints are
determined from the incoming members described within the Tekla Structural
Designer model. The buckling checks are based on these.

By right-clicking a member to edit its properties in the Property dialog, you
are then able to edit the restraints. You can indicate continuously restrained
sub-beams and also edit length factors.

For composite beams the buckling checks are only performed at construction
stage as at composite stage they are always assumed to be fully restrained.

TIP Restraint settings for composite beams can be easily reviewed and adjusted
graphically via Review View > Show/ Alter State. For more details see: Review and
modify restraints
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Composite beam natural frequency
A natural frequency check can optionally be requested. When activated a
simple (design model) approach is taken based on uniform loading and pin
supports. This fairly simple calculation is provided to the designer for
information only. The calculation can be too coarse particularly for long span
beams and does not consider the response side of the behaviour i.e. the
reaction of the building occupants to any particular limiting value for the floor
system under consideration. In such cases the designer has the option to
perform a 1st order modal analysis.

Composite beam transverse reinforcement
This reinforcement is be provided specifically to resist longitudinal shear.

Since the profile metal decking can be perpendicular, parallel or at any other
angle to the supporting beam the following assumptions have been made:

• if you use single bars they are always assumed to be at 90° to the span of
the beam,

• if you use mesh then it is assumed to be laid so that the main bars are at
90° to the span of the beam.

The reinforcement you specify is assumed to be placed at a position in the
depth of the slab where it is able to contribute to the longitudinal shear
resistance

Automatic transverse shear reinforcement design

It is possible to automatically design the amount of transverse shear
reinforcement for each beam. This is achieved in Tekla Structural Designer by
checking the Auto-select option on the Transverse reinforcement tab of the
Composite Beam Properties.

NOTE The Auto-select option for designing transverse shear reinforcement is only
available when the beam is in auto-design mode.

If you are checking a beam, then you must specify the transverse shear
reinforcement that you will provide, and then check out this arrangement.

The auto-selected bars can be tied into the stud group spacing by checking the
Bar spacing as a multiple of stud spacing option. Alternatively, the spacing can
be controlled directly by the user.
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Bar spacing as a multiple of stud spacing

When the option Bar spacing as a multiple of stud spacing is checked, the
Transverse Reinforcement tab provides the user with controls on the bar size
and the multiples of stud spacing.

These can be used to achieve a selection of say, 12mm diameter bars at 2
times the stud spacing, with a slightly greater area than a less preferable
16mm diameter bars at 4 times the stud spacing.

Controlling the bar spacing directly

When the option Bar spacing as a multiple of stud spacing is not checked, the
Transverse Reinforcement tab provides the user with direct control on the bar
size and the bar spacing.

Allow non-composite design
Typically, at the outset you will know which beams are to be non-composite
and which are to be composite and you will have specified the construction
type accordingly. However, circumstances can arise in which a beam initially
intended to be composite proves to be ineffective. Examples might be:

• very small beams,

• beams with a significant point load close to a support,

• beams where the deck is at a shallow angle to the beam, hence the stud
spacing is impractical,

• beams where, for a variety of reasons, it is not possible to provide an
adequate number of studs, and

• edge beams, where the advantages of composite design (e.g. reduced
depth) are not so clear

Where Tekla Structural Designer is unable to find a section size which works
compositely, you can ask for a non-composite design for the same loading.
You will find that this facility is particularly useful when you right-click a key
beam in the model in order to perform an individual member design.

To invoke non-composite design

1. Select the composite beam(s) as required.

2. In the Properties Window select Allow non-composite design

Steel column design
Click the following links to find out more:

• Steel column overview (page 219)

• Simple columns (page 220)
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• Steel column fabrication (page 220)

• Steel column restraints (page 224)

• Steel column connection eccentricity moments (page 225)

• Splice and splice offset (page 230)

• Steel column web openings (page 231)

• Instability factor (page 187)

Steel column overview
Tekla Structural Designer allows you to analyse and design a structural steel
column which can have moment or simple connections with incoming
members, and which can have fixity applied at the base. The column can have
incoming beams which may also be capable of providing restraint, and may
have splices along its length at which the section size may vary. You are
responsible for designing the splices appropriately.

In its simplest form a steel column can be a single pin ended member between
construction levels that are designated as floors.

More typically it will be continuous past one or more floor levels, the whole
forming one single entity typically from base to roof.

Steel columns that share moments with steel beams form part of a rigid
moment resisting frame.

In all cases you are responsible for setting the effective lengths to be used
appropriate to the provided restraint conditions. All defaults are set to 1.0L.

Design is performed using a set of design forces obtained from 3D Analysis.
(Grillage Chasedown Analysis and FE Chasedown Analysis results are not
considered.)

If working to either AISC or Eurocodes, the design will take into consideration
additional moments resulting from the eccentricity of pinned beam end
connections. If working to other head codes, while the eccentricity moments
are calculated, they are not used in the design.

Steel member orientation

Tekla Structural Designer considers member orientation when displaying
analysis results. Therefore, to apply the sign convention correctly, you need to
know which is the end 1 and which is the end 2 of the member. For columns
you also need to be able to identify the four faces: A, B, C & D.

If you select the Direction option for a member in Scene Content, Tekla
Structural Designer displays a direction arrow the member which points points
from end 1 to end 2 of the member. For columns the direction is always from
bottom to the top and the arrow is always drawn adjacent to Face A. Looking
down from the top of a column, Face B, C, and D then follow in the clockwise
direction.
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Simple columns
A steel column can be designated as a `simple column' - in which case specific
design rules are required.

A simple column should not have any applied loading in its length.

Simple columns are subject to axial forces and moments due to eccentricity of
beam reactions.

In order to prevent end fixity moments you would have to manually pin the
ends of the column.

NOTE The simple column design rules have not yet been implemented in
Tekla Structural Designer: such columns are thus classed as “beyond
scope” when designed.

Steel column fabrication

Fabrication types summary - all head codes

The steel column fabrication types that can currently be designed in Tekla
Structural Designer are dependent on the design code, and also the
construction type specified in the column properties - refer to the following
table for details.

Construction: Non-composite column

Rolled Plated Concrete filled Concrete
encased

AISC Yes No No No
Eurocode Yes No No No
BS Yes No No No
IS Yes Yes No No
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AS Yes Yes No No

Construction: Composite column

Rolled Plated

AISC No No
Eurocode No No
BS No No
IS No No
AS No No

Plated columns - Indian head code

When the Fabrication type is set to Plated, a range of steel compound sections
can be designed to the Indian design code.

The section shapes supported are:

• Rolled Channels back to back

• Rolled Channels toe to toe

• Doubled rolled I sections
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• Doubled rolled I sections with plates

The scope of design of these compound sections includes both beams and
columns and autodesign.

NOTE Autodesign requires a Design section order to be specified, a new
design section order can be created specifically for compound
sections once these have been added to the sections database.

In general, the scope of strength checks undertaken is the same as for rolled
sections with the following current limitations:

• The design is for non-composite sections only.

• Slender Sections are beyond scope.

• High Shear case with minor axis moment is beyond scope.

• Design of the lacing or battening system is beyond scope.

• Only parallel flange sections can be used.

Plated columns - Australian head code

When the Fabrication type is set to Plated, only welded doubly symmetric I-
section columns can be designed to the Australian code.

A pre-defined range of these is available from the Welded Columns page of
the Select Section dialog - these can be both checked and autodesigned.

NOTE Autodesign requires a Design section order to be specified, the Welded
Columns design section order is provided for this purpose.

While you can add to the range of welded columns in the Select Section dialog
by clicking the Add... button, any such user-defined columns can only be
analyzed, but are not designed.

Plated columns available on other pages of the Select Section dialog can be
analyzed, but are not designed.
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Composite, concrete filled, and concrete encased steel columns

Whilst composite columns, concrete filled hollow sections and concrete
encased sections can be specified in Tekla Structural Designer they are not
designed.

For composite columns and concrete filled hollow sections, the analysis uses
the bare steel inertia and not the ‘effective composite inertia’. This is
conservative as the lower stiffness of the bare section will promote more
second-order effects. On the other hand for concrete encased columns Tekla
Structural Designer takes into account the encasement based on the size
specified by the user.

When working to the US head code: AISC 360-16, sub-section I1.5 deals with
the calculation of stiffness for concrete filled hollow sections and concrete
encased sections used in the Direct Analysis Method (DAM). In accordance
with C2.3, Tekla Structural Designer takes account of the standard stiffness
adjustment factor of 0.8 with τb set to 1.0 given the additional notional load of
0.1% is also applied. I1.5 requires these types of member to take τb as 0.8
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when considering the flexural stiffness. The user can achieve this for concrete
encased columns by adjusting the Modification Factors in the . (For composite
columns and concrete filled hollow sections which both use the bare steel
stiffness, no adjustment is required).

Steel column restraints
Restraints to flexural and torsional buckling are determined from the incoming 
members that connect to the column. The buckling checks are based on these 
restraints.

Restraints are considered effective on a particular plane providing they are 
within ±45° to the local coordinate axis system.

In all cases Tekla Structural Designer sets the default unrestrained length 
factor between restraints to 1.0.

You have the control to set any unrestrained length to be continuously 
restrained over that length - when set in this way the relevant buckling check is 
not performed during the design process.

NOTE The Steel Column Properties window only allows you to set entire 
stacks as either continuously restrained or unrestrained. In order to
specify restraints between the incoming members within each stack it 
is necessary to open the Steel Column Property dialog instead.

TIP As an alternative to using the Steel Column Property dialog, restraint 
settings for steel columns can be easily reviewed and adjusted
graphically via Review View > Show/ Alter State. For more details see: 
Review and modify restraints

Lateral torsional buckling (LTB):

• Members framing into either Face B or D are by default assumed to 
provide full LTB restraint. You therefore need to consider whether or not your 
particular configuration of incoming members is capable of providing this level 
of LTB restraint. If necessary you can edit the default restraint provision by se-
lecting the Face A override and/or Face C override checkboxes as appropriate.

NOTE Face A can be identified graphically, from which the other faces 
follow, see: Steel member orientation (page 219)

Compression/Strut buckling:

• Members framing into either Face A or C will by default provide restraint
against major axis compression buckling. Members framing into either
Face B or D will by default provide restraint against minor axis compression 
buckling. You can remove these default restraints if required by selecting 
the Major override and/or Minor override checkboxes.
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Steel column connection eccentricity moments

Overview

Nominal eccentricity moments that arise from beam end reactions are
considered in Tekla Structural Designer's steel column design.

These moments do not come directly from the global analysis but instead are
calculated at the ‘load analysis’ post-processing stage as follows:

• At each level the eccentricity of each connection is taken as half the depth
of the supporting column, plus an additional user defined offset from the
column face.

• At each level the pinned beam end reactions connecting to the column at
each face are determined.

• If braces also connect to the same face, the force in the brace will also be
taken into consideration if the "Include force in eccentricity moment" brace
release property is checked for the appropriate end of the brace.

• Taking the beam end reactions (and brace forces if included) on opposite
faces multiplied by their connection eccentricities, resultant eccentricity
moments are determined.

• These moments are then distributed above and below the level based on
the column stiffnesses.

NOTE The eccentricity moments are typically assumed not to be transferred
beyond the level at which they are applied.

Patterning of eccentricity moments

The eccentricity moments resulting from live loads can be patterned if
required to account for the likelihood that the load is not present on all spans
simultaneously.
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When eccentricity moment patterning is enabled you must then indicate which
of the live cases are to be patterned, (you may for example decide not to
pattern storage loads.)

For those live cases with patterning enabled, five patterns are considered.
These are:

Pattern 0 is for the full live load at all positions i.e. no patterning - this gives the
maximum axial force in any one stack with (usually) lower eccentricity
moment.

Patterns 1 to 4 are ‘true’ patterns switching live load ‘on’ and ‘off at each pair of
positions around the column in order to generate the maximum live
eccentricity moments about the major and minor axes of the column.

NOTE The same pattern is applied at the top and bottom of the stack, so for
example it is not possible to have P1 at the top and P4 at the bottom.

Design

NOTE Patterned eccentricity moments are only considered in the design for the
AISC or Eurocode head codes. If working to other head codes, while the
patterned eccentricity moments are calculated, only the fully loaded pattern
(P0) is used in the design.

In general, eccentricity moments are only added to the 'real' moments at the
ends of each stack and are only added if they make the design worse.

If you have elected to pattern live eccentricity moments these are considered
in conjunction with the eccentricity moments from other types of load, and
with the 'real' moments.

• As the eccentricity moments are considered localised to each floor the full
axial force from other floors is maintained. The axial force at the level
under consideration will be slightly reduced with patterning enabled as the
live floor loading will not be present on all sides simultaneously.

• Since it is not known whether a reduced axial force with more eccentricity
moment is a worse case than full axial and a lower (or even zero, in the
balanced case) eccentricity moment, the design loops through all patterns
in order to consider each eventuality.

• The patterned eccentricity moments are considered in all design checks
apart from 'Shear', (which is unaffected).
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• To keep the design details to a manageable level, results for every pattern
are not listed; the pattern which produces the governing design forces is
listed in the check combination and location tree and details heading, (as
shown below).

Define connection eccentricity values

The eccentricities at each level are defined in the column properties and a
different eccentricity can be applied to each face.

As long as the option to apply eccentricity at a face is checked, the total
eccentricity at that face is taken as half the dimension of the supporting
column, plus the additional eccentricity from the face as specified in the
Properties window shown above.

If you uncheck the option to apply eccentricity at a face the end reaction on
that face is applied axially.
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NOTE Face A can be identified graphically, from which the other faces follow, see:
Steel member orientation (page 219)

Pattern eccentricity moments for live loadcases

Patterning can be switched on for specific live loadcases in a two-step process
as follows:

1. From the Home ribbon:

a. Click Model Settings > Loading > General

b. Select Use patterning of eccentricity moments for steel columns

c. Click OK

2. From the Loadcases page of the Loading dialog:

a. Select a live loadcase that you want to be patterned

b. Select Pattern Eccentricity Moments for Steel Columns

c. When patterning has been selected for each of the required
loadcases, click OK

Review connection eccentricity moments

Because eccentricity moments do not come directly from the global analysis
they cannot be displayed graphically in a Results View, they can only be
displayed on a column by column basis by opening a Load Analysis View.

With a Load Analysis View open and the required loadcase or combination
selected in the Loading list, you then select the Major, or Minor direction in
the Loading Analysis ribbon.

The 'real' moments are displayed as a shaded diagram using solid lines, the
eccentricity moments as an unshaded using dashed lines:
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The red marker line can be set to a specified distance in the Properties
window to allow the real and ecc. moment values above and below the line to
be displayed.

Displaying patterned eccentricity moments

When you select a patterned live loadcase a Show ecc. moment pattern box
will become available in the Properties window.

After selecting Show ecc. moment pattern you can then click Ecc. moment
pattern in order to select the pattern to display from the droplist.
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Splice and splice offset
Splices are allowed at floor levels only and must be placed at changes of angle
between two adjacent stacks and at changes of section size or type. A
validation error will result if this is not the case. The splice can be given an
offset from the floor level - the default of 500mm is considered not to be
structurally significant.

You must detail the splice to resist the applied forces and moments. The detail
should provide continuity of stiffness and strength. Splices given considerable
offset should be designed to take account of the P-d moment (also known as
moment induced by strut action) at the position as well as the forces from the
analysis.

NOTE To remind you of the above requirement the following warning is
issued when splice loads are exported to BIM as part of the analysis
results: "The loads given do not include any additional moment due to
member buckling." A similar warning is also issued when splice loads
are included in reports. This is an explicit requirement in the British
Standards (Clause 6.1.8.2 of BS 5950-1), although as the same
engineering principle applies the world over, we issue it for all head
codes.

Each lift (length between splices) of a general column can be of different
section size and grade. Different section types within the same column are not
allowed due to the particularly complex design routines that general columns
require. You are responsible for guaranteeing that the splice detail ensures
that the assumptions in the analysis model are achieved and that any
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difference in the size of section between lifts can be accommodated
practically.

Steel column web openings

NOTE In the current release of the program the design or checking of columns with
web openings is “Beyond Scope”

You can define rectangular or circular openings and these can be stiffened on
one, or on both sides.

Web openings can be added to a column by a 'Quick-layout' process or
manually.

The 'Quick-layout' process, which is activated using the check box on the Web
openings dialog page, adds web openings which meet certain geometric and
proximity recommendations (taken from Table 2.1 of SCI Publication P355 if
the Head Code is set to Eurocode, or taken from SCI Publication P068 if the
Head Code is set to BS). The openings so created are the maximum depth
spaced at the minimum centers recommended for the section size.

Web openings can also be defined manually. With Quick-layout cleared, the
`Add' button adds a new line to the web openings grid to allow the geometric
properties of the web opening to be defined.

Column base plate design
The definition and check of column base plates is an intrinsic part of Tekla
Structural Designer - all data associated with a particular column base plate is
held within the model. Only simple column base design checks under
Eurocode and US head code are supported in the current release.

Click the following links to find out more:

• Column base plate design workflow (page 231)

Related video

Simple column base plate workflow and design

Column base plate design workflow

NOTE To find out more about the theory, assumptions and checks performed for
the head code being worked to, see: or .

Related video

Simple column base plate workflow and design
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Data sources

Whilst all column base plate data is held in the model, the source of such data
is several fold. This includes:

• Default data - when the column base plates within the model are set up by
Tekla Structural Designer, intelligent defaults are used that can establish a
part or full solution to the configuration.

• Derived data - the model already holds such items as the section size and
grade of the column and concrete foundation, plus the design forces.

• Property Sets - certain data can be set to be used to modify existing
properties of the column base plates e.g. base plate steel grade, bolt size
etc. For more information, see:

• Added data - any individual column base plate can be edited to improve or
add to the configuration e.g. additional bolts.

Generate base plates

When a steel column is created or copied a base plate is automatically
generated at the lower end of the column if a support is required.

Base plates can also be created by clicking the (Add) Base Plate button on the
Design ribbon and then selecting a steel column in the model. Note that
moving a steel column that already has a base plate attached will
automatically move the attached base plate with it.

Design columns

Base plates have the capability of automatically sizing when the column size
changes.

This Autosize option, which is on as default, will update the plate size and the
bolt layout when the column size changes to avoid an invalid base plate
configuration. This is not to be confused with automatic design of the base
plate which is beyond the scope of Tekla Structural Designer.

Edit base plate properties

Once the associated columns are sized it’s possible to turn off Autosize and
start to finalize the base plate configuration.

This is easily done based on the column size by navigating to Structure Tree >
Members > Base Plates and selecting the column size.

You can then adjust the column base plate properties in the Properties
window.

Engineers Handbooks 232 Steel design handbook



Alternatively, and also for more complex bolt/rod layouts, you can right click
an individual base plate and select Edit from the context menu, which opens
an Edit dialog for all of the base plate properties.

You can see whether your base plate configuration looks sensible by display in
the Structure 3D view.

To copy, move or delete base plates

• Base plates can be moved/copied/deleted independently of the column
they are associated to as long as the target location is the bottom of a valid
column.

• Base plates can be moved/copied/deleted with the associated column.

• By simply selecting the column to move/copy/delete the base plate, as
default, will be selected too.

• You can chose to only move/copy/delete the column by de-selecting the
base plate from the usual dialog.

Check base plates

Having established and rationalized the base plate configurations it is now
logical to carry out a design check.

You can check an individual base plate, or a selection of base plates and adjust
them as you proceed or, once you are content with the layout, you can check
them all in a single operation:

• To check an individual base plate - select it in the model (or in the Structure
Tree), right-click to display the context menu and select Check Base Plate

• To check a selection of base plates - navigate to the Structure Tree >
Members > Base Plates, select the column size to check, right-click and
select Check Base Plates

• To check all base plates in the model - navigate to the Design toolbar and
select Check Base Plates

Review check status and utilization

You can then use Review View to visually check which column base plates have
passed and which have not, and their associated utilization ratios.
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View results and print calculations

Results of your column base plate checks can be viewed on the screen by right
clicking on a base plate and selecting Check Base Plate from the context
menu.

When you are ready to create a report:

• if you require the input, diagrams, and design results you should
incorporate the Base Plates chapter,

• if you only require a summary of base plate design check calculations you
should include the Base Plate Design Summary chapter. (The default
includes this along with design calculations for other member types in the
model).

• if you require a material list containing base plate components, for
example rods (US), or bolts (Eurocode), and anchor plates, these are listed
in the Material Listing report, as well as the plates themselves, but not the
welds.
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Create drawings

Base plate detail drawings that convey the structural intent are easy to create.
It should be borne in mind that these are NOT the final detail drawings, their
purpose is to eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer.

Steel brace design

Steel brace overview
Tekla Structural Designer allows you to analyze and design a steel member
with pinned end connections for axial compression and tension.

Steel braces can be specified as rolled I-sections, C-sections, T-sections,
rectangular, square and circular hollow sections, angles, double angles, and
flat sections.
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NOTE If working to the US head code, a brace specified as a flat section can
only be analyzed, but design is beyond scope.

Design is performed using a set of design forces obtained from 3D Analysis.
(Grillage Chasedown Analysis and FE Chasedown Analysis results are not
required.)

Applied loading

The following points should be noted:

• Loads for the brace are derived from the building model.

• Element loads cannot be applied directly to the brace itself.

• Live and Roof Live load reductions are not applied.

• Moments due to self weight loading are ignored.

Design Forces

The design forces for strength checks are obtained from an analysis of the
entire structure. Braces can be subject to axial compression or tension, but will
not be subject to major and minor axis bending.

Input method for A and V Braces
A and V Braces should be modeled using special tools which can be found on
the 'Steel Brace' drop list in the 'Steel' section on the 'Model' tab.

Although it is also possible to model the exact same brace arrangement using
individual elements created using the simple 'Steel Brace' command, it is
important to note that whilst the Notional Loads \ EHFs (Equivalent Horizontal
Forces) calculated for models built using the A or V Brace tools are correct, this
is not the case when the A or V braces are built up out of individual brace
members. In this latter case, elements of the vertical loads that are supported
by the bracing system are 'lost' and are not included in the Notional Load \
EHF calculations with the result that the calculated Notional Loads \ EHFs are
not correct.

Steel brace in compression
Effective length factors are defined for each axis of buckling.

• Effective length factor y-y

• Effective length factor z-z

NOTE If designing to British Standards, see Steel brace in compression - BS
5950-1:2000 (page 237)
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Steel brace in tension
The net area of the section is required for tension checks. This can be specified
either as:

• Percentage value

• Effective net area

NOTE If designing to British Standards, see Steel brace in tension - BS 5950-1:2000
(page 237)

Steel brace in compression - BS 5950-1:2000
If either an Angle (single or double) or Channel or Tee section has been
selected as the brace member then a 'Connection at each end' property box
appears which allows selection of an appropriate Clause from Table 25 of the
BS code to describe the connection type.

The default Clauses from Table 25 are as follows:

Single Angle 4.7.10.2a
Double Angle 4.7.10.3d
Channel 4.7.10.4b
Tee 4.7.10.5b

Notes:

1. Clauses 4.7.10.2b, 4.7.10.2c, 4.7.10.3b, 4.7.10.3c, 4.7.10.3d and 4.7.10.3e
only apply to Bolted connections so in these cases 'Bolted' should be
selected in the 'Connection' property box. ('Bolted' is the default
connection.)

2. For Angle (single and double), Channel and Tee sections the Effective
Length Factors will be auto-completed according to the connection Clause
selected but these Factors can be changed if required. For Angle (single
and double) sections the length Lv-v is always assumed to be L/3 and the
Effective Length Factor v-v will act on this Lv-v.

3. For single Angle sections the longer leg is assumed to be the connected
element unless 'Short attached' is checked on the Size page of the dialog.

4. For double unequal Angle sections, whichever leg is not the back-to-back
leg is assumed to be the connected element when connection Clauses
4.7.10.3a and 4.7.10.3b are selected, and vice versa with Clauses 4.7.10.3c,
4.7.10.3d and 4.7.10.3e
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Steel brace in tension - BS 5950-1:2000
Brace tension capacity is calculated according to section type as follows:

A. Hollow sections (CHS, RHS, SHS): Gross area capacity
B. Angle, Channel, Tee sections: Reduced effective net area capacity

(Clauses 4.6.3.1 and 4.6.3.2)
C. I/H and any other sections: Effective net area capacity (Clause

4.6.1)

Notes:

1. For section types B and C listed above, an Effective net area (Ae) should be
entered either as a percentage of the gross area (Ag) or as an absolute
value. The default is to use 100% of Ag, and an absolute value cannot be
used if autodesign is also selected.

2. The 'Geometry' property needs to be selected manually if autodesign is
also selected, otherwise the 'Geometry' property does not appear visible.

Steel joist design

Steel joist design overview
Steel joists, (or bar joists), are a specific type of members used in the United
States. They are simply supported secondary members that do not support
any other members - they only support loaded areas, i.e. slab and roof loads.
Steel joists are constrained to standard types specified by the US Steel Joist
Institute, and standardized in terms of span, depth and load carrying capacity.

In Tekla Structural Designer steel joist design is performed in accordance with
the 44th Edition of the Steel Joist Institute (SJI) specification, which uses a
similar approach to that embodied in AISC 360-05/10/16 LRFD and ASD.

Standard types

Steel joists are constrained to standard types specified by the Steel Joist
Institute. They are standardized in terms of span, depth and load carrying
capacity. There are four standard types of steel joist available in Tekla
Structural Designer.

• K series joists - parallel chord steel joists (2 variations; rod or angle webs) -
depths 8" to 30" with spans up to 60ft.

• Including 2.5 K series joist substitutes - a depth of 2.5in, intended to be
used for spans up to 10ft.

• KCS series joists - K series adapted and specially designed for constant
moment/shear along length (position of point loads become irrelevant).
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• LH series joists - long span joists - depths 18" to 48" for clear spans up to
96ft.

• DLH series joists - deep long span joists - depths 52" to 120" for clear spans
up to 240ft.

Special Joists

"SP" suffixes can be added to K, LH and DLH Series joists. Special Joists can
handle 'non-uniform' loading situations. They will attract loads and participate
in the 3D structural analysis, but they cannot be checked or designed.

Joist Girders

These are provided as an option to support steel joists. They will attract loads
and participate in the 3D structural analysis, but they cannot be checked or
designed.

Assumptions and limitations
The following assumptions and limitations currently apply to the design of
steel joists in Tekla Structural Designer:

• All steel joists are considered as simply supported members.

• Steel joists cannot be released axially.

• Cantilevered joists cannot be defined.

• Joist Girders are able to support other joists and brace members, other
joists are only able to support brace members.

• Joist inertia and area values are taken directly from the Steel Joist Institute
tables, with the exception of Joist Girders for which you must provide the
relevant data.

• For all joist types. any resulting load, other then those in the major axis,
that exceeds the user specified Ignore Forces Below setting on Design
Options is reported as a Warning in the results viewer along with the type
and value of force detected.

• Design is currently beyond scope for SP joists and Joist Girders.

• For all steel joists, it is assumed that the top chord is sufficiently braced
against lateral torsional buckling.

• There is no restriction on the minimum span for which a joist can be
defined even though due to their open web nature joists can be almost
impossible to fabricate for very small spans. The user should check the
suitability of using such a joist in these situations.

• For steel joists which support a generic concrete slab, it is assumed that the
minimum concrete slab thickness of 2 inches (50mm) is present. (SJI Steel
Joist Specification 5.9.2). This is not checked by Tekla Structural Designer.
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• In design, the user is expected to refer to the bridging requirements in the
SJI Specification and decide the appropriate details for the relevant
scenario. This is not checked by Tekla Structural Designer.

• ‘Non uniform’ loads are accommodated by KCS joists. E.g. parapet snow
drift load, partition walls. If no KCS joists can be found then SP joists can be
used for these loads but these are not designed/checked.

• Top chord extensions used as eaves and awnings are not designed.

• Camber of the joists is not shown in the graphics nor handled by Tekla
Structural Designer.

• The design and specification of the joist seats (regular or sloping) is not
handled by Tekla Structural Designer.

• Double joist configurations cannot be defined in Tekla Structural Designer.

• The design does not consider the minimum bearing requirements for K,
KCS, LH or DLH joists – these are the responsibility of the designer/
engineer.

• Customisation of KCS joists to accommodate any applied concentrated
loads is not considered byTekla Structural Designer.

• Loadings for accessories to the joist are not included in the standard load
tables. An allowance for this should be included by the designer in the
loading of the model.

• Steel joists are not designed for composite action and when supported by
conventional composite a validation warning is issued. Composite Joists, CJ
Series, cannot be defined in Tekla Structural Designer.

• Moment connections at steel joist ends are not allowed.

• Duct openings are stated in the standard Steel Joist Tables for standard
panel sizes. Actual spacing and layout of the duct arrangements are
beyond the scope of Tekla Structural Designer.

• Fire resistance requirements are not designed nor checked in Tekla
Structural Designer, the designer must ensure suitable compliance.

• There is no design for net uplift currently although uplift can exist in a
combination provided it is overcome by other gravity loads. The designer
should ensure that any uplift due to Wind loads is accurate as the current
version of the Wind Wizard does not determine wind forces for
‘Components and Cladding’.

• Sloping joists are permitted providing the loading is normal to the joist and
the span will be taken as the sloped length. However, joists with sloping
top chords are not allowed.

• SJI allows grades other than 50 ksi [345 MPa] to be used but the Safe Load
Table values are based on 50 ksi [345 MPa]. Tekla Structural Designer
defaults to Grade A992 – 50, it is the user's responsibility to check the
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suitability of this or any other grade they wish to use. No adjustment is
made for higher or lower grades and this is entirely the designer’s call.

Loading
The loads on the joist are from ‘one-way’ load decomposition. The joist is
analyzed as a pin ended beam, only loads in the plane of the web are
considered.

Joist Girders should only be used to support steel joists, and should therefore
have regularly spaced point loads of similar magnitude along their length. As
they are not designed or checked various types of loading could be present, so
the user should verify that they have been used appropriately.

Steel Joists are essentially used to support full length uniformly distributed
loads, however it is acceptable for the joist to be designed to support other
load configurations. This requires the loading pattern on the joist to be
assessed and classified into one of the following loading types: Uniform (or
near uniform), Equivalent Uniform, or Non-Uniform.

The classification of loading type is made in accordance with the following
methods:

Loading
Type

Method

Uniform • No concentrated (point) loads are allowed.

• Loads must be (member) Full UDL, UDL, VDL or Trapezoidal
Load acting in the Major or Global Z directions.

• Loads must be applied over the full length of the beam.

• A percentage load tolerance is calculated and provided this is
less than the uniform load tolerance specified in Design
Settings, then the load combination is classified as ‘Uniform’.

Equivalent
Uniform

• Determine the position of the point of zero shear relative to
the centre span point of the joist.

• If the point of zero shear is located outside the maximum
eccentricity of zero shear limit specified in Design Settings,
then the procedure is ended and the load combination is
classified as ‘Non-uniform’.

• If the point of zero shear is located within the maximum
eccentricity of zero shear limit then an ‘Equivalent Uniform’
load is established.

• The equivalent uniform load is then used to calculate
maximum shear force, bending moment and deflection. The
percentage variation of these values to the actual values from
the beam analysis is then calculated and compared with the
equivalent load tolerance limit specified in Design Settings.
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Loading
Type

Method

Non-
Uniform

• All loads not qualifying as ‘Uniform’ or ‘Equivalent Uniform’ to
the above methods are considered as ‘Non-uniform’.

NOTE It is possible for an individual loadcase e.g. Live to be
classified as ‘Non-uniform’ which when combined with
other loads becomes ‘Equivalent uniform’. Thus, when
designing for strength (comparing with the ‘black value’ in
the SJI Tables) the loading is valid whereas when checking
the deflection (comparing with the ‘red value’ in the SJI
tables) the service design could be invalid (Fail).

Concentrated Loads

All joists supporting concentrated loads require special treatment by the
manufacturer/fabricator even if the loading configuration can be configured as
‘Uniform’ or ‘Equivalent Uniform’ since the joist design usually presumes that
all concentrated loads are applied at panel points. It is common practice for
“field installed members” to be located at all concentrated loads not occurring
at panel points as illustrated below.

In Tekla Structural Designer concentrated loads on K, LH and DLH joists are
limited to the maximum sum of concentrated loads limit specified in Design
Settings. This value is unfactored and in the event that the sum of all
unfactored point loads in all loadcases within a combination exceeds this
value, the relevant load combination is classified as ‘Non-uniform’.

Uplift

If (net) uplift is detected for a combination no design is performed for it and a
warning message is displayed.

NOTE If uplift exists in a loadcase but is ‘overcome’ by positive loading in another
loadcase then the design is valid and no warning is displayed.
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Joist member reports
Joist design results can be viewed on the screen and incorporated into
member design reports. Joists are also included in material listing reports.

The member design report for steel joists is configurable, but limited to the
following chapters:

Chapter Content
Picture

Drawing

Loading

Design Summary

Design Calculations

Steel truss design
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Steel truss design overview
In Tekla Structural Designer although trusses can be defined in any material,
design is restricted to steel and cold formed truss members only.

The Truss Wizard provides a wide range of standard truss shapes and
configurations. This covers most practical layouts of truss. However, you can
also modify a standard truss to produce one of slightly different configuration
or manually ‘stick build’ your own truss from truss members if it is an unusual
layout.

Trusses created by the Truss Wizard will comprise a mix of the following truss
member types:

• Truss member top

• Truss member bottom

• Truss member side

• Truss internal

These are shown in two of the standard configurations below:
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Solver elements are created directly between the member insertion points -
they do not take into account major and minor snap points, or any offsets that
might have been specified in the member properties. Consequently, all
intersecting members ‘node’ at the same point – i.e. all internals meet along
the set out line of the chords; this assumes that set out lines are coincident
with the centroidal axes. Therefore, no in–plane eccentricities are considered
in the analysis and design of the trusses.

A wide range of section types can be defined that includes all the common
rolled sections. There is no restriction on the type and size of sections that can
be connected within the truss. The practicality and efficiency of connections
between members is your responsibility. A 'beyond scope' status is issued if a
section type has been applied that cannot be checked for a given design
condition.

Design is performed using a set of design forces obtained from 3D Analysis.
(Grillage Chasedown Analysis and FE Chasedown Analysis results are not
required.)

The design checks performed depend on the truss member types as follows:

• Truss member top and bottom - these are continuous members with
axial force and bending principally in the plane of the truss. They are
designed as beams (page 178) for all internal forces (axial, major and minor
axis bending and shear) depending upon the section type used. Where
tension exists in a chord member, the tension capacity is based on the
effective net area.

• Truss internal - these are restricted to be pin ended, and are designed to
the appropriate clauses for tension and compression members. Primary
bending moments due to self weight and secondary moments due to
eccentricity of their connections are ignored. Effective lengths for
compression and effective net area for bolted and welded connections can
be taken into account via the properties of the truss members.

• Truss member side - depending on the truss type selected in the Truss
Wizard these will either default to pin ended or fully fixed. If pin ended, the
design checks are the same as for Truss internal. If fully fixed at both ends
(as in the case of a Vierendeel truss), the design checks are the same as for
Truss member top and bottom.

NOTE If a (pin ended) side is intersected by another truss member then it
is still designed for axial force only, but a warning is issued
indicating the forces that have been ignored.

For top and bottom chords, conditions of restraint can be defined in and out-
of-plane for strut buckling and, top and bottom flange for lateral torsional
buckling (LTB). It is upon these that the buckling checks are based. Incoming
members are identified by the program and sensible default values for
whether these provide restraint or not are set up (see Assumptions and
Limitations section below). Restraint cannot be added where no incoming
member exists but full control of the effective length factors is provided. In all
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cases Tekla Structural Designer sets the default effective length to 1.0L, it does
not attempt to adjust the effective length (between supports for example) in
any way. You are expected to adjust the effective length factor (up or down) as
necessary. You can also indicate chord sub-beams to be continuously
restrained over their length where appropriate.

NOTE Effective length factors and continuous sub-beam restraints are edited by
right clicking on individual chords and selecting Edit chord reference from the
context menu - these can then be specified from the respective lateral and
strut restraint pages of the Properties dialog. Continuous sub-beam restraints
can also be edited in Show/Alter State > Restraints, as can restraint of
internals to chord (defaults to in-plane only for strut and unrestrained for
LTB).

Results of your truss design can be viewed on the screen and incorporated
into a report. Truss members are listed as a separate type in the Material
Listing report.

Assumptions and Limitations
Limitations

The following limitations apply:

• Web openings, plated sections including Fabsec beams (with or without
openings) and Westok beams cannot be used as truss members

• Chord members cannot be placed vertically

• The arch member of a bowstring truss is drawn and designed as a series of
facets and not as one continuous curved member

• Truss internals cannot be loaded directly and no loads from floors and
roofs are decomposed to them - sides can be loaded, but forces other than
axial are then ignored in the design if the pinned ends are not removed.

• Truss chords are not by default excluded from diaphragm action within a
floor slab, but they can be deliberately excluded if required. See: https://
teklastructuraldesigner.support.tekla.com/support-article/2816265

Assumptions - Restraints

• In both top and bottom chords the node points are assumed not to have
incoming out of plane members unless you define such members in the
model. Hence, at these positions only in-plane strut buckling restraint is
assumed as a default. You can of course change these.

• In a top chord any incoming members not at node points are assumed to
provide the following LTB and strut restraints,

• • incoming members at 90 degrees (± 45 degrees) to the plane of the
truss i.e. horizontal for a truss in the vertical plane, top and bottom
flange restraint for LTB and out-of plane strut buckling restraint,
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• incoming members at 0 degrees (± 45 degrees) i.e. vertical for a truss in
the vertical plane, no LTB restraint and in-plane strut buckling restraint.

• In a bottom chord any incoming members not at node points are assumed
to provide the following LTB and strut restraints,

• incoming members at 90 degrees (± 45 degrees) to the plane of the
truss i.e. horizontal for a truss in the vertical plane, top and bottom
flange restraint for LTB and out of-plane strut buckling restraint,

• incoming members at 0 degrees (± 45 degrees) i.e. vertical for a truss in
the vertical plane, no LTB restraint and in-plane strut buckling restraint.

• Lateral restraints to the top or bottom flange of a chord are assumed to be
capable of resisting restraint forces not less than those specified in the
relevent section(s) of the design code.

• In all cases, for all member characteristics it is assumed that you will make
a rational and ‘correct’ choice for the effective lengths between restraints
The default value for the effective length factor of 1.0 may be neither correct
nor safe.

Portal frame design
If portal frames are modelled and designed in Tekla Structural Designer they
will be designed elastically for the forces determined from the 3D analysis, in
the same manner as other steel beams and columns.

A more economic design can be obtained by exporting individual frames to
Tekla Portal Frame Designer. This industry leading portal frame software
performs an elastic-plastic analysis and design and undertakes member
stability checks to EC3 or BS5950. Once designed, the resulting sections can
then be returned to the Tekla Structural Designer model.

NOTE Tekla Portal Frame Designer is a separately purchasable product.

1.6 Concrete member and slab design handbook
To get started with designing concrete members in Tekla Structural Designer
see:

• Concrete member design workflow (page 248)

• Concrete member autodesign (page 254)

• Cracked, partially cracked, and uncracked concrete members (page 255)

• Concrete beam and column groups (page 260)

• Concrete beam design properties (page 265)
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• Concrete column design aspects (page 275)

• Concrete wall design aspects (page 281)

• Interactive concrete member design (page 285)

To get started with designing concrete slabs, see:

• Concrete slab design (page 329)

For guidance to help reduce the overall design time, see

• Working with large models

Concrete member design workflow
The following example illustrates the typical process to analyze and design all
the beams, columns and walls in a concrete structure.

Set up pattern loading
By default, only beam loads, and slab loads that have been decomposed on to
beams, are patterned. Loads applied to slabs should be manually patterned
using engineering judgement; this is achieved on a per panel basis for each
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pattern load by toggling the loading status via Update Load Patterns on the
Load ribbon.

Set all beams columns and walls into autodesign mode
For the first pass, in order to get an efficient design at the outset, it is
suggested that you set all members to "autodesign" with the option to select
bars starting from Minima.

Related concept

The autodesign process for concrete members (page 254)

Review beam and column design groups
Provided that the concrete beam and column options are checked in Design
Settings > Design Groups, the design groups shown in the Groups tab of the

Engineers Handbooks 249 Concrete member and slab design handbook



Project Workspace will be applied in the beam and column autodesign
processes.

Groups will initially have been established for members sharing the same
geometry, but you should consider reviewing and amending them if required.

Review beam, column and wall design parameters and reinforcement
settings
The member design parameters and reinforcement settings should be
carefully considered prior to running the design.

Perform the concrete design
By running Design Concrete (Static) from the Design ribbon, you effectively
combine analysis and design (with the exception of slab design) into a single
automated process.

Up to three separate analyses are automatically performed in order to
generate the design forces required for the concrete beam, column, and wall
design:

• 3D Analysis

• Grillage chasedown analysis

• FE chasedown analysis
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NOTE The sets of forces established from the FE chasedown analysis are considered
by default for the design of each concrete member type. They can however be
switched off should you decide that they are not required. The control for
doing this for beams is located in Design Settings > Concrete > Beam >
General Parameters. A similar control is provided for columns and walls also.

NOTE Reinforcement is designed, but member sizes are not changed during the
design process.
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Review stability issues
Issues relating to stability will be flagged in the Design branch of the Project
Workspace Status tab. They can also be review graphically from Show/Alter
State in the Review View.

Tabular results can be investigated from the Review View by clicking Tabular
Data in the ribbon and then selecting the required View Type.
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Review the design status and ratios
You can display the Design Status and Ratios from the Review View in order to
determine if any remodelling is required.

In this example a number of members are not heavily loaded so you could
consider resizing or designing them interactively.

If you make any changes, to see their effect simply re-run Design Concrete
(Static) once more.

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer.
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Print calculations
Create a model report that includes the member design calculations that have
been performed. (The default Member Design Calcs report includes these
along with design calculations for other member types in the model).

Concrete member autodesign
The design mode for each member is specified in its properties.

Autodesign (concrete beam)

• When Autodesign is selected an iterative procedure is used to select
longitudinal bars for each bending design region on the beam, both top
and bottom. Similarly an iterative procedure is used to select links/stirrups
for each shear design region on the beam.

• When Autodesign is not selected (i.e. check mode), the existing
reinforcement provision is retained and Tekla Structural Designer
determines if it is sufficient.

NOTE If concrete beams have been set to be designed using Design and detailing
groups (concrete) (page 260), then if at least one member of the group is set
to autodesign the whole group will be auto-designed.

Rationalization of Reinforcement

The Auto-design process returns a set of information about the reinforcement
to be provided in each design region of the beam. The number and size of the
longitudinal bars in the top and bottom of the beam is given as well as the
size, number and spacing of the shear links/stirrups.

This information is then "rationalized" to give an arrangement of longitudinal
reinforcement that provides a solution for the beam as a whole whilst still
meeting the requirements of the individual design regions.

The rationalization process is carried out separately for the longitudinal bars in
the top of the beam and those in the bottom of the beam.

The arrangement of shear links/stirrups is not rationalized. These can vary in
size, spacing and number from region to region without having any impact on
adjoining regions.

Autodesign (concrete column)
• When Autodesign is selected an iterative procedure is used to design both

the longitudinal bars and links. This applies the spacing maximisation
method which attempts to return a solution with the largest possible
longitudinal bar spacing and largest possible link/tie spacing.

Engineers Handbooks 254 Concrete member and slab design handbook



• For rectangular, circular and parallelogram sections, if a single layer of
reinforcement is not sufficient, autodesign will attempt a two layer
solution. For circular sections, if a second layer is required you can control
the minimum layer spacing via Design Settings (a larger spacing will be
used if needed).

• When Autodesign is not selected (i.e. check mode), the existing
reinforcement provision is retained and Tekla Structural Designer
determines if it is sufficient.

NOTE If concrete columns have been set to be designed using Design and detailing
groups (concrete) (page 260), then if at least one member of the group is set
to autodesign the whole group will be auto-designed.

Autodesign (concrete wall)
• When Autodesign is selected an iterative procedure is used to determine

the reinforcement. A spacing maximisation method is applied for both
longitudinal bars and links/ties. This attempts to return a solution with the
largest possible longitudinal bar spacing and largest possible link/tie
spacing.

• When Autodesign is not selected (i.e. check mode), the existing
reinforcement provision is retained and Tekla Structural Designer
determines if it is sufficient.

Select bars starting from
This option appears for concrete members when Autodesign is selected. It sets
the autodesign start point for both longitudinal bars and links/stirrups/ties.

The options are:

• Minima (default)

• Current bars

Selecting Minima removes the current arrangement and begins with the
minimum allowed bar size from the selection order.

NOTE When a member is in check mode, it can still be autodesigned "on the fly" by
choosing Design Member from the right-click menu. In this case it uses the
Select bars starting from option currently assigned to the member for
autodesign. (This property is hidden when in check mode, but can be
confirmed if required by switching the member back to Autodesign mode.)

Cracked, partially cracked, and uncracked concrete
members
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Assuming concrete sections (walls, columns and beams) are cracked has a
direct affect on analysis - smaller Modification Factors are applied to cracked
sections, (typically a cracked member is assumed to have half the stiffness of
an uncracked member), causing an increase in deflection. Indirectly the design
can also be affected because the sway/drift sensitivity calculations are also
influenced by this assumption.

The Assume cracked setting in the member properties is used to specify
cracked/uncracked status. It can be set for individual concrete beam spans,
column stacks and wall panels as follows:

• Yes - the section is fully (100%) cracked

• No - the section is uncracked (0%)

• Partially - the section is partially cracked (anywhere between 0 - 100%)

While it can be set directly in the member properties, Assume cracked can also
be set or toggled graphically in a Show/Alter State Review View. For meshed
walls a feature is provided to speed up this process.

Usage of cracked, partially cracked, and uncracked
This feature is of especial use in the design of tall buildings, for which the
engineer needs to particularly assess and modify the stiffness of the lateral
force resisting system (usually composed primarily of concrete (shear) walls) to
control lateral displacements. The stiffness of concrete members is
determined in large part by their state of cracking - which can vary between
the ‘extreme’ conditions of entirely uncracked and fully cracked.

You have the option to specify the (fully) cracked and uncracked conditions for
concrete members (beams, columns and walls) and control their stiffness
accordingly and separately via Modification Factors (page 127).

NOTE The default values of these for the Building Analysis assume the
loading is long term and should be modified when considering short
term loading - for more see this TUA article Where do the default
values for cracked and uncracked properties of concrete come from?.

You also have the option to specify an intermediate state, partially cracked i.e.
neither uncracked nor fully cracked, which is applicable to beams, columns
and walls (meshed). The partially cracked state is set by a simple degree of
cracking % for which the stiffness modification factor is automatically
calculated and applied.

Tall Building Companion Features - as mentioned, this feature adds to and
can be considered in the context of a number of other Tekla Structural
Designer features targeted particularly at the design of tall buildings. These
are:

• Dynamic Analysis - Wind Tunnel Data Report Generation
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• Design for high strength concrete grades (Eurocode) - for more on this see
the Tekla Structural Designer 2019i Release Notes

• Stresses in 2D elements

• 2D In-Plane Stress Contouring useful for assessing extent of cracking of
Concrete Walls

• Diaphragm loads and diaphragm load tables

Partially cracked modification factor
Assume cracked can be set to:

• Yes - the section is fully (100%) cracked

• No - the section is uncracked (0%)

• Partially - the section is partially cracked

• Percentage - anywhere between 0 - 100%

The partially cracked modification factor (ModFactorPartially Cracked ) is
automatically calculated by linear interpolation for the specified percentage (x
%) between the factors set for uncracked (ModFactorunCracked) and cracked
(ModFactorCracked) as follows:

• ModFactorPartially Cracked = ModFactorunCracked - x% * (ModFactorunCracked -
ModFactorCracked)

• Thus for example for the default short term (Modal Analysis & RSA)
concrete meshed wall modification factors of cracked = 0.5 and
uncracked = 1.0, a Partially cracked value of 50% gives a modification
factor = 1.0 - 0.5*(1.0 - 0.5) = 0.75.

• The member stiffnesses are then adjusted accordingly using the
calculated partially cracked modification factor values:

• Meshed Walls - the factor is applied to properties E, G and/ or t as
appropriate in the same manner as the cracked/ uncracked factors
(specific to the factors currently set in the model)

• Beams & Columns - the factor is applied to section properties in the
same manner as the cracked/ uncracked factors (specific to the
factors currently set in the model).

Determining wall cracked properties
For engineers investigating the sway characteristics of taller buildings the
cracked/uncracked status of walls is a complex topic of critical importance.

A couple of challenges faced by engineers are:

1. If using general stiffness adjustments - what are the realistic adjustment
values for cracked and uncracked panels?
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2. How can the cracked/uncracked status of wall panels be easily
determined?

Tekla Structural Designer provides a feature in Show/Alter State to significantly
assist with the latter task for meshed panels. This graphically displays the
current cracked/uncracked status of each panel and indicates in which panels
the stress threshold has and has not been exceeded. It then allows you to
update the cracked status to be compatible with the threshold.

Use of the Review Wall Stress feature requires a degree of engineering
judgment - you will need to make your own choices with regard to:

• strength or service level stress?

• basing the stress threshold on max instead of in-plane stress contours?

• whether the panel cracks for any level of stress, or could a higher threshold
be considered?

You will also need to be familiar with the limitations and assumptions that
apply.

Workflow for reviewing wall cracked properties
To determine an appropriate cracked status for wall panels, you could adjust
the following basic workflow to suit your needs:

1. Analyze the model to determine some initial stresses.

2. Open a Review View and click Show/Alter State.

3. In the Show/Alter State Properties window:

• Set the Attribute to Assume cracked

• Set the [M]ode to 

• Set the Result type to Strength or Service as you deem appropriate.

• Set the Stress type to In-plane tension - Y or Max tension - Y as you
deem appropriate.

NOTE If using In-plane tension - Y contours:
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• these give an average stress through the thickness of the
wall and therefore exclude local stress concentrations that
exist as a result of out of plane bending

• (engineers often choose to ignore out of plane bending
when considering the overall cracked status of panels)

• Enter the Stress threshold that you want to work to.

In the below example, the most likely scenario where everything was
initially set as cracked is shown; in lower panels this is a correct setting, in
the higher ones they could be changed to uncracked.

4. By hovering the cursor over an individual panel a tooltip is displayed. This
reports the maximum stress value from all nodes in the panel and the
case/combination in which it occurs. This value is used to determine if the
stress threshold has been exceeded.

NOTE To investigate reported stresses in more detail you might choose
to open a Results View to of tension stress contours for specific
envelopes or combinations.

5. At this point you could choose to manually set or toggle the cracked/
uncracked status of the individual panels, however Auto update provides
a quicker way to make all panels compatible.

6. To make all panels automatically compatible:

• Click  to expose the Auto update button.

• Click the Auto update button 
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Each panel is updated as follows:

• uncracked panels in which the stress threshold has been not exceeded
are unaffected,

• uncracked panels in which the stress threshold has been exceeded are
set to cracked,

• cracked panels in which the stress threshold has been exceeded are
unaffected,

• cracked panels in which the stress threshold has not been exceeded
are set to uncracked.

7. Reanalyze the model to take into account the revised cracked/uncracked
properties.

8. Review the results once more and make further adjustments if required.

Concrete beam and column groups

Why use design and detailing groups?
Concrete beams and columns and isolated foundations are put into groups for
two reasons:

1. For editing purposes - individual design groups can be selected and
displayed graphically so that their properties can be changed as a group
in the properties window.

2. For design and detailing purposes - to standardise designs, reduce
processing time, and reduce the volume of output created.

In a manual process, the Engineer might select a number of sufficiently similar
members to form a "design group" to carry out a single design that is
sufficient for all members in the group. Using this single set of design results,
they would then create sub-groups of the members in the design group to
produce a set of output details for each of these sub-groups.
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In Tekla Structural Designer, concrete design groups are analogous to the
manually created design groups described above. Concrete detailing groups
are analogous to the sub-groups.

A fixed set of rules are used to automatically determine member groups: for
example beams must be of similar spans, columns must have the same
number of stacks, bases must be of similar lengths in X and Y, and similar
depths etc. The same rules also constrain manual group editing.

NOTE Grouped design and detailing is optional and can be deactivated if required:

From the Design tab, click Settings> Design Groups, then select or unselect
the member types to be designed in groups.

What happens in the group design process?
When the option to design a specific concrete member type using groups is
checked, for that member type:

• In each design group the first member to be designed is selected
arbitrarily. A full design is carried out on this member and the
reinforcement so obtained is copied to all other members in the group.

• These other members are then checked one by one to verify that the
reinforcement is adequate for each and if this proves not to be the case, it
is increased as necessary and the revised reinforcement is copied to all
members in the group.

• This process continues until all members in the group have been
satisfactorily checked.

• A final check design is then carried out on each group member. During this
process peak and individual utilizations are established.

Design group requirements
Concrete member design groups are formed according to the following rules:

Member type Design group rules
Concrete beam • A beam element may be in only one design group.

• Design groups may be formed from single span or
multi-span continuous beams.

• All beam elements in the group must have an identical
number of spans.

• For each individual span all beam elements in the
group must have an identical cross section, including
flange width where appropriate, and span length.

• All beam elements in the group must have identical
material properties and nominal cover.
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Member type Design group rules
• All beam elements in the group must be co-linear or

be non-co-linear with identical degrees of non-co-
linearity between spans.

Concrete column • A column element may be in only one design group.

• All column elements in the group must have an
identical number of stacks.

• For each individual stack all column elements in the
group must have an identical cross section, and stack
length.

• All column elements in the group must have identical
material properties and nominal cover.

Pad base • A pad base may be in only one design group.

• Each base in the group must have an identical cross
section and depth.

• Each base in the group must have identical
eccentricities in X and Y.

• Each base in the group must have identical material
properties and nominal cover.

Pile cap • A pile cap may be in only one design group.

• Each pile cap in the group must have an identical
cross section and depth.

• Each pile cap in the group must have identical
eccentricities in X and Y.

• Each pile cap in the group must have identical
material properties and nominal cover

Detailing group requirements
Each parent design group is sub-divided into one or more detailing groups.

Although there can be a "1 to 1" relationship between a design group and a
detailing group, in practice there will often be a "1 to many" relationship as
each design group is likely to require several detailing groups to allow for
differences in the connected geometry.

Detailing groups are formed for the different concrete member types based
on the following rules:

Member type Design group rules
Concrete beam • A detailing group may be associated with only one

parent design group.

• A beam element may be in only one detailing group.
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Member type Design group rules
• Detailing groups may be formed from single span or

multi-span continuous beams.

• All beam elements in the group must have an identical
number of spans.

• The cross section, including flange width where
appropriate, span length and material properties in
span

• "i" of all beam elements in the group must be
identical .

• All beam elements in the group must have identical
plan offsets.

• All beam elements in the group must be co-linear or
be non-co-linear with identical degrees of non-co-
linearity between spans.

• All beam elements in the group must have identical
inclinations.

• The support types and sizes, including the attached
structure above and below the beam element, must
be identical in all beam elements in the group
however different support types and sizes in
individual multi-span continuous beams are
acceptable i.e. support i in beam element j must be
identical to support i in all other beam elements in the
group but supports i and i+1 in beam element j may
be different.

Concrete column • A detailing group may be associated with only one
parent design group,

• A column may only be in one detailing group,

• All columns in the detailing group must have an
identical number of stacks,

• All columns in the group must have an identical cross-
section, rotation and alignment/snap levels/offsets in
stack 'i'. In a multi-stack column, the cross-section may
be different in each stack, i.e. the cross-section in span
'i' may be different to that in span 'j'.

• Stack 'i' and stack 'i+1' must be co-linear for all
columns, OR must be non-co-linear with an identical
degree of non-co-linearity for all columns. The exact
inclination must be the same for stack 'i' in all
columns.

• At every level each column is considered to be either
"internal" or "external" (depending on if it has beams
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Member type Design group rules
framing into it on all four sides, or not). These settings
do not have to be identical for columns to be in the
same group, but only if you have selected the option:
Provide ties through floor depth for internal columns
in Design Options > Concrete > Column > Detailing
Options.

Pad base • A detailing group may be associated with only one
parent design group.

• A base may be in only one detailing group.

• The attached column cross-section above the base
must be identical for all bases in the group however
different support types are acceptable.

Pile cap • A detailing group may be associated with only one
parent design group.

• A pile cap may be in only one detailing group.

• The attached column cross-section above the base
must be identical for all pile caps in the group
however different support types are acceptable.

Group management
Automatic Grouping

Concrete beams and columns are grouped automatically.

In Model Settings > Grouping the user defined Maximum length variation is
used to control whether elements are sufficiently similar to be considered
equivalent for grouping purposes.

Manual/Interactive Grouping

After assessing the design efficiency of each group, you are able to review
design groups and make adjustments if required from the Groups tab of the
Project Workspace.

Detailing groups cannot be edited manually.

NOTE When manually adding members to a group, the order in which they are
added will incrementally affect the average length within the group, (which is
then compared to the maximum length variation). Therefore, if members are
not being added as you expect, try adding them in a different order.

Regroup ALL Model Members

If you have made changes in Design Settings that affect grouping, you can
update the groups accordingly from the Groups tab of the Project Workspace
by clicking Re-group ALL Model Members.
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NOTE Any manually applied grouping will be lost if you elect to re-group!

Model Editing and Group Validity Checks

When new beam elements are created when a "split" or "join" command is run
the resulting beam elements are automatically placed in existing design and
detailing groups [or new groups created].

Concrete beam design aspects

Concrete type
While you can apply both normal and lightweight (LW) concrete in the beam
properties, beam design using lightweight concrete is only available for
Eurocodes.

When using other Head Codes beams can only be designed using normal
weight concrete.

LW density classes and grades

6 Density classes (1.0, 1.2 ….. 2.0) are available and 15 default grades are
provided; 5 in each of the density classes: 1.6, 1.8 and 2.0.

• For example the grade name “LWAC30/37-DC1.8” denotes; LWAC =
Lightweight aggregate concrete; 30/37 = Strength class; DC1.8 = density
class.

• Custom LW grades can be added for which note that new LW-specific
property η1 must be specified.

NOTE LW grades can be reviewed, edited and applied via Review View > Show/Alter
State Material Grade Attribute.

Deflection control (ACI/AISC)
Tekla Structural Designer implements both a simplified, and also a more
rigorous method for controlling deflection.

The actual method applied to a specific beam will depend upon whether it is
required to support sensitive finishes.

When the rigorous method is applied, immediate short-term deflections, and
also long-term deflections resulting from creep and shrinkage of flexural
members are considered.

Structure supporting sensitive finishes

Any beam that supports or is attached to partitions or other constructions
likely be damaged by large deflections should be identified as such by
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selecting Structure supporting sensitive finishes under the Design Control
heading in the beam properties.

The deflection method applied to the beam depends on this setting as follows:

• beams not required to support sensitive finishes adopt the simplified
method.

• beams required to support sensitive finishes adopt the rigorous method.

The simplified method

For those beams that have not being chosen to support sensitive finishes,
deflection is controlled by the simplified method of limiting the span to depth
ratio.

This check can be satisfied by providing a total beam depth which exceeds
hmin, (where hmin depends on the clear span and beam end conditions).

If this check is not satisfied the beam is then rechecked by the rigorous
method.

The rigorous method

For beams that do not meet minimum thickness requirements determined by
the simplified method, or that support sensitive finishes, deflections should be
calculated by rigorous method.

The parameters listed below directly affect the rigorous calculation method
and hence require consideration:

1. Does the beam support sensitive finishes?

• If the Structure supporting sensitive finishes beam property (located
under the Design Control heading) is cleared the simplified method
may suffice in which case rigorous calculations are not required.

2. Can the beam flanges be taken into account?

• Selecting Consider flanges (located under the Design Control heading)
can assist in reducing the calculated deflections.

3. Does the beam contain compression steel?

• In the current release of the program it has been assumed that the
beam always contains compression steel for the rigorous method
deflection calculations.

4. 4. Are the deflection limits appropriate?

• These limits are editable in the beam properties, the default ratios
being span/360 for live load, and span/480 for total load affecting
sensitive finishes.

• The default span\over limits tend to produce conservative results.

• You are also given the flexibility to specify absolute deflection limits as
an alternative, or in addition to the above span\over limits.

5. Is the long term deflection period correctly specified?
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• The default value is 5 years, but this can be edited via Design Options >
Beam > General Parameters

6. Is the time at which brittle finishes are introduced correctly specified?

• The default value is 1 month, but this can be edited via Design Options
> Beam > General Parameters

7. Are the percentages of dead load applied prior to brittle finishes and long
term live load correctly specified?

• The deflection check takes account of these percentages, (defaulting to
50% of dead load applied prior to brittle finishes and 33% of long term
live load). You are able to adjust each of these by selecting the
loadcase name from the left hand side of the Loadcases dialog and
then adjusting the value.

Deflection control (AS 3600)
Tekla Structural Designer controls deflections either by limiting span to depth
ratios, or by applying the simplified method. The choice of method being set
via Design Options > Concrete > Beam > General Parameters.

The simplified method

In the simplified deflection calculation procedure actual short-term deflection
is calculated using the mean value of modulus of elasticity of concrete at
appropriate age (Ecj) and an effective second moment of area of member (Ief).

When the simplified method is applied, the shrinkage parameters that are
required are specified on the Design Options > Concrete > Beam > General
Parameters page.

Limiting span to depth ratios method

The deflection of reinforced concrete beams is not directly calculated and the
serviceability of the beam is measured by comparing the calculated limiting
effective span/effective depth ratio (Lef/d)

Structure supporting sensitive finishes

Any beam that supports or is attached to partitions or other constructions
likely be damaged by large deflections should be identified as such by
selecting Calculate deflection after installation of finishes under the
Design Limits heading in the beam properties.

When this option has been selected an additional span\over or absolute limit
can be specified and checked against in the beam properties.

• beams not required to support sensitive finishes adopt the simplified
method.

• beams required to support sensitive finishes adopt the rigorous method.

Parameters affecting deflection

Engineers Handbooks 267 Concrete member and slab design handbook



The parameters listed below directly affect the deflection calculations and
hence require consideration:

1. 1. Increase reinforcement if deflection check fails

• If this beam property (located under the Design Control heading) is
cleared and the check fails, then the failure is simply recorded in the
results

• If it is checked, then the area of tension reinforcement provided is
automatically increased until the check passes, or it becomes
impossible to add more reinforcement.

2. Consider flanges

• Checking this beam property (located under the Design Control
heading) can assist in satisfying the deflection check.

Deflection control (Eurocode BS and IS)
Tekla Structural Designer controls deflection by comparing the calculated
limiting span/effective depth ratio L/d to the maximum allowable value (L/
d)max

The parameters listed below directly affect the deflection calculations and
hence require consideration:

1. Increase reinforcement if deflection check fails

• If this beam property (located under the Design Control heading) is
cleared and the check fails, then the failure is simply recorded in the
results

If it is checked, then the area of tension reinforcement provided is
automatically increased until the check passes, or it becomes impossible
to add more reinforcement.

2. Structure supporting sensitive finishes (Eurocode only)

• This beam property (located under the Design Control heading, and on
by default) is used to control the value of the f2 parameter used in the
deflection check. When unchecked f2 will be taken as 1.0.

3. Consider flanges

• Checking this beam property (located under the Design Control
heading) can assist in satisfying the deflection check.

Ignore lateral instability (Eurocode)
This option (located under the Design Control heading) allows you to consider
or ignore lateral instability for slender spans to EC2 clause 5.9(1) (off by
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default). When the option is checked on the slender span check is excluded
from design.

Consider flanges
Flanged beam properties can be specified under the Design Control heading in
the beam properties, by selecting Consider Flanges.

Typically, flanged beams can be either "T" shaped with a slab on both sides of
the beam or "Γ" shaped with a slab on only one side of the beam.

The characteristic behaviour of flanged beams which can be made use of in
design is the fact that the major axis bending resistance of the member is
enhanced by the presence of adjoining concrete slabs which serve to increase
the area of the compression zone activated during major axis bending.

This effectively raises the position of the neutral axis thereby increasing the
lever arm of the longitudinal tension reinforcement and reducing the quantity
of reinforcement required.

Related concept

Flanged concrete beams (page 272)

Design parameters (Eurocode only)
Located under the Design parameters heading in the beam properties, the
following parameters relating to shrinkage and creep can be specified for
individual members.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio

The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):
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For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Nominal cover
In the beam properties, the nominal concrete cover is the distance between
the surface of the reinforcement closest to the nearest concrete surface
(including links and surface reinforcement where relevant) and the nearest
concrete surface.

Reinforcement - longitudinal bar patterns
Under the reinforcement heading in the beam properties, there are three
Standard Patterns available for top reinforcement, SPT1, SPT2 and SPT3 and two
Standard Patterns available for bottom reinforcement, SPB1 & SPB2 as
illustrated in the figures below.

Standard Patterns of Top Reinforcement
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The bars used in the Standard Top Patterns are:

(1) Straight bar extending to approximately 25% or 33% of each span (end
points of this bar are determined by the design region settings)

(2) Straight bar extending to approximately 10% of each span (end points of
this bar are determined by the design region settings) - if required by the
design

(3) Double cranked bar lapped with bar (1)

(5) Straight bar running approximately from face to face of beam supports

(6) Single cranked bar running from center span to center span with the option
to merge bars if they are the same size and number to extend the bar over
several spans

(12) Bob bar

(13) Bob bar

Standard Patterns of Bottom Reinforcement

The bars used in the Standard Bottom Patterns are:

(4) Bar with a bob at each end

(7) Straight bar with a length approximately 70% of span - if required by the
design

(8) Single cranked bar extending over several spans or over one span only and
lapped within a support - with bob if it continues over an end span.

(9) Straight bar

(10) Straight bar running approximately from face to face of beam supports

(11) Straight bar

(14) Bob bar

Modified versions of the above standard patterns are applied for use in single
spans and in cantilever spans where no backspan beam is present.

For short span beams, it becomes uneconomic and impractical to lap bars in
beams. These facts coupled with the anchorage lengths that are required
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make the use of multiple design regions for the longitudinal reinforcement
unnecessary. To cater for this a short span beam length can be defined in
Design Options > Beam > Reinforcement Settings and the bar patterns
adopted for such short spans are as shown below:

Standard Patterns of Reinforcement for Short Span Beams

Flanged concrete beams

Consider flanges

Flanged beam properties can be specified under the Design Control heading in
beam properties, by selecting Consider Flanges.

Typically, flanged beams can be either "T" shaped with a slab on both sides of
the beam or "Γ" shaped with a slab on only one side of the beam.

The characteristic behaviour of flanged beams which can be made use of in
design is the fact that the major axis bending resistance of the member is
enhanced by the presence of adjoining concrete slabs which serve to increase
the area of the compression zone activated during major axis bending.

This effectively raises the position of the neutral axis thereby increasing the
lever arm of the longitudinal tension reinforcement and reducing the quantity
of reinforcement required.

Validation of slabs for use in the flange effective width calculations

If a slab is present (and provided that a user defined flange has not been
specified), the program automatically validates the slab as a potential
candidate for being a beam flange using a number of criteria, the main ones
being;

• the slab can be on one or both sides of the beam but

• it must extend for a distance ≥ the slab depth from the vertical face of the
beam and
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• it must extend for the full span length of the beam

• the slab must be a reinforced concrete slab

• if there are slabs on both sides of the beam, they may be of different depths
and these depths may vary along the length of the beam

The effective width of any valid slab on each side of the beam, b eff,i, is
calculated and the results that are appropriate at the mid-span length point
are displayed along with the flange depth, under Design control in the Beam
Property dialog.

NOTE When automatically calculated, the flange width and depth are only displayed
in the Beam Property dialog and not in the Beam Properties window,
(because the width and depth could vary if multiple beams were to be
selected).

Include flanges in analysis

Selecting this option allows the flanged beam section properties to be
considered in the analysis, stiffening the beam and reducing the deflection.

Consider as isolated (ACI/AISC)

ACI 318 clause 8.12.4 states:

"Isolated beams, in which the T-shape is used to provide a flange for additional
compression area shall have a flange thickness not less than one-half the
width of web and an effective flange width no more than four times the width
of web."

When the Consider flanges check box is selected, an Isolated Beam check
box is displayed to control whether or not the above code limit is applied.
When the check is performed, if the flange geometry does not meet the above
requirements the flanges are ignored.

NOTE Our understanding is that while this limit usually applies to precast beams, it
is not usually applied to in-situ construction. Therefore, by the default the
Isolated Beam check box is cleared, which means that the above check is not
performed.

Effective Width of flanges (ACI/AISC)

For ACI 318-08 and ACI 318-11

For "T" shaped flanged beams the effective flange width, b eff, is given by :

beff = MIN(L/4, 16*hf + bw, b1 + b2 + bw) - Owi

For beams with slab one side only, the effective flange width, b eff is given by :

beff = MIN(L/12+ bw, 6*hf + bw, bi + bw) - Owi

where

L = span length
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IF construction is continuous:

= distance of center-to-center of supports

ELSE

= MAX(clear span + h, distance between centers of supports)

bi = 0.5 * the clear distance between the vertical faces of the supports for the
valid concrete slab on side i of the beam or from the vertical face of the beam
to the centerline of any supporting steel beam

Owi = the user specified allowance for an opening

For ACI 318-14

All limits on the flange width apply to the overhangs on each side of the beam.
It is also clarified in this version that the clear span should be used in these
calculations.

beff,i = MIN(ln/8, 8*hf , bi) - Owi

Effective Width of flanges (Eurocode)

The effective width of the compression flange is based on L0, the distance
between points of zero bending moment.

For flanged beams the following values of L0 are to be used;

For a simply supported beam L0 = L

For a continuous beam, the value of L0 may be obtained using the following
simplified rules;

End span of a continuous beam with a pinned end support L0 = 0.85*L

End span of a continuous beam with a fixed end support L0 = 0.70*L

Internal span of a continuous beam L0 = 0.70*L

where

L = the clear length of the span under consideration

The effective flange width, beff, is given by;

beff = bw + ∑beff,i

where

beff,i = the effective width of the flange on side i of the beam

= MIN[0.2*L0, bi,(0.2*bi + 0.1*L0)] - Ow i

where

L0 = the distance between points of zero moment as defined above
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bi = 0.5 * the clear distance between the vertical faces of the supports for the
valid concrete slab on side i of the beam or from the vertical face of the beam
to the centreline of any supporting steel beam

bw = the width of the beam

Owi = the user specified allowance for an opening

NOTE If the slab thickness varies on each side of the beam, the thinner value is used
in calculating the beam properties.

The above calculation for beff is also used for "Γ" beams with a slab on only
one side although in this case, b1 or b2 as appropriate is = 0.

Concrete column design aspects

Concrete type
While you can apply both normal and lightweight concrete in the column
properties, column design using lightweight concrete is currently beyond
scope.

Apply rigid zones
Unless you have chosen not to apply them, rigid zones are created at concrete
column/beam connections.

In most situations in order to get an efficient design you would want rigid
zones to be applied. You can however choose not to consider them by
checking the Rigid zones not applied option that is provided in Model Settings,
this will deactivate them throughout the model. You can also selectively
deactivate rigid zones at specific column/beam connections by unchecking the
Apply rigid zones option that is provided in the column properties under the
Design control heading.

• For example, you might choose not to apply them if you encounter
problems with short members and rigid zones which cannot be overcome
by modifying the physical model.

• When rigid zones are not applied, the positions of releases in analysis
model are affected, and member start and end points for design are also
adjusted.

The Apply rigid zones setting is located under the Design control heading in
the column properties.
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Design parameters (Eurocode only)
Located under the Design parameters heading in the column properties, the
following parameters relating to shrinkage and creep can be specified for
individual members.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio

The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Relative Humidity

Typical input range 20 to 100%

Age of Loading

This is the age at which load is first applied to the member.

The Age of Loading should include adjustments necessary to allow for cement
type and temperature as defined in EC2 Annex B.

NOTE The program defaults the Age of Loading to 14 days for all members -
you are advised to consider if this is appropriate and adjust as
necessary.
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Confinement reinforcement
Located under the Confinement reinforcement heading in the column
properties, the Provide support regions setting determines the way each
stack is divided into regions for the purpose of designing the confinement
reinforcement.

• Checked - confinement reinforcement is designed separately in three
regions.

• Cleared - the same confinement reinforcement is designed for the whole
stack.

Slenderness
Located under the Slenderness heading in the column properties, the
significant parameter within the slenderness criteria is a choice of how the
column is contributing to the stability of the structure.

• bracing - provides lateral stability to the structure.

• braced - considered to be braced by other stabilizing members.

The second slenderness parameter is the effective length factor, which is
either input directly by choosing the User input value option, or it is
calculated in accordance with the requirements of the selected design code.

Stiffness
The stiffness settings affect the calculation of clear height, also referred to as
the unsupported or unrestrained length (depending on the head code being
worked to) which is the clear dimension between the restraining beams at the
bottom of the stack and the restraining beams at the top of the stack. The
unsupported length may be different in each direction.

Effective concrete beams

An effective concrete beam is one which provides stiffness at a restraint
position. A concrete beam is only considered effective if it is "fixed" at the
position where it joins to the column. Concrete beams are only effective in a
direction if they are within 45° of that direction, and therefore no concrete
beam can be effective in both directions. A concrete beam is only effective if
its angle to the horizontal is 45° or less.

A concrete beam only restrains the end of the stack if it is within the depth of
the stack section from the end of the stack, and if its centre is nearer to this
end of the stack than the far end. Therefore, at a node at a stack join, if the top
of the beam is below the node by a dimension greater than the depth of the
stack below the node, it is not considered. Similarly, if the bottom of the beam
is above the node by a dimension greater than the depth of the stack above
the node, it is not considered.

Effective flat slabs/other types of slab
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When determining the unsupported length, if no effective beams are found at
the end of a stack, Tekla Structural Designer considers whether there is a flat
slab restraining the stack at that end. The Use slab for calculation... upper/
lower, major/minor options, (which are located under the Stiffness heading in
the column properties), are used to indicate whether any such slab should be
considered as a restraint.

If there are no effective beams and there is no flat slab, the program looks for
any other type of slab panel at that end. If a panel is found, then provided it
has the Include in diaphragm property selected, it acts as a restraint at the
position, in the same way as a flat slab.

A flat slab or any other type of slab panel only restrains the end of the stack if
it is within half the slab depth from the end of the stack, and if its centre is
nearer to this end of the stack than the far end.

If, at an end of the stack, no effective beams, flat slab or other slab panel that
acts as a restraint is found, then the unsupported length includes the stack
beyond this restraint, and the same rules apply for finding the end of the
unsupported length at the end of the next stack (and so on). If there is no
stack beyond this restraint (i.e. this is the end of the column), the unsupported
length ends at the end of the column.

Sway/Drift Checks
By default all stacks of all columns are taken into account in the sway/drift,
wind drift and seismic drift checks.

Located under the Sway and drift checks heading in the column properties,
these parameters provides a facility to exclude particular column stacks from
these calculations to avoid spurious results associated with very small stack
lengths. You can either clear the check box located under 'All Stacks' to
exclude the entire column, or you can exclude a particular stack by clearing
the check box located under that stack only.

Nominal cover
In the column properties, the nominal concrete cover is the distance between
the surface of the reinforcement closest to the nearest concrete surface
(including links and surface reinforcement where relevant) and the nearest
concrete surface.

Reinforcement
The type and grade of vertical and confinement reinforcement to be
considered for the design are specified under the Reinforcement heading in
the column properties.

Where possible bars are arranged in a single layer:
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Using a 2nd layer of reinforcement

• In Autodesign: for rectangular, circular and parallelogram sections, if a
single layer of reinforcement is not sufficient, design will attempt a two
layer solution.

• Rectangular and parallelogram sections: a second layer is added in line
with the first bar along the adjacent length.

NOTE At least 2 intermediate bars are needed in each direction for a
2nd layer to be added.
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• Circular sections: if a second layer is required you can control the
minimum layer spacing via Design Settings (a larger spacing will be used
if needed).
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• A link is added along the second layer for all 3 section shapes.

• In Interactive Design: you can choose to toggle the second layer on or off in
the Interactive Design dialog.

• When using a 2nd layer, design checks are unchanged, except for the
addition of a layer spacing check for circular sections.

Concrete wall design aspects

Concrete type
While you can apply both normal and lightweight concrete in the wall
properties, wall design using lightweight concrete is currently beyond scope.

End 1 and End 2 extensions
Wall extensions (End 1/End 2) can be applied in the wall properties in order to
remove physical overlaps with adjoining walls and columns without
compromising the integrity of the underlying analysis model.

Negative extensions can be created automatically where appropriate.
Extensions can also be defined manually if required, in which case they can be
input with either positive or negative values:

• A positive extension extends the wall length beyond its insertion point.

• A negative extension trims the wall back from the insertion point.

Although the length of the wall used in the analysis model (Lwall) is unchanged,
the wall length that is used in the design, quantity reporting and drawings
changes to Lwall,d

Reinforcement layers
Either one or two layers of reinforcement can be specified in the wall
properties.

Design parameters (Eurocode only)
Located under the Design parameters heading in the wall properties, the
following parameters relating to shrinkage and creep can be specified for
individual walls.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio
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The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Relative Humidity

Typical input range 20 to 100%

Age of Loading

This is the age at which load is first applied to the member.

The Age of Loading should include adjustments necessary to allow for cement
type and temperature as defined in EC2 Annex B.

NOTE The program defaults the Age of Loading to 14 days for all members -
you are advised to consider if this is appropriate and adjust as
necessary.

Sway/Drift Checks
By default all panels of all walls are taken into account in the sway/drift , wind
drift and seismic drift checks.

Located under the Sway and drift checks heading in the wall properties, these
parameters provides a facility to exclude particular wall panels from these
calculations to avoid spurious results associated with very small stack lengths.
You can either clear the check box located under 'All panels' to exclude the
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entire wall, or you can exclude a particular panel by clearing the check box
located under that panel only.

Confinement reinforcement
Located under the Confinement reinforcement heading in the wall properties,
the Provide support regions setting determines the way each panel is divided
into regions for the purpose of designing the confinement reinforcement.

• Checked - confinement reinforcement is designed separately in three
regions.

• Cleared - the same confinement reinforcement is designed for the whole
panel.

Slenderness
Located under the Slenderness heading in the wall properties, the significant
parameter within the slenderness criteria is a choice of how the wall is
contributing to the stability of the structure.

• bracing - provides lateral stability to the structure.

• braced - considered to be braced by other stabilizing members.

The second slenderness parameter is the effective length factor, which is
either input directly by choosing the User input value option, or it is
calculated in accordance with the requirements of the selected design code.

Stiffness
The stiffness settings affect the calculation of clear height, also referred to as
the unsupported or unrestrained length (depending on the head code being
worked to) which is the clear dimension between the restraining beams at the
bottom of the panel and the restraining beams at the top of the panel. The
unsupported length may be different in each direction.

Effective Concrete Beams

An effective concrete beam is one which provides stiffness at a restraint
position. A concrete beam is only considered effective if it is "fixed" at the
position where it joins to the wall. Concrete beams are only effective in a
direction if they are within 45° of that direction, and therefore no concrete
beam can be effective in both directions. A concrete beam is only effective if
its angle to the horizontal is 45° or less.

A concrete beam only restrains the end of the panel if it is within the depth of
the panel section from the end of the stack, and if its centre is nearer to this
end of the panel than the far end. Therefore, at a node at a panel join, if the
top of the beam is below the node by a dimension greater than the depth of
the panel below the node, it is not considered. Similarly, if the bottom of the
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beam is above the node by a dimension greater than the depth of the panel
above the node, it is not considered.

Effective flat slabs/other types of slab

When determining the unsupported length, if no effective beams are found at
the end of a panel, Tekla Structural Designer considers whether there is a flat
slab restraining the panel at that end. The Use slab for calculation... upper/
lower, major/minor options, (which are located under the Stiffness heading in
the wall properties), are used to indicate whether any such slab should be
considered as a restraint.

If there are no effective beams and there is no flat slab, the program looks for
any other type of slab panel at that end. If a panel is found, then provided it
has the Include in diaphragm property selected, it acts as a restraint at the
position, in the same way as a flat slab.

A flat slab or any other type of slab panel only restrains the end of the panel if
it is within half the slab depth from the end of the panel, and if its centre is
nearer to this end of the panel than the far end.

If, at an end of the panel, no effective beams, flat slab or other slab panel that
acts as a restraint is found, then the unsupported length includes the panel
beyond this restraint, and the same rules apply for finding the end of the
unsupported length at the end of the next panel (and so on). If there is no
panel beyond this restraint (i.e. this is the end of the wall), the unsupported
length ends at the end of the wall.

Nominal cover
Nominal concrete cover is specified in the wall properties.

For walls, it is measured as follows:

• For 1 layer of reinforcement, the vertical bar is on the centre-line of the
wall thickness, the face of the horizontal bar is closest to the critical
concrete face.

• For 2 layers of reinforcement, the horizontal bars are placed outside the
vertical bars at each face.

The nominal concrete cover is measured to the face of the horizontal bar or
any link/confinement transverse reinforcement that may be present.

Reinforcement
Under the Reinforcement heading in the wall properties, the Reinforcement
layers, Form and Include end zones properties can be combined as required in
order to obtain a range of reinforcement patterns, e.g:

• Single layer, using mesh reinforcement

• Two layers, using mesh reinforcement

• Single layer, using loose bars
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• Two layers, using loose bars

• End zones, with a single layer of mesh in the mid zone

• End zones, with two layers of mesh in the mid zone

• End zones, with a single layer of loose bars in the mid zone

• End zones, with two layers of loose bars in the mid zone

Interactive concrete member design
The combined analysis and design processes, Design Concrete (Static),
Design All (Static) etc. are complemented by the program's interactive
member design facilities. These allow you to interact with the concrete
member designs to override the results arising from the auto-design process.

The following interactive member designs are provided:

• Interactive concrete beam design (page 285)

• Interactive concrete column design (page 290)

• Interactive concrete wall design (page 310)

Generally you are advised to perform interactive member designs only after
the Design All process has been carried out. In this way multiple analysis
models will have been considered to arrive at the forces being designed for.

The Interactive design dialogs display a limited selection of the relevant critical
design results including bar details and allow you to make changes to the
number, size and spacing (for links/ties only) of the selected bars.

After making changes, you are able to see the effect on the displayed results -
you then have the option of canceling or accepting the changes.

Interactive concrete beam design

Opening the Interactive Beam Design Dialog

The Interactive Beam Design dialog (page 286) can be opened from any of the
2D or 3D Views as follows:

1. Right-click the member you want to design interactively.

2. Select Interactive Design... (Static or RSA as required). The Interactive
Beam Design dialog is displayed.

3. Interactively adjust the reinforcement as required until the design is
satisfactory.
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Changing the bar pattern used in the Interactive Beam Design Dialog

The interactive dialog can be opened from any of the 2D or 3D Views as
follows:

1. If the Interactive Beam Design Dialog is open, click Cancel to close it.

2. If necessary, re-select the beam to be designed.

3. Change the Top and Bottom longitudinal bar pattern in the Properties
Window as required.

4. Hover the cursor over the beam until its outline is highlighted, then right-
click.

5. From the context menu select Interactive Design...

The Interactive Beam Design Dialog opens and reinforcement is automatically
re-selected for the beam based on the new bar pattern.

Interactive Beam Design dialog
The Interactive Beam Design dialog shows the current reinforcement and
check results for each beam span in the selected beam line. When any of the
editable fields are changed, the checks are re-run and the results are updated;
enabling you to quickly see the effect of each change you make to the
reinforcement.

To display the dialog:

1. Right click on an existing concrete beam.

2. In the context menu, select Interactive Design....

The dialog content is described below.
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1. Beam/span summary pane

The top row in this pane shows the beam line summary, consisting of the
overall utilization ratio and design status.

Subsequent rows show the design status of each span and associated
utilization ratio.

• To design a particular span, click on the corresponding row for that span in
the summary pane.
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2. Longitudinal Bars tab

1. Span Summary: Displays the design status of the selected span and the
associated utilization ratio.

2. Bar Selection Tables: Used for editing the longitudinal bars into the
beam.

• Each row in the table is labeled with a specific “bar number” (taken
from the standard patterns applied to the beam in the Properties
Window); these represent bar locations within the beam.

• Two different bar sizes can be defined in each row, the only restriction
being that the second bar must always be smaller than the first.

• The number of bars of each size is defined using the Count field.
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• When bars are joined to the adjacent span, changing those bars within
this span has the effect of changing those bars in the adjacent span, as
they are effectively the same bar. (This is only done when the spans
are "matching" in terms of their alignment and dimensions.)

3. Bar Pattern Layout: a schematic diagram representing the top and
bottom patterns assigned to the beam.

4. Design Summary Table: Displays critical results for each of the design
regions from all combinations:

• Area of reinforcement required, As,reqd

• Area of reinforcement provided, As,prov

• Reinforcement area utilization ratio

• Smallest clear spacing between bars

• Minimum required reinforcement area, As,min

5. Additional checks: Side bar, deflection and cover check results are
displayed below the design summary table.

3. Links/Stirrups tab

1. Link/Stirrup Selection Table: Specifies the number of link/stirrup legs,
size and spacing in each of the regions.

2. Optimise Button : This calculates the optimum length of the central
region given the reinforcement that you have selected. The button is not
be visible when the beam is in a design group with other beams, and is
also not visible when the span is a cantilever.

3. Link/Stirrup Design Summary Table: Displays the most critical result
from all combinations:
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• Region length

• Link/Stirrup area over spacing required for shear, Asw,reqd/s

• Link/Stirrup area over spacing required for torsion, Aswt,reqd/s

• Link/Stirrup area provided, Asw,prov

• Link/Stirrup utilization ratio

4. Buttons: (See separate section below.)

Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

Detail Drawing Creates a detail drawing for the
selected member

Drawing Options Opens the DXF Export Preferences
dialog

See also

Interactive concrete member design (page 285)

Interactive concrete column design

Opening the Interactive Column Design Dialog

The Interactive Column Design dialog (page 302) can be opened from any of
the 2D or 3D Views as follows:

1. Right-click the member you want to design interactively.

2. Select Interactive Design... (Static or RSA as required). The Interactive
Column Design dialog is displayed.

3. Click on an individual stack in the Column/stack summary pane
(page 303).

4. Interactively adjust the reinforcement as required for the chosen stack
until the design is satisfactory.
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Arranging bars in the Interactive Column Design Dialog

The way in which bars are arranged depends on the column shape.

In circular columns, bars are arranged simply by modifying the bar size and
count fields.

In rectangular columns bars are arranged as described below.

Principal bars exist at fixed locations; they are labeled with numbers in the
cross-section, as shown above. You can only change the principal bar sizes, not
their locations.

Intermediate bars are the unnumbered bars in the cross-section. You can
change both their size and number. They are defined in the bar location table
by reference to the principal bars between which they lie.
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A count of "1" for each intermediate length in the bar location table indicates
that a single intermediate bar is positioned between each of the principal bars.

If the count is increased to "2" for Int. length 1-2, but reduced to "0" for Int.
length 2-3, the following arrangement is achieved. (Two intermediate bars are
positioned between principal bars 1 and 2, but there are now no intermediate
bars between principal bars 2 and 3.)

Note that Int. lengths 3-4 and 4-5 are adjusted automatically in the table to
match.

Link / Tie arrangements in rectangular and parallelogram sections have the
following basic options:

• Single links/ties,

• Double links/ties,

• Triple links/ties,

• Cross links/ties.

Tie bars are used with these arrangements. Link/Tie arrangements in other
section shapes use standard link/tie positions with additional tie bars where
required.
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Using a 2nd layer of bars

It is sometimes not possible to find a solution using a single-layer of
reinforcement - (a problem more common in hi-rise structures with large
columns in lower stacks).

Selecting the Use 2nd layer option in the interactive design provides you with
more flexibility to find a solution in these cases.

A 2nd layer can be applied to rectangular/parallelogram and circular sections.

Rectangular/parallelogram: a second layer in line with the first bar along the
adjacent length

• At least 2 intermediate bars are needed in each direction

A link is added along the second layer for all 3 section shapes.
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When using a 2nd layer, design checks are unchanged, except for the addition
of a layer spacing check for circular sections.

Column interaction diagrams (US customary units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual columns by accessing the interactive design. There are
two types of interaction diagrams: "axial force-moment interaction diagrams"
and "moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Column axial force-moment interaction diagram

The column axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
in that direction) are shown in the same colour, a different colour being used
for each of the two directions.
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The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

In general, the envelope will only be symmetrical for symmetrically reinforced
rectangular and circular sections.

Column moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.
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The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a column.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force. The design process for biaxial bending is as follows:

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
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Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - meaning the corner of the column near
bar 4 is at the top and the point near bar 2 is at the bottom. The linear strain
distribution between these points is then used to calculate the stress in each
bar.

If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Column interaction diagrams (metric units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual columns by accessing the interactive design. There are
two types of interaction diagrams: "axial force-moment interaction diagrams"
and "moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Column axial force-moment interaction diagram

The column axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
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in that direction) are shown in the same colour, a different colour being used
for each of the two directions.

The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

In general, the envelope will only be symmetrical for symmetrically reinforced
rectangular and circular sections.

Column moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
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many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.

The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a column.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force. The design process for biaxial bending is as follows:

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
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Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - meaning the corner of the column near
bar 4 is at the top and the point near bar 2 is at the bottom. The linear strain
distribution between these points is then used to calculate the stress in each
bar.

If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Defining additional column design cases for user defined forces

Additional design cases can be specified in order to for example design for
results from Post Tensioning analysis programs. These additional forces are
entered per selected stack on the Additional Design Cases page of the dialog.
Any number of design cases can be added and are checked alongside regular
combinations.

1. In the Interactive Column Dialog, select Additional Design Cases
(page 308) tab.

2. Click Design Cases to open a dialog in which to add the cases (these
belong to the model, so appear for all column stacks and wall panels).

3. Click OK to close the Additional Design Cases dialog.

4. Make relevant cases Active in the current stack.

5. Enter the loading for the Active cases.

6. Repeat 4 and 5 for all column stacks where appropriate.

The additional loading cases are now always checked whenever the regular
combinations are checked.

Interactive Column Design dialog
The Interactive Column Design dialog shows the current reinforcement and
check results for each stack in the selected column. When any of the editable
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fields are changed, the checks are re-run and the results are updated; enabling
you to quickly see the effect of each change you make to the reinforcement.

To display the dialog:

1. Right click on an existing concrete column.

2. In the context menu, select Interactive Design....

The dialog content is described below.

1. Column/stack summary pane

The top row in this pane shows the column summary, consisting of the overall
utilization ratio and design status.

• With this row selected you can edit the section size and grade for all stacks
simultaneously.

Subsequent rows show the design status of each stack and associated
utilization ratio.

• To design a particular stack, click on the corresponding row in the
summary pane.
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2. Longitudinal tab

All straight-edged cross sections have “Principal” bars located at shear tie
corners. Between these, evenly spaced identical “Intermediate” bars can be
located. Circular sections have 6 or more evenly spaced bars around the edge
of the section.

1. Longitudinal Bars:

• Principal bar size: Used to change the size of all principal bars.

• Use 2nd layer: Check the box to allow a second bar layer if
required.

• Spacing: For circular sections the user can control the layer
spacing.

• Intermediate bar size: (Not displayed for circular columns) Used to
change the size of all intermediate bars.

2. Bar Location Table: Used for adding intermediate bars into the cross-
section:

• Int. length - identifies the edge along which the bars are positioned

• Count - for changing the number of intermediate bars along the length
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• Ctr spacing - the centerline spacing for the current number of bars
along the length

• Status - indicates when the maximum bar spacing limit has been
exceeded. (When the minimum bar spacing limit is exceeded this is
displayed elsewhere in the Design Summary Table).

3. Design Summary Table: Displays the most critical result from all
combinations:

• Design and Resistance Moments and Moment Ratios

• Axial Force, Axial Resistance and Axial Ratios

• Smallest clear bar spacing

• Minimum area of steel

• Area of steel provided

4. Section Droplist: Used for changing the section size for the current stack.

NOTE If the droplist is used to change the section shape an autodesign
is performed.

5. Concrete Droplist: Used for changing the concrete grade for the current
stack.

6. Confinement status : This status is determined based on the
requirements for bars being tied.

7. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Tie locations

• Section dimensions

• Principal bar labels
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3. Links/Ties tab

1. Links:

• Use support region links/ties : Select to design support regions for
the links/ties.

• Link/Tie spacing : Specifies the link/tie spacing (if support regions are
applied two different spacings can be specified)

• Link/Tie size: Used to change the size of link/tiebars (all must have the
same size).

2. Link/Tie Design Summary Table: Displays the most critical result from all
combinations:

• Region length

• Link/Stirrup area over spacing required, major

• Link/Stirrup area over spacing required, minor

• Link/Tie area over spacing provided

• Link/Tie utilization ratio
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3. Section Droplist: Used for changing the section size for the current stack.

NOTE If the droplist is used to change the section shape an autodesign
is performed.

4. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions

• Principal bar labels

4. Interaction Diagram tab

1. N-M Interaction diagram : Top, mid fifth and bottom moment results for
each analysis type are plotted on the diagram for each combination

• The curves for bending about the major axis are shown in red

• The curves for bending about the minor axis are shown in blue
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2. M-M Interaction diagram : The diagram is different for each value of
axial force. Initially the diagram at the axial force of the critical
combination is drawn - this is the combination with the highest MEd / Mres
ratio.

3. Parameters: Select the analysis method, combination, and position for
which the diagrams are displayed.

• Set Critical button: If you have changed the parameters for which the
diagrams are displayed, you can click this button in order to revert
back to the critical parameters.

4. Design Forces: The design forces applicable for the selected parameters.

5. Additional Design Cases tab

This tab can be used for example to design for results from Post Tensioning
analysis programs.

1. Design cases...button: Click to open a dialog in which to add any
additional design cases.

The design case names defined here are available to all columns and walls
in the model.
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The Active box in this dialog is used to control which design cases are
considered (for the entire model).

After clicking OK you are then able to specify the design case design
forces in the Design cases table.

2. Design cases table: Each design case added via the Design cases...
button appears in the table, but only those that were marked as active
(for the entire model) are then available to have design forces applied.

In order to apply the design case design forces to a given stack you must:

• Select the required stack in the stack summary

• Click the Active box for the design case

• Enter the design forces

3. Design Moment Factors... button: Offers three potential “Design
Moment” adjustments for each direction:

• Set an imperfection eccentricity allowance (Eurocode only). This is
added to the analysis moment.

• Apply an amplification factor to allow for Second Order Effects (could
also be considered as a way to introduce an extra factor of safety).

• Apply a minimum moment check in one or both directions (the
calculation of this is specific to the Head Code set and is a function of
the section dimension “h” in the direction considered).

When applied, the resulting adjusted design moment is automatically
calculated and displayed in the dialog.

The adjustment values and options can be applied to individual Cases and
also quickly in a single operation to all Active Cases (those with “Active”
option checked on) as shown below:
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6. Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

Autodesign Stack Performs an autodesign reselecting
bars for the current stack

Detail Drawing Creates a detail drawing for the
selected member

Drawing Options Opens the DXF Export Preferences
dialog

Copy Opens a new dialog enabling the
selective coping of section/concrete
grade/reinforcement from the
selected stack to other stacks in the
same column.

See also

Interactive concrete member design (page 285)

Interactive concrete wall design

Opening the Interactive Wall Design Dialog

The Interactive Wall Design dialog (page 320) can be opened from any of the
2D or 3D Views as follows:

1. Right-click the wall you want to design interactively.

2. Select Interactive Design... (Static or RSA as required). The Interactive
Wall Design dialog is displayed.

3. Click on an individual panel in the wall/panel summary pane (page 320).

4. Interactively adjust the reinforcement as required until the panel design is
satisfactory.

Wall interaction diagrams (US customary units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual walls by accessing the interactive design. There are two
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types of interaction diagrams: "axial force-moment interaction diagrams" and
"moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Wall axial force-moment interaction diagram

The wall axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
in that direction) are shown in the same colour, a different colour being used
for each of the two directions.
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The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

Wall moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.
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The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a wall. The wall major and minor
axes follow the same convention as columns - the major axis is perpendicular
to the length (on plan) of the wall as shown.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force.

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - The linear strain distribution between the
top and bottom points is then used to calculate the stress in each bar.
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If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Wall interaction diagrams (metric units)

To visually observe the utilization of the design, interaction diagrams can be
drawn for individual walls by accessing the interactive design. There are two
types of interaction diagrams: "axial force-moment interaction diagrams" and
"moment interaction diagrams".

When the dialog is first opened the moment interaction diagram is displayed
for the critical parameters, but you can then view the diagram for any analysis
method, combination and position. The "Set Critical" button can be used to
return to the critical parameters.

Wall axial force-moment interaction diagram

The wall axial force - moment interaction diagram is created by fixing the
neutral axis rotation so that the neutral axis is perpendicular to the desired
direction of moment resistance and varying the depth of the neutral axis. This
is done about four orientations, separated by 90°: positive moment resistance
in the y-direction; positive moment resistance in the z-direction; negative
moment resistance in the y-direction; negative moment resistance in the z-
direction.

This method creates a list of points plotted on the interaction diagram for each
rotation. Each direction having two lists: one for positive moment resistance
and one for negative moment resistance. The failure envelopes created from
two lists referring to moments in the same direction (for positive and negative
in that direction) are shown in the same colour, a different colour being used
for each of the two directions.
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The applied values are plotted for all combinations on the same diagram. The
points referring to moments in each of the directions are in the same colour
as the failure envelope for that direction. Points for both directions are plotted
on the same diagram.

Wall moment interaction diagram

The moment interaction diagram is created for a specific axial force, and is
used to show the interaction of the applied moments compared to the
moment interaction failure envelope. The failure envelope is created by taking
many rotations of neutral axis, and calculating the depth for that rotation and
axial force. Moments are then taken about the plastic centroid to calculate the
moment resistance in each direction.
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The moment interaction diagram is calculated for each combination
individually, as it is calculated based on the applied axial force which is
typically different for each combination.
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The resultant moment (of resistance) angle is zero when creating positive
moments about the major axis and no moment about the minor axis. For
consistency, the neutral axis rotation is zero when it lies parallel with the
major axis with compression above the major axis. The resultant moment
angle (both applied and resistance) and neutral axis angle are then measured
anti-clockwise from this zero position.

The method and convention is the same for columns and walls. The
convention is shown graphically above for a wall. The wall major and minor
axes follow the same convention as columns - the major axis is perpendicular
to the length (on plan) of the wall as shown.

The N.A. rotation is that for the calculated NA depth and at which the ratio of
moments of resistance equals that of the applied moments for the applied
axial force.

For biaxial bending design the method of checking whether the reinforcement
in the section is sufficient is to check whether the bending resistance of the
section is larger than the applied moment for a given axial force. Tekla
Structural Designer therefore calculates the neutral axis position (rotation and
depth) at which the ratio of the moment limits in each direction is equal to the
ratio of the applied moments and the resultant axial resistance of the section
is equal to the applied axial force.

This is done by calculating the neutral axis depth at which the applied axial
force would equal the ultimate axial resistance of the section, and calculating
the ultimate moment resistance in each direction for this neutral axis depth.

For this calculation the cross-section shown above is effectively rotated so that
the neutral axis depth is horizontal - The linear strain distribution between the
top and bottom points is then used to calculate the stress in each bar.
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If the ratio of the ultimate moment resistance in each direction is not equal to
the applied ratio, then Tekla Structural Designer iterates to find the next
neutral axis angle "guess" and re-runs the process.

When the final neutral axis angle has been found, the program compares the
resultant applied moment with the resultant moment resistance to find the
moment utilization ratio for the applied force and moment combination.

The moments of resistance about each axis are given in the output below the
respective tables which calculate the moment resistance contribution of each
bar for that direction.

Defining additional wall design cases for user defined forces

Additional design cases can be specified typically in order to for example
design for results from Post Tensioning analysis programs. These additional
forces are entered per selected panel on the Additional Design Cases page of
the dialog. Any number of design cases can be added and are checked
alongside regular combinations.

1. In the Interactive Wall Dialog, select Additional Design Cases (page 327)
tab.

2. Click Design Cases to open a dialog in which to add the cases (these
belong to the model, so appear for all column stacks and wall panels).

3. Click OK to close the Additional Design Cases dialog.

4. Make relevant cases Active in the current stack.

5. Enter the loading for the Active cases.

6. Repeat 4 and 5 for all wall panels where appropriate.

The additional loading cases are always checked whenever the regular
combinations are checked.

NOTE Additional design cases can also be set up directly from Result Lines
in order to facilitate local section design around openings - see the
following topic.

Using result lines for local section design around openings

Interactive design of local sections around/between openings is possible using
Result Lines.

The design is performed either as a column or wall section (as specified by the
user), using those design forces determined along the lengths cut by the result
lines. Engineering judgement is therefore required when positioning the lines
to ensure suitable design forces are obtained.

For further details of the process, see:
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Related video

Interactive design using Result lines

Interactive Wall Design dialog
The Interactive Wall Design dialog shows the current reinforcement and
check results for each panel in the selected wall. When any of the editable
fields are changed, the checks are re-run and the results are updated; enabling
you to quickly see the effect of each change you make to the reinforcement.

To display the dialog:

1. Right click on an existing concrete beam.

2. In the context menu, select Interactive Design....

The dialog content is described below.

1. Wall/panel summary pane

The top row in this pane shows the Wall summary, consisting of the overall
utilization ratio and design status.

• With this row selected you can edit the thickness and grade for all stacks
simultaneously.

Subsequent rows show the design status of each panel and associated
utilization ratio.

• To design a particular panel, click on the corresponding row for the panel
in the summary pane.
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2. Longitudinal tab (no end-zones)

Use end-zones : With this box unchecked end-zones are not used.

1. Panel: Used for adding either one or two layers of bars in the panel.

• Number of layers - (1, or 2)

• If Reinforcement type = loose bars

• Number of rows - the number of bars in each layer

• Centre spacing - the spacing between adjacent bars in a layer
(measured centre to centre)

• Vertical bar size - specifies the size to be checked

• Additional end row bars - specifies the number of additional bars in
the end row

• Centre spacing (end rows) - the spacing between layers (measured
centre to centre)

• If Reinforcement type = mesh

• Mesh size - specifies the mesh size to be checked
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• End row vertical bar size - specifies the vertical bar size at the ends
of the mesh

• Additional end row bars - specifies the number of additional bars in
the end row

• Centre spacing (end rows) - the spacing between layers (measured
centre to centre)

2. Design Summary Table: Displays the most critical result from all
combinations:

• Design and Resistance Moments and Moment Ratios

• Axial Force, Axial Resistance and Axial Ratios

• Smallest clear bar spacing

• Minimum area of steel

• Area of steel provided

3. Thickness: Used for changing the thickness of the current panel.

4. Concrete Droplist: Used for changing the concrete grade for the current
panel.

5. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions
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2. Longitudinal tab (with end-zones)

Use end-zones : With this box checked end-zones are used.

1. End-zones: Used for adding bars in the end-zones.

• Length - length of each end-zone

• Number of rows - the number of loose bars in each end-zone

• Centre spacing - the spacing between adjacent bars in a layer
(measured centre to centre)

• Vertical bar size - specifies the size to be checked

• Additional end row bars - specifies the number of additional bars in
the end row

• Centre spacing (end rows) - the spacing between layers in the end-
zone (measured centre to centre)
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2. Mid-zone: Used for adding either one or two layers of bars in the panel
between the end-zones.

• Number of layers - (1, or 2)

• If Reinforcement type = loose bars

• Number of rows - the number of bars in each layer

• Centre spacing - the spacing between adjacent bars in a layer
(measured centre to centre)

• Vertical bar size - specifies the size to be checked

• If Reinforcement type = mesh

• Mesh size - specifies the mesh size to be checked

• End row vertical bar size - specifies the vertical bar size at the ends
of the mesh

3. Design Summary Table: Displays the most critical result from all
combinations:

• Design and Resistance Moments and Moment Ratios

• Axial Force, Axial Resistance and Axial Ratios

• Smallest clear bar spacing

• Minimum area of steel

• Area of steel provided

4. Thickness: Used for changing the thickness of the current panel.

5. Concrete Droplist: Used for changing the concrete grade for the current
panel.

6. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions
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3. Lateral tab

1. Panel:

• Use links/ties : Select to specify links/ties.

• Link/Tie size: Used to change the size of link/ties (all must have the
same size).

• Horizontal bar size: Used to specify the size of horizontal bars.

• Horizontal bar spacing: Used to specify the vertical spacing of
horizontal bars.

2. Use support region links/ties: Select to design support regions for the
links/ties.

NOTE Only displayed provided Use links/ties box is also checked.

• Link/Tie spacing : Specifies the link/tie spacing (if support regions are
applied two different spacings can be specified)

3. Link/Tie Design Summary Table: Displays the most critical result from all
combinations:

• Link/Tie area over spacing required, major

• Link/Tie area over spacing provided, major

• Link/Tie utilization ratio, majo
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• Link/Tie area over spacing required, mino

• Link/Tie area over spacing required, mino

• Link/Tie utilization ratio, minor

4. Horizontal Reinforcement Summary Table: The table displays the
horizontal bar spacing and reinforcement ratios.

5. Thickness: Used for changing the thickness of the current panel.

6. Cross-section : The drawing displays:

• Exact bar positions (drawn to scale)

• Link/Tie locations

• Section dimensions

4. Interaction Diagrams tab

1. N-M Interaction diagram : Top, mid fifth and bottom moment results for
each analysis type are plotted on the diagram for each combination

• The curves for bending about the major axis are shown in red

• The curves for bending about the minor axis are shown in blue
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2. M-M Interaction diagram : The diagram is different for each value of
axial force. Initially the diagram at the axial force of the critical
combination is drawn - this is the combination with the highest MEd / Mres
ratio.

3. Parameters: Select the analysis method, combination, and position for
which the diagrams are displayed.

• Set Critical button: If you have changed the parameters for which the
diagrams are displayed, you can click this button in order to revert
back to the critical parameters.

4. Design Forces: The design forces applicable for the selected parameters.

5. Additional Design Cases tab

This tab can be used for example to design for results from Post Tensioning
analysis programs.

1. Design cases...button: Click to open a dialog in which to add any
additional design cases.

The design case names defined here are available to all columns and walls
in the model.
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The Active box in this dialog is used to control which design cases are
considered (for the entire model).

After clicking OK you are then able to specify the design case design
forces in the Design cases table.

2. Design cases table: Each design case added via the Design cases...
button appears in the table, but only those that were marked as active
(for the entire model) are then available to have design forces applied.

In order to apply the design case design forces to a given panel you must:

• Select the required panel in the panel summary

• Click the Active box for the design case

• Enter the design forces

3. Design Moment Factors... button: Offers three potential “Design
Moment” adjustments for each direction:

• Set an imperfection eccentricity allowance (Eurocode only). This is
added to the analysis moment.

• Apply an amplification factor to allow for Second Order Effects (could
also be considered as a way to introduce an extra factor of safety).

• Apply a minimum moment check in one or both directions (the
calculation of this is specific to the Head Code set and is a function of
the section dimension “h” in the direction considered).

When applied, the resulting adjusted design moment is automatically
calculated and displayed in the dialog.

The adjustment values and options can be applied to individual Cases and
also quickly in a single operation to all Active Cases (those with “Active”
option checked on) as shown below:
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6. Buttons

Button/option Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

Autodesign Panel Performs an autodesign reselecting
bars for the current panel

Detail Drawing Creates a detail drawing for the
selected member

Drawing Options Opens the DXF Export Preferences
dialog

Copy Opens a new dialog enabling the
selective coping of wall thickness/
concrete grade/reinforcement from
the selected panel to other panels in
the same wall.

7. Suspend Checking option

By default this option is unselected and checks are made after every edit. For
large structures with many combinations interactive checking takes time which
can be frustrating if you want to make several changes.

When this option is selected, checking is suspended. (The option also changes
to red to highlight that this is the case).

Checks are only carried out and results updated when the option is unselected
once more.

See also

Interactive concrete member design (page 285)

Concrete slab design
To get familiar with the concrete slab design processes. click the following
links:

• Flat slab design workflow (page 330)

• Slab on beams design workflow (page 342)

• Concrete slab design aspects (page 348)
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Flat slab design workflow
A simple flat slab model as shown below is used in order to demonstrate the
techniques involved in the slab design process.

Note that there is a transfer level at the first floor:
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Set up pattern loading

If necessary you should consider manually splitting and joining slab panels to
facilitate management of the pattern loading process.

By default, only beam loads, and slab loads that have been decomposed on to
beams, are patterned. Loads applied to slabs should be manually patterned
using engineering judgement; this is achieved on a per panel basis for each
pattern load by toggling the loading status via Update Load Patterns on the
Load ribbon.

Establish slab design moments

Analysis is required to establish the moments to be used in the slab design -
this analysis is automatically performed when either Analyze All, Design
Concrete or Design All are run.

Typically these moments are taken from the FE chasedown model results - as
each floor is analyzed individually this method mimics the traditional design
approach.

If you have elected to mesh 2-way slabs in the analysis, the 3D Analysis model
results will also be considered.
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NOTE It is NOT suggested that it should be standard practice to mesh 2-way slabs,
for slabs that are not needed to participate in the lateral load analysis it is
better not to mesh in 3D, however: - you may choose to mesh them to cater
for the possibility of un-braced flat slab design. - more likely, you may do so to
deal with significant transfer slabs - e.g. a shear wall supported by a slab,
(there is no need to create a system of fictitious beams).

Consider simple (linear) deflection (US customary units)

Approximate slab deflections can be obtained by reviewing the 2D deflection
contours for the FE Chasedown results in the Results View, (typically by
opening a separate Level view of each floor).

NOTE Deflection results for combinations should be viewed based on "service"
rather than "strength" factors - in this way the applied stiffness adjustments
do not need to account for load factors.

NOTE For Flat Slab panels - Deflection checks are not performed automatically. In
practice flat slab models are often irregular, so some degree of engineering
judgement will be required.

If the Head Code you are working to prevents you from running a Rigorous
Deflection Check you can still use a "Deemed-to-Satisfy" method to assess
deflections utilizing slab strips as outlined below:
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1. With the level view displayed in 2D, click Create Strip and create a strip
between supports.

2. To display the strip results right-click the strip and choose Open Load
Analysis View. The maximum deflection and span of the strip are both
reported.

In this example there is a requirement to limit total deflection to span/240

Taking the span as the length of the slab strip: 288in

Deflection limit: 288/240 = 1.2 in

Actual deflection: 0.9 in - the check passes

The initial check was performed taking the diagonal across a slab panel.
Checks should also be made between the horizontal and vertical spans. More
generally, check the max deflection occurring along a straight line between
any two support points.
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Consider simple (linear) deflection (metric units)

Approximate slab deflections can be obtained by reviewing the 2D deflection
contours for the FE Chasedown results in the Results View, (typically by
opening a separate Level view of each floor).

NOTE Deflection results for combinations should be viewed based on "service"
rather than "strength" factors - in this way the applied stiffness adjustments
do not need to account for load factors.
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NOTE For Flat Slab panels - Deflection checks are not performed automatically. In
practice flat slab models are often irregular, so some degree of engineering
judgement will be required.

If the Head Code you are working to prevents you from running a Rigorous
Deflection Check you can still use a "Deemed-to-Satisfy" method to assess
deflections utilizing slab strips as outlined below:
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1. With the level view displayed in 2D, click Create Strip and create a strip
between supports.

2. To display the strip results right-click the strip and choose Open Load
Analysis View. The maximum deflection and span of the strip are both
reported.

In this example there is a requirement to limit total deflection to span/250

Taking the span as the length of the slab strip: 7317mm

Deflection limit: 7317/250 = 29mm

Actual deflection: 22mm - the check passes

The initial check was performed taking the diagonal across a slab panel.
Checks should also be made between the horizontal and vertical spans. More
generally, check the max deflection occurring along a straight line between
any two support points.
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Select a Level, or sub-model

In models with distinct floor levels you should use 2D Views to work on the
floor design one level at a time. Occasionally the "3D geometry" of a model
may make it less easy to distinguish between individual floors, in which case it
may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check slabs
and patches: this saves time as only the slabs and patches in the current level
are considered. Running Design Slabs or Design Patches from the Design
ribbon will take longer as it considers all the slabs and patches in the model.

Add patches

This is an interactive process - requiring a certain amount of engineering
judgement.

Typically you should expect to work on this one floor at a time, (making use of
multiple views when creating patches as discussed below).

It is suggested that you add patches in the Results View while looking at
relevant moment contours - For example you might (after selecting the FE
chasedown result type) have Mx moments on in one view on the left and My
moments in a second view on the right, as below:
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By doing this, it is possible to see how patches extend over the peaks.

Typically, at the initial patch creation stage you should make the patches a
reasonable size and not be concerned if they are a bit too big - as this should
be reviewed/resolved at the patch design optimization stage.

In a "slab on beam" situation, you may want to add beam and wall patches to
cover the full extent of non-zero top bending moments. By doing so you can
then set the top reinforcement in the slab panels to none and the panel design
should still pass.

Design panels

NOTE Panel design is dependent on the areas of patches (patch areas which are
excluded from panel design) - hence patches should be added before panels
are designed.

To design multiple slab panels, either:

• From the Design ribbon run Design Slabs in order to design or check all the
panels in the model - by default newly created panels will all be in "auto-
design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Slabs or Check Slabs. Working in this way restricts the design
or checking to the slab panels in the current view. This will be a much
faster option on large buildings and avoids time being wasted designing
slab panels at levels where patches have not yet been set up.

NOTE When accessed from the right-click menu, these commands operate as
follows:

Engineers Handbooks 338 Concrete member and slab design handbook



- Design Slabs will re-design slabs (potentially picking new reinforcement)
regardless of the current autodesign setting.

- Check Slabs will check the current reinforcement in slabs regardless of the
current autodesign setting.

Review/optimize panel design

Once again it is suggested that you use split Review Views to examine the
results as indicated below.

In this example a number of members are not heavily loaded so you could
consider resizing or designing them interactively.

The view on the left shows Slab Design Status, the view on the right shows
Slab Reinforcement in the panels. Note that the tool tip indicates all panel/
patch reinforcement as you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 8mm dia bars are selected and you would just never use anything less
than a 10mm bar in a flat slab, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to).

NOTE Auto-design will select the smallest allowable bars at the minimum centers
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
150mm.

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.
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Remember:

• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.

• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

Design patches

Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design the patches
which will top up the reinforcement as necessary within the strips of each
patch.

To do this, either:

• From the Design ribbon run Design Patches in order to design or check all
the patches in the model - by default newly created patches will all be in
"auto-design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands operate as
follows:

- Design Patches will re-design the patches (potentially picking new
reinforcement) regardless of the current autodesign setting.

- Check Patches will check the current reinforcement in the patches regardless
of the current autodesign setting.

Review/optimize patch design

At this stage the patch sizes can be reviewed:

• Beam patches - can the width be adjusted (minimized)

• Wall patches - can the width be adjusted (minimized)

• Column patches - Is the size reasonable - this relates to code guidance
about averaging in columns strips - it is not reasonable to average over too
wide a width. If in doubt safe thing to do is err on the side of caution and
make them a bit smaller.

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.
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• Now click Slab Reinforcement in the Review View to review and standardize
the patch reinforcement. For instance in column patches this might include
forcing the spacing of the slab reinforcement to be matched (if the slab has
H12-200, then in the patch don't add H12-125, swap to H16-200 - then
there will be alternate bars at 100 crs in this strip of the patch.

Add and run punching checks

Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added over the entire floor, or structure by windowing
it. You can then select any check and review the properties assigned to it.
Internal/edge/corner locations are automatically determined (with a user
override if you require). Once added click Design Punching Shear and the
checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the slab

NOTE In order to see the punching check status in the Review View you might need
to first switch off Slab Items and Slab Patches in Scene Content.

Rigorous deflection check

In Tekla Structural Designer you can choose to adopt a rigorous approach to
slab deflection calculation using iterative cracked section analysis. For futher
details, see:
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Create drawings and quantity estimations

Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations

Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).

Slab on beams design workflow
A simple slab on beam model as shown below is used in order to demonstrate
the techniques involved in the slab design process.

Note that not all the slab panels are rectangular.
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Set up pattern loading

By default, only beam loads, and slab loads that have been decomposed on to
beams are patterned. Loads applied to slabs should be manually patterned
using engineering judgement; this is achieved on a per panel basis for each
pattern load by toggling the loading status via Update Load Patterns on the
Load ribbon.

Establish slab design moments

Analysis is required to establish the moments to be used in the slab design -
this analysis is automatically performed when either Analyze All, Design
Concrete or Design All are run.

Typically these moments are taken from the FE chasedown model results - as
each floor is analyzed individually this method mimics the traditional design
approach.

If you have elected to mesh 2-way slabs in the analysis, the 3D Analysis model
results will also be considered.

NOTE It is NOT suggested that it should be standard practice to mesh 2-way slabs,
for slabs that are not needed to participate in the lateral load analysis it is
better not to mesh in 3D, however: - you may choose to mesh them to cater
for the possibility of un-braced flat slab design. - more likely, you may do so to
deal with significant transfer slabs - e.g. a shear wall supported by a slab,
(there is no need to create a system of fictitious beams).

Select a Level

In models with distinct floor levels you should use 2D Views to work on the
floor design one level at a time. Occasionally the "3D geometry" of a model
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may make it less easy to distinguish between individual floors, in which case it
may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check slabs
and patches: this saves time as only the slabs and patches in the current level
are considered. Running Design Slabs or Design Patches from the Design
ribbon will take longer as it considers all the slabs and patches in the model.

Add beam and wall top patches

You may optionally want to add beam and wall "top surface" patches to cover
the full extent of non-zero top bending moments. By doing so you can then set
the top reinforcement in the slab panels to none and the panel design should
still pass.

This is an interactive process - requiring a certain amount of engineering
judgement.

Typically you should expect to work on this one floor at a time, (making use of
multiple views when creating beam patches as discussed below).

It is suggested that you add patches in the Results View while looking at
relevant moment contours - For example you might (after selecting the FE
chasedown result type) have Mdx top moments on in one view on the left and
Mdy top moments in a second view on the right, as below
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By doing this, it is possible to see how patches extend over the moment
contours.

It is suggested that at the initial patch creation stage you should make the
patches a reasonable size and not be concerned if they are a bit too big - as
this should be reviewed/resolved at the patch design optimization stage.

Design panels

NOTE Slab on beams panel design takes account of any beam or wall patches (by
excluding the patch areas from panel design) - hence patches should be
added before panels are designed.

To design multiple slab panels, either:

• From the Design ribbon run Design Slabs in order to design or check all the
panels in the model - by default newly created panels will all be in "auto-
design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Slabs or Check Slabs. Working in this way restricts the design
or checking to the slab panels in the current view. This will be a much
faster option on large buildings and avoids time being wasted designing
slab panels at levels where patches have not yet been set up.

NOTE When accessed from the right-click menu, these commands operate as
follows:

- Design Slabs will re-design slabs (potentially picking new reinforcement)
regardless of the current autodesign setting.

- Check Slabs will check the current reinforcement in slabs regardless of the
current autodesign setting.
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Review/optimize panel design

It is suggested that you use split Review Views to examine the results as
indicated below.

The view on left shows Slab Design Status, (with slab patches turned off in
Scene Content to assist clarity), the view on right shows Slab Reinforcement in
the panels. Note that the tool tip indicates all panel/patch reinforcement as
you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 8mm dia bars are selected and you would just never use anything less
than a 10mm bar in a slab, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to).

NOTE Auto-design will select the smallest allowable bars at the minimum centers
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
150mm.

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.

Remember:
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• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.

• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

• If the span-effective depth check is failing, review the panel properties to
confirm that edge categories are set correctly, (and if the panel shape is
irregular consider whether it is being suitably idealized as a rectangular
panel). See: Slab on beam idealized panels (page 353)

Design beam and wall patches

Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design any beam or
wall patches that you may have defined.

To do this, either:

• From the Design ribbon run Design Patches in order to design or check all
the patches in the model - by default newly created patches will all be in
"auto-design" mode - so reinforcement is selected automatically.

or

• In the 2D View of the floor which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands operate as
follows:

- Design Patches will re-design the patches (potentially picking new
reinforcement) regardless of the current autodesign setting.

- Check Patches will check the current reinforcement in the patches regardless
of the current autodesign setting.

Review/optimize patch design

At this stage the patch sizes can be reviewed:

• Beam patches - can the width be adjusted (minimized)

• Wall patches - can the width be adjusted (minimized)

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.

• Now click Slab Reinforcement in the Review View to review and standardize
the patch reinforcement.
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Create drawings and quantity estimations

Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations

Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).

Concrete slab design aspects

Concrete type

While you can apply both normal and lightweight (LW) concrete in the slab
properties, slab design using lightweight concrete is only available for
Eurocodes.

When using other Head Codes slabs can only be designed using normal weight
concrete.

LW density classes and grades

6 Density classes (1.0, 1.2 ….. 2.0) are available and 15 default grades are
provided; 5 in each of the density classes: 1.6, 1.8 and 2.0.

• For example the grade name “LWAC30/37-DC1.8” denotes; LWAC =
Lightweight aggregate concrete; 30/37 = Strength class; DC1.8 = density
class.

• Custom LW grades can be added for which note that new LW-specific
property η1 must be specified.

NOTE LW grades can be reviewed, edited and applied via Review View > Show/Alter
State Material Grade Attribute.

How the load decomposition method affects slab design

Only slabs that have been specified with two-way load decomposition are
designed.

One-way load decomposition in Tekla Structural Designer is a simple
procedure that does not determine slab design forces. When a slab's
decomposition is set as one-way it is assumed that it is some form of precast
slab (presumably designed by safe load tables).

• A flat slab panel always uses two-way load decomposition.
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• A slab on beams panel can either be specified to use one-way or two-way
decomposition - however if it is specified as one-way it cannot then be
designed in Tekla Structural Designer.

It should be noted that any in-situ slab is capable of two-way decomposition:

• When a slab is set as two-way it will only effectively span in 2 directions if
its proportions and support conditions mean that there will be a two-way
effect.

• For example - If a slab that has a span of 6 units in one direction and 50
units in the other is set to two-way decomposition, then although it is two-
way the FE analysis will still inherently take the load one-way.

Two-way spanning slab panel design moments

When a slab panel is specified with two-way decomposition, a general FE
based approach is used to determine the design moments. If you have elected
to mesh 2-way slabs in the analysis, the 3D Analysis results are also
considered:

• The worst design moment (per unit width) is found in each direction of the
slab - if the design moment is zero in one of the directions then the
analysis has shown that the slab is effectively spanning one-way and the
supplied reinforcement in this secondary direction will be selected to suit
the minimum requirements of secondary reinforcement.

• Note that this FE based approach inherently caters for point loads, line
loads, openings, etc and for the possibility of variable adjacent span
lengths in a continuous "1-way" slab (and of course it can still be applied to
the simple case of a "1-way" slab with a uniform UDL applied and uniform
span lengths).

Alignment of slab panel reinforcement

X direction reinforcement is aligned to the panel span, which is determined by
the slab's rotation angle property. Y direction reinforcement is always
perpendicular to the X direction reinforcement.

For further details, see: Rotation angle for slab items and panels (page 355)

Slab panel reinforcement

In a slab you have two surfaces: Top (T) and Bottom (B).
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In each surface you have two layers of steel in orthogonal directions - X
direction steel and Y direction steel. Layer 1 is the outside layer - the one
closest to the surface. Layer 2 is the inside layer. Which direction is the outer
layer is controlled by this slab panel setting: Outside layer in X direction.

Any of the four layers can be set to "none" if required.

Slab patch reinforcement

Additional rectangular reinforcement patches can be applied to slab panels:

• column patch - at column stack heads

• beam patch - along beams

• wall patch - along walls

• panel patch - at the panel centre

• typically positioned centrally - but not restricted to this location and also
not restricted to existing purely within one panel

• can also be positioned under loads

These patches are either in the top or the bottom of the slab and may or may
not have reinforcement defined in them. If no reinforcement is defined then
the background reinforcement is used. If patch reinforcement is defined then
it will either be used on its own, or if you select the "Combine with Panel
Reinforcement" option, the sum of the background + patch reinforcement will
be used. Note that this option is only selectable when the "Align to Panel
Reinforcement" option is also selected since combining in this way would only
be valid provided the reinforcement is reasonably aligned. Choosing the
reinforcement to be combined also forces the "Cover as Panel" option to be
selected as the program assumes the reinforcement to be in a single layer. If
the reinforcement is not combined you can specify the cover to the patch
reinforcement by turning off the "Cover as Panel" option.

Note that patches may overlap on the plan view, and there is no restriction on
this, even patches relating to the same layer of reinforcement are allowed to
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overlap. This situation is handled conservatively during design by simply
ignoring the overlap.

Each patch manages reinforcement and the reinforcement design using a
number of slab design strips. Some key points to bear in mind considering
patch design are:

• A patch only manages data in the top or the bottom layers of a slab, not
both.

• There can be up to 3 design strips in each direction of a patch

• There is no requirement to have design strips in both directions - there can
be one design strip in one direction and none in the other.

• Within any strip there might be patch reinforcement to consider but note
that:

• The underlying panel reinforcement can be none

• The added patch reinforcement can be none.

• If there is patch reinforcement to consider this can be considered instead
of, or in addition to, relevant slab reinforcement

Slab patch strip design

For the strip designs within each patch it is necessary to establish which bar
layer is to be designed and work out if and how the patch reinforcement
combines with the panel reinforcement.
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As shown above there are 2 distinct options:

1. Patch aligned to panel

2. Patch NOT aligned to panel:

In both cases the reinforcement that is determined for use in the design
checks is some combination of the panel and patch reinforcement. Expanding
upon this the cases considered are:

Patch aligned to panel:

1. Patch reinforcement type = NONE then the panel reinforcement is used
for all layers

2. Combine with Panel Reinforcement = No Then the patch reinforcement is
used in the patch surface and the panel reinforcement is used in the
opposite surface.

Engineers Handbooks 352 Concrete member and slab design handbook



3. Combine with Panel Reinforcement = YES Then the patch reinforcement is
combined with panel reinforcement and used in the patch surface and the
panel reinforcement is used in the opposite surface.

Patch NOT aligned to panel:

Patch reinforcement is used in the surface to which the patch applies.
Reinforcement in the other surface is taken from the panel using the most
aligned possibility.

Patches to both surfaces

As stated above, patch reinforcement is only ever used in the surface to which
a patch applies, reinforcement in the other surface is taken from the panel.

In rare situations you may have separate patches on both surfaces; in which
case you would want the patch reinforcement from the top patch to be
considered on the top surface and patch reinforcement from the bottom
patch to be considered on the bottom surface.

In this specific situation, for both patches the other surface doesn't necessarily
need to be designed to only consider reinforcement in the panel; you can
avoid this by selecting the patch property Consider patch surface moments
only.

Span effective depth checks for irregular shaped panels

Only slabs that have been specified with two-way load decomposition are
designed.

In order to perform span - effective depth checks for irregular shaped beam
and slab panels, they have to be converted to idealized four sided rectangular
panels.

For further details, see: Slab on beam idealized panels (page 353)

Slab on beam idealized panels

Only slabs that have been specified with two-way load decomposition are
designed.

In order to perform span - effective depth checks for irregular shaped beam
and slab panels, they have to be converted to idealized four sided rectangular
panels.

To do this, the enclosing lengths of the panel in X and Y are first determined,
(local X being defined by the panel rotation angle):

Lx-enc = maximum overall length of the panel measured parallel to local X

Ly-enc = maximum overall length of the panel measured perpendicular to
local X

A user specified adjustment ratio is then applied to these lengths to determine
the adjusted lengths. Conservatively the adjustment ratio defaults to 1.0 in
both directions.
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In situations where the panel does not have 4 sides, (such as the one shown
below), some engineering judgement might be required when deciding on
appropriate values of the adjustment ratios in each direction.

The resulting idealized panel with dimensions in X and Y is illustrated below:.

Edge Category
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For the span-effective depth check, the edge categories in each direction have
to be manually assigned to the idealized slab panel. The three edge categories
being:

• Unsupported

• Continuous Support

• Dis-continuous Support (default)

Rotation angle for slab items and panels
The rotation angle in the slab item/panel properties is used to control the span
direction. For reinforced slabs the X direction reinforcement is aligned to the
span.

NOTE When SpanDirection is switched on in Scene Content, the rotation angle/X
direction is represented by a blue arrow.

Slab items and panels defined by a level

When the rotation angle/X direction = 0

• Span direction aligns with global X

When the rotation angle/X direction = 90

• Span direction aligns with global Y

Panels defined by a frame

When the rotation angle = 0

• Span direction is horizontal

When the rotation angle = 90

• Span direction is vertical

Slab items and panels defined by a sloped plane

NOTE In a sloped plane positive Y is always aligned to the up-slope direction, so that
positive X is always perpendicular to the slope.

When the rotation angle/X direction = 0

• Span direction aligns with X direction of the slope (i.e. perpendicular to the
slope, as shown below)
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When the rotation angle/X direction = 90

• Span direction aligns with Y direction of slope (i.e. parallel to the slope, as
shown below)
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1.7 Slab deflection handbook
This handbook provides an overview of how iterative cracked section analysis
is applied in Tekla Structural Designer for the purpose of obtaining a better
estimate of slab deflections.

NOTE Tekla Structural Designer's iterative cracked section analysis for slab
deflections is only available for the Eurocode and ACI/AISC Head Code.

• Slab deflection methods (page 357)

• Rigorous slab deflection workflow (page 359)

• Factors that affect rigorous slab deflection estimates (page 360)

• Event sequences (page 368)

• Slab deflection analysis sequence (page 381)

• Total, differential, and instantaneous deflection types (page 382)

• Slab deflection calculations in depth (page 383)

• Check lines (page 396)

• Slab deflection status and utilization (page 399)

• Slab deflection example (Eurocode) (page 401)

• Slab deflection example (ACI) (page 437)

Related video

Rigorous Slab Deflection (Eurocode)

Rigorous Slab Deflection Design (ACI)

Slab deflection methods
Concrete is considered a durable and economic material for floors systems.
However, reinforced concrete slabs deflect. The magnitude of the deflection is
more complicated for concrete as deflection increases with time. It’s long term
behavior is characterized by cracking caused by flexure, shrinkage and creep.
If this is not taken into consideration by allowing adequate tolerances to glass
facades and internal partitions for example then problems can arise.

Tekla Structural Designer provides two alternative methods for checking
deflections. Either:

• Deemed-to-satisfy checks, or

• A rigorous theoretical deflection estimation using iterative cracked section
analysis
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Deemed-to-Satisfy Checks
A couple of deemed-to-satisfy checks are presented here.

1. The use of a limiting span-to-depth ratio (L/d) method. This method is
assumed to ‘be adequate for avoiding deflection problems in normal
circumstances’. It can only be considered as a rough deflection estimate
and is not intended to predict how much a member will actually deflect.
Total deflection is expected to be < span / 250 (Eurocode) or < span / 250
(US) and deflection affecting sensitive finishes is expected to be < span /
500 (Eurocode) or < span / 480 (US)

2. A linear analysis with adjusted analysis properties.

It is important to appreciate that these deemed-to-satisfy methods do not
predict actual deflections even though the linear analysis method provides a
total deflection that can be checked against the span / 250 (Eurocode) or <
span / 250 (US) limit mentioned above.

When normal deflection limits do not apply, for example, due to stricter usage
limits, glazed cladding systems or where a faster pace of construction is
applied then the ‘deemed-to-satisfy’ checks are no longer applicable - the
alternative is a rigorous deflection estimation which is the primary topic for
this guide.

See also

• Deemed to satisfy slab deflection checks example (Eurocode) (page 402)

• Deemed to satisfy slab deflection checks example (ACI) (page 438)

Rigorous theoretical deflection estimation
The rigorous theoretical deflection assessment takes into account cracking,
creep and shrinkage over time.

In the UK, rigorous deflection estimation is taken to mean deflection
estimation in accordance with the Concrete Society Technical Report 58.

The principle of assessing deflections rigorously involves assessing the
curvatures induced by both load and shrinkage, adding them together and
then the total curvature is translated into a deflection.

The Technical Report discusses the importance of construction events. Total
deflection at the end of every event comprises:

• An instantaneous deflection which is influenced by the extent of cracking

• An additional accumulated creep deflection

• An additional accumulated shrinkage deflection.

Once these totals are known, differential deflections between any two events
can be calculated.

The Technical Report gives detailed guidance on some very complex looking
calculations - it all seems very “rigorous”. However, we must not lose sight that
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the material - Concrete is a very variable material. Furthermore, how
accurately can we really predict input parameters such as event loads and
timings? The report advises that deflection accuracy can only be considered an
estimate in the range +15 to -30%.

In the US, the basic approach described in ACI 318 has a similar approach to
cracking, interpolating between the fully cracked and the uncracked states,
(although it doesn’t recognize the reduction in tension stiffening). For creep
and shrinkage, in ACI 318 there is a single multiplier for the deflection
calculated from the cracked flexural rigidity. There are additionally two ACI
Committees 435 and 209 which go into more detail about creep and shrinkage
calculations. The US user can therefore either adopt the basic ACI 318
approach, or, take on board the ACI Committee 435 & 209 guidance. In special
situations the TR58 approach could even be considered.

Expectations - It is incorrect to think that rigorous methods will provide
greater economy. i.e. by allowing the engineer to reduce slab thickness or the
quantity of reinforcement. The end result is greatly influenced by the various
input parameters which each can impact on the deflection.

See also

• Rigorous slab deflection workflow (page 359)

• Rigorous slab deflection analysis example (Eurocode) (page 405)

• Rigorous slab deflection analysis examples (ACI) (page 440)

Rigorous slab deflection workflow
You perform rigorous slab deflection analysis in Tekla Structural Designer
from the Slab Deflection toolbar.

The suggested workflow is as follows:

1. Define the slab loading event sequences (page 368).

2. and review deflections for the final load event.

You can analyze the current or selected level (sub-model) or choose to
analyze every slab in the model. Obviously your choice has an effect on
the time necessary to undertake the iterative slab deflection analysis.

3. Define the slab deflection checks via the Slab Deflection Check
Catalogue and then place Check lines (page 396) as required.

4. Graphically review the Slab deflection status and utilization (page 399).

5. Make adjustments as necessary until the status passes. For more
information, see .

NOTE A reasonable level of slab reinforcement should be established prior to
running the Slab Deflection Analysis as this will have a significant impact on
the deflection calculations.
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Factors that affect rigorous slab deflection estimates
Many input parameters have an impact on the rigorous deflection estimates.
These include:

• Level of Restraint

• Concrete properties

• Stiffness adjustments

• Allowance for shrinkage effects

• Event sequence parameters

• and even the assumed analysis properties of connected columns and walls

Some of the key factors are described below, these vary depend on the head
code being worked to.

Quasi-permanent load factors (EC2)
An accurate prediction of deflection requires a realistic assessment of the
loading. To the Eurocodes long term loads are termed quasi-permanent and a
ψ2 factor is applied to the imposed load which varies based on the use of the
structure. These are dealt with when defining the imposed load case.
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Beta coefficient (EC2)
This property is set in the Event Sequence dialog.
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Beta relates to the duration of the load and tension stiffening effects.

NOTE Tension stiffening occurs when the concrete is not fully cracked -
because there is still concrete in the tension zone that transfers some
tensile forces, the stiffness is greater than that of the fully cracked
stiffness (and less than the uncracked stiffness).

Due to phenomena such as increased cracking or local bond failure, tension
stiffening effects reduce over time - Beta is used to account for these, (see EC2
Clause 7.4.3 and TR58).

• For loads with a short duration, and for cyclic loads, Beta should be set to
1.0.

• For loads with a long duration, Beta should be set to 0.5.

NOTE In Tekla Structural Designer, Beta defaults to 1.0 where the start event
time is <= 30 days and 0.5 if >30 days, but may be changed for any
event.
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Since these phenomena are irreversible, it is not recommended that Events
have a value of Beta greater than that set for any previous Event and a
warning will be issued if you do this.

However, there are circumstances where you may wish to have a value of
Beta=0.5 in the earlier events, and Beta=1.0 in a later Event. For example, TR58
suggests that Beta=1.0 be used for the variable part of imposed load (if you
wish to consider that at all).

In this case the analysis will permit you to enter these values. However,
because the reduction in tension stiffening is carried forward and is
irreversible in the analysis, caution is advised.

To explain this issue more fully, the impact of choosing Beta=1.0 at a later
event, for different extents of cracking, is explored below.

Consider 3 possible configurations of a model, where:

1. There are many elements that are uncracked at the end of earlier events.
For a later event where the duration is short (which implies you should set
Beta=1), setting Beta=0.5 could lead to an overestimation of incremental
cracking, and subsequently overestimation of deflection.

2. There are many elements that are cracked in an earlier event, for which
you have chosen Beta=0.5. For a later event where the duration is short
(which implies you should set Beta=1), if cracking increases in that Event,
setting Beta=1.0 could lead to an underestimate of incremental cracking,
and subsequently an underestimate of deflection for this later event.

3. The majority of cracking occurs in an earlier event, for which Beta=0.5, if
cracking does not increase in a later Event, the value of Beta in that later
Event will have minimal impact on deflection. To ascertain whether the
cracking increases, you may run separate analyses, with values of
Beta=0.5 & 1.0, and compare the results.

In summary, it is prudent to consider whether cracking is likely to increase in
later events for which you wish to set Beta=1.0.

However, it is likely that you will observe minimal difference between the total
deflection estimates, and that other assumed values will be of much greater
significance.

It is straightforward to run the analysis with different values of Beta to
determine whether this is the case.

Restraint type (EC2)
This property is located under the Deflection parameters heading in the slab
item Properties Window.
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NOTE The Restraint type is actually a property of the parent slab, so if you
change it for one slab item it will also be updated for all other slab
items in the same slab.

The value to adopt is a matter of judgment - for guidance on this refer to EC2
cl 7.4.3(4) and TR58

Changing the value will affect tensile strength (fct) and hence cracking
moment.

Restraint constant (ACI)
This property is located under the Deflection parameters heading in the slab
item Properties Window.
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NOTE The Restraint constant is actually a property of the parent slab, so if
you change it for one slab item it will also be updated for all other slab
items in the same slab.

For US customary units, restraint constant values from ACI 435 are:

• For situations with significant restraint - 4.0

• For insignificant restraint - 7.5

The default is conservatively set to 4.0.

The allowable input range is between 1 and 10 and is a user specified value by
the engineer.

The restraint constant is used to determine the Modulus of Rupture, fr =
“restraint constant” x λ x √(fc’)

Where:

fc’ = specified compressive strength (psi)

λ = 1.0 (for normal weight concrete)

Concrete Properties (Eurocode)
The concrete properties that exist as a property of the individual slabs defined
in the model are very important. Stiffness is variable and is aggregate
dependent. The Cement class can also affect deflection.
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The elastic deformation of concrete largely depends on its composition
(especially the aggregates). For C35/45 concrete, Eurocode 1992-1-1:2004
Table 3.1 provides a modulus of elasticity, E of 34GPa (34000 N/mm2) as a mid
range value using quartzite aggregate. For different aggregates this can range
between -30% and +20%.

What is the correct E value for your concrete?

If you know the value, you should set up a new material grade and assign it to
the elements in the model. It may, however, be easier when assessing the
impact, to use the stiffness adjustment option, for details of which see the
Stiffness Adjustments section below.

Concrete Properties (ACI)
The concrete properties that exist as a property of the individual slabs defined
in the model are very important. Stiffness is variable and is aggregate
dependent.
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What is the correct E value for your concrete?

If you know the value, you should set up a new material grade and assign it to
the elements in the model. It may, however, be easier when assessing the
impact, to use the stiffness adjustment option, for details of which see the
Stiffness Adjustments section below.

Stiffness Adjustments
The relative stiffness of the interconnecting elements will play a role in the
force distribution and hence the deflection results.

For existing models the values can be reviewed and amended by clicking
Settings > Modification Factors on the Slab Deflection ribbon. These are user
defined values with assumed defaults.

As mentioned in the above Concrete Properties (Eurocode) and Concrete
Properties (ACI) sections, an alternative to assessing the impact of a different
grade could be to alter the Modification Factors specified for flat slab E and G
values. i.e. Concrete material property of slab = 34000 N/mm2. What impact
would using a value of 32000 N/mm2 make? Flat slab stiffness adjustment =
32000/34000 = 0.9412

Shrinkage
Shrinkage is the strain in hardened concrete that can occur due to moisture
loss.

Shrinkage is taken into consideration by making an overall adjustment to the
total deflection. This approach is in line with many other software products.
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The adjustment is specified in the Slab Deflection Settings dialog.

We recommend an allowance with an upper limit of 30%. The default is set as
0.25 (25%).

Event sequences
An Event sequence defines all the construction stage events that slabs in a sub
model will go through starting from the day the slabs are cast.

By default a model event sequence is initially applied to all sub models in the
structure; if required custom event sequences can also be defined to override
the model event sequence for specific sub models.

NOTE Event sequences are NOT structure event sequences, i.e. they do not
describe all the events starting from the first day of the overall
construction.

Click the links below to find out more:

• Construction stage events (page 368)

• A typical model event sequence (page 369)

• Custom event sequences (page 377)

• Understanding event sequence deflections (page 380)

Construction stage events
An Event Sequence defines all the construction stage events that slabs in a sub
model will go through starting from the day the slabs are cast.

Deflection is very dependant on the extent of cracking. Once the slab has
cracked then it is assumed to remain cracked. The tensile stress of concrete
varies with time so careful consideration of load events are required so
predicted stresses can be compared with allowable at the appropriate age.
Propping loads from slabs being cast above are acknowledged to be significant
early loading events which will cause cracking.

In addition to the Final load event, construction stages that could be
considered are:

1. Striking

2. Casting the floor above
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NOTE Propping loads from casting slabs above have an impact on already struck slabs -
dependant upon the extent of back-propping adopted.

Extract from How to design reinforced concrete flat slabs using Finite Element Analysis,
The Concrete Centre - Figure 2

3. Adding Partitions

4. Finishes

A typical model event sequence
Let us consider a multistory building where the slab layout is the same on
each level.
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If we think about the slab model event sequence that occurs for the slab at
level 1 it could be something like this:

1. Strike and backprop slab (slab carries it's own weight)

2. Cast Slab above (slab carries a proportion of the weight of slab above - the
proportion is dependent on the number of levels of backpropping and
there is also some debate about the efficiency of load sharing between
the supporting levels. In this example we will assume 2 levels of propping
and that the level directly below supports 60% and level 2 below supports
40%.)
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3. Strike and backprop slab above (slab above now carries its own weight)

4. Cast slab 2 above (slab carries a proportion of the weight of the slab 2
above)

5. Strike and backprop slab 2 above (slab 2 above now carries its own
weight)
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6. If propping extends through 3 levels then there can be events for casting
and striking the slab 3 above. In this example, the propping is removed
and used two levels above.

7. Additional load from finishes (in particular from sensitive finishes)
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8. Start of occupation.

9. Final Load Event

A special note about the Final load event - It is perfectly ok to have multiple
events at the same final time, you should not separate these events by a small
number of days.

The view shown below is a graphical representation of the above but in this
case is recognizing 3 levels of backpropping
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Extract from How to design reinforced concrete flat slabs using Finite Element
Analysis, The Concrete Centre - Figure 2

This sort of event sequence can be described within the Event Sequences
dialog as shown below.

NOTE Some of the event parameters vary between headcodes, so both the
ACI and Eurocode versions of the dialog are shown.

Model Event Sequence ACI (US Imperial units)
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Model Event Sequence Eurocode (metric)
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Note the increased slab self weight when casting slab 1 above and slab 2
above where an additional 60% and 40% of the slab weight is being supported
respectively. This is defined in the On submodel % column.

A slab model event loading sequence for any other internal slab i.e. level 2
would be identical to that described above.
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If we now consider the uppermost slab - the roof.

• Is the slab event sequence for the roof any different?

• Can we use the slab model event sequence above for the roof?

The event sequences for casting any slabs above are not required, since there
is no need to make an allowance for additional propping loads. This means
that a different event sequence is necessary to deal with the roof. In Tekla
Structural Designer differences in event sequences are dealt with using a
Custom Event Sequence.

Technically, we could deal with the propping events in one of two ways.

1. Delete the event

2. Keep the event, but adjust the included slab self weight to allow only for
the roof load as the previous event. i.e the event has no change in load to
that of the previous load event.

In Tekla Structural Designer, we must deal with the change using method 2
above. This is due to the way Tekla Structural Designer deals with Custom
event sequences (page 377).

See also

Custom event sequences (page 377)

Custom event sequences
Custom event sequences are required to deal with different slab loading
sequences, such as for the roof slab and special cases like transfer slabs.

A custom event sequence can be created via the Add button on the Event
Sequences page (highlighted below).

Once it has been added and given a name you can then edit the Custom event
sequence by selecting it in the list.
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Editing a custom event sequence

When first added, a Custom Event Sequence is identical to the Model Event
Sequence. It therefore needs to be edited to achieve the required slab loading
sequence.

In the screenshot below, to create a custom event sequence for the roof we
have edited the slab self weight load in the Cast slab 1 above and Cast slab 2
above events to 100% i.e. it is only supporting the roof slab self weight and not
any extra propping load from any slabs above.

Custom Event Sequence ACI (US Imperial units)

Custom Event Sequence Eurocode (metric)
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It should be noted that it is not possible to Add, Insert, Remove or change the
order of Custom event sequences. It is also not possible to alter any item that
is greyed out within the table. This includes events and loadcases. You can,
however, edit the Load start time, Number of Exposed faces, Construction
loads and the % of load to apply in the combinations (and if working to ACI:
Ultimate Creep and Aging Coefficients; or if working to Eurocodes: Beta,
Temperature, Relative Humidity). This could mean that careful consideration
of the slab model event sequence is necessary to ensure any necessary events
are included.
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Assigning a custom event sequence to a submodel

When first added, a Custom Event Sequence is identical to the Model Event
Sequence. It therefore needs to be edited to achieve the required slab loading
sequence.

You can assign different event sequences to different submodels (slabs) using
the Submodels page of the Load Event Sequence.

In the screenshot below, the slab model event sequence is assigned to all
slabs, except the roof, which has its own custom event sequence defined.

Hence, when you run a rigorous slab deflection estimate on a selected slab, it
runs the Load Event Sequence specified on the Submodel page above.

Understanding event sequence deflections
The model described in A typical model event sequence (page 369) consists 3
identical levels and then a roof level with different loading applied. To cater for
this a Custom Event Sequence has been applied to the roof submodel.

When you run Slab Deflection > Analyse All for this model, 4 sub-models are
dealt with one after the other:

• Each one considers 9 events

• Each one does an iterative cracked section analysis at every one of these
events

• assume say, average of 20 iterations in each cracked section analysis

• That's 180 analyses for each sub-model - over 700 analyses for the
whole structure.

• There is an additional instantaneous analysis for each event.

After analysis the deflections can be reviewed for individual events. The view
below shows the deflections for Event 4 “Cast slab 2 above”.
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Event 4 ends when the slab is 27 days old. The view above is the deflection
estimate when each of the slabs are this age. These things don't happen at the
same time but it's a very convenient way to display things.

Initially, this has the potential to be confusing, however it should be easy to
understand provided you remember that:

• Event Sequences are “Slab Event Sequences”. They describe the events a
slab goes through where Day 0 = the day the slab is cast.

• Event Sequences are NOT structure event sequences. They do not describe
the all the events starting on day 1 of the overall construction.

Slab deflection analysis sequence
The same basic process is followed irrespective of whether the current level
(sub-model), a selected level, or all slabs in the model are analyzed.

In simple terms, events are considered in sequence.

For each event:

• An iterative cracked section analysis including long term effects determines
the deflection at the end of the event.

• An additional analysis using the determined state of cracking along with
short term cracked properties is undertaken to calculate the total
instantaneous deflection associated with the event.

• The state of cracking is carried forward to the next event as the starting
point.
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Having run a Slab Deflection Analysis the following analysis results are then
available to review for either the chosen level (sub-model) or the entire
structure dependent upon your chosen analysis

• Deflections (page 382) - Three deflection types are available: Total,
Differential, and Instantaneous.

• Extent of Cracking (page 386) - You can also review contours to display the
extent of cracking at any load event.

• Relative Stiffness (page 388) - You can also review the relative stiffness in a
particular result direction for any specified event.

• Effective Reinforcement (page 390) - You can also review the area of
effective reinforcement for a chosen result direction for each FE element.

Total, differential, and instantaneous deflection types
Once the slab deflection analysis has been run, three deflection types are
available for review:

• Total deflection at the end of any event.

• Differential deflection between any two events (Start of Event and End of
Event).

• Instantaneous deflection (not actually needed for TR 58).

• This is the deflection when the entire event loading is applied to a
version of the model using the established extent of cracking along with
short term analysis properties.

• US codes require an assessment of the instantaneous deflection
associated with the imposed load only. This is achieved by adding extra
events at the same time as the final event where only the required
imposed load is applied.

Understanding differential deflections

When looking at differential deflections it is important to appreciate that an
event is not a single point in time, it is a time period which has different
deflections at the start and the end - so it is logical that there can be a
differential deflection for a single event.

To clarify the selections requested in the ribbon:

• Start Event defines the start of the start event

• Event defines the end of the event

Therefore, if you specify the same event as the start and the end event, you
will still see a differential deflection.

To clarify further, consider the scenario below:

• Event 1 - Construction loading
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• Event 2 - Application of Sensitive Finishes

• Event 3 - Application of Additional Finishes

• Event 4 - Occupation (all loading with live load set at long term factor)

• Event 5 - Final loading event (as above with live load set at 100%)

To determine the maximum differential deflection relevant to the application
of sensitive finishes you would define this as the deflection between Events 2
and 5 (Start of Event 2 to End of Event 5). If you opted to pick Events 1 and 5
you would get an un-conservative deflection reported since the effect of
construction loading is also considered.

Slab deflection calculations in depth

Interrogating slab deflection calculations
Tekla Structural Designer's Slab Deflection Analysis is not a "black box" - the
calculated results are all exposed for interrogation as required.

Several different Results views are available: Deflection, Extent of Cracking,
Relative Stiffness and Effective Reinforcement. There is also a Composite
modulus report available for each slab.

To help pull all the results together, the items noted above are tied together in
the following way:

1. Every element is part of a slab item. Each slab item can have different
effective concrete properties.

The best way to understand this is to look at the summary of information
from the Composite Modulus report for each event and consider things
like:

• Adjusted event times due to temperature and cement class

• Adjusted creep properties due to the number of exposed faces

• Incremental loading factors

• The Composite Modulus Calculation

2. Every shell element can have different Effective Reinforcement:

• This is determined automatically

• The Effective Reinforcement results view allows you to confirm the
values used.

3. Cracking and Stiffness Calculations for each event:
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• This is dependent upon the effective concrete properties, effective
reinforcement, and the forces that develop

• So this calculation is unique for each direction of each shell for each
event.

• The stiffness of cracked sections is dependent on the degree of cracking
- so the procedure is iterative (force -> stiffness -> new force, etc)

• At the converged conclusion of this you can see (and check):

- the extent of cracking via the Extent of Cracking results view

- the stiffnesses determined via the Relative Stiffness results view

Composite creep
Design codes typically provide a way of calculating an effective creep modulus
at time, t for a constant load/stress applied at time t0. Typically this is
presented as ϕ(t, t0).

An effective Young's Modulus is then calculated as Ec, eff (t, t0) = Ec,28 / [ 1 + ϕ(t,
t0) ]

However, codes typically do not give guidance on how to deal with a loading
history where loads vary over the time period being considered.

Technical Report 58 introduces guidance on this topic and proposes a method
by which the loading history can be taken into account. (Reference Section
8.4.1, equation 8.37 and also the example on page 36):

Where:

n = event under consideration

wi = incremental load in event i (= load in event i - load in event (i-1)) (note that
this will be a negative value when load is removed)

Eeff,i = Ec, eff (tend,n, ti) (i.e. covers period from start of event i to end of event n)

The above is logical when you consider a single member subjected to a
constant loading arrangement that is increased or decreased at each event.
However, when you consider an entire slab with many panels receiving
different loading increments in different events it does not seem reasonable
to consider all the panels together. Two examples of this are:

1. Why should the addition of cladding loads affect internal panels to the
same extent as edge panels?

2. In a transfer slab why should panels that don't support columns be
affected to the same extent as those which do?
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The aim of TR58 is clear, in that loading on a span/panel is taken as an
indication of stress. What this fails to consider is that loading on another span/
panel can also induce stress (although in most situations this will be a
secondary effect). It is also clear that you do not actually need "loads", you just
need "relative loads" or some other measure of the relative work done in each
event. With this in mind a more general approach has been developed where
the relative "work done" by each panel is determined by considering the strain
energy in each event:

1. Calculate total strain energy 'Q0' for each Slab Item for a unit loadcase

• 'Q0' = sum of 2D Element strain energies

2. For each Load Event 'i'

• Calculate incremental strain energy 'Qi' 'Qi' = sum of incremental 2D
Element strain energies

• Calculate equivalent incremental load factor 'λi

' λi = Qi / Q0

3. Ecomp can be established from the equation below where "incremental
work done" replaces "incremental load" in the TR58 equation.

There is an array of intermediate values which lie behind the calculation of the
composite modulus, Ecomp for each slab item, for each event. The composite
modulus calculation is provided as an excel spreadsheet report.

You can either generate a report for a chosen slab, selected slabs or all slabs,
dependant upon your selection method.

• To obtain slab modulus reports for all slab items, right click anywhere in a
scene view and choose Export Eff. Modulus report to Excel > For all slab
items

• To obtain slab modulus reports for selected slab items, select the slabs in
the structure view regime, right click anywhere in the scene view and
choose Export Eff. Modulus report to Excel > For selected slab items

• To obtain slab modulus reports for a chosen slab items, right click a slab
panel in the structure view regime and choose Export Eff. Modulus report
to Excel > For current slab items

A typical composite modulus report for a slab panel is shown below.
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It should be noted that Tekla Structural Designer takes into account the
cement class when determining the temperature adjusted age of loading so
minor variations will occur.

The effective modulus is used in determining the properties for each load
event.

Extent of cracking
The effective modulus, and the effective reinforcement are used to determine
the cracked or uncracked state of each shell for each event, for each direction.

Eurocode 2 provides an expression that predicts the behavior between the
cracked and uncracked states. This expression uses a Distribution factor, ζ
that apportions the behavior between a fully-cracked state (±1.0) and an
uncracked state (0) for interpolating the stiffness when a state of partial
cracking exists.

ζ = 1 - ß (Mcr / M)2

Where:

• ß is a user defined value specified in the Event Sequences and is either: 1.0
for single short-term loading 0.5 for sustained loads or many cycles of
repeated loading

• Mcr is the hogging (positive) or sagging (negative) cracking moment.

• Ma(+|-) is the relevant Wood-Armer moment in the direction for which the
display is shown (X or Y). This is calculated from Mx, My & Mxy in the usual
way, when determining the extent of cracking for a shell element for each
iteration for each Event.

If you view Extent of Cracking results for a chosen result direction and cycle
through the events you will see each of the FE elements shaded to indicate the
extent of cracking.

At the first sign of cracking, Mcr > Ma. If you hover over an FE element the
tooltip provides some intermediate calculation results to verify this
distribution factor.
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The tooltip shows the applied moment for the Event in question, rather than
the worst moment of all Events up to and including the one being looked at -
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this allows engineers to deduce that a greater level of cracking was caused by
an earlier Event.

Relative stiffness
The tooltip provides detailed information on the relative stiffness calculations.
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The tooltip lists:

• Ec28 : Edb*1.05*stiffness adjustment factor. (Where Edb = the short term
modulus from the concrete materials database). The stiffness adjustment
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factor used is determined from the Slab Deflection ribbon > Settings >,
Modification Factors page. Provided for information - not directly used in
any analysis.

• Ec28+As : the short term modulus including for reinforcement. Provided for
information - not directly used in any analysis.

• EST(i) : the short term modulus used in the instantaneous analysis (i.e.
includes area of reinforcement and cracking if cracking has occurred) for
the selected event.

• ELT,C(i) : the modulus used in the final iteration of long term deflection
estimation (i.e. includes area of reinforcement and cracking if cracking has
occurred, and effective creep) for the selected event.

• ELT,C&S(i) : ELT,C(i) with further adjustment to allow for effect of shrinkage (=
ELT,C / multiplier) for the selected event. The shrinkage multiplier to
determine the shrinkage contribution is determined for the chosen event
based upon the ratio of the maximum panel Z deflection (including
shrinkage) / total Z deflection (excluding shrinkage). This provides an
indication of the overall effective stiffness adjustment. Provided for
information - not directly used in any analysis.

Based on the modulus, E defined above, a number of ratios are provided in
the tooltip for the chosen result direction.

• Short Term Uncracked = Ec28+As / Ec28

• Short Term + Cracking = EST / Ec28

• Creep + Cracking = ELT,C / Ec28

• Creep + Cracking + Shrinkage = ELT,C&S / Ec28

Effective reinforcement
Effective reinforcement for each shell element is also required for the
determination of the shell's effective properties at the end of each load event.

The effective reinforcement used in the property calculations are reported to
you in the 4 layers for every shell element. The information is provided as a
color coded shell display from minimum to maximum reinforcement area.
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If you hover over a shell the tooltip provides the following information:

• Axt : X Top Effective Reinforcement.
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• Dxt : Distance from the section centroid to the center of X top
reinforcement.

• Axb : X Bottom Effective Reinforcement.

• Dxb : Distance from the section centroid to the center of X bottom
reinforcement.

• Ayt : Y Top Effective Reinforcement.

• Dyt : Distance from the section centroid to the center of Y top
reinforcement.

• Ayb : Y Bottom Effective Reinforcement.

• Dyb : Distance from the section centroid to the center of Y bottom
reinforcement.

Shrinkage allowance
Shrinkage is the strain in hardened concrete that can occur due to moisture
loss.

• Eurocode 2 provides a method to estimate shrinkage strains and
curvatures based on exposed surface area, member size, relative humidity
and reinforcement quantity and position.

• Asymmetry of reinforcement leads to curvature which leads to deflection. It
is estimated this effect can contribute up to 30% to the long-term
deflection.

• Technical Report 58 provides a theoretical method of estimating the
additional shrinkage deflection effect in the analysis

At this time the TR58 method has not been implemented within Tekla
Structural Designer. Shrinkage is taken into consideration using a multiplier,
by making an overall adjustment to the total deflection (excluding shrinkage)
in line with simpler adjustment proposals of the ACI code. This approach is in
line with many other software products.

The simplest ACI approach makes an allowance for all long term effects (creep
and shrinkage) by using an adjustment factor. This is based on the graph
below and also provides some specific values.
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Time Multiplier for long-term deflections
5 years or more 2.0
12 months 1.4
6 months 1.2
3 months 1.0

Note that we said shrinkage effects and not creep and shrinkage. Creep is
dealt with rigorously in Tekla Structural Designer so we need to ascertain the
proportional effect of shrinkage only. ACI 435 provides some indication of the
separate contribution of creep and shrinkage.

Table 4.1 - Multipliers recommended by different authors

Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0
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Comparing the different sources the ratio of shrinkage is as follows:

• Sbarounis 1.2 / 5 = 24%

• Branson 1 / 4 = 25%

• Graham and Scanlon 1 / 3.5 = 28%

(ignore higher modulus of rupture because reduced values are considered
automatically in the cracked section analysis).

The above provides a shrinkage ratio of between 24% and 28%. Hence we
recommend a value of between 20%-30% is used. A 25% default is provided
via the Slab deflection ribbon > Options dialog and the Creep and Shrinkage
page.

The total deflection due to shrinkage effect is determined based on an
identified “Total Shrinkage Event” towards the end of the event sequence. The
event sequence with the latest load start time is used for calculating the
shrinkage adjustment. If multiple events exist with the latest load start time
then the first one is considered.

A special note about the Final load event - It is perfectly ok to have multiple
events at the same final time, you should not separate these events by a small
number of days.

Using this “total shrinkage effect” we can then assign a proportion of the total
shrinkage to each event.

With reference to earlier versions of ACI 435 (1966) on which the values in the
graph above are based, additional values for 1 month and 3 years can be
obtained. This follows the case where As’ = 0 (because compression steel is
allowed for differently in the code). By comparison with the graph above, we
can see closely matched values.

Duration of
loading

Factor F

 As' = 0 As' = 0.5As As' = As
1 month 0.58 0.42 0.27
3 months 0.95 0.77 0.55
6 months 1.17 0.95 0.69
1 year 1.42 1.08 0.78
3 years 1.78 1.18 0.81
5 years 1.95 1.21 0.82

The values we have adopted for considering shrinkage effects are as tabulated
below. The final column provides the proportion of the total shrinkage at a
given time.
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Time Long Term Effects
Factor

Proportion of Total
Shrinkage

0 0 0.00
1 month 0.6 0.30
3 months 1 0.50
6 months 1.2 0.60
1 year 1.4 0.70
3 years 1.8 0.90
5 years and above 2 1.00

From the above, for any event, the end of event time is used to calculate a
“Proportion of total shrinkage” using linear interpolation between the values
discussed in the table above.

Deflection calculations on the Z deformation are then adjusted to account for
shrinkage effects.

As an example, let’s assume the following event sequence.

• Event 1 = 7 days, Event 2 = 10 days, Event 3 = 17 days, Event 4 = 20 days,
Event 5 = 27 days, Event 6 = 2 months, Event 7 = 6 months, Event 8 = 1 year
and Event 9 = 70 years

Assuming a shrinkage factor of 25% (user defined input value), a basic
multiplier can be determined = 1/(1-25%) = 1.333

Event 9 Final event at 70 years analysis deflection (excluding shrinkage) =
32.4mm

Therefore, the Total deflection (including shrinkage) = 32.4 x 1.333 = 43.2 mm

Total Deflection from shrinkage alone is 43.2 - 32.4 = 10.8 mm

We can now apportion this deflection due to shrinkage, to each event based
upon the event time and a proportion value.

i.e.

At 0 days proportion of total shrinkage is 0, At 1 month proportion is 0.3.
Therefore using linear interpolation between these values;

• Event 1 (7 days) Shrinkage multiplier = 0.3 * 7/30 = 0.07

• Event 2 (10 days) Shrinkage multiplier = 0.3 * 10/30 = 0.1

• Event 3 (17 days) Shrinkage multiplier = 0.3 * 17/30 = 0.17

• Event 4 (20 days) Shrinkage multiplier = 0.3 * 20/30 = 0.2

• Event 5 (27 days) Shrinkage multiplier = 0.3 * 27/30 = 0.27

At 1 month proportion of total shrinkage is 0.3, At 3 month proportion is 0.5.
Therefore using linear interpolation

• Event 6 (2 months) Shrinkage multiplier = 0.4
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At 6 month proportion of total shrinkage is 0.6

• Event 7 (6 months) Shrinkage Multiplier = 0.6

At 1 year proportion of total shrinkage is 0.7

• Event 8 (1 year) Shrinkage Multiplier = 0.7

At 70 years proportion of total shrinkage is 1.0

• Event 9 (70 years) Shrinkage Multiplier = 1.0

The Shrinkage deflection that occurs at each event is then the total shrinkage
10.8 mm x the shrinkage multiplier calculated above.

• Event 1 (7 days) Shrinkage = 0.07 x 10.8 = 0.76 mm

• Event 2 (10 days) Shrinkage = 0.1 x 10.8 = 1.08 mm

• Event 3 (17 days) Shrinkage = 0.17 x 10.8 = 1.84 mm

• Event 4 (20 days) Shrinkage = 0.2 x 10.8 = 2.16 mm

• Event 5 (27 days) Shrinkage = 0.27 x 10.8 = 2.92 mm

• Event 6 (2 months) Shrinkage = 0.4 x 10.8 = 4.32 mm

• Event 7 (6 months) Shrinkage = 0.6 x 10.8 = 6.48 mm

• Event 8 (1 year) Shrinkage = 0.7 x 10.8 = 7.56 mm

• Event 9 (70 years) Shrinkage = 1.0 x 10.8 = 10.8 mm

For each event, the total deflection (including shrinkage) reported in the Slab
deflection view regime and the tooltips is the event analysis deflection
(excluding shrinkage) + the proportion calculated above using the shrinkage
multiplier.

Check lines
Check lines - a unique feature inTekla Structural Designer - provide a practical
way to automate deflection checking and reduce the possibility of errors.

Each check line defines a line along which deflection checks are required.
Multiple check lines can be created and each line can have several different
deflection checks performed (against either a total, instantaneous, or
differential deflection limit).

Whilst the check lines have to initially be positioned using engineering
judgment, once they are in place they provide an instantaneous means to
evaluate revised deflections following changes to the model parameters and
re-analysis.

Assessing slab deflections without check lines would be quite an arduous task,
since deflection limits are of the form (span / fixed value) and the spans can
vary on an irregular slab, hence the permissible limit would also vary.
Furthermore, you may wish to check total or differential deflections at or
between different load events. Would the critical location be obvious?
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Setting up the checks in advance (via the slab deflection check
catalogue)
The deflection checks to be performed for the check lines are set up in the
Slab Deflection Check Catalogue before the check lines are positioned.

Each check in the catalogue is specified as a Total, Differential or
Instantaneous deflection limit that is checked for a specified event, (or in the
case of a Differential check between the start of an event and the end of an
event).

Related task

Application of check lines
The application of check lines is an iterative activity. They should be created at
all locations where you deem deflection checks to be required.

Check lines can only be created in a 2D view. If the Create command is greyed
out ensure you switch to a 2D view.

When you click Create, the Properties Window automatically includes those
slab deflection checks from the Slab Deflection Check Catalogue where "Use in
new Check Lines" was checked. Note that a maximum of six checks can be
assigned to a single check line; if you require more than six checks, then
multiple check lines can be applied at the same location.

You can add further checks from the catalogue or add new checks directly
from the Properties Window.

You can also edit the "Use in New Check Lines" option in the catalogue prior to
running the Create command to change the default checks automatically
assigned to each new check line.

Related task

Displaying check line results
The Check Line deflection can be overlayed on the slab by using the
Deflections command in the ribbon, it is perhaps easier to visualize if you
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switch the view to a 3D view of the slab using the 2D/3D toggle button in the
bottom right of the window.

You can also right click on a check line and open the deflections check view.
This displays a cut line through the slab, showing the deflected shape with the
maximum and minimum deflection values. Beneath this it also draws the
average slopes between maximum and minimum points and reports the
average slope ratios.

The above deflection check view is controlled from the Loading Analysis ribbon
which has droplists to enable you choose the Result Type (Total,
Instantaneous, or Differential) and the Event(s).

The average slope ratios (for the appropriate result type/event) are checked
against the deflection limits that have requested for the check line.

Doing the checks this way inherently deals with offset peak deflections (non-
uniform load) and also cantilevers.

Related task
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Check line reports
A tabulated report is available for each check line which itemizes each
requested deflection check along the check line.

You can generate a check line report for an individual check line by right
clicking the check line and selecting Member Report.

You can also generate a Slab deflection check line report for the entire
structure, selected level, planes or sub structures via the Model Report
command on the Report ribbon.

Related task View slab deflection reports

Slab deflection status and utilization
The status and the utilization can be graphically displayed for both Check lines
and slabs.

Check lines Status and Utilization

Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical utilization ratio

Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check lines
are automatically re-checked so you will obtain instant feedback on status and
utilization.

Related task:

Slab Deflection Status and Utilization

Slab deflection status is determined for each slab item as the worst status
from all associated check lines detected within the slab item or touching the
slab item boundary.
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In the above status view:

1. No check lines cross the slab items between C-D / 2-3 and C-E / 3-4 so the
slab reports Unknown as no checks have been performed

2. One passing check line crosses the slabs between C-E / 4-5 so the slab
reports a Pass.

3. A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, all other slab items
Fail.

Slab deflection utilization is similarly determined for each slab item as the
worst utilization from all associated check lines.
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Related task:

Slab deflection example (Eurocode)
In the following exercise slab deflections will be checked for the tutorial model
shown below.

It is a simple multi-bay flat slab structure on an 8m square grid of columns.
The slabs have been sized based on deemed-to-satisfy rules taken from
“Economic Concrete Frame Elements to Eurocode 2 - The Concrete Society”.
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Geometry:

• 8m grid

• 285 thick C30/37 slab

• 400 square columns

Loading:

• Finishes - 1.5kN/m2

• Imposed - 5.0kN/m2

• Perimeter Cladding - 10.0kN/m

Deemed to satisfy checks (page 402) provide one method of checking,
however the main focus of the exercise will be to investigate rigorous slab
deflection checks (page 405).

Deemed to satisfy slab deflection checks example (Eurocode)
A simple way to assess slab deflection in Tekla Structural Designer is to run a
linear analysis using adjusted analysis properties, and then check the resulting
deflections by manually determining critical spans.
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Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection EC.tsmd

Perform Linear Analysis

1. From the Analyze toolbar, click Analyze All (Static)

2. Open a view of the Typical floor level

3. Switch to the Results View

4. From the Results toolbar, review 2D deflections for the FE chase-down
analysis for the load combination 1, service load results 
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Identify critical check locations

We can see that the maximum reported deflection is 38.9mm, occurring in the
middle of a corner bay. This should be assessed by taking the slab span
diagonally across the bay.

NOTE In 'real world' flat slabs some engineering judgment might be required when
assessing which deflections and span lengths require checking.

Guidance exists in How to Design Concrete Structures using Eurocode 2, The
Concrete Centre, Figure 9

In our example, taking the diagonal dimension across the columns, the
deemed-to-satisfy span / 250 rule provides a deflection of [√(80002+80002)] /
250 = 45.3mm.

This compares favorably.

NOTE Remember, the method does not predict actual deflections. The total
deflection is simply expected to be less than span / 250.

Concrete properties used in the analysis

The Tekla Structural Designer deflection result is completely dependent upon
the concrete elastic modulus used in the analysis which is adjusted by a
modification factor to consider such things as creep, cracking and shrinkage.

The modification factor is set from the Settings dialog on the Analyze ribbon.
As shown below, for the FE chase-down analysis of flat slabs this defaults to
0.2.
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Rigorous slab deflection analysis example (Eurocode)
There are many input parameters that will have an impact on the rigorous
deflection estimates and would therefore need to be considered. For details
see: Factors that affect rigorous slab deflection estimates (page 360)

For this exercise, initially it will be assumed that the default settings have
already been reviewed and set as required.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection EC.tsmd

Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)
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2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Review the Model Event Sequence

To review the model event sequence:

1. From the Slab Deflection toolbar, click Event Sequences

2. Click Model Event Sequence 

This has already been setup for this example as shown below:

Deflections to the end of each of the above event periods will be
calculated by the analysis.
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3. Click OK to close the dialog.

Perform Iterative Slab Deflection Analysis

To establish some initial results (with all parameters left as default values) you
could just click Analyse All from the Slab Deflection toolbar, however, in a real
model rather than analysing all levels at once, it can be more efficient to work
on just the current level, or a selected level. Obviously considering just a single
level reduces the time necessary to undertake the iterative slab deflection
analysis.

1. Open a 2D plan view of the level Typical floor

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

Review Deflections for Events

Deflections can be reviewed for each event by making selections from the
Event droplist in the ribbon.

You are able to review:

• Total deflection at the end of any event.

• Differential deflection between any two events (Start of Event and End of
Event).

• Instantaneous deflection (not actually needed for TR 58).

The image below shows total deflection contours for the final load event.
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NOTE To see the image as shown, you may need to adjust some of the
selections in Scene Content, for example Slab Patches should be de-
selected.

As a comparison with the simple approach earlier (39.7mm), the Total
deflection at the final load event for the chosen location is 35.2mm.
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NOTE In the above contour plot the deflections are not exactly symmetrical -
this is because reinforcement is in the outer layer in the Y direction
making the slab stiffer in that direction.

Total deflections to the end of each of the event periods in the Event Sequence
are available and could also be displayed as required.

In the Event Sequence there is an event for “Sensitive Finishes added” - we
shall now show differential deflection between this and the final event.

1. From the Slab Deflection toolbar, change the Result Type to Differential

2. Select the Start Event as Sensitive Finishes added

3. Select the Event as Final load event 

The 2D view now displays the differential deflections between “Sensitive
Finishes added” and the final event.
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Review Other Results

In addition to the deflections you can display the extent of cracking at any load
event.

You can also review the relative stiffness in a particular result direction for any
specified event.

You can also review the area of effective reinforcement for a chosen result
direction for each FE element.

1. Select the Result as Extent of Cracking, and then:

a. Select the Result Direction as X,

b. Select the Result Type as Total,

c. Select the Event as Propping removed,

The extent of cracking for the Propping removed load event is displayed.
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2. Select the Result as Relative Stiffness, and then:

a. Select the Result Direction as X - Creep + Cracking + Shrinkage,

The relative stiffness for the Propping removed load event is displayed.
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3. Select the Result as Effective Reinforcement, and then:

a. Select the Result Direction as X Top,

The effective reinforcement for the X Top direction is displayed.
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NOTE When you hover over any FE element in the slab deflection view
regime - values are provided within the tooltip.
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Define Check Line Deflection Checks

Check lines have to initially be positioned using engineering judgment.

The deflection checks associated with each check line are selected from a
predefined Deflection Check Catalogue. This is viewed by clicking Deflection
Checks in the ribbon.

You can add new checks to the catalogue as required.

1. From the Slab Deflection toolbar, click Deflection Checks 

Whilst three checks have been defined above, only two of these have
been set to be used in new Check Lines:

• Sensitive finishes will check the differential deflections from when the
sensitive finishes are applied to the final load event against a
deflection limit of 1/500

• Total will check the total deflections to the final load event against a
deflection limit of 1/250

2. Click OK to close the dialog.

Place Check Lines

NOTE Check lines can only be created in a 2D view.

We will define several check lines in this example:

1. Ensure you are in the Typical floor 2D plan view and if necessary change:

a. the Result back to Deflections,

b. the Result Type to Total,

c. the Event to Final load event

2. Click Create 

NOTE When you click Create, the Properties Window automatically
includes the slab deflection checks from the catalogue for which
“Use in new Check Lines” was checked.
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3. To place the check line at approximately mid-span between grid lines 4-5
from grid line A to E:

a. Pick the start point to the left of grid line A as shown: 

b. Pick the end point to the right of grid line E as shown: 

c. Press Esc to end the command.

4. Right click on the check line and choose Open deflections check view
from the context menu. 
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The deflection results along the length of the check line are displayed.

The Slab Deflection toolbar allows you to specify the total (as shown
above), or differential or instantaneous results for the selected events.
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Tekla Structural Designer then draws average slopes between maximum
and minimum points.

If we return to the original deemed-to-satisfy check - this was performed
diagonally between columns in bottom right corner panel of the slab - we
will now revisit this using a check line.

5. Create a check line running diagonally between columns in bottom right
corner panel (from D/1 to E/2) where the peak deflection occurs. 

6. Right click to open the deflections check view for the new check line. 

A total deflection limit of Span / 250 is the same as saying that the average
slope between points of maximum and minimum deflection = 1 / 125. In
the view above the average slope between these points is 1 / 155, i.e. less
than the limit.

Doing the checks this way inherently deals with offset peak deflections
(non-uniform load) and also cantilevers.
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Generate Check Line Reports

A tabulated report is available for each check line which itemises each
requested deflection check along the check line.

You can generate a check line report for an individual check line by right
clicking the check line and selecting Member Report.

1. Return to the Typical floor 2D view, right click on the diagonal check line
and select Report for Member 

As previously noted, the slope above is reported as 1:155 which is not less
than the allowable slope limit of 1:125 and hence a Pass.

If you click within the Load Analysis Deflection view, the ribbon changes to
allow you to display deflection results and slopes for the Result Type -
Total or Instantaneous for a chosen event, or Differential between chosen
events.

2. Switch to the Load Analysis Deflection view for the diagonal check line.

3. From the Slab Deflection toolbar, change the Result type to Differential
and check deflection and slopes between theSensitive finishes added
and Final load event. 

We can add as many check lines to the model as we consider appropriate.
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4. Return to the Typical floor 2D view.

5. Add three further check lines using the default deflection checks in the
catalogue as follows:

a. along grid line 1, from A/1 to E/1

b. along grid line B, from B/1 to B/5

c. half way between grid line A and B, starting at grid line 1 and finishing
at grid line 5

6. Press Esc to end the command. 

If you select each Check Line in turn you are able to edit the deflection
checks associated with it in the Properties Window.
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7. Select the check along grid line that runs along grid line 1 and ensure that
it also has a Check #3 defined as Cladding. 

Review Check Line Status and Utilization

Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical Utilization ratio.

1. Click on the Typical floor 2D view to make it active.

2. To make it easier to see the check lines, change the Result droplist from
Deflections to None.

3. Click Status in the Check Lines group of the ribbon to see the pass/fail
status graphically displayed for each check line. 
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TIP You can also hover over a check line and the tooltip displays the
utilization and pass/fall status.

4. Click Utilization in the Check Lines group to show the critical utilization
for each check line and investigate the tooltip results. 
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Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check
lines are automatically re-checked so you will obtain instant feedback on
status and utilization

Review Slab Status and Utilization

Every check line is associated with at least one slab item. If all checks lines
associated with the slab item pass then the slab item passes.

Both the Status and the Utilization can be reviewed.
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1. Click Status in the Slab Deflections group of the ribbon to see the pass/
fail status of each slab. 

• No check lines cross the slab items between C-D / 2-3 and C-E / 3-4 so
the slab reports Unknown as no checks have been performed.

• One passing check line crosses the slabs between C-E / 4-5 so the slab
reports a Pass.
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• A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, the slab items Fail
where the check lines runs along A/1-E/1.

2. Click Utilization in the Slab Deflections group to show the Utilization of
each slab item. 

This is the worst utilization from all associated check lines.

Engineers Handbooks 425 Slab deflection handbook



Optimization

If you find that a slab either fails deflection checks (or passes with a low
utilization) then changes will need to be made. There are many areas where
adjustments can be made.

• Adjust slab/panel depths?

• Adjust reinforcement?

• Re-consider the Event timings and loadings?

• Adjust other settings?

Any or all changes are possible.

When changes are necessary we would recommend that it will be more
efficient to work on one level at a time. The automatic re-checking of check
lines will help considerably with this optimization.

The analysis is extremely quick and since everything is contained within one
model file, it allows “What If” scenarios to be considered to find the optimum
solution.

In this exercise we will start by looking at the impact of adjusting the
reinforcement.

1. Highlight the check line running along grid line B and make a note of its
utilization. 

TIP Press the tab key if necessary to highlight the check line when it is
directly under the mouse cursor.

2. Click Slab Reinforcement in the Show/Alter State group to show the
existing reinforcement.

3. In the Properties Window:

a. Leave the Slab Reinforcement to modify as Panel

b. Leave the Slab Layer to modify as Bottom

c. Change the Reinforcement Direction to BarsY to see the bars in that
direction
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4. Click on one of the corner slab panels to select H16 150 as the
reinforcement to be applied. 

5. Click on the eight slab panels currently showing H16 bars at 175 spacings
to change them to the 150 spacings. 
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6. Change the Reinforcement Direction to BarsX to see the bars in that
direction.

7. Edit the same 8 panels in exactly the same way, so that the bars in X
match the bars in Y.

8. Click Analyse Current to update the results

9. Click Utilization in the Check Lines group to show the critical utilization
for each check line once again.

10. Investigate the tooltip results 

Engineers Handbooks 428 Slab deflection handbook



You should find that although some utilizations have reduced, the line
along grid line B is still failing. At this point you could begin to look at the
impact of the various other input parameters. For now, we will adjust the
concrete grade of the typical floor slab group from C30/37 to C35/45.

11. Right click slab SI 4 between D-E/1-2 on the typical floor level and choose
Edit.... from the context menu. 

Engineers Handbooks 429 Slab deflection handbook



NOTE Editing a slab item via the right click context menu updates the
parent slab properties, not just the individual slab item. Hence
any changes will be applied to all the slab items in S 1.

12. On the Slab concrete page of the dialog, change the Concrete Strength to
C35/45 and click OK 

To update the check line results we need to re-run the analysis. A
chasedown analysis is automatically performed as part of the slab
deflection analysis, however, it should be borne in mind that some edits
could affect the element design i.e. reducing the concrete slab thickness
would result in an increase to the required reinforcement and hence a
Design Concrete (Static), Slab or patch design may be required again.

13. Click Analyse Current again to update the results.

14. Review the Check Lines Status. 
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The check line with the more onerous Cladding deflection limit is still
failing, but we can clearly see improvements in the results. It has reduced
from a Utilization ratio of 1.538 to 1.262.
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In fact, to obtain a Pass we would have needed to increase the concrete
grade to C45/55.

NOTE For the purpose of this exercise, as the cladding check is not a
code requirement we will simply disable it before proceeding to
generate the model report.

15. Select the check line along grid 1 and then in the Properties window,
reset Check #3 to None.

Generate Model report

A Slab Deflection Check Lines model report can be created for the selected
Model Filter (entire structure, level, plane or sub structure). This lists all the
check lines for the chosen model filter. To help identify the check lines in the
report it is sensible to include a saved picture of the scene view displaying
check lines and their associated reference within the report.

1. In Scene Content, switch on the Text display for the Slab Deflection
Checks. 

TIP The check line references can be customised using the Name
property for each individual check line.
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2. Right click in the Typical floor 2D view and choose Save View
Configuration... from the context menu, then specify a name. 

This saved view can be included in the Check line report.

3. On the Report ribbon, click Model Report...

4. Click Add and provide a Name “Check Line Report” for the report.

5. In Chapters and Options, drag View to the Report Structure area

6. In Chapters and Options, drag Concrete>Slab/Mat Design per
Plane>Slab Deflection Check Lines to the Report Structure area 
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7. In the Report Structure, expand Concrete> Slab/Mat Design per Plane>
Slab Deflection Check Lines and right click, Model Filter> Edit/New 

8. In the Filter dialog, click Add and select Selected levels and ensure a check
against Typical floor 
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9. Click OK to return to the Report Contents dialog.

10. In the Report Structure, right click View, then choose Settings...

11. Select the Slab Deflection view you created earlier 
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12. Click OK to return to the Report Contents dialog

13. Click OK to exit and save the report. 

A report structure called Check Line Report has now been saved that
contains a view and the check lines.

14. To display the report.

a. Use the Select drop list in the ribbon to select “Check Line Report”

b. Click the Show Report command to open the report.

Engineers Handbooks 436 Slab deflection handbook



Engineers Handbooks 437 Slab deflection handbook



Slab deflection example (ACI)
In the following exercises deflections will be checked for the two story multi-
bay flat slab tutorial model shown below.

Geometry:

• Bay centers 26’ 3”

• Floor to Floor spacing 9’ 10”

• Slab thickness 11 ¼ “, concrete grade 4500 psi

• 18” x 18” columns, concrete grade 4500 psi

• Analysis stiffness adjustment factors in accordance with ACI code guidance

Loading:

• Dead area load 30 psf

• Live area load 105 psf

• Cladding perimeter load 0.7klf

Deemed to satisfy checks (page 438) provide one method of checking,
however the main focus of these exercises will be to investigate rigorous slab
deflection analysis (page 440) and check lines (page 476) as the method of
checking.

Deemed to satisfy slab deflection checks example (ACI)
A simple way to assess slab deflection in Tekla Structural Designer is to run a
linear analysis using adjusted analysis properties, and then check the resulting
deflections by manually determining critical spans.
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Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI.tsmd

Perform Linear Analysis

1. From the Analyze toolbar, click Analyze All (Static)

2. Open a view of the Typical floor level

3. Switch to the Results View

4. From the Results toolbar, review 2D deflections for the FE chase-down
analysis for the load combination 1, service load results 

Identify critical check locations

We can see that the maximum reported deflection is 1.1in, occurring in the
middle of a corner bay. This should be assessed by taking the slab span
diagonally across the bay.

NOTE In 'real world' flat slabs engineering judgment will be required to assess which
deflections and span lengths require checking.
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The deflection at the identified location now needs to be checked against a
limiting span-to-depth ratio which we will assume for this example can be
taken as span /240.

Taking the diagonal dimension across the columns, the deemed-to-satisfy
span / 240 rule provides a deflection of [√(26' 3"2+26' 3"2)] / 240 = 1.8in.

This compares unfavorably.

NOTE Remember, the method does not predict actual deflections. The total
deflection is simply expected to be less than span / 240.

Concrete properties used in the analysis

The Tekla Structural Designer deflection result is completely dependent upon
the concrete elastic modulus used in the analysis which is adjusted by a
modification factor to consider such things as creep, cracking and shrinkage.

The modification factor is set from the Settings dialog on the Analyze ribbon.
As shown below, for the FE chase-down analysis of flat slabs this defaults to
0.25.
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Rigorous slab deflection analysis examples (ACI)
Three alternative methods of allowing for creep and shrinkage in the analysis
are investigated.

• Slab Deflection Property Choices (page 441)

• Method 1: Simplified Event Sequence + Simplified Combined Creep and
Shrinkage Allowance (page 443)

• Method 2: Simplified Event Sequence + Rigorous Creep and Shrinkage
Allowance (page 455)

• Method 3: Detailed Event Sequence + Rigorous Creep and Shrinkage
Allowance (page 462)

• Observations on the Different Methods (page 471)

• Use of check lines to check deflections (page 476)

Slab Deflection Property Choices

Aging Coefficient - User Defined or Automatic?

Tekla Structural Designer calculates a modulus of elasticity for each load event
which accommodates both creep and aging.

The Aging, Creep and Shrinkage page on the Slab Deflection Settings dialog
allows you to choose the method for this.

• Automatic - the modulus of elasticity used in the analysis (termed the
composite modulus) is calculated rigorously according to the procedure
defined in the Concrete Society Technical Report 58. This requires an early
age event history to be defined by way of a detailed event sequence.

• User defined - the modulus of elasticity used in the analysis is calculated in
accordance with ACI 435 Equation 3.33c:

Ēc(t, t0) = Ec (t, t0) / ( 1+ χ Ct)

Where:
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• The aging coefficient χ must be specified in the event sequence. The
recommended value is 0.8. This is a user specified value.

• The creep coefficient Ct required in the above equation is automatically
determined by Tekla Structural Designer using equation A-18 from ACI
209 taking account of shape and size effects.

The equation for Ct is [(ti-t0) / (26 e(0.36 x V/S)) + (ti-t0)] x Cui

Where:

• For a slab the volume to exposed surface ratio V/S is taken as h/n where
h is the slab thickness and n is the number of exposed surfaces. If n is
set to zero then the creep coefficient is taken as zero thus eliminating
creep from the analysis properties.

• Start of first event, t0

• End time of event under consideration, ti

• The Ultimate Creep coefficient, Cu must be specified in the event
sequence. In normal conditions the recommended value from ACI 435R
page 55 is Cu = 2.35. A different value can be specified according to
guidance in ACI 209 if desired.

Shrinkage Allowance, or Combined Creep and Shrinkage Allowance?

When creep effects are included in the analysis, the Allowance for Shrinkage
Effects multiplier can be set at a value which caters for shrinkage only.
Alternatively you can increase the multiplier to allow for both creep and
shrinkage, provided that you ensure that creep is not also accounted for in the
analysis.

When using the latter approach it is important to ensure that the Aging
coefficient is set to User defined.
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Restraint Constant - Significant or Insignificant Restraint?

For each of the three methods considered in this example the Restraint
constant (ACI) (page 364) will be varied in order to model different restraint
assumptions.

Restraint constant values from ACI 435 are:

• For situations with significant restraint - 4.0

• For insignificant restraint - 7.5

This will allow us to compare deflections estimations based on the assumption
of significant restraint against those assuming insignificant restraint.

Method 1: Simplified Event Sequence + Simplified Combined Creep and
Shrinkage Allowance

In this approach the simplest method suggested in ACI 318 is emulated. All
creep and shrinkage effects are introduced as a single amplification factor and
a cracked section analysis is run on a simplified event sequence without
addressing the possibility of early age loading.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Simplified Event Sequence.tsmd

Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)

2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Set up the Simplified Combined Creep and Shrinkage Allowance (ignoring ACI 435)

You can increase the Allowance for Shrinkage Effects multiplier to allow for
both creep and shrinkage based on the multipliers from ACI 435 Table 4.1.

Using the ACI code recommendation (highlighted in the below table),
multipliers are immediate 1.0, creep and shrinkage 2.0. Total = 3.0.

Thus a creep and shrinkage contribution = 2.0/3.0 = 0.66 is to be applied which
equates to 66% of the total deflection.

Table 4.1 - Multipliers recommended by different authors
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Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0

When using this approach:

• The automatic procedure using Technical Report 58 is not considered - this
is ensured by setting the Aging coefficient to User defined.

• Creep is not also accounted for in the analysis - it can be excluded by
setting the Number of Exposed Faces to Zero in the event sequence.

1. To adopt the above ACI 318 Code multipliers for simplified creep and
shrinkage:

1. From the Slab Deflection toolbar, click Settings

2. In the dialog, click Aging, Creep & Shrinkage

3. Ensure the Aging Coefficient is set to User defined and the Allowance
for shrinkage effects in total deflection is set to 0.66. 

The above factor allows for both creep and shrinkage, (i.e. creep and
shrinkage effects will account for 66% of the total deflection).

4. Click OK to close the dialog.

2. To exclude additional creep effects from the analysis

As creep is already being catered for by the amplification factor, we have
to exclude additional creep effects from the analysis. This can be done by
setting the number of exposed faces in each event to zero as follows:
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5. From the Slab Deflection toolbar, click Event Sequences

6. Click Model Event Sequence

7. For each listed event in the model sequence, ensure the Number of
Exposed Faces is set to 0. 

If the number of faces = 0 then the creep coefficient Ct = 0 . See: Aging
Coefficient - User Defined or Automatic? (page 441)

Review the Individual Events in the Model Event Sequence

A simplified event sequence has been defined that does not include any
construction stage propping events.

Various guidance documents discuss slab deflection analysis without
addressing the possibility of significant early age loading events such as
propping loads.

An early start event should always be created since time is measured from this
start event. In this example we have assumed a start event of 10 days and
allowed self weight only.
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You will also note that:

• Each event has a load start time. The Final load event is set to the normal
ACI requirement of 5 years.

• ACI requires that instantaneous deflection due to live loads only should be
considered based upon a span/360 limit. To account for instantaneous
deflection due to live load only, an end event has been included with the
same load start time as the preceding event but only including live load.

• Ultimate Creep Coefficient, Cu is set with the default value of 2.350. This
value can be set separately for each event.

• Aging Coefficient is set at the default value of 0.8. This value can be set
separately for each event. It may be more logical to set higher values for
the earlier event times, however, if your primary concern is differential
deflection between later events then it will be conservative to use the same
value everywhere.

• Number of exposed Faces is set to 0 - this has been done to exclude
additional creep effects from the analysis, (as explained in the previous
section).
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Discussion:

• You need to think about the accumulation of deflection through time and
hence the checks that you ultimately wish to consider.

• As an example, if you are interested in differential deflection between the
final load event and the start of finishes (deflection at end of event 1), if you
underestimate deflection to the end of event 1 then this check becomes
more onerous.

• Is it reasonable to assume no construction load and no self weight from
finishes during this period?

• How much load is reasonable to assume at this starting event is ultimately
the responsibility of the engineer.

1. After reviewing the Event Sequence, click OK to close the dialog.

Set up the Restraint Constant

The modulus of rupture is set using the Restraint Constant slab deflection
parameter. Since we are using the ACI code multipliers from Table 4.1 above
this should be set to 7.5.

1. To specify an appropriate restraint constant

1. Open the Structure 3D view

2. Select all the slab items in the model and via the Properties Window,
ensure the Restraint Constant is set to 7.5 
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Perform Iterative Slab Deflection Analysis

To establish some initial results:

1. Open a St.1 (1) 2D view.

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

3. Review the deflections for the events 

Deflections can be reviewed for each event by making selections from the
Event droplist in the ribbon. You are able to review:

• Total deflection at the end of any event.

• Differential deflection between any two events (Start of Event and End
of Event).

• Instantaneous deflection.

The Total deflection at the final load event for the chosen location is 1.3”
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TIP If slab patches are obscuring the above deflection contours, these
can be switched in Scene Content.

Consider the Sustained Load Multiplier Effect from ACI 435

ACI 435 Clause 4.3.4.2 needs to be reviewed carefully at this stage, as this
suggests that the above deflection estimation is unconservative.

• It states that if the restraint stresses are expected to be insignificant, (so
that the restraint constant is set at 7.5) then:
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• “the multiplier for sustained-load deflection should be increased from 2 to
4, as recommended by Sbarounis (1984) and Graham and Scanlon
[1986(b)]”

Table 4.1 - Multipliers recommended by different authors

Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0

Hence the combined creep and shrinkage contribution = 4.0/5.0 = 0.8 (i.e.
80% of the total deflection).

• Alternatively, if the restraint stresses are likely to have a significant effect
then Clause 4.3.4.2 states that:

• a reduced restraint constant of 4 can be used, along with a long-term
sustained-load multiplier of 2.5.

Source Modulus
of rupture,

psi

Immediate Creep λc Shrinkage
λsh

Total λt

Sbarounis
(1984)

7.5 √fc' 1.0 2.8 1.2 5.0

Branson
(1977)

7.5 √fc' 1.0 2.0 1.0

1.0

4.0

Graham
and
Scanlon
(1986b)

7.5 √fc'

4 √fc'

1.0

1.0

2.0

1.5

2.0

1.0

5.0

3.5

ACI Code 7.5 √fc' 1.0 2.0 3.0

In this case the combined creep and shrinkage contribution should be
reduced to 2.5/3.5 = 0.714 (i.e. 71.4% of the total deflection).

1. To adopt the ACI 435 recommendation for insignificant restraint
stresses:

1. From the Slab Deflection toolbar, click Settings
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2. In the dialog, click Aging, Creep & Shrinkage

3. Increase the Allowance for shrinkage effects in total deflection to 0.8
then click OK

4. From the Slab Deflection toolbar, click Analyze Current 

Using this value, the revised deflection prediction increases to 2.2”

2. To adopt the ACI 435 recommendation when restraint stresses are
expected to be significant:

5. Open the Structure 3D view

6. Select all the slabs in the model and via the Properties Window, adjust the
Restraint Constant to 4.0 
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7. From the Slab Deflection toolbar, click Settings

8. In the dialog, click Aging, Creep & Shrinkage

9. Change the Allowance for shrinkage effects in total deflection to 0.714
then click OK

10. Return to the St.1 (1) 2D view.

11. From the Slab Deflection toolbar, click Analyze Current 

Using this value, the revised deflection prediction increases further to 3.1”
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Generate Composite Modulus Report

An effective composite modulus report can be obtained by right clicking a slab
and choosing Export Eff. modulus report to Excel. The report details the
composite modulus Ec determined for each event.

To display the Composite Modulus Report:

1. Set the Result to None to display the slabs.

2. Right click the slab between gridline D-E/1-2 and Export Eff Modulus
report to Excel > For the current slab item 
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We can see from the report that the short term composite modulus, Ec is
used.

Summary of Results

Using the Simplified event sequence + simplified combined creep and
shrinkage allowance method, the results can be tabulated below:

Approach Restraint
Constant for
Modulus of

Rupture

Assumed Creep
and Shrinkage

combined
allowance %

Total deflection

(Final load
event)

ACI 318 (ignoring
ACI 435)

7.5 66% 1.3”

ACI 435 (simple
approach -
insignificant
restraint)

7.5 80% 2.2”

ACI 435 (simple
approach -
significant
restraint)

4.0 71.4% 3.1”

Next steps

• In Method 2 (page 455) we will re-use the same model, but edit the
simplified event sequence so that creep is considered in the cracked
section analysis. The multiplier will also be edited so that it only considers
shrinkage effects.

• In Method 3 (page 462) a modified version of the model using a detailed
event sequence is investigated.

• Having obtained results for all three methods, observations on the
different methods (page 471) are discussed.
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• Finally, using results from one of the methods, deflection checks are
performed using check lines (page 476) and an output report is generated.

Method 2: Simplified Event Sequence + Rigorous Creep and Shrinkage Allowance

In Method 1 (page 443) we used a simplified event sequence (without
addressing the possibility of early age loading), to see how a single multiplier
can be applied to allow for the combined effects of creep and shrinkage.

In Method 2 we will re-use the same model, but edit the previous simplified
event sequence so that creep is considered in the cracked section analysis.
The multiplier will also be edited so that it only considers shrinkage effects.

Download and open the tutorial model (if required)

NOTE If you are reusing the model from the Method 1 (page 443) exercise
you can skip this step.

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Simplified Event Sequence.tsmd

Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)

2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Set up the rigorous creep and shrinkage allowance

In this method the Allowance for Shrinkage Effects multiplier is set to allow
for shrinkage only.

1. From the Slab Deflection toolbar, click Settings

2. In the dialog, click Aging, Creep & Shrinkage

3. Ensure the Aging Coefficient is set to User defined and the Allowance
for shrinkage effects in total deflection is set to 0.25. 
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The above factor allows for shrinkage only.

Refer to Shrinkage allowance (page 392) for an explanation of where this
value comes from.

4. Click OK to close the dialog.

Edit the Event Sequence to ensure that creep is accounted for in the analysis

1. From the Slab Deflection toolbar, click Event Sequences

2. Click Model Event Sequence

3. Ensure that the Number of Exposed Faces is set to 2 for each event. 

The creep coefficient Ct will be calculated based on this, thus affecting the
modulus of elasticity used in the analysis. For further details of this
calculation, see: Aging Coefficient - User Defined or Automatic? (page 441)
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Review the Restraint Constant

1.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, ensure
the Restraint Constant is set to 4.0 

Perform Iterative Slab Deflection Analysis

1. Open a St.1 (1) 2D view.

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

3. Review the deflections. 

The predicted deflection estimate is 1.5” (using a Restraint Constant of
4.0).
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Adjust the Restraint Constant and Re-analyze

Initially the Restraint Constant was set assuming significant restraint; we will
now investigate the effect of assuming insignificant restraint.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, change
the Restraint Constant to 7.5 
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3. Return to the St.1 (1) 2D view.

4. From the Slab Deflection toolbar, click Analyze Current 

With these settings the total deflection predicted at 5 years reduces to 1”
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Generate Composite Modulus Report

An effective composite modulus report can be obtained by right clicking a slab
and choosing Export Eff. modulus report to Excel. The report details the
composite modulus Ec determined for each event.

To display the Composite Modulus Report:

1. Set the Result to None to display the slabs.

2. Right click the slab between gridline D-E/1-2 and Export Eff Modulus
report to Excel>For the current slab item 
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Comparing this report to the report obtained when using the simplified
creep and shrinkage allowance (page 453), we can see a difference in the
value of the Composite Modulus Ec used. In this method, the age of
concrete is taken into account.

To verify the result, consider Event 2, 3 and 4 where the event ends at
1825 days:

• Start event t0 = 10 days, Event being considered, ti = 1825 days

• Time between events (ti-t0) = 1825-10 = 1815 days

• Modulus of Elasticity, E for 4500 psi concrete grade = 4000 ksi (from
Material database)

• Assumed Ultimate Creep Coefficient, Cu = 2.35

• Assumed Aging coefficient χ = 0.8. This is typically in the range 0.7 to
0.9

• Slab depth, d = 11 ¼ in

• Number of exposed faces, h = 2.

Ct = [(ti-t0) / ( 26 e(0.36 x d/h) ) + (ti-t0)] x Cui = [1815 / (26 e(0.36 x 11 ¼ / 2) +
1815] x 2.35 = 2.1199

Thus

Ēc = (t, t0) = Ec (t, t0) / (1 + χ Ct)

For event 2, 3 and 4, Composite Modulus, Ec = 4000 / (1 + 0.8 x 2.1199)
= 1484 ksi
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Summary of Results

Using the Simplified event sequence plus rigorous creep plus shrinkage
allowance method, the results can be tabulated below:

Approach Restraint
Constant for
Modulus of

Rupture

Creep
approach

Assumed
Shrinkage %

Total
deflection

(Final load
event)

ACI 435 (creep
included in
analysis)

4.0 Cu = 2.35,

h = 2

and χ = 0.8

25% 1.5”

ACI 435 (creep
included in
analysis)

7.5 Cu = 2.35,

h = 2

and χ = 0.8

25% 1.0”

Next steps

• In Method 3 (page 462) a modified version of the model using a detailed
event sequence is investigated.

• Having obtained results for all three methods, observations on the
different methods (page 471) are discussed.

• Finally, using results from one of the methods, deflection checks are
performed using check lines (page 476) and an output report is generated.

Method 3: Detailed Event Sequence + Rigorous Creep and Shrinkage Allowance

In this approach, a detailed event sequence has been defined which includes
propping loads at early events to create an overall load history. Creep is
considered rigorously alongside this load history by setting the Aging
coefficient to Automatic. This means that an effective composite modulus
value to the end of each event is calculated in accordance with the Concrete
Society Technical Report 58.

NOTE The aging coefficient method should only be set to Automatic when
defining a detailed event sequence that includes a realistic
assessment of early propping load events.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Detailed Event Sequence.tsmd
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Establish some slab reinforcement

Prior to running a Slab Deflection Analysis, a reasonable level of slab
reinforcement should already be provided. This can be achieved by designing
all slabs and patches as follows:

1. From the Analyze toolbar, click Analyze All (Static)

2. From the Design toolbar, click Design Slabs

3. From the Design toolbar, click Design Patches

Review the Detailed Event Sequence

1. To display the Event Sequence

1. From the Slab Deflection toolbar, click Event Sequences

2. Click Model Event Sequence 

A detailed event sequence has already been created:
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You will note that:

• Ultimate Creep Coefficient, Cu set at 2.35 for this example

• Number of exposed faces, h set at 2 for this example

• Construction load assumed set at 10.4 psf in this example

• Propping load % assumed during early age propping events 160% and
140% assumed.
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Set up Rigorous Creep

This method requires that the Aging coefficient is set to Automatic. Creep is
then considered automatically as part of the analysis for each event sequence.

A user defined allowance for Shrinkage effects in the total deflection is also
specified.

1. To specify the multiplier for shrinkage effects only but also consider
creep in the analysis

1. From the Slab Deflection toolbar, click Settings

2. In the dialog, click Aging, Creep & Shrinkage

3. Ensure the Allowance for shrinkage effects in total deflection is set to
0.25, and the Aging Coefficient is set to Automatic 

Review the Restraint Constant

1.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, ensure
the Restraint Constant is set to 4.0 
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Perform Iterative Slab Deflection Analysis

1. Open a St.1 (1) 2D view.

2. From the Slab Deflection toolbar, click Analyze Current 

After analysis the current view automatically switches into the Slab
Deflections View regime.

3. Review the deflections. 

The predicted deflection estimate is 1.5” (using a Restraint Constant of
4.0).
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Adjust the Restraint Constant and Re-analyze

Initially the Restraint Constant was set assuming significant restraint; we will
now investigate the effect of assuming insignificant restraint.

1. Open the Structure 3D view.

2. Select all the slabs in the model and via the Properties Window, change
the Restraint Constant to 7.5 
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3. Return to the St.1 (1) 2D view.

4. From the Slab Deflection toolbar, click Analyze Current 

With these settings the total deflection predicted at 5 years reduces to 1”
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Generate Composite Modulus Report

An effective composite modulus report can be obtained by right clicking a slab
and choosing Export Eff. modulus report to Excel. The report details the
composite modulus Ec determined for each event.

To display the Composite Modulus Report:

1. Set the Result to None to display the slabs.
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2. Right click the slab between gridline D-E/1-2 and Export Eff Modulus
report to Excel>For the current slab item 

Comparing this report to the report for the more simplified ACI “rigorous”
approach to creep (page 460) undertaken earlier.

• ACI composite modulus calculation for the Final Load Event = 1484 ksi
(also verified by hand calculation earlier)

• TR58 composite modulus calculation for the Final Load Event = 1531
ksi

• These values compare favorably.

Note, however, that if we compared event 5 above where the composite
modulus, Ec = 1284 ksi using the ACI method, we can establish the aging
coefficient as:

Ec = E / (1 + X * Ct)

1284 = 4000 / (1 + χ x 2.1199)

χ = [(4000 / 1284) - 1] / 2.1199 = 0.9978

This increased aging coefficient occurs due to the significant propping
loads at early events, which creates an overall load history that is almost
equivalent to constant loading.

Summary of Results

Using the Detailed event sequence plus rigorous creep and shrinkage
allowance method, the results can be tabulated below:

Approach Restraint
Constant for
Modulus of

Rupture

Creep
approach

Assumed
Shrinkage %

Total
deflection

(Final load
event)

ACI 435 (creep
included in
analysis)

4.0 Cu = 2.35, h =
2 and χ =
automatic

25% 1.5”
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Approach Restraint
Constant for
Modulus of

Rupture

Creep
approach

Assumed
Shrinkage %

Total
deflection

(Final load
event)

based on
TR58

ACI 435 (creep
included in
analysis)

7.5 Cu = 2.35, h =
2 and χ =
automatic
based on
TR58

25% 1.0”

Next steps

• Having obtained results for all three methods, observations on the
different methods (page 471) are discussed.

• Finally, using results from one of the methods, deflection checks are
performed using check lines (page 476) and an output report is generated.

Observations on the Different Methods

Combined Table of Results

Approach Restraint
Constant

for
Modulus

of
Rupture

Creep
approac

h

Assumed
Creep
and

Shrinkag
e

combine
d

allowanc
e %

Assumed
Shrinkag

e %

Total
deflectio

n

(Final
load

event)

Method
1:
Simplified
Event
Sequence
+
Simplified
Combine
d Creep
and
Shrinkage
Allowanc
e

ACI 318
(ignoring
ACI 435)

7.5  66%  1.3”

ACI 435
(simple
approach
-
insignifica
nt
restraint)

7.5  80%  2.2”

ACI 435
(simple
approach
-

4.0  71.4%  3.1”
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Approach Restraint
Constant

for
Modulus

of
Rupture

Creep
approac

h

Assumed
Creep
and

Shrinkag
e

combine
d

allowanc
e %

Assumed
Shrinkag

e %

Total
deflectio

n

(Final
load

event)

significan
t
restraint)

Method
2:
Simplifie
d Event
Sequenc
e +
Rigorous
Creep +
Shrinkag
e
Allowanc
e

ACI 435
(creep
included
in
analysis)

4.0 Cu = 2.35,
h = 2 and
χ = 0.8

25% 1.5”

7.5 Cu = 2.35,
h = 2 and
χ = 0.8

 25% 1.0”

Method
3:
Detailed
Event
Sequence
+
Rigorous
Creep +
Shrinkage
Allowanc
e

ACI 435
(creep
included
in
analysis)

4.0 Cu = 2.35,
h = 2 and
χ =
automati
c based
on TR58

 25% 1.5”

7.5 Cu = 2.35,
h = 2 and
χ =
automati
c based
on TR58

 25% 1.0”

Discussion

When the guidance in ACI 435 about the use of a combined allowance for
creep and shrinkage is taken into account, the simplified approach using a
combined creep and shrinkage multiplier seems to determine very
conservative deflection estimations.

Looking at table 4.1 in ACI 435, it is clear that the creep contribution is the
most significant part of the overall deflection estimate. It is also the area
where there seems to be greatest variation in opinion on the contribution
level.
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The creep contribution can be dealt with more rigorously by including it in the
analysis. So rather than using a short term E value and then amplifying the
result to account for creep, the analysis at the end of each event uses an
effective E value which includes for creep up to that point. This impacts on the
analysis properties of every shell in the FE analysis and even on the extent of
cracking.

It is suggested that when the creep is included in the analysis the use of a
modulus of rupture which assumes low restraint (restraint constant = 7.5) be
used cautiously.

The option to calculate the effective E value based on some UK guidance in
TR58 makes little difference in this example. It should be borne in mind that
the aging coefficient χ is user defined and 0.8 is just a default for “normal”
situations. In situations such as a transfer slab where load will accrue more
slowly over time 0.8 is likely to be conservative and it may be of interest to
consider the TR58 alternative.

Overall, it is expected that most engineers would use the settings highlighted
in bold in the table above as a default starting point and then make
refinements if necessary.

Extent of Cracking

It is clear from the Combined Table of Results, that the Restraint Constant
and hence the Modulus of Rupture has a huge impact on the predicted
deflections. This is due to the impact the modulus of rupture has on the extent
of cracking that develops. This is illustrated below where the extent of cracking
for the final load event is displayed for the Method 2 model.

Extent of cracking resulting from a restraint constant of 4.0

Engineers Handbooks 473 Slab deflection handbook



You can clearly see the majority of the slabs have cracked where the restraint
constant is 4.0.

Extent of cracking resulting from a restraint constant of 7.5
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The majority of the slabs remain uncracked where the restraint constant is 7.5.
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Next steps

• Using results from one of the methods, deflection checks are performed
using check lines (page 476) and an output report is generated.

Use of check lines to check deflections (ACI)

Once the input parameters have been set as required to allow for creep and
shrinkage, and the analysis has been performed, check lines can then be
placed in order to check the deflections.

Download and open the tutorial model

1. Download the tutorial models from here.

2. Open the following tutorial model: 

• Slab deflection ACI - Check Lines.tsmd

Define Check Line Deflection Checks

Check lines have to initially be positioned using engineering judgment.

The deflection checks associated with each check line are selected from a
predefined Deflection Check Catalogue. This is viewed by clicking Deflection
Checks in the ribbon.

You can add new checks to the catalogue as required.

1. From the Slab Deflection ribbon, click Deflection Checks 

Whilst four checks have been defined above, only three of these have
been set to be used in new Check Lines. The more onerous cladding check
which does not come from code requirements is not applied by default:

• Sensitive finishes will check the differential deflections from when the
sensitive finishes are applied to the final load event against a
deflection limit of 1/480

• Total will check the total deflections to the final load event against a
deflection limit of 1/240

Engineers Handbooks 476 Slab deflection handbook

https://teklastructuraldesigner.support.tekla.com/support-article/3072945


• Live load only will check the instantaneous deflections for the live
load only event against a deflection limit of 1/360

2. Click OK to close the dialog.

Place Check Lines

We will define two check lines in this example:

1. Open the St.1 (1) 2D plan view 

NOTE When the 2D plan view is being viewed in 3D as above, the Create
button on the Slab Deflection toolbar is grayed out.

2. Click  in the bottom right corner of the view to toggle the view until it is
displayed in 2D. 
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3. From the Slab Deflection toolbar, ensure the Results are set as above:

a. Result - Deflections,

b. Result Direction - Z,

c. Result Type - Total,

d. Event - Final load event

4. Click Create 

NOTE Check lines can only be created in a 2D view.

NOTE When you click Create, the Properties Window automatically
includes the slab deflection checks from the catalogue for which
“Use in new Check Lines” was checked.
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5. To place a check line running diagonally between columns in bottom right
corner panel where the peak deflection occurs:

a. Pick the start point as grid line intersection D/1.

b. Pick the end point as grid line intersection E/2.

Before creating a second check line, in the Properties Window add a check
#3, by selecting Cladding from the droplist.
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6. Create the second check line along grid line 1.

a. Pick the start point as grid line intersection A/1.

b. Pick the end point as grid line intersection E/1.

7. Create the third check line along grid line B.

a. Pick the start point as grid line intersection B/1.

b. Pick the end point as grid line intersection B/5.
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8. Create the final check line mid-way between grid lines 4-5 from grid line A
to E.

a. Pick the start point approximately as shown: 
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b. Pick the end point approximately as shown: 

Engineers Handbooks 482 Slab deflection handbook



9. Press Esc to end the command. 

NOTE In a real model you can add as many check lines to the model as
you consider appropriate.

10. Right click on the diagonal check line and from the context menu select
Open deflections check view. 
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The ribbon allows you to specify the total (as shown above), or differential
or instantaneous results for the selected events. Tekla Structural Designer
then draws average slopes between maximum and minimum points.

A total deflection limit of Span / 240 is the same as saying that the average
slope between points of maximum and minimum deflection = 1 / 120. In
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the view above the average slope between these points is 1 / 138, so the
check passes.

Doing the checks this way inherently deals with offset peak deflections
(non-uniform load) and also cantilevers.

11. Click within the Deflection load analysis view and change the Result type
to Differential and check deflection and slopes between the Finishes
added and Final load event. The resulting differential deflection is as
shown: 

For the Sensitive Finishes check of differential deflection between finishes
added and the final load limit had a limit of Span / 480, which is the same
as saying that the average slope between points of maximum and
minimum deflection = 1 / 240. In the view above the average slope
between these points is 1 / 194, so this check fails.

Generate Check Line Reports

A tabulated report is available for each check line which itemizes each
requested deflection check along the check line.

You can generate a check line report for an individual check line by right
clicking the check line and selecting Member Report.

1. Return to the St.1 (1) 2D view, right click on the diagonal check line and
select Report for Member 
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As previously stated, the Sensitive Finishes check fails since the slope for
differential deflection is reported as 1:206 which is greater than the
allowable slope limit of 1:240.

Review Check Line Status and Utilization

Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical Utilization ratio.

1. Click on the St.1 (1) 2D 2D view to make it active.

2. To make it easier to see the check lines, change the Result droplist from
Deflections to None.

3. Click Status in the Check Lines group of the ribbon to see the pass/fail
status graphically displayed for each check line. 
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TIP You can also hover over a check line and the tooltip displays the
utilization and pass/fall status.

4. Click Utilization in the Check Lines group to show the critical utilization
for each check line and investigate the tooltip results. 
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Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check
lines are automatically re-checked so you will obtain instant feedback on
status and utilization

Review Slab Status and Utilization

Every check line is associated with at least one slab item. If all checks lines
associated with the slab item pass then the slab item passes.

Both the Status and the Utilization can be reviewed.

1. Click Status in the Slab Deflections group of the ribbon to see the pass/
fail status of each slab. 
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• No check lines cross the majority of the slab items so they currently
have a status of Unknown.

• A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, the 4 slab items
crossed by the horizontal check line Fail.

• One slab item is being crossed (only just, in one corner) by the passing
diagonal check line, this is the only slab to have a pass status.

2. Click Utilization in the Slab Deflections group to show the Utilization of
each slab item. 
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This is the worst utilization from all associated check lines.

Optimization

If you find that a slab either fails deflection checks (or passes with a low
utilization) then changes will need to be made. There are many areas where
adjustments can be made.

• Adjust slab/panel depths?

• Adjust reinforcement?

• Re-consider the Event timings and loadings?

• Adjust other settings?

Any or all changes are possible.

When changes are necessary we would recommend that it will be more
efficient to work on one level at a time. The automatic re-checking of check
lines will help considerably with this optimization.

The analysis is extremely quick and since everything is contained within one
model file, it allows “What If” scenarios to be considered to find the optimum
solution.

In this exercise we will start by looking at the impact of adjusting the
reinforcement.
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1. Click Slab Reinforcement in the Show/Alter State group to show the
existing reinforcement. 

2. In the Properties Window:

a. Leave the Slab Reinforcement to modify as Panel

b. Leave the Slab Layer to modify as Bottom

c. Change the Reinforcement Direction to BarsY to see the bars in that
direction
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3. In the Properties Window:

a. Leave the Slab Reinforcement to modify as Panel

b. Leave the Slab Layer to modify as Bottom

c. Change Apply to User Bars

d. Change Bar size to 7

e. Change Bar spacing to 6in
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4. Click on each panel to apply the new reinforcement. 

5. Repeat the above process to apply the same bars in the X reinforcement
direction also.

6. Click Analyze Current to update the results
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7. Click Utilization in the Check Lines group to show the critical utilization
for each check line once again.

8. Investigate the tooltip results 

We can clearly see improvements in the results, however the check line
along grid 1 with the more onerous Cladding deflection limit is still failing.

At this point in a real model you could begin to look at the impact of the
various other input parameters, such as changing the concrete grade.

For the purpose of this exercise, and as the cladding check is not a code
requirement, we will simply disable it, as follows:

9. Select the check line along grid 1

10. In the Properties window, reset Check #4 to None. 
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11. Click Analyze Current to update the results

12. Click Status in the Check Lines group. All of the check lines should now
pass.
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Generate Model report

A Slab Deflection Check Lines model report can be created for the selected
Model Filter (entire structure, level, plane or sub structure). This lists all the
check lines for the chosen model filter. To help identify the check lines in the
report it is sensible to include a saved picture of the scene view displaying
check lines and their associated reference within the report.

1. In Scene Content, switch on the Text display for the Slab Deflection
Checks. 
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TIP The check line references can be customized using the Name
property for each individual check line.

2. Right click in the Typical floor 2D view and choose Save View
Configuration... from the context menu, then specify a name. 
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This saved view can be included in the Check line report.

3. On the Report ribbon, click Model Report...

4. Click Add and provide a Name “Check Line Report” for the report.

5. In Chapters and Options, drag View to the Report Structure area

6. In the Report Structure, right click View, then choose Settings...

7. Select the Slab Deflection view you created earlier 
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8. Click OK to return to the Report Contents dialog

9. In Chapters and Options, drag Concrete>Slab/Mat Design per
Plane>Slab Deflection Check Lines to the Report Structure area 
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10. In the Report Structure, expand Concrete> Slab/Mat Design per Plane>
Slab Deflection Check Lines and right click, Model Filter> Edit/New 

11. In the Filter dialog, click Add and select Selected levels and ensure a check
against St. 1 (1) 
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12. Click OK to return to the Report Contents dialog.

13. Click OK to exit and save the report. 

A report structure called Check Line Report has now been saved that
contains a view and the check lines.

14. To display the report.

a. Use the Select drop list in the ribbon to select Check Line Report

b. Click Show Report to open the report.
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1.8 Precast member design handbook
Precast structures can be modeled and analyzed in Tekla Structural Designer.
Precast beams and columns can then be designed, provided that you have
access to a license of Tekla Tedds.

This handbook describes the workflow required in Tekla Structural Designer
for running the Tekla Tedds precast calculations.

NOTE The following limitations apply:

• Only design of normal weight precast concrete beams and columns to
Eurocodes is supported.

• Design of precast concrete slabs and walls is beyond scope for all head
codes.

• The process is only applicable to precast structures that don't make use of
in-situ structural toppings.

• Precast construction which adopts a more hybrid construction
involving the use of in-situ toppings exceeds the limitations of the
Tekla Tedds calculations and should therefore be considered beyond
scope.

The following topics are covered:

• Precast member design workflow (page 503)

• Precast member design groups (page 513)

• Precast beam design (page 515)

• Precast column design (page 529)

• Precast column connection eccentricity moments (page 533)

• Precast member design commands (page 538)

Related video

Precast modeling, analysis and design using Tekla Tedds

Precast member design workflow
The basic workflow for precast design in Tekla Structural Designer is described
in the sections below:

Related video

Precast modelling, analysis and design using Tekla Tedds
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Configure precast beam and column design settings
Specific precast beam design settings and precast column design settings that
apply to all the beams and columns in the model should be specified prior to
running the designs.

These are set on the repective Concrete>Precast pages of the Design
Settings dialog.

By ensuring the defaults are set correctly you can avoid having to manually set
the values in each Tedds precast calculation as it is run.

You still have control within individual calculations to adjust these settings on
a member by member or group basis.
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Define and place precast members
To place precast members, simply use the Concrete Column > Precast, or
Concrete Beam > Precast commands on the Model tab.

An alternative to this would be to use the Concrete Column > Column, or
Concrete Beam > Beam commands and to subsequently change the
Fabrication parameter to be Precast.

Configure precast groups
Customizable member groups are created automatically. You can choose
whether to utilize them for design purposes via the Design Groups page of
the Design Settings dialog.
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Using precast member design groups (page 513) can help speed the overall
design process, particularly so in the case of medium to large size models.

• An envelope of group design forces is passed to a single Tedds calculation.

• User can manipulate design options, member size, material etc.

• Any changes are applied to each member in group.

• Each individual member of group is checked against individual loads
without any further user interaction.

The initial precast member design groups can be reviewed from the Groups
tab of the Project Workspace - you can move members into new groups as
required.

Set the Tedds results output level
You can choose the output level for the Tedds precast calculations in advance
by clicking Home > Settings > Report > Tedds Reports

By ensuring this is set correctly beforehand you can avoid having to manually
set the level in each Tedds precast calculation as it is run.

The setting applies to all Tedds linked calculations (precast and timber).
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Establish design forces by running the analysis
Precast members can only be designed provided a set of analysis results exist.
These can be generated from the Analyze ribbon by running .

A design force envelope is established, and all critical load combinations are
considered in one Tedds calculation.

Provided load combinations have been created, once analysis has been
performed the Design using Tekla Tedds options become available.

Design using Tekla Tedds

NOTE We recommend that the Tekla Structural Designer model is developed as
much as possible prior to considering the design of the precast members.
This should ensure that the correct distribution of forces is carried through
into the Tekla Tedds calculations.

Design a Selection

To design several precast members or groups in one go:

1. Select the precast members you want to design.

2. Right click and select Design using Tekla Tedds> Selection

3. Design the selected members.

NOTE If grouped design is active, a single grouped design is performed
for each group included in the selection using critical design
forces established from all members in the group (irrespective of
whther ot not they were included in the selection). At the end of
the process all members in each designed group are checked,
(irrespective of whether or not they were included in the
selection).

4. When changes are made to the model, you can check if the existing
sections are still sufficient by by running

5. Check In Tedds from the Design tab.

NOTE Tedds calculation data is retained from one run of the design to
the next unless changes are made in Tekla Structural Designer
that force the Tedds calculation data to be re-established. If you
want to manually clear the Tedds calculation data from a previous
design run you can do so by running Clear Tekla Tedds Data from
the right-click context menu.

Design a group

If you have activated concrete member design groups, each group can be
designed as follows:
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1. Highlight any member in the group, right click and select Design using
Tekla Tedds> Group

This design gathers the analysis results for all members in the group and
collates them in to one design. (In effect assuming that all the worst case
loads are happening on one member simultaneously.)

2. Design the selected member for these loads.

3. Click Finish.

If the section size was changed during the design, all members of the
group will be updated to the new section. If the reinforcement data was
changed this is also copied to all group members.

Irrespective of whether the section or reinforcement has been changed or
not, all members in the group are then automatically checked against only
the loads that they see individually. A pass fail status and utilization ratio
is calculated accordingly for each one.

4. In the Review View, review the utilization ratios for all members in the
group - if these all indicate an efficient design, the process can stop at this
point.

NOTE For columns in particular, the envelope of design forces applied
to members of the group can be overly conservative - e.g. if some
columns are loaded about one axis, and some loaded about the
other, they are all designed as if loaded about both axes.

5. If a group member has a lower than desired utilization, right click on it
and select Design using Tekla Tedds> Member

6. In the Review View, review the resulting utilizations for the group
members - note that some of might now fail.

7. Using the new utilizations to better inform you choice, add extra groups
as necessary and re-allocate the members between the groups.

8. Run Design using Tekla Tedds> Group for one member in each of the new
groups.

9. Iterate the process, starting from step 5 above.

10. When changes are made to the model, you can check if the existing
designs are still sufficient by by running Check In Tedds from the Design
tab. Alternatively you can check groups individually by running Check
using Tekla Tedds> Group for one member in each group.

NOTE Tedds calculation data is retained from one run of the design to
the next unless changes are made in Tekla Structural Designer
that force the Tedds calculation data to be re-established. If you
want to manually clear the Tedds calculation data from a previous
design run you can do so by running Clear Tekla Tedds Data from
the right-click context menu.
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Ungrouped Design

If you have elected not to make use of design groups, each member can be
designed individually as follows:

1. Highlight the member, right click and select Design using Tekla Tedds>
Member

2. Design the selected member.

3. Continue to design additional members in the same way as required.

4. When changes are made to the model, you can check if the existing
sections are still sufficient by by running Check In Tedds from the Design
tab.

NOTE Tedds calculation data is retained from one run of the design to
the next unless changes are made in Tekla Structural Designer
that force the Tedds calculation data to be re-established. If you
want to manually clear the Tedds calculation data from a previous
design run you can do so by running Clear Tekla Tedds Data from
the right-click context menu.

Design model

If you want to design every precast (and timber) member in the model in one
go:

1. In the Project Workspace, click Group tab.

2. In the tree, right-click Groups.

3. In the context menu, select Design using Tekla Tedds > Model

At the end of the process the status and utilization of each member is
displayed in a Review View.

Check the design after changes
If changes are made to the model you can run a 'check' design to determine if
the existing sections are still sufficient. A check is quicker to perform than a
design because the Tedds calculation runs in the background without having
to display the Tedds calculation dialog.

The updated utilizations can then be reviewed in a Review View.

Check the whole model

To check all the existing Tedds member designs,

1. Click Check In Tedds from the Design tab.

This reruns all the Tedds calculations in the background using the latest
analysis results.
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Check a selection

To check several members or groups in one go,

1. Select the members or groups you want to check.

2. Right click and select Check using Tekla Tedds> Selection

The Tedds calculations for the selected members or groups run in the
background using the latest analysis results.

Check a member

To check a single member,

1. Highlight the member you want to check.

2. Right click and select Check using Tekla Tedds> Member

The Tedds calculations for the selected member runs in the background
using the latest analysis results.

The updated status and utilization are displayed in the member tooltip.

Check a group

To check a member group,

1. Highlight a member in the group you want to check.

2. Right click and select Check using Tekla Tedds> Group

• The Tedds calculations for the selected group run in the background
using the group critical design forces.

• All members in the group are then checked against their individual
design forces.

Output the calculations
The Tekla Tedds design results are returned to the Tekla Structural Designer
model.

At this stage you can display member design status and utilization ratios from
a Review View.
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You can also display the design status tabular results.
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Detailed Tekla Tedds calculations for precast members do not exist within
Tekla Structural Designer itself, instead they are available by exporting to Tekla
Tedds.
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Precast member design groups

NOTE The use of suitable design groups for precast members is recommended.
Using design groups will help speed the overall design process and allow for
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identical reinforcement amounts to be provided for each element within the
group.

Why use precast design groups?
Precast beams and columns are put into groups for two reasons:

1. For editing purposes - individual design groups can be selected and
displayed graphically so that their properties can be changed as a group
in the properties window.

2. For design - to standardise designs, reduce processing time, and reduce
the volume of output created.

A fixed set of rules are used to automatically determine member groups: for
example beams must be of similar spans, columns must have the same
number of stacks. Members in all member groups must be of similar lengths
and cross-section.

NOTE Although precast members are automatically grouped for ease of editing, the
use of groups for design is optional and can be deactivated if required: From
the Design tab, click Settings> Design Groups, then select or unselect concrete
beams and/or concrete columns as required.

Activating precast member design groups
Precast beam and column design groups are activated as follows:

1. From the Design tab, click Settings> Design Groups

2. Select concrete beams and/or concrete columns to activate precast beam
and/or precast column design groups.

Group management
Automatic Grouping

Precast beams and columns are grouped automatically according to a fixed
set of requirements.

In Model Settings > Grouping the user defined maximum length variation is
used to control whether elements are sufficiently similar to be considered
equivalent for grouping purposes.

Manual/Interactive Grouping

After assessing the design efficiency of each group, you are able to review
design groups and make adjustments if required from the Groups tab of the
Project Workspace.

See:
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NOTE When manually adding members to a group, the order in which they are
added will incrementally affect the average length within the group, (which is
then compared to the maximum length variation). Therefore, if members are
not being added as you expect, try adding them in a different order.

Regroup ALL Model Members

If you have made changes in Design Settings that affect grouping, you can
update the groups accordingly from the Groups tab of the Project Workspace
by clicking Re-group ALL Model Members.

NOTE Any manually applied grouping will be lost if you elect to re-group!

Precast design group requirements
Precast member design groups are formed according to the following rules:

Member type Design group rules
Precast beam • A beam element may be in only one design group.

• Design groups may be formed from single span or
multi-span continuous beams.

• All beam elements in the group must have an identical
number of spans.

• For each individual span all beam elements in the
group must have an identical cross section, including
flange width where appropriate, and span length.

• All beam elements in the group must have identical
material properties.

Precast column • A column element may be in only one design group.

• All column elements in the group must have an
identical number of stacks.

• For each individual stack all column elements in the
group must have an identical cross section, and stack
length.

• All column elements in the group must have identical
material properties.

Precast beam design
Specific aspects of the precast beam design workflow in Tekla Structural
Designer are described below:
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Section shapes
The following section shapes can be used within the Tekla Structural Designer
- Tekla Tedds workflow.

• Rectangular

• L-Section

• Inverted L-Section

• T-Section

• Inverted T-Section

Beam arrangement
The Tekla Tedds calculations have no concept of the model geometry within
Tekla Structural Designer and so there are no limitations on the design of
curved beams in both major and minor axes. Continuous beams, cantilevered
beams etc. are similarly supported by the workflow.

Concrete type
While you can apply both normal and lightweight concrete in the beam
properties, precast beam design using lightweight concrete is currently
beyond scope.

Nominal cover
The default nominal top, bottom and side cover values set in Design Settings>
Precast> Beam> Reinforcement Settings are automatically passed through
to the Tekla Tedds calculation. The nominal concrete cover is the distance
between the surface of the reinforcement closest to the concrete surface
(including links and surface reinforcement where relevant) and the nearest
concrete surface.

Reinforcement - longitudinal bar patterns

NOTE The reinforcement regions are considered to be the extent of the effective
reinforcement. Anchorage and anchorage lengths are not considered in
precast beam design within Tekla Tedds.

In Design Settings> Precast> Beam there is a one Standard Pattern available
for top longitudunal reinforcement, Precast Top 1, and one Standard Pattern
available for bottom longitudunal reinforcement, Precast Bottom 1 as
illustrated in the figures below.

Standard Pattern of Top Reinforcement - Precast Top 1

Pinned span settings are applied to all spans with Fixity end 1 and 2 set to Pin.
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NOTE As shown above, the concept of continuity bars in pinned spans can be
catered for by enabling Bar (12). When enabled, the end region length is
allowed to be 0%.

Cantilever span settings are applied to all spans with cantilever selected.
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Continuous span settings apply to all other spans.
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Standard Pattern of Bottom Reinforcement - Precast Bottom 1

Pinned span settings are applied to all spans with Fixity end 1 and 2 set to Pin.
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NOTE As shown above, the concept of continuity bars in pinned spans can be
catered for by enabling Bar (14).

Cantilever span settings are applied to all spans with cantilever selected.
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Continuous span settings apply to all other spans.
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Design sections
An individual design section is created for each length of beam with similar
reinforcement definitions. Each design section is then designed for the
maximum forces in that region of similar reinforcement.

The numbers of design sections and their locations are determined by
aggregating the different regions specified in the Design Settings> Precast>
Beam: Top Longitudinal Bar Pattern, Bottom Longitudinal Bar Pattern
and Link Settings.

Example: The default Precast Top 1 and Precast Bottom 1 longitudinal bar
patterns for a Pinned Span are adopted without any continuity bars added as
follows:
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• Precast Top 1: single region 100% of the beam span.

• Precast Bottom 1: B1 and B3 regions set as 15% of the beam span.

• Default Link Settings are also adopted: S1 and S3 regions set as 25% of
the beam span.

For a pinned single span precast beam, different region boundaries would
therefore exist at 15%, 25%, 75% and 85% of the span.

Consequently, when the span is designed in Tekla Tedds, 5 design sections
would be created:
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• s1 - positioned half way along the first bottom span region (7.5% of the
span)

• s2 - positioned half way between the first and second region boundaries
(20% of the span)

• s3 - positioned half way along the second and third region boundaries (50%
of the span)

• s4 - positioned half way between the third and forth region boundaries
(80% of the span)

• s5 - positioned half way along the last bottom span region (92.5% of the
span)

NOTE In this example the first design section lies in the B1 bottom span region, so
the positive design moment at s1 would be the maximum that occurs within
B1; the second, third and forth design sections all lie in B2, so the positive
design moment at s2, s3 and s4 would be the maximum that occurs within B2.

The engineer can of course adjust the standard bar patterns in the Tekla
Structural Designer design settings to suit their requirements.

For instance, if in this example the Precast Bottom 1 pinned span pattern
were to be amended so that B1 and B3 regions were set as 25% of the span;
because the bottom and link regions would then coincide, region boundaries
would only exist at 25% and 75% of the span.

Consequently, when the span is designed in Tekla Tedds, only 3 design
sections would be required:

• s1 - positioned half way along the first region (12.5% of the span)
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• s2 - positioned half way between the first and second region boundaries
(50% of the span)

• s3 - positioned half way along the last region (75% of the span)

NOTE In the above elevation diagrams:

• A black section mark indicates the selected design section is
passing the design criteria.

• Grey section marks indicate unselected design sections which are
passing.

• A red section mark would indicate a design section which is failing.

Default reinforcement in the Tekla Tedds calculation
Regardless of beam shape and size imported from Tekla Structural Designer,
the reinforcement in each beam member is always defaulted to the same
values Tekla Tedds calculation.

This default reinforcement is:

• Top: 2x 16 dia bars

• Bottom: 3x 16 dia bars

• Shear: 2 legs of 8 dia bars at 250 cross centres

NOTE The Tekla Tedds calculation contains some limitations to the error
trapping when it comes to maximum reinforcement values. Although
the main bars in both the top and bottom of the beam have a check
allocated to prevent unrealistic distances being entered, the shear
links have no such limitation.

The engineer is expected to use their own knowledge to place in shear
link values and distances which are both realistic and constructible.
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NOTE The Tekla Tedds calculation contains some limitations to the section
diagram. It may be noted that the diagram is never altered if the
number of shear legs is increased from the default value of 2 legs. It
should be noted that shear link legs are indicative only within Tekla
Tedds and in reality there are a variety of ways that reinforcement can
be detailed. The Tekla Tedds calculation therefore chooses to omit
additional shear reinforcement in the section diagram and to flag it
instead in the notes and the calculations.

Lifting checks
Lifting checks are disabled by default. This has been done to ensure a rapid
design of grouped beams can take place. If lifting checks are required then
simply enable the switch within the Design Options dialog within the Tekla
Tedds calculation.

NOTE The lifting check for beam members makes allowance for
reinforcement for both bending and shear checks.

Analysis forces transferred from Tekla Structural Designer
The following values in the Tekla Tedds calculation are populated from the
Tekla Structural Designer model.

• Positive moment

• Positive design moment

• Positive quasi-permanent moment

• Redistribution ratio

• Negative moment

• Positive design moment

• Negative quasi-permanent moment

• Redistribution ratio

• Shear

• Maximum Design shear force

• Design shear force

• Torsion

• Design torsional moment

NOTE Minor axis forces (as defined in Design > Settings > Design Forces) are not
used in the design of the member. Where minor axis forces are present within
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a beam, a warning is displayed within the process dialog of Tekla Structural
Designer.

Other precast beam properties
The following properties which are common to both cast-in-place and precast
beams, are not transferred to the Tekla Tedds calculation, but still require
consideration as they will impact the analysis in Tekla Structural Designer.

• Cracked, partially cracked, and uncracked concrete members (page 255)

• Design parameters (page 269)

Precast column design
Specific aspects of the precast column design workflow in Tekla Structural
Designer are described below:

NOTE The current Tekla Tedds calculation makes no allowance for any shear checks.

Section shapes
Whist a variety of different section shapes can be defined in Tekla Structural
Designer, the Tekla Tedds calculation only supports the design of rectangular
and circular column sections.

Concrete type
While you can apply both normal and lightweight concrete in the column
properties, column design using lightweight concrete is currently beyond
scope.

Nominal cover
The default nominal cover value set in Design Settings> Precast> Column>
Reinforcement Settings is automatically passed through to the Tekla Tedds
calculation. The nominal concrete cover is the distance between the surface of
the reinforcement closest to the concrete surface (including links and surface
reinforcement where relevant) and the nearest concrete surface.
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Reinforcement
Default reinforcement in the Tekla Tedds calculation

Regardless of the column size imported from Tekla Structural Designer, the
initial default reinforcement for all stacks in the Tekla Tedds calculation is as
follows:

• Rectangular columns: a 2x3 formation of 25mm dia rebars with 8mm shear
links.

• Circular columns: 6x 25mm dia rebars with 8mm shear links.
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NOTE Tekla Tedds has no concept of multiple stack columns and Tekla
Structural Designer has to associate separate Tekla Tedds calculations
with each stack. It is the responsibility of the engineer to ensure that
rebar on adjacent stacks are of appropriate quantities and sizes to
ensure correct detailing can take place at the construction stage. It
should be noted that Tekla Structural Designer does not hold any
reinforcement information relating to precast members.
Reinforcement is completely managed by the Tekla Tedds
calculations.

The maximum number of bars which can be entered in either direction for
rectangular columns is 10. For circular columns, the maximum total number of
bars is 20. Please note that these restrictions will have an effect on the
maximum allowable column size for the design workflow.

There is a basic minimum distance calculation within the Tekla Tedds
document relating to bar amounts to avoid unrealistic values of rebar from
being selected. This amount is to be the minimum of:

• K1 x bar dia

• 20mm

• k2 x max aggregate size

NOTE For values of coefficients k1 and k2, refer to clause 8.2 of the
Eurocode.

The number of link legs shown in the Tekla Tedds calculation will increase or
decrease depending on the number of reinforcing bars assigned within the
document.

Engineers Handbooks 531 Precast member design handbook



NOTE The link legs are displayed to indicate required confinement
reinforcement for vertical bars in compression, but have no effect on
the overall design process.

Lifting Checks and Splice Design
Lifting checks and splice checks are disabled by default. This has been done to
ensure a rapid design of grouped columns can take place. If these checks are
required then simply enable the switches within the Design Options dialog
within the Tekla Tedds calculation.

NOTE The lifting check is performed against the unreinforced area of the
column, hence there is no input for the shear link centres within the
calculation. (Bending checks (for splice design) do include
reinforcement allowances within the design process.)

Analysis forces transferred from Tekla Structural Designer
The following values in the Tekla Tedds calculation are populated from the
Tekla Structural Designer model.

• Axial load, 1st case (Max value)

• Axial load, 2nd case (Min value)

• Where tension exists in the column, the lowest compression value is
populated into this parameter and the tension value ignored. A warning
will be displayed in the process log within Tekla Structural Designer.
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• Moment about y axis at top

• Moment about z axis at top

• Moment about y axis at bottom

• Moment about z axis at bottom

NOTE Tekla Structural Designer populates values from all design combinations. For
columns subjected to low axial loading, the moment capacity will not be as
high as a column subjected to larger axial loading. Low axial load and high
moment can easily be a critical combination for concrete column design.

Other precast column properties
The following properties which are common to both cast-in-place and precast
columns, are not transferred to the Tekla Tedds calculation, but require
consideration as they impact the overall performance of the model.

• Cracked, partially cracked, and uncracked concrete members (page 255)

• Design parameters (page 275)

• Stiffness (page 277)

• Sway/Drift Checks (page 278)

Precast column connection eccentricity moments

Overview
Nominal eccentricity moments arise in precast columns due to the reactions
from pin ended beams being applied at eccentricities to the column centerline.
The eccentricity moments are calculated for all headcodes, and can be
interrogated in the Load Analysis View.

If working to Eurocodes, these eccentricity moments are also taken into
account when precast columns are transferred to Tedds for design.

These moments do not come directly from the global analysis but instead are
calculated at the ‘load analysis’ post-processing stage as follows:

• At each level the eccentricity of each connection is specified as a user
defined offset from the column face. If rigid zones are not being used this
is increased by half the depth of the supporting column.

• At each level the pinned beam end reactions connecting to the column at
each face are determined.

• If braces also connect to the same face, the force in the brace will also be
taken into consideration if the "Include force in eccentricity moment" brace
release property is checked for the appropriate end of the brace.
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• Taking the beam end reactions (and brace forces if included) on opposite
faces multiplied by their connection eccentricities, resultant eccentricity
moments are determined.

• These moments are then distributed above and below the level based on
the column stiffnesses.

NOTE The eccentricity moments are typically assumed not to be transferred
beyond the level at which they are applied.

Patterning of eccentricity moments

The eccentricity moments resulting from live loads can be patterned if
required to account for the likelihood that the load is not present on all spans
simultaneously.

When eccentricity moment patterning is enabled you must then indicate which
of the live cases are to be patterned, (you may for example decide not to
pattern storage loads.)

For those live cases with patterning enabled, five patterns are considered.
These are:

Pattern 0 is for the full live load at all positions i.e. no patterning - this gives the
maximum axial force in any one stack with (usually) lower eccentricity
moment.

Patterns 1 to 4 are ‘true’ patterns switching live load ‘on’ and ‘off at each pair of
positions around the column in order to generate the maximum live
eccentricity moments about the major and minor axes of the column.
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NOTE The same pattern is applied at the top and bottom of the stack, so for
example it is not possible to have P1 at the top and P4 at the bottom.

Design to Eurocodes

In general, eccentricity moments are only added to the 'real' moments at the
ends of each stack and are only added if they make the design worse.

If you have elected to pattern live eccentricity moments these are considered
in conjunction with the eccentricity moments from other types of load, and
with the 'real' moments.

• As the eccentricity moments are considered localised to each floor the full
axial force from other floors is maintained. The axial force at the level
under consideration will be slightly reduced with patterning enabled as the
live floor loading will not be present on all sides simultaneously.

Define connection eccentricity values
The eccentricities at each level are defined in the column properties and a
different eccentricity can be applied to each face.

If you uncheck the option to apply eccentricity at a face the end reaction on
that face is applied axially.

NOTE Face A can be identified graphically, from which the other faces follow, see:
Steel member orientation (page 219)
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Pattern eccentricity moments for live loadcases
Patterning can be switched on for specific live loadcases in a two-step process
as follows:

1. From the Home ribbon:

a. Click Model Settings > Loading > General

b. Select Use patterning of eccentricity moments for precast
columns

c. Click OK

2. From the Loadcases page of the Loading dialog:

a. Select a live loadcase that you want to be patterned

b. Select Pattern Ecc. Moments for Precast Columns

c. When patterning has been selected for each of the required
loadcases, click OK

Review connection eccentricity moments
Because eccentricity moments do not come directly from the global analysis
they cannot be displayed graphically in a Results View, they can only be
displayed on a column by column basis by opening a Load Analysis View.

With a Load Analysis View open and the required loadcase or combination
selected in the Loading list, you then select the Major, or Minor direction in
the Loading Analysis ribbon.

The 'real' moments are displayed as a shaded diagram using solid lines, the
eccentricity moments as an unshaded using dashed lines:
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The red marker line can be set to a specified distance in the Properties
window to allow the real and ecc. moment values above and below the line to
be displayed.

Displaying patterned eccentricity moments

When you select a patterned live loadcase a Show ecc. moment pattern box
will become available in the Properties window.

After selecting Show ecc. moment pattern you can then click Ecc. moment
pattern in order to select the pattern to display from the droplist.
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Precast member design commands
By right clicking over the required member in a view or appropriate branch of
the Project Workspace, the following interoperative design commands can be
accessed:

• Design using Tekla Tedds

• Check using Tekla Tedds

• Export to Tekla Tedds

• Clear Tekla Tedds Data

NOTE Initially only Design using Tekla Tedds command is shown, but once this has
been run the other commands then become available.

Each of the above offers a sub-menu of choices, depending on context:

• > Model

• > Member

• > Group

• > Selection

• > <Substructure name>

NOTE Check using Tekla Tedds > Model is repeated on the Design ribbon tab as

 Check in Tedds
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1.9 Timber member design handbook
Timber structures can be modelled and analyzed in Tekla Structural Designer.
If a licence of Tekla Tedds is available, timber beams, columns and braces can
then also be designed.

NOTE The following limitations and assumptions apply:

• The user should ensure the locale is set correctly in Tekla Tedds before
attempting to run the design from Tekla Structural Designer.

• Design is supported for NDS LRFD, NDS ASD, base Eurocode, and the
following Eurocode National Annexes: UK; Ireland; Norway; Finland;
Sweden.

• If the Singapore or Malaysia Eurocode National Annex is selected, the
calculation will adopt base Eurocode recommended values.

• All timber sections should be consistent with the appropriate to the
selected head code.

• If working to the NDS code, size classifications taken from the NDS
supplement 'Design Values for Wood Construction' are used in the Tedds
calculation to distinguish which grades are valid for particular timber
species. The same classification rules are not implemented in Tekla
Structural Designer itself. Therefore, after a member has been designed in
Tedds, if the member size or grade is subsequently changed in Tekla
Structural Designer the associated Tedds calculation is deleted, so that the
member cannot be checked and a redesign is required.

• Column design: If designing a multi-stack column the user must indicate a
splice in the stack properties before running the design if a change in
cross section is required between stacks. If a splice has not been specified
the change in section size will not be correctly returned to the Tekla
Structural Designer model.

The following topics are covered in this handbook:

• Timber member design workflow (page 539)

• Timber member design groups (page 552)

• Timber member design commands (page 555)

Timber member design workflow
The essentials of design of timber members using Tekla Tedds can be thought
of as being very similar to Interactive concrete member design (page 285)
within the program:

• Just like the concrete beam/ column/ wall interactive design dialog, the
Tedds Timber member design calculation interface lists the design forces
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and settings for a selected member/ group, populated from the model and
analysis, the design pass/fail status and individual check results and
utilization ratios. You can make changes in the interface - such as to section
size and/ or grade - and immediately see the design results for these. All
the data you input and changes you make are updated to and stored in the
model. You can then re-analyze and run a check on all designed members
to ensure the design results are up to date. You can perform design and
analysis loops as necessary so that all members are passing, and to cater
for any other changes to the model or loading.

• Design Groups (page 552) work in a similar manner also - these are
automatically created for Timber members and listed in the Project
Workspace Groups Tree. The resulting groups can be reviewed and
customized as necessary. Group design is enabled by default ( in Design
Settings > Design Groups > Timber Beams/ Columns/ Braces) and can
be run both via the model and from the Groups Tree.

Key aspects of the Tedds integrated timber design process and workflow in
Tekla Structural Designer are:

Set the timber design code
The timber design code is set from the Home ribbon by clicking Model
Settings > Design Codes > Resistance Codes.

• If working to US codes, there are two different methods, ASD or LRFD to
choose from and also a choice of code year to apply. The design forces
consider only the selected design method.

• If working to Eurocodes, the timber design code will be applied with a
national annex that is appropriate to the head code that has been selected.

The selected design code is automatically applied in all Tedds timber member
designs.

Define and place timber members
To place timber members, select the appropriate member type from the
Timber group on the Model ribbon, ensure the values in the Properties
window are as required and then pick the points to locate the members in
position.

Note the following with regard to the properties:
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• Section shapes - When defining a timber model in Tekla Structural
Designer it may appear that the range of timber sections is somewhat
limited. This is because Tekla Structural Designer doesn't currently have a
facility to specify timber sections by simply inputting a breadth and depth.
Instead you have to select the required size from Tekla Structural
Designer's database of timber sections.

While this might seem to be a significant limitation, it is actually not too
great an issue, because the Tedds timber calculation allows you to override
the original size to input the breadth and depth you require. Then when
the member data is transferred back from Tedds to Tekla Structural
Designer the new size is automatically added to the timber section
database.

Once the new section is in the section database it becomes available for
future Tekla Structural Designer models also.

• Timber fabrication and grade - You can specify timber, glulam, or
structural composite lumber fabrication types.

Initially the grade must be selected from the existing grades in the Tekla
Structural Designer materials database, although if the grade is changed in
the the Tedds timber calculation, when the member data is transferred
back from Tedds to Tekla Structural Designer the new grade is
automatically added to the materials database.

NOTE If a situation arises such that the material properties in the
programs don’t align, Tedds ignores unmatched data and selects
calculation defaults.

• Multi-stack columns - splices should be specified in the stack properties
when the column is being defined if a change in cross section is required
between stacks. If a splice has not been specified before the column is
designed in Tedds the change in section size will not be correctly returned
to the Tekla Structural Designer model.

Create load combinations and set load duration/time effect factors
Loads are applied in the standard manner. Once load combinations have been
created you should review their load duration/ time effect factors.

These factors are set on the Timber design tab on the Combinations page of
the Loading dialog once you have selected an individual combination from the
list in the dialog. The value is set automatically according to the constituent
loadcases.

• ASD combination:

Engineers Handbooks 541 Timber member design handbook



• LRFD combination:

• Eurocode combination:
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You have control to adjust the default value on a combination by combination
basis.

NOTE The actual factor that gets applied in the Tedds calculation will be the one that
is associated with the worst case load combination.

Configure timber design settings
Certain timber design settings which apply to the entire building can be
specified on the .

• If working to US codes:

• If working to Eurocodes:
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By ensuring the defaults are set correctly you can avoid having to manually set
the values in each Tedds timber calculation as it is run.

You still have control within individual calculations to adjust these settings on
a member by member or group basis.

NOTE Tedds data is retained from one run of the design to the next unless changes
are made in Tekla Structural Designer that force the Tedds calculation data to
be re-established.

If you change timber design settings after a member has already been
designed you would need to manually clear the Tedds data from the design in
order to have it use the revised design settings. To do this highlight the
member, right-click and select Clear Tekla Tedds Data from the context menu.

Configure timber groups
When timber members are placed in the model, to make editing easier they
are automatically grouped according to a set of rules (page 554).

These initial groups can be reviewed from the Groups tab of the Project
Workspace - you can add new groups and move members between groups as
required.

Groups are not only useful for editing, they can (optionally) be activated for
design purposes also. There are a number of reasons why you would choose
to do this.

• Why use timber design groups? (page 552)

• Activating timber member design groups (page 552)

Set the Tedds results output level
You can choose the output level for the Tedds timber calculations in advance
by clicking Home > Settings > Report > Tedds Reports
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By ensuring this is set correctly beforehand you can avoid having to manually
set the level in each Tedds timber calculation as it is run.

The setting applies to all Tedds linked calculations (precast and timber).

Establish design forces by running the analysis
Timber members can only be designed provided a set of analysis results exist.
These can be generated from the Analyze ribbon by running .

A design force envelope is established, which if designing to the US head code
considers the selected design method (ASD or LRFD) only.

All critical load combinations are considered in one Tedds calculation.

Provided load combinations have been created, once analysis has been
performed the Design using Tekla Tedds options become available.

Design using Tekla Tedds
After Analysis, Design or Check using Tekla Tedds can be initiated from both
the Project Workspace and any graphical view of the model:

You can right-click over any individual member in the Project Workspace, or
make a graphical selection, then right-click to open the context menu listing
the Tekla Tedds design options. You can then select Design of the Member,
Group or Selection as appropriate. Design of a Selection can also be used for
example to design all members of a truss - which can be selected with one
click - in one operation.

• Design a selection (page 547)

• Design a group (page 548)

• Design a grouped member (page 550)
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• Design an ungrouped member (page 550)

• Design model (page 551)

Check the design after changes
If changes are made to the model you can run a 'check' design to determine if
the existing sections are still sufficient. A check is quicker to perform than a
design because the Tedds calculation runs in the background without having
to display the Tedds calculation dialog.

You can check the whole model from the Design tab, or right-click over any
individual member in the Project Workspace, or you can make a graphical
selection, then right-click to open the context menu listing the Tekla Tedds
design options as shown below. You can then select Design of the Member,
Group or Selection as appropriate.

• Check model (page 551)

• Check a selection (page 551)

• Check a member (page 551)

• Check a group (page 551)

The updated utilizations can then be reviewed in a Review View.

Output the calculations
The Tekla Tedds design results are returned to the Tekla Structural Designer
model.

At this stage you can display member design status and utilization ratios from
a Review View:

You can also display the design status tabular results:
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Detailed Tekla Tedds calculations for timber members do not exist within
Tekla Structural Designer itself, instead they are available by exporting to Tekla
Tedds.

Design timber members using Tekla Tedds

Design a selection

To design several timber members or groups in one go:

1. Select all the timber members you want to design.
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2. Right click and select Design using Tekla Tedds> Selection

Tekla Structural Designer highlights the first member or group in the
selection and a Tedds dialog opens displaying the design forces at the
member's first design section.

NOTE If grouped design is active, a single grouped design is performed
for each group included in the selection using critical design
forces established from all members in the group (irrespective of
whether or not they were included in the selection). At the end of
the process all members in each designed group are checked,
(irrespective of whether or not they were included in the
selection).

3. Using the results preview, design the member's first design section for its
critical design forces, then if there is a second section design that also.

4. When all sections are satisfactory, click Finish.

Tekla Structural Designer highlights the next member or group in the
selection and the Tedds dialog re-opens to allow it to be designed.

Continue in the same way until all the selected members/groups have
been designed.

NOTE If a section is changed during the design to a size that does not
exist in Tekla Structural Designer's Timber Section database, it will
be automatically added to the local section database that exists
for the current model only.

Design a group
If you have activated timber member design groups, each group can be
designed as follows:

1. In the Project Workspace, click Groups tab.

2. In the Design tree, expand Timber Beams, Timber Columns, or Timber
Braces as required. 

NOTE When designing timber brace pairs, the groups for these are
always located under Timber Braces and not Timber X Braces, A
Braces, V Braces, K Braces. These latter groups are used for
editing purposes only, but not design.

3. In the Design tree, right-click the timber member group you want to
design.

a. It can be useful at this point to click Select in visible views to confirm
all the group members.

4. In the context menu, select Design using Tekla Tedds> Group.
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This design gathers the analysis results for all members in the group and
collates them into one set of critical design forces. (In effect assuming that
all the worst case loads are happening on one member simultaneously.)

5. Using the results preview, design the first design section in the group for
its critical design forces, then if there is a second section design that also.

6. When all sections are satisfactory, click Finish. 

If the section size was changed during the design, all members of the
group are updated to the new section.

Irrespective of whether the section has been changed or not, all members
in the group are then automatically checked against only the loads that
they see individually. A pass fail status and utilization ratio is calculated
accordingly for each one.

7. In the Review View, review the utilization ratios for all members in the
group - if these indicate an efficient design, the design can stop at this
point. 
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NOTE For columns in particular, the envelope of critical design forces
applied to members of the group can be overly conservative - e.g.
if some columns are loaded about one axis, and some loaded
about the other, they are all designed as if loaded about both
axes.

If the utilizations indicate the existing grouping is not very efficient, you can
investigate alternative grouping arrangements by adding extra groups as
necessary and re-allocating members between the groups. You might also
consider individually designing grouped members (as described below) when
optimizing the groups.

Design a grouped member

If after running a grouped design some group members have a lower than
desired utilization, you can re-design them individually to investigate the effect
optimizing them would have on the rest of the group.

1. Highlight a group member which has a lower than desired utilization, right
click and select Design using Tekla Tedds> Member

The analysis results of the selected member are used to establish the set
of critical design forces.

2. Optimize the design of the member for its forces.

3. Click Finish.

4. If the section size was changed during the design, all members of the
group are updated to the new section and checked against only the loads
that they see individually.

5. In the Review View, review the new utilizations for the group members -
note that some of the group might now be failing.

6. Using the new utilizations to better inform you choice, add extra groups
as necessary and re-allocating members between the groups.

7. Run Design using Tekla Tedds> Group for each of the new groups.

8. Iterate the process as necessary until the groups are fully optimized.

Design an ungrouped member

If you have elected not to make use of design groups, each member can be
designed individually as follows:

1. Highlight the member, right click and select Design using Tekla Tedds>
Member

2. Tekla Structural Designer highlights the member and a Tedds dialog
opens displaying the design forces at the member's first design section.

3. Using the results preview, design the member's first design section for its
critical design forces, then if there is a second section design that also.
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4. When all sections are satisfactory, click Finish.

5. If the section size was changed during the design, it is updated to the new
section in the Tekla Structural Designer model.

6. The member status and utilization are displayed in the member tooltip.

Design model

If you want to design every timber (and precast) member in the model in one
go:

1. In the Project Workspace, click Group tab.

2. In the tree, right-click Groups.

3. In the context menu, select Design using Tekla Tedds > Model

At the end of the process the status and utilization of each member is
displayed in a Review View.

Check timber members using Tekla Tedds

Check model

To check all the existing Tedds member designs,

1. Click Check In Tedds from the Design tab.

This reruns all the Tedds calculations in the background using the latest
analysis results.

Check a selection

To check several members or groups in one go,

1. Select the members or groups you want to check.

2. Right click and select Check using Tekla Tedds> Selection

The Tedds calculations for the selected members or groups run in the
background using the latest analysis results.

Check a member

To check a single member,

1. Highlight the member you want to check.

2. Right click and select Check using Tekla Tedds> Member

The Tedds calculations for the selected member runs in the background
using the latest analysis results.

The updated status and utilization are displayed in the member tooltip.
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Check a group

To check a member group,

1. Highlight a member in the group you want to check.

2. Right click and select Check using Tekla Tedds> Group

• The Tedds calculations for the selected group run in the background
using the group critical design forces.

• All members in the group are then checked against their individual
design forces.

Timber member design groups

Why use timber design groups?
Timber beams, columns and braces are put into groups for two reasons:

1. For editing purposes - individual design groups can be selected and
displayed graphically so that their properties can be changed as a group
in the properties window.

2. For design -

a. to standardize designs,

b. to reduce the volume of output created,

c. to speed up the design process, particularly so in the case of medium
to large size models.

When groups are used for design:

• An envelope of group design forces is passed to a single Tedds calculation.

• User can manipulate design options, member size, material etc.

• Any changes are applied to each member in group.

• Each individual member of group is checked against individual loads
without any further user interaction.

NOTE Although timber members are automatically grouped for ease of editing, the
use of groups for design is optional and can be deactivated if required: From
the Design tab, click Settings> Design Groups, then select or unselect the
member types to be designed in groups.

Activating timber member design groups
Timber beam, column and brace design groups are activated as follows:

1. From the Design tab, click Settings> Design Groups
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2. Select Timber Beams, Timber Columns, Timber Braces as required. 

Group management
Automatic Grouping

Timber beams, columns and braces are grouped automatically according to a
fixed set of requirements, including section size, grade, and member length.

In Model Settings > Grouping the user defined maximum length variation is
used to control whether elements are of sufficiently similar length to be
considered equivalent for grouping purposes.

Manual/Interactive Grouping

After assessing the design efficiency of each group, you are able to review
design groups and make adjustments if required from the Groups tab of the
Project Workspace.

See:

NOTE When manually adding members to a group, the order in which they are
added will incrementally affect the average length within the group, (which is
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then compared to the maximum length variation). Therefore, if members are
not being added as you expect, try adding them in a different order.

Regroup Members

If you have made changes in the model that impact on grouping of a specific
member type, you can update the affected groups from the Groups tab of the
Project Workspace by right-clicking Timber Beams, Timber Columns, or
Timber Braces as required and selecting Regroup Members.

NOTE Any manually applied grouping will be lost if you elect to re-group!

Regroup ALL Model Members

If you have made changes in the model that impact on grouping, you can
update all affected groups accordingly from the Groups tab of the Project
Workspace, by clicking Re-group ALL Model Members. (Located at the top of
the Groups tab.)

NOTE Any manually applied grouping will be lost if you elect to re-group!

Timber design group requirements
Timber member design groups are formed according to the following rules:

Member type Design group rules
Timber beam • A beam may be in only one design group.

• All beams in the group must have an identical cross
section.

• All beams in the group must have an identical grade.

• All beams in the group must have an identical number
of spans.

• Individual span lengths must be the same across the
group.

Timber column • A column may be in only one design group.

• All columns in the group must have an identical cross
section.

• All columns in the group must have an identical grade.

• All columns in the group must have an identical
number of stacks.

• Any splices must be located in the same stacks for all
columns of the group.

• Individual stack lengths must be the same across the
group.
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Member type Design group rules
Timber brace • A brace may be in only one design group.

• All braces in the group must have an identical cross
section.

• All braces in the group must have an identical grade.

• All braces in the group must have an identical span
length.

Timber member design commands
By right clicking over the required member in a view or appropriate branch of
the Project Workspace, the following interoperative commands can be
accessed:

• Design using Tekla Tedds

• Check using Tekla Tedds

• Export to Tekla Tedds

• Clear Tekla Tedds Data

NOTE Initially only Design using Tekla Tedds command is shown, but once this has
been run the other commands then become available.

Each of the above offers a sub-menu of choices, depending on context:

• > Model

• > Member

• > Group

• > Selection

• > <Substructure name>

NOTE Check using Tekla Tedds > Model is repeated on the Design ribbon tab as

 Check in Tedds

1.10 Foundation design handbook
This handbook contains information relevant to the design of foundations in
Tekla Structural Designer.

You can find the following information in this handbook:

• Pad base design workflow (page 556)
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• Pile cap design workflow (page 562)

• Pad base, strip base and pile cap design forces (page 568)

• Mat foundation design workflow (US customary units) (page 583)

• Mat foundation design workflow (metric units) (page 569)

• Piled mat foundation design workflow (US customary units) (page 597)

• Piled mat foundation design workflow (metric units) (page 608)

• Concrete slab design aspects (page 348)

Pad base design workflow
The small concrete building model shown below will be used to demonstrate
the pad base design process.

The model has already been designed prior to placing the bases.
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Apply pad bases under supported columns
Pad bases can only be placed under, and be loaded by supported columns;
strip bases can only be placed under and be loaded by supported walls.

NOTE If a ground beam is attached to the same support, loading from the beam will
also be considered in the base design.

At this stage, as you are not aware of the individual base size and depth
requirements; you can simply choose to place the bases where required,
accepting the default size/depth offered.

Auto-size pad bases individually for loads carried
To obtain an idea of the range of potential sizes, bases should initially be
designed individually for their respective loads, as follows:

1. Access Design Groups page of the Design Settings dialog box to ensure
that group design is turned off for Isolated Foundations.
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2. Select the bases to be auto-sized and in the Properties Window and
choose to auto-design both the size and depth; In this way the program
establishes suitable base dimensions for you.

Similarly, the reinforcement can be set to be auto-designed in the same
manner.

3. From the Foundations tab click Design Pad Bases.

Each base will be sized accordingly (any that are not in auto-design mode
will simply be checked).

4. With the auto-design options cleared, you can then adjust individual base
dimensions and re-check if required (by right-clicking the base that has
been edited and choosing Check Member).

The site boundary may impose restrictions on the positioning of an
isolated foundation relative to the column/wall it supports. This restriction
may result in a requirement for an offset base, this can be achieved by
specifying the eccentricity required in the base properties.

NOTE The overall auto-design procedure is summarized as follows:

1. Bearing Design: - increase size
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2. Bending Design: - increase reinforcement - If max allowable
reinforcement is reached then increase depth, set reinforcement back to
start point, and go back to step 1.

3. Shear Design - increase depth, set reinforcement back to start point, and
go back to step 1

4. Punching Shear Design - increase depth, set reinforcement back to start
point, and go back to step 1

5. Sliding Checks - increase depth, set reinforcement back to start point,
and go back to step 1

6. Uplift Checks - increase size, set reinforcement back to start point, and
go back to step 1

At every stage, if the max allowable depth is reached the design fails.

Apply grouping to rationalize pad base sizes

NOTE Grouping can only be applied to pad bases - not to strip bases.

Once pad bases have been sized individually, the designs can be rationalized
by activating grouping, in order to obtain one design per group sufficient for
all bases within the group.

This is done as follows:

1. Select a base that you want to be in a particular group.

2. In the Properties Window, ensure it is set to auto-design.

3. Right-click the same base and from the context menu choose Create
Property Set...

4. Select all the other bases that you want to be in the same group.
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5. In the Properties Window, click Apply... to apply the property set you have
just created to the selected bases.

NOTE Ensure you click Apply... from the Properties Window and not
from the right-click menu, otherwise the properties will only be
applied to the last base selected.

6. From the Groups page of the Project Workspace, right-click Pad Bases
(under the Design branch) and choose Regroup Members - this will put
those bases that share similar properties into the same group.

7. Open Design Settings dialog box, and from the Design Groups page
select the option to design isolated foundations using groups.
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8. Click Design Pad Bases - the results obtained will reflect the grouping that
has been applied.

Review/optimize base design
In the Review View you can examine the design efficiency by switching from
Foundations Status to Foundations Ratio. Note that the tool tip also indicates
the base size and status as you hover over any base.

If the selections are unacceptable you may need to review the settings in
Design Settings> Concrete> Foundations.

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
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eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations
Create a model report that includes the concrete pad base design calculations
that have been performed. (The default Building Design report includes these
along with design calculations for other member types in the model).

Pile cap design workflow
The small concrete building model shown below will be used to demonstrate
the pile cap design process.
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The model has already been designed prior to placing the pile caps.

Apply pile caps under supported columns
Before a pile cap can be placed the Pile Type Catalogue must contain at least
one pile type.

Pile caps can only be placed under and be loaded by supported columns.

NOTE If a ground beam is attached to the same support, loading from the beam will
also be considered in the pile cap design.

At this stage, as you are not aware of the individual pile cap size and depth
requirements; you can simply choose to place pile caps where required,
accepting the default size/depth offered.
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Auto-size pile caps individually for loads carried
To obtain an idea of the range of potential sizes, pile caps should initially be
designed individually for their respective loads

Note that when piles are auto-designed the outcome will depend on the auto-
design method selected; the pile cap size will either be based on the minimum
number of piles required, or on the minimum pile capacity.

To individually size the pile caps:

1. In the Design Settings dialog box got to Concrete> Foundations>
Isolated Foundations > Piles to choose the pile auto-design method
required: (minimize pile capacity, or minimize number of piles).

2. Access Design Groups page of the Design Settings dialog box to ensure
that group design is turned off for Isolated Foundations.

3. Select the pile caps to be auto-sized and then in the Properties Window
choose to auto-design both the piles and depth; In this way the program
will establish suitable pile cap dimensions for you.

Similarly, the reinforcement can be set to be auto-designed in the same
manner.

4. From the Foundations tab, click Design Pile Caps and all the pile caps set
in auto-design mode will be sized accordingly. (Those not in auto-design
mode will simply be checked). Similarly the piles beneath the pile caps will
either be designed (if pile auto-design mode is enabled) or checked.
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At any point you can switch to a user defined arrangement, modify the pile cap
configuration and have the design re-checked.

One example where you might choose a user defined arrangement is where
the site boundary imposes restrictions on the positioning of the pile cap
relative to the column/wall it supports. Switching to a user defined
arrangement allows you to specify an eccentricity and create an offset pile cap.

NOTE In the current release lateral stability of piled foundation systems is not
considered in software design checks.

Apply grouping to rationalize pile cap sizes
Once pile caps have been sized individually, the designs can be rationalized by
activating grouping, in order to obtain one design per group sufficient for all
pile caps within the group.

This is done as follows:

1. Select a pile cap that you want to be in a particular group.

2. In the Properties Window, ensure it is set to auto-design.

3. Right-click the same pile cap and from the context menu choose Create
Property Set...

4. Select all the other pile caps that you want to be in the same group.

NOTE When applied moments are significant, be cautious when
grouping pile caps where auto-design has initially determined
different principal directions.

Engineers Handbooks 565 Foundation design handbook



5. In the Properties Window, click Apply... to apply the property set you have
just created to the selected pile caps.

NOTE Ensure you click Apply... from the Properties Window and not
from the right-click menu, otherwise the properties will only be
applied to the last pile cap selected.

6. From the Groups page of the Project Workspace, right-click Pile Caps
(under the Design branch) and choose Regroup Members - this will put
those pile caps that share similar properties into the same group.

7. Open the Design Settings dialog box, and from the Design Groups page
select the option to design isolated foundations using groups.
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8. Click Design Pile Caps - the results obtained will reflect the grouping that
has been applied.

Review/optimize pile cap design
In the Review View you can graphically examine the pile cap design status &
efficiency by switching between Foundations Status and Foundations Ratio.
Note that the tool tip also indicates the base size and status as you hover over
any base.

Similarly you can graphically examine the pile design status & efficiency by
switching between Piles Status and Piles Ratio.

If the selections are unacceptable you may need to review the settings in
Design Settings> Concrete> Foundations

Design results can be examined in more detail by selecting Tabular Data and
setting the View Type to Design Summary. By selecting the Pile Caps or Piles as
the Characteristic (and the appropriate material) the full results for each pile
cap or pile can be examined.

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
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eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer.

Print calculations
Create a model report that includes the concrete pile cap design calculations
that have been performed. (The default Building Design report includes these
along with design calculations for other member types in the model).

Pad base, strip base and pile cap design forces
Forces acting on supports

The following forces and moments on the supports are determined from the
analysis of the active load combinations:

• Vertical force in direction Z

• Horizontal forces in directions Y and X

• Moments around X and Y axis

NOTE A torsional moment around the Z axis is also determined, but the base/pile
cap is not designed for this in the current release.

Foundation self weight

The foundation self-weight is automatically calculated and applied as an added
load, Fswt

Soil self weight
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The surcharge depth and soil unit weight that have been specified in the base/
pile cap properties are used to determine the soil self weight. This is applied as
an added load, Fsoil

NOTE In the current release, horizontal pressure caused by soil is not considered.

Additional surcharge loads

For isolated foundations user can apply additional surcharge loads: acting in
the global Z direction.

• Permanent (dead) surcharge load

• Variable (live) surcharge load

Design Forces

To obtain the design forces, the loads due to foundation self weight, soil self
weight and additional surcharge are added to the forces acting on the
supports.

These design forces (axial load and bi-axial shear and moment) are then
applied to the base/pile cap at the foundation level.

NOTE In the current release lateral stability of piled foundation systems is not
considered in software design checks.

Mat foundation design workflow (metric units)
The small concrete building model shown below will be used to demonstrate
the process for modeling and designing a mat foundation.
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For mat foundations the overall procedure is basically the same as that for flat
slabs, with the exception that an extra check for mat bearing pressure is
required.
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Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

Determine the soil parameters
Unless you are going to define discreet piled supports, the mat will need to be
supported on ground bearing springs. When these are activated you have
then to also specify:

• Allowable bearing pressures

• Ground stiffness type (Linear, or non linear spring)

• Linear ground stiffness, or,

• Non-linear ground stiffness (+/-) and tension/compression limits

• Horizontal support

Allowable bearing pressures
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When using ground bearing springs, a check is performed as part of the
design process to ensure the allowable bearing pressure you enter is not
exceeded.

Ground stiffness type

Both linear and non-linear ground springs can be defined, although in the
majority of cases it is suggested that linear springs should suffice.

When linear spring are applied:

• Allowable bearing pressures are checked

• Uplift (tension) is checked

• If no problems then linear springs are sufficient

When non-linear springs are applied:

• You can have compression only

• And also capped compression

• Either way analysis takes longer

NOTE For compression-only supports ( -ve stiffness set to zero ) a loadcase
of lateral load only will never solve for Non-linear analysis. What
happens in the solver is what would happen in reality if Gravity
suddenly turned off! Structures stabilized by gravity load would flip
over in the presence of lateral load - i.e. no static equilibrium position
exists to be found.

Ground stiffness

You are required to enter an appropriate stiffness for the soil conditions on
site.

The actual value entered is your responsibility, but as a guide the table below1

illustrates the potential range of values that might be considered.

Material Lower Limit (kN/m3) Upper Limit (kN/m3)
Loose Sand 4,800 16,000
Medium
Dense Sand

9,600 80,000

Dense Sand 64,000 128,000
Clayey
Medium
Dense Sand

32,000 80,000

Silty Medium
Dense Sand

24,000 48,000

Clayey Soil
(qa<200kPa)

12,000 24,000
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Clayey Soil
(200<qa<800
kPa)

24,000 48,000

Clayey Soil
(qa>800kPa)

48,000 200,000

1. Reference: "Foundation Analysis and Design", Joseph E. Bowles, 1995
(Table 9-1)

Horizontal support

The degree of horizontal support provided by the ground springs can be set
as:

• Fixed

• Free

• Spring (default 20% of vertical spring stiffness)

If set to "Free" a mechanism will result unless you provide additional discreet
supports.

Determine the remaining mat properties
You are required to manually specify the Reduce live loads by mat property.
This could vary for individual mat panels, depending on the columns and walls
attached to each panel, and the number of floors they are supporting.

If using an "area" method of mat creation you will also need to specify the
amount of slab overhang.

The remaining properties are then similar to those used to define a typical
concrete flat slab.

In this example the minimum area method is used to create a mat with the
following properties:

• Imposed loads reduced by 30%

• Default overhang

• Mat thickness 600mm

• Ground bearing springs used

• Default allowable bearing pressures

• Default linear spring properties

Create the mat
To create the mat:

1. Choose the method, (e.g. Minimum Area)

2. Enter the mat properties, (see above)
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3. Click on those columns (or walls) that define its perimeter,

4. Either press <Enter>, or re-click on one of the selected columns to
complete the mat definition.

NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

Enable soil structure interaction
When not supported by a mat, columns and walls typically have supports at
their bases.

When a mat is introduced these supports must be removed - as the mat
now supports the whole building on ground bearing springs. Consequently
adding a mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of "soil structure interaction" (or
support settlement). In the past this has often been ignored, even though
design codes suggest that it should be considered.

If you want to include design for situation without support settlement then
you need to think about the workflow sequence or use runs with differing
ground stiffness assumptions.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.
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Model validation
Once the mat has been placed it is worth running a validation check from the
Model ribbon at this stage - specifically to check for potential conflicting
supports.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the bearing pressures and the moments to be
used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Design
All (Static), and any seismic RSA combinations by running Design All (RSA).
These processes will also recheck all the member designs taking account of
the effects of soil structure interaction.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs supported on ground
bearing springs.

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE In a large model, if you anticipate several analysis might be required to
determine the size of mat required, you might find it more efficient to just run
the analyses that are required from the Analyze ribbon then re-run the
member design at a later stage.

NOTE For compression-only supports ( -ve stiffness set to zero ) a loadcase of lateral
load only will never solve for Non-linear analysis. What happens in the solver
is what would happen in reality if Gravity suddenly turned off! Structures
stabilized by gravity load would flip over in the presence of lateral load - i.e.
no static equilibrium position exists to be found.
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Check foundation bearing pressure and deformations
You can check the mat bearing pressure and 2D deflection contours from the
Results View for each of the analysis types that have been performed before
commencing the detailed design.
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By viewing the 2D deflection results for combinations based on "service"
rather than "strength" factors the stiffness adjustments that you apply (via
Analysis Options> Modification Factors> Concrete) do not need to account for
load factors.

The default stiffness adjustments are dependent on the design code. For
design to EC2 the default adjustment factor applied is 0.2. For design to ACI
the default adjustment factor applied is 0.25.

Re-perform member design
Depending on the steps that have been taken to establish the mat size, at this
point the design condition reported in the Status Bar for the members will
either be "Valid" or "Out of Date".

Unless the status is "Valid" you should recheck the member designs (taking
into account the effects of soil structure interaction) by clicking Design All
(Static) from the Design toolbar.

NOTE Similarly if an RSA design has previously been performed, but is now out of
date Design All (RSA) should be re-run.

If any concrete members now fail, you can switch them back into Autodesign
mode, (ensuring Select bars starting from is set to Current rather than Minima)
and then design again. This ensures that the bars that were satisfactory for the
original design are only ever increased not reduced.

Open an appropriate view in which to design the mat
In models with mats at distinct floor levels you should use 2D Views to work
on the mat design one level at a time. Occasionally the "3D geometry" of a
model may make it less easy to distinguish between individual floors, in which
case it may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check mats
and patches: this saves time as only the mats and patches in the current level
are considered. Running Design Mats or Design Patches from the Foundation
ribbon may take longer as it considers all the mats and patches in the model.
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Add patches
This is an interactive process - requiring a certain amount of engineering
judgment.

When placing patches under walls you can choose to place a single patch
along the wall, an internal patch under the middle, or end patches at the wall
ends (as shown above).

Typically at the initial patch creation stage you should make the patches a
reasonable size and not be concerned if they are a bit too big - as this will be
reviewed/resolved at the patch design optimization stage.

NOTE Whilst the command to add Patches appears on both the Foundations and
Design ribbons, the former defaults to creating patches on the bottom
surface, the latter to the top surface. For mats the Foundations ribbon default
will generally be correct.

Design mats

NOTE Mat design is dependent on the areas of patches (patch areas which are
excluded from mat design) - hence patches should be added before mats are
designed.

To design multiple mats, either:
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• From the Foundations ribbon run Design Mats in order to design or check
all the mats in the model (each according to their own autodesign setting),
or,

• If you have created mats at multiple levels you may prefer to work on one
level at a time. To do this, open a 2D View of the level to be designed then
right-click and choose either Design Slabs or Check Slabs.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Slabs will re-design slabs and mats (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Slabs will check the current reinforcement in slabs and
mats regardless of the current autodesign setting.

Review/optimize mat design
It is suggested that you use split Review Views to examine the results. You
could arrange one view to show Mat Design Status, and then a second view to
show Slab Reinforcement in the panels. Note that the tool tip indicates all
panel/patch reinforcement as you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 8mm dia bars are selected and you would just never use anything less
than a 10mm bar in a mat, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to.)

NOTE Auto-design will select the smallest allowable bars at the minimum centers
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
150mm.

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.

Remember:

• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.
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• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

Design patches
Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design the patches
which will top up the reinforcement as necessary within the strips of each
patch.

To do this, either:

• From the Foundations ribbon run Design Patches in order to design or
check all the foundation patches in the model - by default newly created
patches will all be in auto-design mode - so reinforcement is selected
automatically, or,

• In the 2D View of the level which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Patches will re-design the patches (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Patches will check the current reinforcement in the
patches regardless of the current autodesign setting.

Review/optimize patch design
At this stage the patch sizes can be reviewed:

• Wall patches - can the width be adjusted (minimized)?

• Column patches - Is the size reasonable? - this relates to code guidance
about averaging in columns strips - it is not reasonable to average over too
wide a width. If in doubt safe thing to do is err on the side of caution and
make them a bit smaller.

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.

• Now click Slab Reinforcement in the Review View to review and standardize
the patch reinforcement. For instance in column patches this might include
forcing the spacing of the mat reinforcement to be matched (if the mat has
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H12-200, then in the patch don't add H12-125, swap to H16-200 - then
there will be alternate bars at 100 crs in this strip of the patch.

Add and run punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:

You can then select any check and review the properties assigned to it.
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Once added click Design Punching Shear. See:

The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat

Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
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eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations
Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).

Mat foundation design workflow (US customary units)
The small concrete building model shown below will be used to demonstrate
the process for modeling and designing a mat foundation.
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For mat foundations the overall procedure is basically the same as that for flat
slabs, with the exception that an extra check for mat bearing pressure is
required.
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Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

Determine the soil parameters
Unless you are going to define discreet piled supports, the mat will need to be
supported on ground bearing springs. When these are activated you have
then to also specify:

• Allowable bearing pressures

• Ground stiffness type (Linear, or non linear spring)

• Linear ground stiffness, or,

• Non-linear ground stiffness (+/-) and tension/compression limits

• Horizontal support

Allowable bearing pressures
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When using ground bearing springs, a check is performed as part of the
design process to ensure the allowable bearing pressure you enter is not
exceeded.

Ground stiffness type

Both linear and non-linear ground springs can be defined, although in the
majority of cases it is suggested that linear springs should suffice.

When linear springs are applied:

• Allowable bearing pressures are checked

• Uplift (tension) is checked

• If no problems then linear springs are sufficient

When non-linear springs are applied:

• You can have compression only

• And also capped compression

• Either way analysis takes longer

NOTE For compression-only supports ( -ve stiffness set to zero ) a loadcase
of lateral load only will never solve for Non-linear analysis. What
happens in the solver is what would happen in reality if Gravity
suddenly turned off! Structures stabilized by gravity load would flip
over in the presence of lateral load - i.e. no static equilibrium position
exists to be found.

Ground stiffness

You are required to enter an appropriate stiffness for the soil conditions on
site.

The actual value entered is your responsibility, but as a guide the table below1

illustrates the potential range of values that might be considered.

Material Lower Limit Upper Limit
 (kN/m3) (kip/ft2/ft)

approx.
(kN/m3) (kip/ft2/ft)

approx.
Loose Sand 4,800 31 16,000 102
Medium
Dense Sand

9,600 61 80,000 509

Dense Sand 64,000 407 128,000 815
Clayey
Medium
Dense Sand

32,000 204 80,000 509

Silty Medium
Dense Sand

24,000 153 48,000 306

Engineers Handbooks 586 Foundation design handbook



Material Lower Limit Upper Limit
 (kN/m3) (kip/ft2/ft)

approx.
(kN/m3) (kip/ft2/ft)

approx.
Clayey Soil
(qa<200kPa)

12,000 76 24,000 153

Clayey Soil
(200<qa<800k
Pa)

24,000 153 48,000 306

Clayey Soil
(qa>800kPa)

48,000 306 200,000 1273

1. Reference: "Foundation Analysis and Design", Joseph E. Bowles, 1995
(Table 9-1)

Horizontal support

The degree of horizontal support provided by the ground springs can be set
as:

• Fixed

• Free

• Spring (default 20% of vertical spring stiffness)

If set to "Free" a mechanism will result unless you provide additional discreet
supports.

Determine the remaining mat properties
You are required to manually specify the Reduce live loads by mat property.
This could vary for individual mat panels, depending on the columns and walls
attached to each panel, and the number of floors they are supporting.

If using an "area" method of mat creation you will also need to specify the
amount of slab overhang.

The remaining properties are then similar to those used to define a typical
concrete flat slab.

In this example the minimum area method is used to create a mat with the
following properties:

• Live loads reduced by 30%

• Overhang, 20in.

• Mat thickness, 24in.

• Ground springs used

• Default allowable bearing pressures

• Default linear spring properties
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Create the mat
To create the mat:

1. Choose the method, (e.g. Minimum Area)

2. Enter the mat properties, (see above)

3. Click on those columns (or walls) that define its perimeter,

4. Either press <Enter>, or re-click on one of the selected columns to
complete the mat definition.

NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

Enable soil structure interaction
When not supported by a mat, columns and walls typically have supports at
their bases.

When a mat is introduced these supports must be removed - as the mat
now supports the whole building on ground bearing springs. Consequently
adding a mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of "soil structure interaction" (or
support settlement). In the past this has often been ignored, even though
design codes suggest that it should be considered.

Engineers Handbooks 588 Foundation design handbook



If you want to include design for situation without support settlement then
you need to think about the workflow sequence or use runs with differing
ground stiffness assumptions.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.

Model validation
Once the mat has been placed it is worth running a validation check from the
Model ribbon at this stage - specifically to check for potential conflicting
supports.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the bearing pressures and the moments to be
used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Design
All (Static), and any seismic RSA combinations by running Design All (RSA).
These processes will also recheck all the member designs taking account of
the effects of soil structure interaction.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs supported on ground
bearing springs.

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE In a large model, if you anticipate several analysis might be required to
determine the size of mat required, you might find it more efficient to just run
the analyses that are required from the Analyze ribbon then re-run the
member design at a later stage.
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NOTE For compression-only supports ( -ve stiffness set to zero ) a loadcase of lateral
load only will never solve for Non-linear analysis. What happens in the solver
is what would happen in reality if Gravity suddenly turned off! Structures
stabilized by gravity load would flip over in the presence of lateral load - i.e.
no static equilibrium position exists to be found.

Check foundation bearing pressure and deformations
You can check the mat bearing pressure and 2D deflection contours from the
Results View for each of the analysis types that have been performed before
commencing the detailed design.
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By viewing the 2D deflection results for combinations based on "service"
rather than "strength" factors the stiffness adjustments that you apply (via
Analysis Options> Modification Factors> Concrete) do not need to account for
load factors.

For the above analysis Tekla Structural Designer default stiffness adjustment
factors were used, the default factor for foundation mats being 0.2 for both
ACI and EC2 design codes.

Re-perform member design
Depending on the steps that have been taken to establish the mat size, at this
point the design condition reported in the Status Bar for the members will
either be "Valid" or "Out of Date".

Unless the status is "Valid" you should recheck the member designs (taking
into account the effects of soil structure interaction) by clicking Design All
(Static) from the Design toolbar.

NOTE Similarly if an RSA design has previously been performed, but is now out of
date Design All (RSA) should be re-run.

If any concrete members now fail, you can switch them back into Autodesign
mode, (ensuring Select bars starting from is set to Current rather than Minima)
and then design again. This ensures that the bars that were satisfactory for the
original design are only ever increased not reduced.
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Open an appropriate view in which to design the mat
In models with mats at distinct floor levels you should use 2D Views to work
on the mat design one level at a time. Occasionally the "3D geometry" of a
model may make it less easy to distinguish between individual floors, in which
case it may be easier to design the floors one sub-model at a time.

NOTE When working in a 2D View use the right-click menu to design or check mats
and patches: this saves time as only the mats and patches in the current level
are considered. Running Design Mats or Design Patches from the Foundation
ribbon may take longer as it considers all the mats and patches in the model.

Add patches
This is an interactive process - requiring a certain amount of engineering
judgment.

When placing patches under walls you can choose to place a single patch
along the wall, an internal patch under the middle, or end patches at the wall
ends (as shown above).

Typically at the initial patch creation stage you should make the patches a
reasonable size and not be concerned if they are a bit too big - as this will be
reviewed/resolved at the patch design optimization stage.
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NOTE Whilst the command to add Patches appears on both the Foundations and
Design ribbons, the former defaults to creating patches on the bottom
surface, the latter to the top surface. For mats the Foundations ribbon default
will generally be correct.

Design mats

NOTE Mat design is dependent on the areas of patches (patch areas which are
excluded from mat design) - hence patches should be added before mats are
designed.

To design multiple mats, either:

• From the Foundations ribbon run Design Mats in order to design or check
all the mats in the model (each according to their own autodesign setting),
or,

• If you have created mats at multiple levels you may prefer to work on one
level at a time. To do this, open a 2D View of the level to be designed then
right-click and choose either Design Slabs or Check Slabs.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Slabs will re-design slabs and mats (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Slabs will check the current reinforcement in slabs and
mats regardless of the current autodesign setting.

Review/optimize mat design
It is suggested that you use split Review Views to examine the results. You
could arrange one view to show Mat Design Status, and then a second view to
show Slab Reinforcement in the panels. Note that the tool tip indicates all
panel/patch reinforcement as you hover over any panel.

If the selections are unacceptable you may need to review the design settings.
e.g - if 3 size bars are selected and you would just never use anything less than
a 4 size bar in a mat, then set that as a minimum.

Once the selections are reasonable it is advisable to select all the panels and
swap them out of auto-design mode (and after this point be careful not to use
the right-click option to design panels unless you really want to.)

NOTE Auto-design will select the smallest allowable bars at the minimum centers
necessary to provide sufficient reinforcement area. Larger bars are only tried
when the minimum permissible spacing is reached. Design options allow you
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to control the minimum acceptable bar sizes and spacings. It is important to
use these settings so that the reinforcement established in the slabs is
sufficiently spaced to allow introduction of additional reinforcement in the
patches. For example you might set a "minimum spacing (slab auto design)" =
6".

After using the Review View update mode to standardize reinforcement you
can then run Check Slabs from the right-click menu to check the revised
reinforcement.

Remember:

• Consider swapping between Status and Ratio views - if utilizations all < 1
but some panels failing then problems are to do with limit checks. The
Ratio view is better for helping you focus on the critical panels.

• During this process it will also make sense to be adding panel patches in
which the reinforcement is set to none and strip is set to average. The
purpose of this is to smooth out local peaks at the most critical locations
which would otherwise dictate the background reinforcement level needed
to get a pass status.

Design patches
Having established and rationalized the slab panel reinforcement which sets
the background levels of reinforcement, it is now logical to design the patches
which will top up the reinforcement as necessary within the strips of each
patch.

To do this, either:

• From the Foundations ribbon run Design Patches in order to design or
check all the foundation patches in the model - by default newly created
patches will all be in auto-design mode - so reinforcement is selected
automatically, or,

• In the 2D View of the level which you want to design right-click and choose
either Design Patches or Check Patches. Working in this way restricts the
design or checking to the patches in the current view.

NOTE When accessed from the right-click menu, these commands
operate as follows:

• Design Patches will re-design the patches (potentially picking
new reinforcement) regardless of the current autodesign
setting.

• Check Patches will check the current reinforcement in the
patches regardless of the current autodesign setting.
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Review/optimize patch design
At this stage the patch sizes can be reviewed:

• Wall patches - can the width be adjusted (minimized)?

• Column patches - Is the size reasonable? - this relates to code guidance
about averaging in columns strips - it is not reasonable to average over too
wide a width. If in doubt safe thing to do is err on the side of caution and
make them a bit smaller.

• Having got the sizes sorted out and the patches re-designed, swap them
out of auto-design mode.

• Now click Slab Reinforcement in the Review View to review and standardize
the patch reinforcement. For instance in column patches this might include
forcing the spacing of the mat reinforcement to be matched (if the mat has
size 4 at 8in, then in the patch don't add size 4 at 5in, swap to size 5 at 8in -
then there will be alternate bars at 4in crs in this strip of the patch.

Add and run punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:

You can then select any check and review the properties assigned to it.
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Once added click Design Punching Shear. See:

The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat
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Create drawings and quantity estimations
Drawings that convey the structural intent are easy to create. It should be
borne in mind that these are NOT the final detail drawings, their purpose is to
eliminate the need for manual mark-up drawings as a means of
communication between the engineer and the detailer

Print calculations
Create a model report that includes the panel, patch, and punching check
calculations that have been performed. (The default Building Design report
includes these along with design calculations for other member types in the
model).

Engineers Handbooks 597 Foundation design handbook



Piled mat foundation design workflow (US customary units)
The following example illustrates the typical process to model and design piles
in a piled mat foundation.
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Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

In order to retain the existing reinforcement design all members should be set
to check mode. Alternatively you might choose to "check and increase" the
reinforcement instead, (by leaving members in autodesign mode with the
option to select bars starting from current.)

Create the mat
As piled mats are typically designed on the basis that they are supported on
the piles alone, in most situations you would generally clear Use Ground
Bearing Springs (under Soil Parameters in the mat properties.)

NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

In this example the minimum area method is used to create a mat with:

• An overhang of 40in.

• Mat thickness 24in.

• The Use Ground Bearing Springs option cleared
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Define the pile catalogue
The pile catalogue should be created prior to placing piles in the mat. You are
required to define the pile properties in the catalogue manually.

In this example it is assumed this structure is stable horizontally so that the
pile type horizontal restraint is left as Fixed.

NOTE In Tekla Structural Designer the only properties that directly influence the pile
design are the compressive and tensile capacity and the horizontal and
vertical stiffness.

Add piles to the mat
Although piles can be added individually, it is often more efficient to add
multiple piles at regular spacings in the form of a pile array.

These can either be placed vertically or on an incline if required.

A preview of the array is displayed making it easier to adjust the array
properties before placing the layout.
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After piles have been placed as an array, you are then free to edit individual
pile positions, or delete them as required.
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Remove existing column and wall supports
When not supported by a mat, columns and walls typically have supports at
their bases.

When a piled mat is introduced these supports must be removed - as the
mat now supports the whole building on pile springs. Consequently adding
a piled mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of support settlement. In the past this
has often been ignored, even though design codes suggest that it should be
considered.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.
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Model validation
Once the piles have been placed it is worth running a validation check from
the Model ribbon to check for potential conflicting supports.

Before the mat was placed the structure would have required supports
underneath columns and walls for it to be designed. As support is now being
provided by the piles the member supports are no longer required and should
therefore be removed.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the axial forces in the piles and the moments
to be used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Analyze
All (Static), and any seismic RSA combinations by running 1st or 2nd Order RSA
Seismic.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs, either supported on
ground bearing springs, or on discreet piled supports, (or a combination of
both).

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE Analyze All is run in preference to Design All at this stage because member
design is influenced by, and should therefore follow after the piled raft
design.

Perform the pile design
The piles are checked (and the mat is designed) by running Design Mats from
the Foundations ribbon.

NOTE The pile types/sizes are not changed during this process
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Review the pile design status and ratios
You can display the Pile Status and Pile Ratios from the Review View in order
to determine if any remodeling of piles is required.

In this example a number of piles are not heavily loaded so you could consider
deleting some of them, or switching the pile type that has been applied.

If you make any changes, to see their effect simply re-run Analyze All followed
by Design Mats once more.
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At any stage if you reapply a pile array to a mat any previously existing piles in
the mat are removed.

Add and run pile punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:

You can then select any check and review the properties assigned to it.

Once added you can then design and check them individually, if required.
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Or you can run all the checks in one go from the Foundations ribbon, by
clicking Design Punching Shear. See:
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The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat

Key aspects of the check performed are:

• Punching shear resistance is assumed to be provided by the concrete alone
- there is no option to add specific punching shear reinforcement in the
form of studs and rails (as there is for column punching checks, including
those supported by mats).

• The check considers 3D Building Analysis, FE Chase-Down and Grillage
Chase-Down results for all active gravity, wind, seismic and RSA load
combinations.
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• The check considers only a single pile - not a pair - and only vertical shear
not moment (as piles are modeled a pinned spring supports without
moment fixity).

• Just as for punching checks of columns supported by piled mats, all loading
and reactions (from ground bearing springs) within the punching perimeter
are considered.

• There is an additional pile-specific Design setting to use the pile capacity in
the punching check in Design Settings > Concrete > Cast-in-place >
Foundations > Mat Foundations > Piles (default Off).

Perform the mat design
The Design of the mat itself is described in the Mat foundation design
workflow (US customary units) (page 583) topic.

Piled mat foundation design workflow (metric units)
The following example illustrates the typical process to model and design piles
in a piled mat foundation.

Engineers Handbooks 608 Foundation design handbook



Design the structure before supporting it on the mat
The model should already be designed and member sizing issues resolved
prior to placing the mat foundation.

In order to retain the existing reinforcement design all members should be set
to check mode. Alternatively you might choose to "check and increase" the
reinforcement instead, (by leaving members in autodesign mode with the
option to select bars starting from current.)

Create the mat
As piled mats are typically designed on the basis that they are supported on
the piles alone, in most situations you would generally clear Use Ground
Bearing Springs (under Soil Parameters in the mat properties.)

NOTE The "Mesh 2-way slabs in 3D Analysis" option gets activated automatically for
the level in which the mat is created, enabling the 3D analysis model to be
supported on the ground springs.

In this example the minimum area method is used to create a mat with:

• An overhang of 1.0m

• Mat thickness 600mm

• The Use Ground Bearing Springs option cleared
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Define the pile catalogue
The pile catalogue should be created prior to placing piles in the mat. You are
required to define the pile properties in the catalogue manually.

In this example it is assumed this structure is stable horizontally so that the
pile type horizontal restraint is left as Fixed.

NOTE In Tekla Structural Designer the only properties that directly influence the pile
design are the compressive and tensile capacity and the horizontal and
vertical stiffness.

Add piles to the mat
Although piles can be added individually, it is often more efficient to add
multiple piles at regular spacings in the form of a pile array.

These can either be placed vertically or on an incline if required.

A preview of the array is displayed making it easier to adjust the array
properties before placing the layout.
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After piles have been placed as an array, you are then free to edit individual
pile positions, or delete them as required.
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Remove existing column and wall supports
When not supported by a mat, columns and walls typically have supports at
their bases.

When a piled mat is introduced these supports must be removed - as the
mat now supports the whole building on pile springs. Consequently adding
a piled mat means re-analysis and hence re-design of the whole building.

NOTE A simple technique for detecting and removing the supports is described in
the next section "Model Validation".

Inherent in the re-design is the inclusion of support settlement. In the past this
has often been ignored, even though design codes suggest that it should be
considered.

Note however that soil structure interaction only affects the 3D analysis model
results, and the chasedown results in the lowest sub-model. Members in all
other sub-models are thus already being designed both with and without the
affects of support settlement.
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Model validation
Once the piles have been placed it is worth running a validation check from
the Model ribbon to check for potential conflicting supports.

Before the mat was placed the structure would have required supports
underneath columns and walls for it to be designed. As support is now being
provided by the piles the member supports are no longer required and should
therefore be removed.

A "Supports exist within area of Mat Foundation" warning is issued if member
supports conflict with ground springs. (This can be remedied by right-clicking
on the warning and choosing Delete Items).

Perform the model analysis
Analysis is required to establish the axial forces in the piles and the moments
to be used for the mat design.

Gravity, lateral and seismic combinations can be analyzed by running Analyze
All (Static), and any seismic RSA combinations by running 1st or 2nd Order RSA
Seismic.

In each of the 3D, FE chasedown, and grillage chasedown analyses that get
performed mats are modeled as meshed 2-way slabs, either supported on
ground bearing springs, or on discreet piled supports, (or a combination of
both).

In the FE chasedown and grillage chasedown models the mat and first level
above the mat are always combined in a single sub-model.

NOTE Analyze All is run in preference to Design All at this stage because member
design is influenced by, and should therefore follow after the piled raft
design.

Perform the pile design
The piles are checked (and the mat is designed) by running Design Mats from
the Foundations ribbon.

NOTE The pile types/sizes are not changed during this process
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NOTE In the current release lateral stability of piled foundation systems is not
considered in software design checks.

Review the pile design status and ratios
You can display the Pile Status and Pile Ratios from the Review View in order
to determine if any remodeling of piles is required.

In this example a number of piles are not heavily loaded so you could consider
deleting some of them, or switching the pile type that has been applied.

If you make any changes, to see their effect simply re-run Analyse All followed
by Design Mats once more.
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At any stage if you reapply a pile array to a mat any previously existing piles in
the mat are removed.

Add and run pile punching checks
Punching checks require slab reinforcement to be defined/known in order to
determine punching capacities.

Punching checks can be added individually, or by windowing over an area. See:

You can then select any check and review the properties assigned to it.

Once added you can then design and check them individually, if required.
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Or you can run all the checks in one go from the Foundations ribbon, by
clicking Design Punching Shear. See:
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The checks are done and status is shown as:

• Pass - if no shear reinforcement is needed

• Warning - if shear reinforcement is needed

• Fail - if it is impossible to achieve required capacity by adding share
reinforcement

• Unknown - if check not run yet

• Beyond scope or error - if for example the centroid of the column/wall lies
outside the mat

Key aspects of the check performed are:

• Punching shear resistance is assumed to be provided by the concrete alone
- there is no option to add specific punching shear reinforcement in the
form of studs and rails (as there is for column punching checks, including
those supported by mats).

• The check considers 3D Building Analysis, FE Chase-Down and Grillage
Chase-Down results for all active gravity, wind, seismic and RSA load
combinations.

• The check considers only a single pile - not a pair - and only vertical shear
not moment (as piles are modeled a pinned spring supports without
moment fixity).
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• Just as for punching checks of columns supported by piled mats, all loading
and reactions (from ground bearing springs) within the punching perimeter
are considered.

• There is an additional pile-specific Design setting to use the pile capacity in
the punching check in Design Settings > Concrete > Cast-in-place >
Foundations > Mat Foundations > Piles (default Off).

Perform the mat design
The Design of the mat itself is described in the Mat foundation design
workflow (metric units) (page 569) topic.

1.11 Sustainability and Tekla Structural Designer
Click the link below to find out about the carbon impact of structures and how
Tekla Structural Designer helps engineers to assess this for their projects:

• Measuring the carbon impact of a structure (page 618)

• Embodied carbon workflow (page 620)

Measuring the carbon impact of a structure

Global impact of construction industry
According to The Institution of Structural Engineers (IStructE):

• Buildings and construction account for about 40% of energy related CO2
emissions

• Manufacture and disposal of materials used in structures accounts for
about 11% of all greenhouse gas emissions

• Analysis suggests that inefficiency in material use of up to 50% is common

Typical emissions at each stage of the structure's life
In order to reduce carbon emissions it is first necessary to measure them. This
can be done in different ways - in the UK for example by using BS EN 159781

the life cycle of the structure can be split into four stages as shown below, and
the emissions assessed at each stage.
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The distribution of emissions at each stage breaks down in approximately in
these proportions:

Stage Typical distribution of emissions
Product Stage 50%
Construction Stage 5%
Use Stage 43%
End-of-Life Stage 2%

It can be seen that the largest portion of emissions occurs at the Product
Stage, and this is the stage that can be targeted by Tekla Structural Designer to
make savings.

1. BS EN 15978:2011: Sustainability of construction works. Assessment of
environmental performance of buildings. Calculation method. London: BSI,
2011

Measuring Product Stage Carbon
In the UK, the Product Stage is split into modules A1-A3, which are:

• Raw material extraction

• Transport of raw materials to manufacturing facilities

• Manufacture

The carbon impact of materials used in manufacture can then be measured by
using an Embodied Carbon Factor (ECF).
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This factor is specific to each material and is multiplied by the quantity of that
material in order to give a quantity of CO2 emitted in the Product Stage.

Many construction materials have standard ECF values that the engineer can
use, and in addition manufacturers may also provide third-party verified
Environmental Product Declarations (EPDs) which can be used when the
engineer knows exactly which manufacturer the material will be sourced from.

Reporting and export of embodied carbon data
Tekla Structural Designer includes an automated and comprehensive built-in
calculation of Embodied Carbon quantities, together with powerful options for
graphical review/optimization and reporting of this aspect of design. For more
information, see Embodied carbon workflow (page 620).

In addition Tekla Structural Designer also enables model material data to be
exported to One Click LCA, which:

• is a widely used cloud-based software for life-cycle assessment and the
calculation of embodied carbon.

• complies with a large number of standards including BREEAM and LEED.

• includes a huge database of generic and manufacturer-specific
Environmental Product Declarations (EPDs)

The data can either be exported to a spreadsheet, or directly to the One Click
LCA service, from where the environmental impact of the design can be
reviewed and reports can be created.

NOTE The One Click LCA service can only be used if you have a One Click LCA
account.

Both of the above features enable the Engineer to quickly and easily
determine the embodied carbon for the part of a project they are responsible
for. This also helps them to develop and compare different scheme options.
For a selected scheme they can then track progress as they make refinements
to drive down the carbon impact.

See also

Embodied carbon workflow (page 620)

Embodied carbon workflow
The basic steps required to calculate, optimize and report embodied carbon
content are as follows:

Embodied carbon assessment (video)

Embodied carbon assessment in Tekla Structural Designer (eLearning)
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Set up embodied carbon factors
The factors to be assigned to model entities are set up from the which is
accessed from the Home ribbon by clicking:

Embodied Carbon Factors

Setting up and managing the embodied carbon factor (ECF) values is the
engineer's responsibility, although some sample ECF definitions have been
added to the settings sets for all countries/ codes for the following categories;
concrete, metal deck, reinforcement, steel, timber.

NOTE There is potentially considerable variability/ uncertainty in ECFs - for example
for concrete, many mix variations are possible for every strength grade and all
could be unique. Hence the sample ECFs are included principally for guidance
and are not a complete set - the engineer is advised to review, edit and add to
them as they need.

Many construction materials have ECF values that the engineer can use, and in
addition manufacturers may also provide third-party verified Environmental
Product Declarations (EPDs) which can be used when the engineer knows
exactly which manufacturer the material will be sourced from.

Standard ECF values should be saved in global settings so that they can be
applied to future models also. However there are some project specific ones
(like cladding for walls and roofs) that you would not want to make available
for all models.
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NOTE If you open an old model (i.e. one created before you established a global set
of ECF values), initially the won't contain any values, but you can click the
Load button in order to inherit any factors that exist as global settings.

Related tasks

•

Manage how factors are applied to the model
Once the factors have been set up, the same dialog is used to manage how the
ECFs in each category are applied to entities in the model.

You first select the main category you wish to view/edit at the top left e.g.
“Steel”. You can then review for this category the ECF list order, description
(which can be any variation of text and numbers etc) value, and the number of
assigned entities where applicable. This last figure is key to the management
process and is circled in the image below.

• The list of factors in the dialog can be further controlled by additional filters
below the main category, those available being dependent on the selected
category - e.g. by a grade filter for the material categories and/or by a
country filter for categories such as reinforcement and metal deck.

The current assignment of ECFs is constantly active, starting at the top of the
list and working down, so the top factor has first priority and so on.

From here you might choose to reorder the list of factors to suit the current
model by dragging and dropping factors with the mouse. The assignment of
factors updates automatically as edits are made - applicable factors at the top
of the list always being assigned wherever possible in preference to factors
occurring lower down the list.

If certain factors are inappropriate for the current model they can be
deactivated via the checkbox at the left of the factor to prevent them from
being applied.

Once an entity in the model has a factor from the list assigned the process
stops for that entity and category, hence there is no duplication of factor
assignment within a category where lower (in the list) ECF definitions are also
applicable.
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NOTE There is not a one-to-one relationship between model entities and ECFs - for
example a composite slab will have different ECFs assigned for its decking,
concrete material, and its reinforcement.

You can edit the description and/or value for ECFs and add additional ones via
the Add/Edit factor buttons. While doing this you can also set the category and
entity filters which control the grades and/or entity types to which the factor
applies. For example you could set a factor for the concrete category that
applies only to a specific grade and only concrete columns and beams. You
can also remove factors.

NOTE The category and entity filters available in the Edit Factors dialog are dictated
by the main category filter set at the top left of the dialog - e.g. “Concrete”,
“Steel”, “Cladding” etc. Thus for example only steel entity types are listed in
the Edit Factor dialog’s entity filter list when “Steel” is set as the main dialog
category.

NOTE Any amendments will only apply to the current model unless you choose to
save them back to the global settings set.

Note that as shown below, a message will be displayed in red text until every
entity in the model has had a factor assigned, the purpose of the message
being to highlight that the total embodied carbon mass of the structure will be
incomplete.

To help resolve this issue you can graphically review the carbon factors, as
described in the following Review how factors have been applied section.

Related tasks

•
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Review how factors have been applied
Probably the easiest way to review how the ECFs have been applied to the
model is graphically in a Review View.

By stepping through the applicable carbon source categories you can quickly
review how each of the factors have been applied.

An option is also provided here to apply overrides if required, (although
preferably you should consider adding new factors instead using the ). Setting
overrides is primarily recommended for entities that require different factors
but are indistinguishable in terms of their data (and so cannot be assigned
automatically) such as Roof/ Wind panels (in the “Cladding” category).

NOTE There is not a one-to-one relationship between model entities and ECFs - for
example a composite slab will have different ECFs assigned for its decking,
concrete material, and its reinforcement.

Related task

•

Examine tabular overview/details
At an early stage you might choose to display the Embodied Carbon Overview
in a Review Data Table. This is very useful because it rapidly provides a grand
total of the embodied carbon mass for the entire structure. This can be
summarized for the whole model either on a by plane basis....

or by construction type...
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The overview can also be filtered in order to see the totals for specific
construction types only, such as steel beams, as shown below.

If you want to investigate where the above values have come from, you also
have the option to display an Embodied Carbon Detail Review Data Table for
individual construction types.
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This can be displayed as a summary...

or, broken down to shown the separate components that contribute to the
total for each entity...
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NOTE For steel members with pinned or fixed connections, the carbon mass
of the connections at each end is determined as a percentage of that
of the member. This percentage can be adjusted via

Related tasks

• Create embodied carbon overview tabular results

• Create embodied carbon detail tabular results

Review utilization and embodied carbon
Once the model has been designed you can investigate the potential for
optimizing utilization and embodied carbon in a Review View.

This view shows the embodied carbon usage for all, or selected entity types. It
also has filters that can be configured to locate any parts of the model where
high carbon usage coincides with low utilization.

NOTE There is not a one-to-one relationship between model entities and ECFs - for
example a composite slab will have different ECFs assigned for its decking,
concrete material, and its reinforcement.

Having rapidly identified inefficiency in this way, you can then consider the
potential for optimizing your design in some way.

Related tasks

•
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Create reports
Embodied carbon mass is automatically included in the .

Additionally, a separate can be created which summarizes the embodied
carbon in the model by plane and by construction type.

NOTE You can also include a table of Embodied Carbon Factors in the same
report If required.

Related tasks

• Configure and display a Material Listing report

• Configure and display an Embodied Carbon report

1.12 Analysis verification examples

A small number of verification examples are included in this section. Our full
automatic test suite for the Solver contains many hundreds of examples which
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are run and verified every time the Solver is enhanced. These verification
examples use SI units unless otherwise stated.

1st order linear - Simple cantilever

Problem definition

A 4 long cantilever is subjected to a tip load of 20,000.

Assumptions

Flexural and shear deformations are included.

Key results

Result Theoretical
formula

Theoretical
value

Solver value % error

Support
Reaction

-P 20,000 20,000 0%

Support
Moment

PL -80,000 -80,000 0%

Tip Deflection -0.0519 -0.0519 0%

Conclusion

An exact match is observed between the values reported by the solver and the
values predicted by beam theory.

1st order linear - Simply supported square slab

Problem definition

Calculate the mid span deflection of an 8x8 simply supported slab of 0.1
thickness under self-weight only. Take material properties E=2x1011,
G=7.7x1010 and ρ=7849.
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Assumptions

A regular triangular finite element mesh is used with sufficient subdivision.
Flexural and shear deformation is included, and the material is assumed to be
isotropic.

Key results

The mid-span deformation is calculated using Navier's Method.

Result Theoretical
value

Comparison
1

Solver value % error

Mid-span
deflection

7.002x10-3 6.990x10-3 7.031x10-3 0.43%

Mid-span
Moment

23616 23708 23649 0.14%
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Conclusion

An acceptable match is observed between the theoretical values and the
solver results. An acceptable match is also observed between the solver
results and those obtained independently.

1st order linear - 3D truss

Problem definition

Three truss members with equal and uniform EA support an applied load of
-50 applied at the coordinate (4, 2, 6). The start of each truss member is fixed
and are located at (0, 0, 0), (8, 0, 0) and (0, 6, 0) respectively. Calculate the axial
force in each element.
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Key results

The results for this problem are compared against those published by Beer
and Johnston, and against another independent analysis package.

Result Beer and
Johnston

Comparison 1 Solver
value

% error

(0, 0, 0) - (4, 2, -6) 10.4 10.4 10.4 0.00 %
(8, 0, 0) - (4, 2, -6) 31.2 31.2 31.2 0.00 %
(0, 6, 0) - (4, 2, -6) 22.9 22.9 22.9 0.00 %

Conclusion

An exact match is observed between the values reported by the solver and
those reported by Beer and Johnston.

1st order linear - Thermal load on simply supported beam

Problem definition

Determine the deflection, U, due to thermal expansion at the roller support
due to a temperature increase of 5. The beam is made of a material with a
thermal expansion coefficient of 1.0 x 10-5.

Assumptions

The roller pin is assumed to be frictionless.

Key results

Result Theoretical
formula

Theoretical
value

Solver value % error

Translation at
roller

5x10-4 5x10-4 0%

Conclusion

An exact match is shown between the theoretical result and the solver result.
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1st order nonlinear - Simple cantilever

Problem definition

A 4 long cantilever is subjected to a tip load of 20,000.

Assumptions

Flexural and shear deformations are included.

Key results

Result Theoretical
formula

Theoretical
value

Solver value % error

Support
Reaction

-P 20,000 20,000 0 %

Support
Moment

-PL -80,000 -80,000 0 %

Tip Deflection  -0.0519 -0.0519 0 %

Conclusion

An exact match is observed between the values reported by the solver and the
values predicted by beam theory.

1st order nonlinear - Nonlinear supports

Problem definition

A 10 long continuous beam is simply supported by three translational springs
as shown. All springs have a maximum resistance force of 500. Calculate the
reaction forces and deflection at each support.
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Assumptions

Axial and shear deformations are ignored.

Key results

Result Comparison 1 Solver value
LHS Reaction 250 250
Centre Reaction 500 500
RHS Reaction 250 250
LHS Displacement -0.025 -0.025
Centre Displacement -0.797 -0.797
RHS Displacement -0.025 -0.025

Conclusion

An exact match is shown between the solver and the independent analysis
package.

1st order nonlinear - Displacement loading of a plane frame

Problem definition

Calculate the reaction forces of the plane moment frame shown below with
the applied displacement U.
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Assumptions

All elements are constant and equal EI. Axial and shear deformations are
ignored; to achieve the former - analytically the cross sectional area was
increased by a factor of 100,000 to make axial deformation negligible.

Key results

Results were compared with two other independent analysis packages.

Result Comparison 1 Comparison 2 Solver value
LHS Vertical
Reaction

6.293 6.293 6.293

LHS Moment
Reaction

-906.250 -906.250 -906.250

RHS Vertical
Reaction

-6.293 -6.293 -6.293

Conclusion

An exact match is shown between the solver and the two independent analysis
packages.

2nd order linear - simple cantilever

Engineers Handbooks 635 Analysis verification examples



Problem definition

A 10 long cantilever is subjected to a lateral tip load of 45 and an axial tip load
of 4000.

Assumptions

Shear deformations are ignored. Results are independent of cross section
area; therefore any reasonable value can be used. Second order effects from
stress stiffening are included, but those caused by update of geometry are
not. The beam is modelled with only one finite element, (if more elements had
been used the result would converge on a more exact value).

Key results

Results were compared with an independent analysis package.

Result Comparison Solver value
Tip Deflection -0.1677 -0.1677
Base Moment Reaction -1121 -1121

Conclusion

An exact match is observed between the values reported by the solver and the
values reported in “Comparison”.

2nd order linear - Simply supported beam

Problem definition

Determine the mid-span deflection and moment of the simply supported
beam under transverse and tensile axial load.
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Assumptions

Shear deformations are excluded. Results are independent of cross section
area; therefore any reasonable value can be used. The number of internal
nodes varies from 0-9.

Key results

The theoretical value for deflection and moment are calculated as:

Where U is a variable calculated:

No. internal
nodes

Solver
deflection

Solver
deflection %

Solver
moment

Solver
moment %

1 -0.116 0.734 % -0.901 8.631 %
3 -0.115 0.023 % -0.984 0.266 %
5 -0.115 0.004 % -0.986 0.042 %
7 -0.115 0.001 % -0.986 0.013 %
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No. internal
nodes

Solver
deflection

Solver
deflection %

Solver
moment

Solver
moment %

9 -0.115 0 % -0.986 0.005 %

Conclusion

As the element is subdivided the result converges to the correct theoretical
value.

Reference

Timoshenko. S. 1956. Strength of Materials, Part II, Advanced Theory and
Problems. 3rd Edition. D. Van Nostrand Co., Inc. New York, NY.

2nd order nonlinear - Tension only cross brace

Problem definition

Calculate the axial forces of the elements a-e shown in the 5x5 pin jointed
plane frame shown below. Elements d and e can resist tensile forces only.

Assumptions

All elements are constant and equal EA. A smaller value of EA will increase the
influence of second order effects, whereas a larger value will decrease the
influence.

Key results

Under the applied loading element e becomes inactive. The theoretical
formulas presented below are obtained using basic statics. Note that a
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positive value indicates tension. These results assume no 2nd order effects;
this requires the value of EA to be sufficiently large to make the 2nd order
effect negligible.

Result Theoretical
formula

Theoretical
value

Solver value % Error

a 0 0 0 0
b -P -100 -100 0
c -P -100 -100 0
d 141.42 141.42 0

e 0 0 0 0

Conclusion

An exact match is observed between the values reported by the solver and the
values predicted using statics. A 1st order nonlinear analysis can be used, with
any section sizes, to confirm this result without second order effects.

2nd order nonlinear - Compression only element

Problem definition

Calculate the reaction forces for the compression only structure shown below.

Assumptions

All elements are constant and equal EA, and can resist only compressive forces

Key results

Under the applied loading the element on the left becomes inactive, therefore
all applied loading is resisted by the support on the right.

Result Theoretical
formula

Theoretical
value

Solver value

LHS Reaction 0 0 0
RHS Reaction -P -1000 -1000
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Conclusion

An exact match is observed between the values reported by the solver and the
theoretical values.

1st order modal - Simply supported beam

Problem definition

Determine the fundamental frequency of a 10 long simply supported beam
with uniform EI and mass per unit length equal to 1.0.

Assumptions

Shear deformations are excluded. The number of internal nodes varies from
0-5. Consistent mass is assumed.

Key results

The theoretical value for the fundamental frequency is calculated as:

Where m is the total mass of the beam.

No. internal nodes Solver value % error
0 1.0955 10.995 %
1 0.9909 0.395 %
2 0.9878 0.081 %
3 0.9872 0.026 %
4 0.9871 0.011 %
5 0.9870 0.005 %

Conclusion

As the element is subdivided the result converges to the correct theoretical
value.
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1st order modal - Bathe and Wilson eignenvalue problem

Problem definition

A 2D plane frame structure has 10 equal bays each measuring 6.096m wide
and 9 stories 3.048m tall. The column bases are fully fixed. All beams and
columns are the same section, which have a constant mass/unit length equal
to 1.438. Calculate the first three natural frequencies (in Hz) of the structure
under self-weight.

Assumptions

Shear deformations are excluded. Each beam/column is represented by one
finite element. Consistent mass is assumed.

Key results

The results for this problem are compared with those published by Bathe and
Wilson and against an independent analysis package.

Mode Bathe and
Wilson

Comparison Solver value

1 0.122 0.122 0.122
2 0.374 0.374 0.375
3 0.648 0.648 0.652

Conclusion

The results show a good comparison with the original published results and
against the other analysis packages.

References

Bathe, K.J. and E.L. Wilson. 1972. Large Eigen Values in Dynamic Analysis. Journal
of the Engineering Mechanics Division. ASCE Vol. 98, No. EM6. Proc. Paper
9433. December.
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2nd order buckling - Euler strut buckling

Problem definition

A 10 long simply supported beam is subjected to an axial tip load of P.

Assumptions

Shear deformations are excluded. The number of internal nodes varies from
0-5.

Key results

The theoretical value for the first buckling mode is calculated using the Euler
strut buckling formula:

With P = -1.0 the following buckling factors are obtained

No. internal nodes Solver value % error
0 12.000 21.59 %
1 9.944 0.75 %
2 9.885 0.16 %
3 9.875 0.05 %
4 9.872 0.02 %
5 9.871 0.01 %

Conclusion

As the element is subdivided the result converges to the correct theoretical
value.

2nd order buckling - Plane frame

Problem definition

Calculate the buckling factor of the moment frame shown below.
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Assumptions

All elements are constant and equal EI. Axial deformations are ignored; to
achieve this the cross section area is set to 1000. The number of elements per
member is varied between 0 and 5.

Key results

The theoretical buckling load is calculated by

where

Which can be solved using Newtons method and five iterations

No. internal nodes/
members

Solver value % error

0 6.243 0.17 %
1 6.243 0.01 %
2 6.242 0.00 %
3 6.242 0.00 %
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No. internal nodes/
members

Solver value % error

4 6.242 0.00 %
5 6.242 0.00 %

Conclusion

A good match is shown between the solver and theory. The discrepancy
decreases as the level of discretization is increased.

References

Timoshenko, S. and J. M. Gere. 1961. Theory of Elastic Stability. 2nd Edition.
McGraw-Hill Book Company.
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